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Understanding file groups and Budget
plan file setup

Before setting up budget plan files, we recommend that you first familiarize yourself with file groups and
how they work.

Axiom Budgeting groups related files for a single year's annual budget into a file group. You maintain a
single, designated file group for the active budget. This section covers file groups in detail.

Accessing file groups
You access file groups from the File Groups section of the Explorer task pane. Your access rights to each
plan file (read-only or read/write) within a file group are determined by a combination of your security
settings and workflow or process settings (if applicable).

To access a file group:
In the ExplorerExplorer task pane, in the File Groups section, expand a file group to do the following:

1

Setup Guide Axiom Budget Planning │ 5



Option Description

Open Plan Files Select the plan files to open by double-clicking a budget file group's plan
file.

Create Plan Files Create and save empty plan files, per the configuration settings in
dimension tables and the file group's driver files.

Process Plan Files Load historical data into each budget plan file, then run calculations based
on calc methods in the dimension tables.

Copy Plan Files Copy plan files from one file group to another.

Drivers DriversDrivers store configuration settings and key statistics used
throughout the file group. Driver files control plan-wide settings, such as
the current planning period, and contain assumptions such as payroll-
related rates and percentages, production or utilization statistics, and
conversion rates that the plan files use to calculate and spread data.

Utilities If your organization has purchased certain add-on modules, you might
find additional utilities in this folder.

Process Definitions Lists processes defined for the files group. Budget plan files include the
Budget Approval Process definition, by default.

Scenarios This section is not used in Axiom Budgeting 2022.1.

NOTE: By default, only Administrators can see the file group administration options for a group.
Users without Administrator privileges can only open specific plan files for the file groups to which
they have access.

Working with file group aliases
Because you need to manage current and future plan files simultaneously, the task panes recognize the
fiscal year the administrator wants to point them to.

Additionally, using file group aliases allows you to determine when an annual update is made active in
your environment. You can obtain updates at any time an update is made available, without affecting
current operation settings.

In the ExplorerExplorer task pane, the File Group Aliases folder is located in themain File Group section.
There are three aliases available and are currently defaulted with values. BP_CurrentYear, BP_NextYear,
and BP_PriorYear.
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This means that when using task panes to open plan files, the file group aliases determine which plan file
set opens. For example, in the Budgeting task pane, there are two sets of budgets, Open Next Year
Budgets and Open Current Year Budgets.

When opening the Next Year Budgets, the dialog confirms that the plan files are for the next budget year.
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Setting the fiscal year for file group aliases
IMPORTANT: File group aliases also affect scheduled jobs. A scheduled job can only contain one
fiscal year setting. By changing the file group aliases, you may be changing a data set the job will run.
To confirm which file group aliases a scheduled job points to, open the job, and click Process Plan
Files from the task pane. The Select File Group box on theOptions tab displays the alias.

To set the fiscal year for file group aliases:
1. In the ExplorerExplorer task pane, in the File Groups section, right-click BP_CurentYear, and click

Edit.

2. In the File Group field, click the folder icon.

3. Select the file group to use for the current year budget plan files.

4. Click OK.

5. Repeat Steps 2-4 for BP_NextYear and BP_PriorYear.

Deleting a file group
Deleting a file group deletes all of the files stored in the associated file group folder, including templates,
plan files, drivers, calc method libraries, and workflows. Additionally, any document reference tables
linked to the file group are also deleted.
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IMPORTANT: You cannot undo this action, and the deleted files cannot be recovered using normal
Axiom Budgeting functionality. Be sure that you no longer need the file group before you delete it.
You may want to back up the Axiom database before deleting the file group.

To delete a file group:
1. In the ExplorerExplorer task pane, in the File Groups section, right-click the file group to delete.

2. Click Delete.

3. At the confirmation prompt, click Yes.

The system deletes the file group and all of its associated files.

Updating file group aliases
File group aliases are reference pointers that are used throughout the system to determine which file
group corresponds to which budgeting year.

IMPORTANT: The aliases must be set before copying driver security so that themost recent year is
used. For example, if a 2020 file group was created and the intent is to copy the file group security
from 2019, then BP_CurrentYear must point to 2019 File Group.

To update file group aliases:
1. In the Admin ribbon tab, click System Browser.
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2. In the Axiom Explorer window, click File Group Aliases, and double-click the BP_CurrentYear or
BP_PriorYear aliases to assign their respective file group year relative to the new file group year.
For example, if creating a new 2020 file group, set the BP_CurrentYear to 2019 and BP_PriorYear to
2018.

3. In the Edit File Group Alias dialog, click the folder icon.

4. In the Choose File Group dialog, select the file group, and click OK.

5. Click OK.

6. Click Close.
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Setting up Budget plan files
The numbered list below include the required and optional steps you need to complete to configure,
test, and release the budget plan files in your organization for the next budgeting season. The system
can also walk you through these same steps by running the Budget Checklist process.

TIP: The steps below link to the corresponding help topics, where applicable.

1. Change year and period.

2. Prepare data for budget go-live.

3. Reconcile data.

4. Create one plan file for each Labor tab template.

5. Process one plan for each Labor tab template.

6. Create plan files using the scheduled job.

NOTE: Run the Build & Process Budget Files job in Scheduler, and use a filter to run the job.
Review the log for errors once the scheduled job completes to confirm that no errors have
occurred.

7. Open a plan file, and save it to confirm there are no errors on save.

8. Review the Budget Configuration driver.

9. Review all the tabs of a plan file for reasonableness.

TIP: Specifically focus on the Stat_Rev, Expense, and Payroll tabs

10. General plan file tab review

a. Ensure navigation under Go To jumps as expected for all tabs.

b. Row/Col headers should be turned off for all tabs.

c. Confirm all print definitions look as expected.

d. Test each View option to ensure it displays/hides parts as expected.

2
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e. Verify print settings for all worksheets.

f. Save the plan file to the database without any errors.

g. Repeat steps below for different departments types (Nursing, Fixed, Admin).

11. Instructions tab review.

a. Review the due dates.

b. Review the budget questions.

c. Review the budget assumptions.

12. Summary tab review.

a. Do initiatives display as they should? Are initiatives set to be displayed in Budget
Configuration driver?

b. Review labels for proper year setting.

TIP: Projected Year settings are highlighted in blue in the Budget Configuration driver
and can be budget group specific.

c. Confirm columns hidden in the Budget Configuration driver are hidden in the plan file.

TIP: Set the Hide Column option in Budget Configuration driver.

d. Confirm "Display Contribution Margin on Summary Tab" is set properly.

TIP: Set the Display Contribution Margin on Summary Tab? option in Budget
Configuration driver.

e. Review dollar and % variances for NYB to ensure reasonableness.

13. Stat_Rev tab review.

a. Verify that History and YTD numbers are accurate.

b. Verify that Projected numbers appear reasonable.

c. Verify that all expected accounts interfaced.

d. Verify that accounts appear under the correct section.

e. Verify that accounts use the expected calc method.

f. Test changing a calc method type used in a plan file.

g. Confirm statistics coming from the Budget Statistics driver do not contain blue input cells.

h. Confirm correct Budget Method selection.
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i. Verify that sections without data are hidden, as expected.

j. Verify that the Global Drivers are reflected at the top from the Budget Driver driver for the
corresponding Budget Group.

k. Verify that all the expected drivers display.

l. Verify that key statistics, identified in Dimensions, are listed.

m. For revenue accounts, verify that the global adjustments display from the Budget Revenue
Adjustments driver.

n. Check review projections in CYP.

o. Test that the summary section for revenue ties with the detail sections.

p. Confirm that the columns hidden in the Budget Configuration driver are hidden in the plan
file.

q. Test to confirm red flag warnings disappear when all comments with red flags include
comments.

14. Expense tab review.

a. Verify that History and YTD numbers are accurate.

b. Confirm column labels are accurate from the Budget Configuration driver.

c. Verify that all expected accounts interface.

d. Verify that accounts display under the correct sections.

e. Verify that accounts use the expected calc method.

f. Test changing a calc method type used in a plan file.

g. Confirm that expense adjustments interface from expense-related drivers (Budget
GlobalExp, Budget GlobalData, etc.) for all calc methods (Budget Group specific).

h. Test resolving "Salaries do not match" warning.

NOTE: Test with provider and non-provider plan files.

i. Test using ePTO with and without ePTO (Gross and Net).

NOTE: See the Earned Paid Time Off setting in the Budget Labor Configuration driver to
configure this feature.

j. Test resolving "Hours do not match" warning.

NOTE: Test with provider and non-provider plan files.
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k. Ensure that the Budget Method is correct for Detail Method.

l. Review the Statistics spread total for Key Stat accounts.

m. Confirm that the projected numbers appear reasonable.

n. Confirm that the columns hidden in Budget Configuration tab are hidden in the plan file.

o. Confirm that KHABgtMap works as expected.

NOTE: The DEPT column for calc methods that use KHABgtMap will be highlighted in a
different background color. The DEPT column is visible ONLY if KHABgtMap is in used.
Otherwise, the column is hidden.

p. Test the drilling feature by drilling historical GL Transactions.

NOTE: See the Expense Transaction Drilling setting in the Budget Configuration driver to
enable this feature.

q. Confirm that the Use Preliminary Estimate on Detail Calc Method option in the Budget
Configuration driver works as expected.

15. Labor tab review.

a. Verify that the plan files interface with the expected labor type.

NOTE: ACCT.KHAStdLine (or other StdLine columns) Calc Method selection (Labor,
ProviderLabor, etc.)

b. Verify that the expected job codes are interfaced.

NOTE: All job codes that work in the Dept YTD will be interfaced into the Dept.

c. Review the Uniform Merit Increase Date.

d. Review the FTE Comparison to YTD.

e. Test with Projected FTE Starting Point.

f. Test with Forecast FTEs from Projection.

g. Change the titles for Program Additions Title and Position Changes Title, and confirm it
displays up in the plan file.

h. On the Staffing and Jobcode tabs, test % of Staffing Change with Volume.

NOTE: The default is set to 60% for Variable job codes.

i. Ensure that the FICA limits apply, regardless of the fiscal year (it should taper down in the
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months of Oct – Nov, regardless of the fiscal year).

j. Ensure that the total dollars match the dollars on the Expense tab.

k. Confirm that the YTD Hours and YTD Dollars are accurate.

l. Confirm that the GL mapping is accurate.

TIP: Select the Audit view in the Labor tab to confirm the account coding.

m. Test the Dept_BasePay calc methods.

n. Review the allocation rates in the JobCode block for reasonableness.

o. Confirm that the PayTypeMapping Analysis report includes no variances.

p. Confirm that only the PayTypes mapped on the Budget Labor Configuration driver interface
into the Jobcode block.

q. Confirm that the Contract labor (Agency) is set up and interfaces appropriately.

r. Confirm ePTO GLAcct maps correctly when set to Yes.

NOTE: Review the Earned PTO Hours Conversion Factor (by default, the system sets
this to 80 hours) and PTO per FTE (by default, the system sets this to 176).

s. If using Lump Sum, confirm that the Budget Labor Limits is set up for max rates.

NOTE: The default is 100% for full payout ofmerit abovemax rate.

t. Test by adding a new PayType to the Dollars section of JobCode block.

u. Review the Fixed/Variable coding for each job code and test variability.

NOTE: For JobCode and Staffing labor tabs only; Comes from Dimension setting
JobCode.Variable.

v. Test the overrides from the driver, if Budget Group specific.

NOTE: Cross check with the Budget Labor Override driver.

w. Update/change the days staffed and shift hours (impacts variable spread)

NOTE: For the Staffing and JobCodeADC labor tabs only.

x. Employee labor tab only:

l Confirm that the Empl_List tab is unavailable.
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l Review the Employee labor tab for a complete list of the employees.

y. ADC labor tab only:

l On the ADCConfig tab, add a block for Global Budget Group and Dept Exceptions.
Ensure that the ADCConfig tab options came through as expected.

l Confirm that the Jobcode and ADC tabs are equal to each other for FTEs.
l Review FTEs and Hours calculations for reasonableness.

16. Empl_List tab review.
a. Verify all of the interfaced data (comes from EmployeeMaster import).

b. Check that all employees or job codes display under their home department.

c. Check that increases are populated.

d. Test the Lump Sum options.

17. Initiatives tab review (if applicable).
a. If enabled in New Initiatives tab of drivers, all the approved initiatives display on the

Summary tab, and save to the database.

b. The list of initiatives that displays in the New Initiatives tab of Drivers is available for
selection.

c. Test by adding new calc methods.

18. Dept_History tab review.
a. Validate data by ensuring that the historical data ties to department P&Ls.

b. Check that the Dept column for calc methods that use KHABgtMap are highlighted in a
different background color.

NOTE: The Dept column is visible ONLY if KHABgtMap is used. Otherwise, the column is
hidden.

19. Provider and Provider Comp tab review.
a. Verify that History and YTD numbers are accurate.

b. Verify that projected numbers appear reasonable.

c. Verify that all the providers that meet the threshold setup display, if applicable.

d. Verify the summary section totals the detail sections.

e. Verify that all stats and revenue flow to the Stat_Rev tab, as expected.

f. For Provider Detail methodology:
l Verify the FTE is pulling from the ProviderComp tab.
l Review the overall driver for the department, and compare the production days
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based on provider FTE.
l Verify that seasonality appears reasonable, if provider has at least one year of

history.
l Review the various data breakout, if using the detail method, to make sure the data

is grouped appropriately.
l Review the Gross Charges section, and verify that the charges calculate either on

Encounter, WRVU, Procedure, or RVU.

g. Provider Summary methodology:
l Verify that the system appropriately pulls FTE and driver stats from the Simple Dept

Config driver.
l Verify that the system pulls the spread from the Simple Dept Config driver.

h. Verify that the expected job codes relating to providers interface with the ProviderComp
tab.

NOTE: The system will interface all job codes that have worked in the department YTD
into the department when the KHAInt on the Jobcode dimension is set to Provider.

i. Verify that the YTD Hours and YTD Dollars are accurate.

j. Verify that RVUs flow from the Provider tab.

k. Verify that the Comp Models pull properly from the Provider List driver.

l. Complete a few calculations manually to verify that the expected salary calculates.

m. Review the compensation spread for reasonableness.

n. Verify any additional pay/benefits either calculate properly in the provider block and/or pull
appropriately from the Provider List driver.

o. Ensure that the FICA limits are applicable, regardless of the fiscal year.

NOTE: It should taper down in themonths of Oct – Nov, regardless of the fiscal year.

p. Verify that the GLMapping is accurate and flowing to the Expense tab.

20. Reconcile the budget.
a. Schedule nightly recalculation for all budgets to transfer results to the database.

b. Correct any errors encountered during the recalculation process.

c. Review the Budget Income Summary report for reasonableness.

21. Run and review optional calculator reports.
a. NewDepartment utility
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TIP: This utility is located in the Utility section of the file group year you will use for the
planning cycle.

b. Deductions Calculator by Payor utility

TIP: Do not create a plan file for the Budget Deduction Department when using this
utility.

c. Deductions Calculator using FSDetail utility

d. Deductions Calculator using FSPayor utility

e. Budget Balance Sheet and Cash Flow utility

22. Run and review Budget Reconciliation reports.
a. Budget Department Audit report

b. Budget Process Management report

c. Budget Workbook Reconciliation report

d. Global Depreciation Reconciliation report

e. Global Expense Reconciliation report

f. Global Revenue Reconciliation report

g. Labor Non-Matched report

h. Payroll12 Hours Reconciliation report

i. Payroll12 Negative Hours report

j. PayTypeMapping Analysis report

k. Reconcile NYBDetail to Financial report

l. Reconcile Payroll12 to Financial-Dollars report

m. Reconcile Payroll12 to Financial-FICA report

n. Reconcile Payroll12 to Financial-Hours report

o. Salaries Do Not Match report

23. Delete test plan files.

24. Clear test data from the budget data table.

25. Build budget plan files.

26. Process budget plan files.

27. Verify plan file creation and interface.
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28. Advance the plan files using Process Management to Owner stage.

Running the Budget Checklist process
Use this process to walk you through the steps needed to create plan files for the next budgeting season.
The Budget Checklist process displays all of the steps to complete on the left side of the window. Those
steps that include sub-steps are indicated with an arrow icon, which you can click to expand or contract
the list.

To run the Budget Checklist process:
1. In the Bud AdminBud Admin task pane, in the Prepare Budget Plan Files section, double-click

Budget Checklist.

2. In the Process Owner field of the Process Properties tab, do one of the following:
l To assign a specific user as process owner, click Select User.
l To assign users with specific roles as process owners, click Select Role.

NOTE: You must assign a user or role before you can run this process.

3. Click Start Process in the upper right corner of the dialog.
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4. At the Start process 'Budget Checklist' prompt, click OK.

5. As you complete each step, click Complete step in the upper right corner of the screen.

TIP: An arrow icon displays next to steps that contain sub-steps. Click the icon to expand or
contract the list of sub-steps.

NOTE: You can skip steps that do not apply to your organization.

6. In the Process Action dialog, you can enter any details about the step you performed, and click
OK.

TIP: The dialog also displays the next step in the process.
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7. If you need to stop the process as you work on the different steps, click Stop process in the upper
left corner above the list of steps. This places the process in an inactive status until you are ready
to start the process again.

TIP: To view a report of the process history, click Process history in the upper left corner above
the list of steps.

8. At the Are you sure that you want to stop this process? prompt, click OK.

Setting year and period
Use this table to configure the following for your organization:

l Set the fiscal year and the first month of the fiscal year
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l Define the number of work days in the current year, last year, and next year
l Select the standard Full Time Equivalent (FTE) hours worked by employees in a year.

l For Budget Planning, the 02 Budget Labor Configuration driver will use the default FTE scale
created in the Year/Period Form but allow for modifications to the default at the Global and
Budget Group level.

NOTE: The standard FTE hours you select in this worksheet displays as the default FTE Hours in the
Budget Labor Configuration

The FTE Hours you select are reflected on the following tabs in the plan file:

l Expense
l Jobcode
l Staffing
l Employee
l ProviderComp
l altEmployee
l HHLabor
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To set year and period:
1. In theManagement Reporting Admin task pane, in theData Maintenance section, double-click

Update Year and Period Tables.

2. In the Primary Inputs section, complete the following options:

Option Description

Fiscal Year Select the fiscal year.

Fiscal Start Month Select themonth in which the fiscal year starts.

Day Type Select Calendar Days or Work Days.

FTE Scale Select a Daily, Weekly, Monthly, or Yearly scale.

FTE Hours Use one of the option to input the FTE value associated with the
FTE Scale field selected above:

l To use the standard of the number of days worked multiplied by a
40-hour work week divided by 7, type 2086.

l To use the standard 40-hour work-week multiplied by 52weeks,
type 2080(default).

l To use a custom FTE value, type it. To viewmultiple examples of
how to use this field, see the section Examples of custom FTE
scales below.

3. In theWorking Days Inputs area, enter the number of working days for the current year, last
year, and next year for each fiscal month.

TIP: To hide the year and/or period tables, click the corresponding check boxes under the
Working Days Inputs section.

NOTE: When you select Work Days from the Day Type drop-down, Daily is the only available
option from the FTE Hours drop-down.

4. After making your changes, click Save.
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� Examples of custom FTE scales
You can configure the FTE Scale to suit the needs of your organization in a variety of ways, here are some
examples:

Yearly
To calculate a full-time equivalent based on the yearly scale, complete the following:

1. In theDay Type drop-down, select Calendar Days.

2. In the FTE Scale drop-down, select Yearly.

3. In the FTE Hours field, type 2085.714.

NOTE: The default of 2080 hours per year displays next to FTE Hours.

The system displays themonthly hours worked based on your configuration in the Period Table section.
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NOTE: After you save your changes, the system will display values based on this configuration in the
Period Table section.

Daily
To configure a scale for 2080.5 instead of the standard 2086 (2085.71) scale, complete the following:

1. In theDay Type drop-down, select Calendar Days.

2. In the FTE Scale drop-down, select Daily.

3. In the FTE Hours field, enter 5.700.

NOTE: The FTE Hours default for this configuration is 5.7 hours per day.
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NOTE: After you enter your Primary Inputs, the Period Table section displays the calculated results
in real timewhich allows you to view your configuration before saving data.

Weekly
To configure an annual FTE of 2085.71 based on a weekly calculation of 40 hours per week, complete the
following:

1. In theDay Type drop-down, select Calendar Days.

2. In the FTE Scale drop-down, selectWeekly.

3. In the FTE Hours field, type 40.00.

NOTE: The default for this configuration is 40 hours per week.
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NOTE: After you save your changes, the system will display values based on this configuration in the
Period Table section.

Monthly
To configure on a scale where employees work that same number of hours per month, in this example an
annual FTE scale set to 2080 hours, where themonthly FTE hours are 173.3333, complete the following:

1. In theDay Type drop-down, select Calendar Days.

2. In the FTE Scale drop-down, selectMonthly.

3. In the FTE Hours text box, type 173.3333.

NOTE: The default for this configuration is 160 hours per month (for a 30 day month).
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NOTE: After you save your changes, the system will display values based on this configuration in the
Period Table section.

Preparing data for budget go-live
Importing and loading data is an important part of keeping your budget up-to-date and correct. We
recommend that you perform these actions on a biweekly and monthly bases.

The following topics provide instructions on running the required and optional data imports reports.
These are the same imports you will run to create your monthly reports.

IMPORTANT: You must load and reconcile data before you start building and processing plan files.

Run these imports and utilities in the following order to load your data into the system:

1. Import General Ledger data - The Load 12Month import brings in 12months of General Ledger
data from your source system. This will include values for revenues, deductions, expenses, etc. -
including values for balance sheet (if provided).

2. Import Monthly Statistics data - The Load Monthly Stats import brings in departmental-level
statistics, including key and non-key statistics. This can also include facility-level statistics. If payroll
hours are not imported through the Payroll Transfer utility, then they will commonly be imported
using this import.

3. Import Biweekly Payroll data - Imports biweekly payroll data, which includes identifying
department, job code, pay type, and employee ID values.

4. Load EmployeeMaster - Imports the employee level detail information, including base rate,
full/part time status, anniversary date, PTO balance, etc. The employees are listed by job code.
The employeemaster is used in the interfacing and plan files to apply merit and market
adjustments.

5. Loading Revenue and Usage data - Imports your Charge Description Master (CDM)monthly data,
including department, CDMCODE, revenue and volume type (i.e. inpatient, outpatient).

NOTE: This import only applies if your organization is licensed for the CDM template.

6. Load Provider Data - Imports the transactional-level records for a provider, including ID,
department, and key database fields such as CPT, location, FinClass, and other related records.
This information is used for reporting and budgeting purposes. Once loaded, you can configure
whether to use the Provider Summary or Provider Detail options, and adjust your dimension
accordingly. This is the core transactional data from your provider billing database.

NOTE: This import only applies if your organization is licensed for the Provider feature.
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� Other imports
These imports can be run in any order, as needed, with the exception of the Biweekly to Monthly Payroll
Accrual utility. While these imports are not required to create budgets, they do provide enhanced
reporting and plan file analysis without having to leave the Axiom application.

l Running the Biweekly to Monthly Payroll Accrual utility - Run this utility to accrue for hours,
dollars, and statistics from your biweekly payroll import(Payroll26) into themonthly data tables
(Payroll12).

IMPORTANT: This utility is a prerequisite to using theMonthly to GL Accrual utility.

l Running theMonthly to GL Accrual utility - If payroll hours are not coming through your GL
Import, you can move your hours from the Payroll12 data tables created from the previous
process to your Financial tables by running theMonthly to GL accrual utility.

IMPORTANT: Only run this utility if you are not loading hours from your GL using the GL12
Month or Monthly Statistics imports (step 1 or 2 above).

l Loading AP Detail data - Imports your Accounts Payable sub-ledger detail, including amount,
check date, check number, invoice date, invoice number, etc.

l Loading GL Detail data - Imports your general Journal Entry detail, including department, account,
and other identifying information.

l Loading MM Detail data - Imports your Materials Management sub-ledger detail, including
amount, item number, item description, location, quantity, unit price, and vendor information.

l Loading Accrued Receipts data - Imports your Accounts Receipts sub-ledger detail, including item
number, description, invoice date, vendor name and number, and other vendor identifier
information.

l Summarizing CDM statistics to financial - To use your Charge Description Master (CDMCODE) to
create your statistics, we offer a save-to-database utility that summarizes the inpatient and
outpatient volumes in the RevUsage database (ACT_RU_20XX) into statistic accounts that can be
stored in the Financial database (ACT20XX).

NOTE: For this utility to work, your Syntellis Implementation Consultant will help you design
your CDMCODE table during the implementation.

� Resolving import errors
If any of the imports experience validation errors, you can view them in two places in the system: a
separate CSV file and the Execution log area of the Execute Import dialog, as shown in Step 8 of Loading
GL12Month data.

For more information, see Resolving import validation errors.
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� Generating and publishing monthly reports
After the report data is imported and any import errors are resolved, you can run the Department
Monthly Package report to pull together the different monthly reports with the imported data and
distribute them to the appropriate personnel. For more information, see the following:

l Understanding the Department Monthly Package
l Configuring the Department Monthly Package report
l Processing and distributing the Department Monthly Package report

Loading GL12 Month data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a GL_ prefix.

To load GL12 Month data:
1. To change the current period, in the Admin ribbon tab, in theDatabase group, click Imports &

Utilities > System Period/Year.

2. In the System Current Period dialog, in theNew Value field, type the newmonth value, and click
OK.

IMPORTANT: Do not change the System Current Year field unless changing over a new fiscal
year. Setting the system period and year could affect other Axiom Healthcare Suite products.

3. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports,
Management Reporting> 01-Load GL 12 Months, and click Execute.
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4. Click Execute.

5. In the Variables dialog, do the following, and click OK:
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Field Steps

Table: Select Table Select the ACT or BUD table.

Year Selection: Input
Year (YYYY)

Type the year to load.

6. In the Choose the import source file dialog, select the source file to load.-

If the import encounters validation errors, see Resolving import validation errors.

7. After you load the data, run the Income Statement Summary report in Explorer in Reports Library
> Management Reporting > Income Statement > Income Statement Summary to reconcile to
your GL income statement.

Loading Monthly Statistic data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a ST_prefix.

To load Monthly Statistic data:
1. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports >

Management Reporting > 02-Load Monthly Stats, and click Execute.
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2. Click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

Table: Select Table Select the ACT or BUD table.

Year Selection: Input
Year (YYYY)

Type the year to load.

4. In the Chose the import source file dialog, navigate to the location where you stored the source
file, and select it.

NOTE: We recommend that you name the file using a ST_ prefix.

If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

5. If you are not loading your statistics through an import set up by your Kaufman Hall
Implementation Consultant, then you can also load statistics using a Save to Database report.
There are standard reports delivered with your system for this, which you can find in Explorer in
Management Reporting Utilities > Data Input > Input Monthly Statistics.

6. Use the top section of the report, labeled Add New Stats, when entering a newDept-Acct
combination into the database.
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If needed, you can copy additional rows by copying the entire row, and then using the Insert
Entire Row option in Excel. If you Refresh the report, it will bring in all existing statistic
combinations from the database, and you can then update any monthly value in the blue cells in
the Change Existing Stats section.

7. After you complete your inputs, from theMain ribbon tab, click Save to send the data into the
database and save the report.

Loading Biweekly Payroll data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
The file should be saved as LD_MMDDYY_PP. For example, LD_100418_1

To load Biweekly Payroll data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Table Current Periods.
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2. Filter using the Table Type, and select Payroll.

3. Change the period for all of the payroll tables where theUses System checkbox is not selected.
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4. In the Table Current Periods dialog, double-click the current period for the table, and type the
new period.

5. When you have finished all the tables, click OK.
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6. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 03-
Load Biweekly Payroll > Execute.

7. In the Execute Import: 03-Load Biweekly Payroll dialog, click Execute.

8. In the Variables dialog, do the following, and click OK:

Field Steps

Year Selection: Input
Year (YYYY)

Type the year to load.

PayPeriod: Input
Period (1 – 27)

In the drop-down, select the pay period to load to.
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9. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

10. If there are any import exceptions, follow the import exceptions remediation from .

Loading Employee Master
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a LM_prefix.

To load Employee Master:
1. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports >

Management Reporting > 10-Load Employee Master, and click Execute.
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2. Click Execute.
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3. In the Variables dialog, do the following, and click OK:

Field Steps

Yr: Input Year (YYYY) Type the year to load.

4. In the Chose the import source file dialog, navigate to the location where you stored the source
file, and select it.

NOTE: We recommend that you name the file using a LM_ prefix.

If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

5. After you complete your inputs, from theMain ribbon tab, click Save to send the data into the
database and save the report.

Loading Revenue and Usage data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a RU_prefix.
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To load Revenue and Usage data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 09-

Load RevUsage > Execute.

2. In the Execute Import: 09-Load RevUsage dialog, click Execute.
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3. In the Variables dialog, do the following, and click OK:

Field Steps

YR: Input Year (YYYY) Type the year to load.

Month: Select
Current Month

In the drop-down, select themonth to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Loading GL12
Month data.

Loading Provider Detail data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a PB_prefix.

To load Employee Master:
1. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports >

Management Reporting > 4-Load Provider Detail, and click Execute.
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2. Click Execute.
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3. In the Variables dialog, do the following, and click OK:

Field Steps

Yr: Input Year (YYYY) Type the year to load.

Month: Select
Current Month

Select themonth to interface the data into the system from the drop-
down.

4. In the Chose the import source file dialog, navigate to the location where you stored the source
file, and select it.

NOTE: We recommend that you name the file using a PB_ prefix.

If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

5. After you complete your inputs, from theMain ribbon tab, click Save to send the data into the
database and save the report.
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Loading AP Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with an AP_prefix.

To load AP Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

06-Load AP Detail > Execute.

2. In the Execute Import: 06-Load AP Data dialog, click Execute.
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3. In the Variables dialog, do the following, and click OK:

Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading GL Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a JE_prefix.

To load GL Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

05-Load GL Detail > Execute.
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2. In the Execute Import: 05-Load GL Data dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading MM Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with an MM_prefix.

To load MM Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

07-Load Materials Issues> Execute.
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2. In the Execute Import: 07-Load Materials Issues dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading Accrued Receipts data
Make sure the import file is created and saved to a directory accessible by the Axiom Application server.
We recommend naming the file with an AR_prefix.

To load Accrued Receipts data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 08-

Load Accrued Receipts > Execute.
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2. In the Execute Import: 08-Load Accrued Receipts dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Summarizing CDM statistics to financial
To use your ChargeMaster (CDMCODE) to create your statistics, we offer a save-to-database utility that
summarizes the Inpatient and Outpatient volumes in the RevUsage database (ACT_RU_20XX) into
statistic accounts that can be stored in the Financial database (ACT20XX). For this utility to work, your
Kaufman Hall consultant will help you design your CDMCODE table during the implementation.

To summarize CDM statistics to financial:
1. To run this Save to Database utility, navigate to In the ExplorerExplorer task pane, in the Libraries

section, click the Reports Library > Management Reporting Utilities > RevUsage folder, and
double-click Summarize CDM Statistics.

2. In the drop down box in cell M19, select whether you are running the process for Current Year or
Last Year.
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3. Refresh the data by doing one of the following:

l In theMain ribbon tab, click Refresh Data.

l Press F9.

4. In the File Processing task pane, click Process file.
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NOTE: You do not need to run this utility using Multipass unless you are a large health system and
are noting performance issues when previously running.

Resolving import validation errors
If the import experiences import validation errors, you can view them in two places in the system: a
separate CSV file and the Execution log area of the Execute Import dialog, as shown in Step 8 of Loading
GL12Month data.

The CSV file is located in Explorer in the Imports Library > Management Reporting > Import Errors
folder.
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The CSV file shows you which rows of data were invalid within the context of the import data. This error
file includes the following:

l Look up validation errors from Kaufman Hall's Software's built-in validation against lookup
columns.

l Validation errors from any Custom Data Validation steps in the transforms.

l Key validation errors such as blank keys or duplicate keys.

You can also open the file from the Execute Import dialog by clicking the link the Status area. The status
displays either "failed" or "warning," followed by "click here to open errors in a spreadsheet." The status
type depends on whether the option to Ignore lookup and key errors is selected.
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Each execution of an import that results in a lookup error generates a unique error file (differentiated by
a date/time stamp). These error files are not automatically deleted; you must manually delete them
when you finish investigating the error.

The CSV file contains the import data, followed by one or more validation columns. Validation columns
are labeled as follows:

l LookupColumnName Lookup Error column – Contains lookup and key validation messages. For
example, Acct Lookup Error"\ when looking up against the ACCT column.

l AXTRANSFORM_StepNumber column – Contains Custom Data Validation messages where
StepNumber is the number of the associated transformation step. For example, AXTRANSFORM_5
when the associated transform is step 5 in the list.

If there are errors (most commonly new codes in Dimensions), add those codes to dimensions, and re-
run the import.
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Reconciling data
After importing and loading the data, you need to reconcile it to make sure it enters the system correctly
before starting the budget process. We recommend that you perform these actions on a biweekly and
monthly bases.

The following topics provide instructions on running the required reconciliation reports. These are the
same reports you will run to create and reconcile your monthly reports.

IMPORTANT: You must load and reconcile data before you start building and processing plan files.

Run these imports and utilities in the following order to load your data into the system:

1. Reconcile Income Statement - Use this report to review the Income Statement totals by FSDetail
category for the current period and year-to-date compared to budget and prior year.

2. Reconcile GL to GL Transactions - If you load sub-ledger detail, such as Accounts Payable (AP),
Accrued Receipts (AR), Materials Management (MM), and Journal Entries (JE), we have a
reconciliation utility that ties the sub-ledger data back to the General Ledger data (ACT20XX). This
report confirms that the data loaded to the GL matches the data loaded to the Journal Entry (JE)
detail. It also compares the JE detail to AP, MM, and AR transactions to make sure the data
balances.

3. Reconcile GL to RevUsage - Use this report to reconcile GL revenue data in the Financial tables to
the Revenue and Usage data imported into the database on a monthly and year-to-date basis.
The desired result for this report is to show a zero variance.

4. Monthly RevUsage Reconciliations (For CDM template licensed users only) - After all revenue and
usage data is loaded, run theMonthly RevUsage Reconciliation. This report shows the IPVolume,
IPRevenue, OPVolume, and OPRvenue by department for each month.

5. Biweekly Payroll Reconciliation - Run this report after loading the biweekly payroll data to validate
totals for the dollars, hours, and statistics from the import file.

Working with Dimensions
Dimensions are the key index fields for the tables in the Axiom Budgeting 2022.1 database. All data in the
system will be associated with one or more dimensions.

A few examples of dimensions used in Axiom Budgeting 2022.1 include:

Each dimension has multiple fields. The fields within dimensions tables are typically referred to as
columns. Field/column names are expressed as tablename.fieldname.

Setup Guide Axiom Budget Planning │ 58



When Axiom Budgeting 2022.1 is first implemented, your Syntellis Implementation Consultant helps you
configure the dimension tables to reflect the structure of your organization (departments, entities,
accounts, and so on). Subsequently, you may need to edit dimensions in order to add new departments,
accounts, positions, pay types or other items to the database.

Working with the Dimension Maintenance Utility
Your organization may usemultiple distinct Entity Management branches within your structure to help
manage your Axiom products. It might be the responsibility of each local product administrator to
maintain their own elements within dimensions for each Axiom product that your organization is
licensed for. Additionally, and ideally, each administrator should not be able to modify elements outside
of their area, otherwise, reports and processes could be negatively impacted.

The Dimension Maintenance Utility allows the administrator for a local branch to manage only grouping
columns within a dimension and limits this dimension to only the elements that the administrator has
access to.

IMPORTANT: Version 2017.1 and higher includes a variety of security changes to enable this tool. The
dimension tables have been restricted to read-only access until the system administrator configures
a user for dimension maintenance security. For more information, see Editing the security rights for a
user.

The Dimension Maintenance Utility allows administrators to:

l Havemulti-user and filtered access to key universal dimensions.

l Restrict dimension grouping column maintenance to specified product grouping columns.

l Create dimension grouping columns, and assign them to products.

l Add new records and update all validated grouping columns, even when they are outside of that
product range.

l Create dimension grouping columns that automatically display in an organized manner.

To enable the Dimension Maintenance functionality described above, the following features were
created:

l In the Edit Data Structuremode, administrators can manage grouping columns using datasets.
l In the Dimension Maintenance Utility, depending on their roles, users can select the products and

dimensions to maintain.
l Using the security feature in the Dimension Maintenance Utility, for each product, administrators

can quickly assign write filters to those users who have an administrator role assigned to them.

The following table represents which dimensions are part of each product. A check mark means users can
access the dimension using the Dimension Maintenance Utility, but the records each user can edit
depends on the security filter applied to each.
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The following dimension tables are not affected by this update and are not part of the Dimension
Maintenance Utility. Each of these dimensions retain:

l Full edit rights, per authorized user.
l Ability for direct table edit.
l Leverage existing edit tools as you have used in the past.

Setup Guide Axiom Budget Planning │ 60



IMPORTANT: Because Axiom Budgeting and Performance Reporting uses CDMCODE, GLPERIOD, and
INITIATIVEID dimension tables, which are not included as part of the Dimension Maintenance Utility,
you will need to access these dimensions in the Budget System Maintenance > View Dimension
Tables area of the Bud Admin task pane or from the Explorer task pane.

Configuring the Dimension Maintenance Utility

To configure the Dimension Maintenance Utility, do the following:

1. Configure the utility to assign any custom dimension grouping column to their respective
products. For more information, see Assigning an existing grouping column to a dataset (product).

2. Configure the security for each administrator user in the utility. You must apply a dimension filter
to any member that you want to have edit rights. IfNotConfigured displays, then the user does
have edit ability. A filter grants users edit abilities for those records within the assigned filter. For
more information, see Editing the security rights for a user.

3. Review and test the Dimension Maintenance Utility.

Editing the security rights for a user

You can only access the security management feature of the Dimension Maintenance Utility if you are
assigned the security administrator role.

With Dimension Maintenance - Security, you can set in bulk the security rights for all users assigned a
product administrator role for all dimensions for a specific dataset (product).
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NOTE: If a user is assigned as an administrator for a product and as a user for another product, the
user can only access the tables for the product they are administrator of. For example, if a user is a
product administrator for Axiom Cost Accounting and a user for Axiom Budgeting and Performance
Reporting, the user would only be able to edit the dimensions for Axiom Cost Accounting.

IMPORTANT: For a user (with a product administrator role) to edit a dimension, you must first assign
them security rights using this utility.

To edit the security rights for a user:
1. From the Explorer task pane, in the Reports Library section, select System Files > Dimension

Maintenance, and double-click Dimension Maintenance - Security.

2. In the Select a Product drop-down, select the product to display the respective product
administrators, and click OK.

3. Select a user, and do one of the following:

IMPORTANT: IfNotConfigured displays in the cell, then the user does not have edit rights. For
full edit access on numeric dimensions, enter >= 0, for example Acct > 0.
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To... Then...

Use the filter
wizard to specify
the security
rights

a. Right-click the cell to edit.

b. Select Axiom Wizards > Filter Wizards.

c. Use the Filter Wizard to select and specify
the security rights for a product
administrator. For more information on
using the Filter Wizard, do the following:

i. On theMain ribbon tab, click Help.

ii. In the left navigation pane, click
Reference > Filters > Filter
Wizard.

Enter the
security rights
manually

Click in a cell, and type the rights.

In the following example, Angela is not authorized to edit the ACCT dimension. She can, however,
edit the DEPT dimension records for departments that belong to Entity 2.

4. In theMaintenance - Security table, at the top of the utility, On indicates saving will post changes
to the database.
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NOTE: The ability to save is initially enabled (On). Clicking Save on theMain ribbon tab posts
any changes to the database.

5. In theMain ribbon tab, click Save.

Assigning an existing grouping column to a dataset (product)

You can associate each grouping column you create with multiple licensed products. The assignment
determines which product each column gets displayed under within the Data Maintenance utility.

NOTE: You can only perform assignments for custom columns that your organization has added. We
recommend that you do not change the assignments of any standard columns included with the
product.

IMPORTANT: Make sure to define a default value entry for the column. To do this, complete steps 1-
8 of Creating a grouping column.

To assign an existing dimension grouping column to a dataset (product):
1. From the Explorer task pane, in the Libraries section, click Table Library > !Dimensions.

2. Right-click a dimension, and select Edit table structure.

Setup Guide Axiom Budget Planning │ 64



3. In the Edit Table dialog, click the Columns tab.

4. In the list of columns, select a column to assign, and click the Assign Column to Data Sets button.

5. In the Data Set Assignment dialog, in the list of data sets (products) that have predefined for you,
select the checkbox next to the products to assign this grouping column to, and click OK.

NOTE: The list that displays will vary depending on the Axiom Healthcare Suite products you
are licensed to use.

Setup Guide Axiom Budget Planning │ 65



Product Product Node

Budget Planning BP

Financial Planning FP

Rolling Forecast RF

Cost Accounting Cost

Cost Management CM

Capital Planning CP

Decision Support DSS

Capital Tracking CT

Performance Reporting PR

Available to all related products General
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After you select the products, they display in the Edit Table dialog in the Product Data Sets field.

6. In the Edit Table dialog, click OK.

Managing dimensions
After you configure the Dimension Maintenance Utility and set the security rights for the appropriate
users, they can access the utility from the Administrator task pane to manage and configure dimensions.
The products and dimensions a user can access will vary depending on their role. As an administrator,
you can select all of the Axiom products.

For more information, see the following:

l Launching the Dimension Maintenance Utility
l Editing a dimension
l Adding a dimension record
l Creating a grouping column

Creating a grouping column

Some dimension tables include grouping columns that allow data associated with those records to share
common settings or be rolled up into larger groups for calculation or reporting purposes.

NOTE: If you created a custom grouping column in Axiom Budgeting version 2016.4 or earlier, you
need to assign it to a data set (product). For instructions, see Assigning an existing grouping column
to a dataset (product).

Here are a few guidelines for naming your columns:

l Keep the descriptions of grouping columns short and simple.
l Avoid using common English words in your grouping column names, such as Interface or Union.

Instead, combine words to come up with column titles such as IntGroup.
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l It is good practice to fill out each grouping column for every element (table row).
l Spaces are not allowed. Use the underscore to separate upper/lower case words.
l Grouping columns cannot start with a number, but they may include a number.

To create a grouping column:
1. In the Explorer task pane, in the Libraries section, click Table Library > !Dimensions.

2. Right-click the dimension table to add the grouping column to, and select Edit table structure.

3. In the Edit Table dialog, click the Columns tab.

4. Above the list of column names on the left side of the tab, click the + button.

5. In the Column Name field, type a name for the new column.

IMPORTANT: Use only alphanumeric characters in group column labels.

6. In the Data Type field, click the drop-down button, and select String.

7. In theDefault Value field, type a default value that displays to the user.

8. Click Apply.

9. In the list of columns, select the column you just added.

10. Above the list of columns, click the Assign Columns to Data Sets button.

11. In theData Set Assignment dialog, select the checkbox for any Axiom Healthcare Suite products
to add to the column to, and click OK.

12. In the Edit Table dialog, click OK.

13. To view the new column, in theMain ribbon tab, click Refresh Data.

The new grouping column nowdisplays in the dimension.

Editing a dimension

The Dimension Maintenance Utility allows you to edit the grouping columns for one or more products,
but the product options available to you depend on the role assigned to you. Axiom Financial Planning
administrators have rights to Financial Planning dimensions, Axiom Capital Planning and Capital Tracking
administrators have rights to Capital dimensions, and so on.

TIP: You never edit database tables directly in the database. Instead, data is pulled into
spreadsheets, where you can edit the data and then subsequently save it back to the database.

The columns that display depend on what products each column is assigned to using the Data Set
Assignment.

When editing dimensions, keep in mind the following:
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l The products you select determine the columns you can view.
l The dimension you select determines the table you can edit.
l Your role determines the records you can edit.

Some dimensions are not included in the Dimension Maintenance Utility. You can continue to access and
modify these dimensions from the Axiom product's Admin task pane, as usual. If the dimension you
open displays as read-only, this means that you need to use the Dimension Maintenance Utility to
modify it. For example, in Axiom Budgeting, when you open the DEPT dimension from Bud Admin task
pane > Budget System Maintenance > View Dimension Tables, the tab displays DEPT R/O. Though you
can view the dimension, you need to use the Dimension Maintenance Utility to edit it. On the other
hand, if you open the INITIATIVEID dimension, the tab does not display R/O. This means that you can
modify the dimension as usual. This is because the INITIATIVEID table is not included in the list of tables
that aremaintained via the Dimension Maintenance Utility. For a list of dimensions not included in the
Dimension Maintenance Utility, see the Overview section.

IMPORTANT: Edit dimension data with extreme care, as any errors introduced could cause problems
throughout the system. Do not modify fields not described in Axiom documentation.

After you select the product(s) and dimension to edit, the Dimension Maintenance Utility refreshes itself
and displays the different products and the columns that belong to them for the dimension. As seen in
the following example, the columns display in groups.

TIP: It is not always necessary to populate every field. Enter as much information in the dimension
table as you have available.
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In the blue cells, you can do the following:

l Choose from a list of validated values by double-clicking the folder in the column next to the
grouping column.

l Enter free-form values, though we recommend that you take into consideration any existing
values or rules for that column.

Grouping columns tagged as General display first, as shown in the previous example. General columns
are typical reference fields leveraged by multiple products. Each subsequent grouping displays based on
the products you selected. Records display depending on the security assigned to you. For example, if a
no write filter is assigned for that member, the dimension will return no records. For more information,
see Editing the security rights for a user.

IMPORTANT: If you are not sure whether to edit a cell, contact your system administrator.

Some columns in dimensions tables are validated, allowing only certain predefined values. If you enter
an invalid value, an error will occur when you save, specifying the cell so you may make a correction and
save again.

The following are examples of validated columns:

l RFCODE.RFStdLine – Used during the reporting process to identify the standard financial
statement categories to use for each RFCode category. (Same as Acct.FSDetail in Axiom
Management Reporting.)
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l RFCODE.RFType – Used during the forecast workbook interface process to define the categories
within each model that an account or account group will be categorized into. (Similar to
BudgetType in the traditional budget workbooks.)

To edit a dimension:
1. Launch the Dimension Maintenance Utility.

2. In the RF Admin task pane, in theDimension Update section, double-click Dimension
Maintenance.

3. In the Bud Admin task pane, in the Budget System Maintenance section, double-click Dimension
Maintenance.

4. In the Refresh Variables dialog, do the following, and click OK:

a. In the Select The Product To Edit drop-down, select the product.

NOTE: The list of products that display is determined by the Axiom product licenses
that your organization owns.

b. In the Select a Dimension to Edit drop-down, select the dimension.

c. In theOptional Data Filter field, do one of the following:
l Type a filter syntax.
l To select an existing filter or create a filter that you can save for later use, click Select

Filter.

5. To retrieve a smaller subset of data, you can use theQuick Filter in theWorkbook Options of the
Main ribbon tab.

For detailed instructions on how to use the feature, see Applying a Quick Filter to a report.
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6. Enter the dimension member attribute information in the appropriate cells. You can type a value
in the cell free-form or select from a list of existing validated values. These are represented with a
folder icon next to the grouping column. You can do one of the following to enter validated values:

l Next to the column, double-click the folder icon. In the Choose Value dialog, select the
value, and click OK.

l If you have a large number of entries to make, instead of opening each folder, you can copy
and paste the validated value to other cells in the same column.

IMPORTANT: Do not change the format of cells in dimensions (e.g., number, date,
percentage, and so on).

7. After you finish making your changes, in theMain ribbon tab, click Save.

NOTE: If a column is missing, then it is assigned to a different dimension or not assigned. For more
information, see Assigning an existing grouping column to a dataset (product).

Adding a dimension record

When you save the new dimension record, it displays in the existing table on the next utility refresh.

To add a dimension record:
1. Launch the Dimension Maintenance Utility.
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2. In the Cost Accounting Admin task pane, in the Costing Structure Maintenance section, double-
click Dimension Maintenance.

3. In the Bud Admin task pane, in the Budget System Maintenance section, double-click Dimension
Maintenance.

4. To select the product to add the new dimension record, do the following:

a. Press F9 or in theMain ribbon tab, in theWorkbook Option group, click Refresh Data.

b. In the Refresh Variables dialog, from the Select The Product To Edit drop-down, select the
Axiom Healthcare Product.

c. From the Select a Dimension to Edit drop-down, select the dimension.

d. Click OK.

5. At the bottom of the workbook, click the Add_New_Dimension tab.

6. You can type a value in the cell free-form or select from a list of existing validated values. These are
represented with a folder icon next to the grouping column. You can do one of the following to
enter validated values:

l Next to the column, double-click the folder icon. In the Choose Value dialog, select the
value, and click OK.
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l If you have a large number of entries to make, instead of opening each folder, you can copy
and paste the validated value to other cells in the same column.

7. For each record to create, in the Save? cell, click the drop-down box, and select Yes.

If you do not select Yes, the Save ? cell for the new dimension displays No with a red background
as a reminder that you need to save your changes. If you do not save your changes, the default
values you enter will not display. If you leave the values unpopulated, the system will populate
the defaults using those defined in the column properties in the dimension table.

8. In theMain ribbon tab, click Save.

Upon Save, the new record posts to the database and the utility refreshes, moving the newly saved
record to theDimension Maintenance tab.
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IMPORTANT: When adding new records, the field used as that user’s security filter must be
completed and within their filter before it will save successfully. If it is not, the system displays a
message that you cannot post this record to the database because it is outside of your write filter.
For example, if a security administrator using the Dimension Maintenance Security provides a filter
for Angela to grant her edit rights to the Department dimension for Entity =2, then Angela must enter
2 in the Entity column before saving. For more information about setting up security for the
Dimension Maintenance Utility, see Editing the security rights for a user.

Working with dimensions
Dimensions are key fields in each data table. Each dimension has its own table that includes a series of
attributes (columns) for each element that further defines the dimension. These columns are leveraged
throughout various Axiom Healthcare Suite products in reports, planning processes, and plan file
configurations. Many dimensions, such as DEPT, are shared between various products.

When Axiom Healthcare Suite products are first implemented, a Syntellis Implementation Consultant
helps you configure the dimension tables to reflect the organizational structure such as departments,
entities, accounts, and so on. Subsequently, editing dimensions to add new departments, accounts,
positions, pay types, or other items to the database is part of your routine system maintenance.

IMPORTANT: Becausemany dimensions are shared across multiple Axiom Healthcare Suite
products, do not delete a grouping column or modify entries in the dimension tables without
consulting the administrators for the other applications.

Some columns in dimension tables are validated. This means they only allow certain predefined values
that are contained in validation system table. If you enter an invalid value, an error occurs when you
save, specifying the cell so you can correct it and save again using a corrected entry.

Examples of validated columns include:

l ACCT.Credit – Identifies which accounts should have their signs reversed during an import.
l PAYTYPE.CM_PayCategory – Defines which summary pay category to use for each Cost

Management plan file during a sequential interface. May also be used in reporting for grouping
PayTypes.

l JOBCODE.CM_PlanCode – Used for combining job codes during reporting and Cost Management
plan file creation. If there are historical values for two job codes that you want to report as one
combined job code, list the surviving job code on both lines.

Dimensions aremanaged and maintained using the Dimension Maintenance utility. This utility allows
users assigned the Product Administrator role to only manage grouping columns within specified
dimensions. It also limits these dimensions to only the elements that the Product Administrator role can
access.
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ACCT

The ACCT dimension table contains records for each account in the GL of your organization. This includes
accounts that can be found on the balance sheet, income statement, hours, and statistics.

Refer to the Axiom EPM Dimensions Setup files (AcctCoding sheet) for codes to use in \Axiom\Reports
Library\System Files\Documents\Admin\Management Reporting\KHA EPM Dimensions Coding.xls.

The following table lists all of the options available in this dimension table:

Column Description

ACCT The Axiom account number. This can be the combination of the prime
account and sub account, if that is how your GL system is set up.

Description The account description from the GL. Do not enter a description in all
capital letters. To remove the all-caps format in the spreadsheet, use the
Proper formula =Proper().

Credit Used during the interface process to reverse the signs so values are stored
in a positive condition in the database. Select one of the following valid
entries:

l dr
l C
l NA

Normally, Revenue and Liabilities are C, and all others are dr.

RptMap Used to group accounts. Valid entries include any account numbers in the
ACCT column. The system automatically copies the information in the
ACCT column to this column during installation.
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Column Description

Statement Used to identify the Financial Statement category. Select one of the
following valid entries:

l BS (Balance Sheet)
l CM
l HoursJC (Jobcode Hours)
l Hours
l IS (Income Statement)
l KeyStat
l NA
l NI (New Initiatives)
l Statistic
l VCC (Variance Comments Collection)

NOTE: This is an Axiom standard column and categories cannot be added
or edited. The default value is NA.

Setup Guide Axiom Budget Planning │ 77



Column Description

Type Used to identify themajor Financial Statement category. Select one of the
following valid entries:

l Allocation
l Asset
l Bmark (Benchmark)
l Capital
l Comments
l Deduction
l Equity
l Expense
l FTEs
l GenStat
l HoursJC (Job Code Hours)
l Hours
l KeyStat
l Liability
l NA
l NetAsset
l Plan
l Revenue
l Scenario
l Statistic
l Target (Hours codes that are not reported as FTEs should be coded as

Statistic.)
l VCC (Variance Comments Collection)

NOTE: This is an Axiom standard column and categories cannot be added
or edited. The default value is NA.

FSSummary Used to identify summary-level Financial Statement categories. For the
naming convention, use the first letter of the type category with an
underscore and then the category name. For example, R_PatientRev or E_
Salaries.

NOTE: This is an Axiom standard column and categories cannot be added
or edited. Default value is NA.
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Column Description

FSDetail Used to identify line-item Financial Statement categories. For the naming
convention, use the first letter of the type category with an underscore
and then the category name. For example, R_IPRev, R_OPRev. For a list of
the available options, see Options for Acct.FSDetail.

NOTE: This is an Axiom standard column and categories cannot be added
or edited. The default value is NA.

FSPayor A variation of FSDetail used if GL accounts have payor categories; used for
Budgeting Deductions models. If this is not used, match to FSDetail.
Categories can be added or edited. The default value is a blank.

FPCode Used to identify the name of the Financial Planning category to use for
summarization during the integration process with Axiom Financial
Planning. If Axiom Financial Planning is not used, the default is NA.

FSProvider Used to identify line-item Financial Statement categories. For the naming
convention, use the first letter of the type category with an underscore
and then the category name. For example, R_IPRev, R_OPRev.

NOTE: This is only used if licensed for the Provider Budget Module. The
default value is NA.

FPCategory Used to identify the name of the Financial Planning category to use for
transferring the financial plan targets during the integration process with
Axiom Financial Planning. If Axiom Financial Planning is not used, the
default is NA.

BPCode Used to identify the payors from the Budget Deductions report. During
installation, the system automatically copies the information from the
FPCode column to this column.

FlexStat Identifies the primary statistic used for Flexible Budgeting. Themost
common set up is KeyTot for all stat, hours, and expenses. Revenue uses
KeyIP for IP, KeyOP for OP, and KeyOth for other patient revenue. The
default is NA.

COSTCAT Represents the cost category mapping of accounts, which is used to assign
cost categories to incoming data when the GL data is imported into a CGL
format table.

FlexPercent Identifies default variable percentage (0-100%) to use for Flexible
Budgeting. Values should be entered as decimals, 0.75 = 75%. The default
value is 0 (zero).

CostMethod Identifies the Cost Calculation Offset Accounts used for writing offsets to
the GL-oriented tables and matches them to themethod that they
represent.
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Column Description

FlexGroup Used to group accounts together for Flexible Budgeting. For example,
Medical Supplies or Other Expenses. The default is NA.

CostVarPct The Percent Variable for Axiom Cost Accounting; 0 = Fixed, which is used in
the costing processes to determine the dollar weighted variability for
calculation results.

KHAInt Used to identify which tab an account should be interfaced to during the
budget plan file creation process. Valid entries include the following:

l Stat_Rev – Type this to assign to all statistics, revenue, and deduction
accounts that will be budgeted in the budget plan files.

l Expense – Type this to assign to all expense and hours accounts that
will be budgeted in the budget plan files.

l NA – Type this to exclude an account from all budget plan files.

KHAStdLine Identifies default budget methodology used in budget plan files during
budget plan file creation. Refer to calc methods for Stat_Rev sheet and
Expense sheet in the Axiom Budgeting and Performance Reporting
Administrator's Guide (Budget Plan Files chapter) for valid entries and
definitions. The default value is NA.

RFPayor This field references the Payor column in the Payor dimension. Used in
Axiom Rolling Forecasting 2020.3 and later releases. Default value is zero
(0).

CostDSSSummary An FSSummary clone owned by Axiom Cost Accounting and Axiom
Decision Support so that cost accounts can be categorized differently to
facilitate costing and DSS needs without impacting Axiom Financial
Reporting.

KHABgtCode Used for combining accounts together during budget plan file creation. If
there are historical values for two accounts that you want to budget as
one combined account, list the surviving account number on both lines. If
not combining accounts, this value should match value in the Account
column. The default value is 0 (zero).

CostProvider Used by the Axiom Cost Accounting system when performing the Provider
RVU costing method. This identifies the cost information at the account
level that is associated to the Provider, which is then allocated to his or her
patients’ cost item or chargeable activities.
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Column Description

BudgetType Used to identify which category an account should be interfaced to during
the budget plan file interface process.

If KHAInt = Stat_Rev, valid entries are:

l IPRev
l OPRev
l OthPtRev
l OtherRev
l Allowance
l BadDebt
l KeyIP
l KeyOP
l KeyOth
l OthStat

If KHAInt = Expense, valid entries are:

l Salaries
l Benefits
l Supplies
l OtherExp
l PaidHours

The default value is NA.

DropDown Identifies the drop-down pick list when adding new accounts on Stat_Rev
or Expense sheets in the budget plan file. It should be the same as the
value in the BudgetType column.

CDMStdLine Used to identify default budget methodology for CDM budget plan files
(departments that have CDMStdLine in KHACMDimGrp column of DEPT
Dimension) during budget plan file creation. It is used similarly to
KHAStdLine in Budget Planning workbooks.

Valid entries are:

l Statistical accounts = CDMStatistic
l IP Revenue accounts = CDMIPRevenue
l OP Revenue accounts = CDMOPRevenue

Copy the remaining account assignments from KHAStdLine column.
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Column Description

KHASum Used to summarize information from the Stat_Rev and Expense sheets to
the Summary sheet within the budget plan files.

NOTE: This is an Axiom standard column and categories cannot be added
or edited. The default value is NA.

CYPMethod Identifies themethodology used for projecting the remainder of the
current fiscal year. Valid entries are dependent upon values in the
KHAStdLine column:

l Input Monthly, Detail, or any of the Fixed Options:
o Rolling12 – Use historical values from previous year's samemonths
o Annual –- Annualize YTD value
o RemBud – Use remaining budget
o CapBud – Use Total Budget less YTD actual
o PctBud – Use percentage of CY Actual over Budget

l Variable – Use Variable
l Labor – Use Labor
l FICA – Use FICA
l Hours – Use Hours
l GlobalExpense – Use GlobalExpense
l Depreciation – Use Depreciation
l IP_Per_Unit – Use IP_Per_Unit
l OP_Per_Unit – Use OP_Per-Unit
l Oth_Per_Unit – Use Oth_Per_Unit

BudStat Identifies Budget Statistic accounts used in Budget Statistics Driver.
Standard entries are:

l Admits
l PatientDays
l Discharges
l AdjDischarges
l Encounters
l ERVisits
l ClinicVisits

You can also create custom stats to use in the Budget Statistics Driver and
identify accounts appropriately. The default value is a blank.

Setup Guide Axiom Budget Planning │ 82



Column Description

PhyStdLine Identifies default budget methodology used in the Provider budget plan
files (departments which have PhyStdLine in KHACMDimGrp column of the
DEPT dimension table) during budget plan file creation. Refer to Provider
Version Only: Calc Methods - Stat_Rev Sheet and Expense Sheet in the
Axiom Budgeting and Performance Reporting Administrator's Guide
(Budget Plan Files chapter) for valid entries and definitions.

The default value is NA.

Setup Guide Axiom Budget Planning │ 83



Column Description

CYFMethod Used to identify themethodology used for projecting the remainder of the
current fiscal year in the current year forecast utility. This utility is available
in Axiom Budgeting and Performance Reporting in the Bud Admin task
pane in Financial Reporting > Financial Utilities > Current Year Forecast.

Statistics:

l Key Dept Statistics – See Forecast Methods below, normally use Trend
l Other Dept Statistics – See Forecast Methods below

Revenue:

l IP Revenue – IP_Per_Unit
l OP Revenue – OP_Per_Unit
l Other Patient Revenue – Oth_Per_Unit
l Other Operating Revenue – See Forecast Methods below

Salaries:

l Hours – See Forecast Methods below
l Salaries – Labor

All Other Accounts: See Forecast Methods below

Forecast Methods:

l IP_Per_Unit: YTD IP_Per_Unit * Forecasted Volume
l OP_Per_Unit: YTD OP_Per_Unit * Forecasted Volume
l Oth_Per_unit: YTD Oth_Per_Unit * Forecasted Volume
l Labor: Actual Hourly Rate * Forecast Hours * Budget Rate Change
l RemBud: Remaining Budget from CYB
l Annual: YTD / Calendar Days * Remainng Calendar Days
l Rolling12: YTD Actual / YTD Budget * Remainder of LYA
l PctBud: YTD Actual / YTD Budget * Remainder of CYB
l Variable: Actual Rate per Unit * Forecast Volume
l Trend
l CapBud: Remaining Budget not to exceed the annual budget

You can also add additional CYFMethod columns. Create a new
CYFMethod column and use this in conjunction with the CYFDimGrp
column in the DEPT dimension if you need to use a different CYP method
for different departments.

ReclassType Defines the type reclass that was used to calculate the values in the
account. This information is important for post-reclass reporting.
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Column Description

AllocType Defines the type of account for indirect allocations in Axiom Cost
Accounting.

CostAdjustmentID Used in Axiom Cost Accounting to tie allocation and Reclass StepIDs to
account numbers for easier referencing in downstream reports. This
number represents the ReclassID (reclasses) or the StepID (overhead
allocations) accounts that are not reclass or allocation accounts that have
a value of zero in this column.

CMStdLine Used to identify the StdLine for Axiom Cost Management.

KHAStandardClass The KHA standard classification for accounts to be used in reports to
standardize across the organization. Double click to select the appropriate
classification.

BPCategory Used to identify the Budget Planning category.

NewDeptStdLine You can use this option to set or update the calc method for each
department. It is intended to be used in conjunction with the New
Department Utility which resides at \Axiom\File Groups\Budget-
2022\Utilities (from Budget-2022 File Group). In that utility, you can
populate the NYBKHA field of the various actual tables for
accounts/paytypes/jobcodes for a new department. Once those are set
up, you can use the NewDeptStdLine column in the ACCT dimension to
define what calc methods to use (because there is no real historical data to
build from). You can assign NewDeptStdLine to the department in the Dept
dimension via the KHACMDimGroup grouping column.

InitStdLine Used to make accounts available for initiatives in the Axiom Budgeting
budget workbook.

In the Choose Value dialog for the InitStdLine, there are five validated
values to select from. The following table lists the Initiative Standard Lines
that we recommend you assign to each account type:

l Statistics accounts to use Detail Line
l Patient Revenue accounts to use Patient Revenue
l Other Revenue accounts to use Detail Line
l Deduction accounts to use Detail Line
l Labor accounts to use Detail Line
l Benefit accounts to use Detail Benefits w Percent
l All other expense accounts to use Detail Line
l Hours accounts to use Hours Line
l For accounts not configured, NAwill be the default value
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Column Description

RFCode Identifies the RFCode for account. Only used with Axiom Rolling
Forecasting. The default value is Z_Exclude.

CM_Group Used to summarize account types at a higher level for Axiom Cost
Management analysis and reporting needs.

InitType Used by the system to select the sections so that when the user refreshes
the plan file, the accounts will insert into the appropriate section of the
Initiative block in the Axiom Budgeting budget workbook.

In the Choose Value dialog for the InitType, you can configure up to
seventeen possible values. The section types available are noted in the
following list. NA is the default value until configured or for any account
not configured.

l Benefits
l ContractLabor
l Deduction
l Depreciation
l Drugs
l Hours
l Interest
l IPRev
l NA
l OPRev
l OtherExp
l OtherRev
l ProFees
l PurchSvcs
l Salaries
l Statistic
l Supplies
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Column Description

CM_NonLabor Used to classify non-labor accounts in Axiom Cost Management according
to FSDetail. Valid entries include the following:

l Drugs
l KeyStats
l OtherExp
l PurchSvcs
l Supplies

These classifications are used in reporting and plan creation.

CM_Map Used to map accounts together in Axiom Cost Management. You can use
this column to map closed accounts with another existing account or to
group like accounts.

CM_TargetBgt Used to create team workbooks in Axiom Cost Management at the
account level.

DEPT

The DEPT dimension contains records for each department within an organization. For example,
radiology, emergency, finance, and so on.

The following table lists all of the options available in this dimension table:

Column Description

DEPT The Axiom department number, which is formed by combining the entity
and cost center.

Description The department description. The naming convention is entity abbreviation
with department description. For example, MHS Operating Room.

NOTE: For closed departments, add three asterisks to the beginning of the
description. For example, MHS *** Operating Room. Descriptions should
not be in all capital letters.

Entity The Axiom entity code. The description lookup table is in the ENTITY
dimension table. This should be the Business Unit, and match the first
three to four characters of the department number.

CostCenter The cost center portion of the department number. You can use this for
comparative reporting across entities, such as comparing the cost per unit
of all operating rooms across your health system.

RptMap Used to consolidate departments for reporting.

Setup Guide Axiom Budget Planning │ 87



Column Description

BudgetGroup A collection of departments used primarily for plan file purposes. This is
commonly setup by a KHA consultant during implementation but can
easily be updated by clients. For example, departments 16010 and 16020
may be assigned to EMC budget group.

NOTE: BudgetGroup is a validated dimension so additions and deletions
need to first be added/deleted in the associated validation table.

ProdMap Used to consolidate departments for productivity reporting.

VP The Vice President responsible for the department. Use the naming
convention of FirstName LastName. This information is primarily used for
rollup reporting.

Director The director responsible for the department. Use the naming convention
of FirstName LastName. This information is primarily used for rollup
reporting.

Manager Themanager responsible for the department. Use the naming convention
of FirstName LastName. This information is primarily used for rollup
reporting.

Division The division for rollup reporting, which is defined by your organization.
You can use this information to consolidate types of departments together
for reporting. For example, you can use the word Radiology to combine all
radiology departments across all entities.

KHABgtCode Used to identify departments to combine during plan-file creation.

DeptType Determines the Direct or Indirect department category. Direct
departments are those that generally provide patient care services and
generate revenue, while Indirect departments are involved in support
services and do not generate patient care related revenue.

Owner Used to identify the network ID of the person responsible for initial input
of the plan file (i.e. Manager). It should be the same as their Axiom login ID.
Naming convention would be first initial, full last name (or whatever your
network ID naming convention is).

If your organization does not use this role for plan file approval, type [skip]
in the cell.

IMPORTANT: Do not leave this cell blank.
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Column Description

KHABgtTemplate Used to identify the template to use for plan file creation. Valid options
include the following:

l Master
l NA
l NoBudget
l RollingForecast

NOTE: This is an Axiom standard column and categories cannot be added
or edited. The default value is NA.

Reviewer The network ID of the person responsible for reviewing the cost
management plan, for example, Director. This information should be the
same as the user's Axiom login ID. The naming convention is first initial, full
last name or whatever your network ID naming convention is.

If your organization does not use this role for plan file approval, type [skip]
in the cell.

IMPORTANT: Do not leave this cell blank.

Approver The network ID of the person responsible for approving the cost
management plan, for example, VP. This information should be the same
as their Axiom login ID. The naming convention is first initial, full last name
or whatever your network ID naming convention is.

If your organization does not use this role for plan file approval, type [skip]
in the cell.

IMPORTANT: Do not leave this cell blank.

CostMap Allows departments to processed as a group in the unit cost processing
phase of cost accounting. All costs for the group are combined and
allocated to all of the Cost Items within the group. In most cases, the first
or largest department of the groups becomes the target CostMap
definition to which the other members aremapped.

MarkupName The specified markup table to use when processing unit costs using the
ReverseMarkup method.

NOTE: Currently only one table is available per department.
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Column Description

LaborType Used to identify the labor method to use for plan file creation. Valid
options are:

l altEmployee
l Employee
l HHLabor
l JobCode
l JobCodeADC
l NA
l NoBudget
l Staffing

NOTE: This is an Axiom standard column and categories cannot be added
or edited. The default value is NA.

TplOptions Used to identify the template option based on licensed products. Valid
options include the following:

l Master (common for all clients)
l MasterCDM (used for clients licensed for CDM option)
l MasterProvider
l NoBudget
l RFProvider

CM_Template Used to assign a specific Axiom Cost Management plan template.

CM_Map Similar to RptMap, used to consolidate departments for reporting.

FinContact Used to assign the finance contact for a department during the cost
management process.

KHACMDimGrp Used to identify the Standard Line selected from the ACCT dimension for
use in budget planning specifically for the budget values. Valid options are
the options used on the ACCT dimension. For example the common ones
uses include: KHAStdLine, PHYStdLine.

KeyStatDesc Used to identify the description of the primary statistic for each
department.

CM_TeamMap Used to create team-planning workbooks. You can create teams by
combining like departments or like accounts for team Axiom Cost
Management planning.

JobcodeDimGrp Used to designate which labor type distribution set applies to the
associated department. KHAInt is the standard set of job code labor types.
PhyInt is themodified set of job code labor types.

Setup Guide Axiom Budget Planning │ 90



Column Description

Campus Used as part of Axiom Cost Accounting.

ProviderType Select, by dept, whether to use the Detail or Summary options for provider
plan files.

ProjDimGrp Used to identify the Standard Line selected from the ACCT dimension for
use in budget planning specifically for the projection values. Valid options
are the options used on the ACCT dimension. For example the common
ones uses include CYPMethod.

ShowOnList_
Budgeting

Used to identify if a department displays to be selected during the plan file
creation process. Valid entries include the following:

l TRUE
l FALSE

CM_Team Create teams by combining like departments for team Axiom Cost
Management planning.

KHABgtMap Used for combining departments during plan-file creation. This column is
also used when more than one department is needed in one plan file.

CM_Division Used to group similar departments for Axiom Cost Management reporting
and analytics.

CYFDimGrp Used to identify which CYFMethod column each department uses to
forecast accounts. Valid options are:

l CYFMethod - Uses themethod specified in ACCT.CYFMethod
l NA - Not Applicable
l [Other Column Name] - Uses themethod specified in the corresponding

column on the ACCT dimension table

KHAStandardClass Used for reporting.

FPNode Used to group the department to the appropriate FPNode in Axiom
Financial Planning.

CM_BMarkStatus Used to define which departments to include in Axiom Cost Management
benchmarking reports and analytics. Valid entries include the following:

l Yes – Type to include the department.
l No – Type to exclude the department.

FPType Used to group the department to the appropriate FPTYPE in Axiom
Financial Planning.

FPNodeBS Balance Sheet node for Axiom Financial Planning.
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Column Description

CM_DeptStandard Used for mapping departments to external benchmark data. This mapping
matches the department to the ExternalBMark information in the Axiom
Cost Management file groups.

CM_PdHrsMetricID The paid hours metric ID from external benchmark. Elements are validated
to theMetricID table. Used to link a department with specific metrics in the
CM_Benchmarks_yyyy tables. Used only in Axiom Cost Management.

CM_WkdHrsMetricID Themetric ID for worked hours from external benchmark. Elements are
validated to theMetricID table. Used to link a department with specific
metrics in the CM_Benchmarks_yyyy tables. Used only in Axiom Cost
Management.

CM_
NonLabor1MetricID

Themetric ID for NonLabor 1 from external benchmark. Elements are
validated to theMetricID table. Used to link a department with specific
metrics in the CM_Benchmarks_yyyy tables. Used only in Axiom Cost
Management.

CM_
NonLabor2MetricID

Themetric ID for NonLabor 2 from external benchmark. Elements are
validated to theMetricID table. Used to link a department with specific
metrics in the CM_Benchmarks_yyyy tables. Used only in Axiom Cost
Management.

BudLocalAdmin1 Used to select the local administrator for Axiom Budgeting.

CM_CombineStat Used to determine if key statistics should be combined when grouping
departments together with CM_Map grouping column for Axiom Cost
Management. Valid entries include the following:

l Y – Type if the key statistics of the rolled up departments are to be
cumulative.

l N – Type to use only the key statistics from the surviving department.

CM_
NonLabor3MetricID

Themetric ID for NonLabor 3 from external benchmark. Elements are
validated to theMetricID table. Used to link a department with specific
metrics in the CM_Benchmarks_yyyy tables. Used only in Axiom Cost
Management.

CM_
NonLabor4MetricID

Themetric ID for NonLabor 4 from external benchmark. Elements are
validated to theMetricID table. Used to link a department with specific
metrics in the CM_Benchmarks_yyyy tables. Used only in Axiom Cost
Management.

CM_
NonLabor5MetricID

Themetric ID for NonLabor 5 from external benchmark. Elements are
validated to theMetricID table. Used to link a department with specific
metrics in the CM_Benchmarks_yyyy tables. Used only in Axiom Cost
Management.
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Column Description

BudLocalAdmin2 Used to select the local administrator for Axiom Budgeting.

BudLocalAdmin3 Used to select the local administrator for Axiom Budgeting.

FlexGroup Used for grouping departments together for the flexible budget utility. (For
example, Imaging).

FlexDept Used for defining each department as fixed or variable during the flexible
budget utility. Valid entries include the following:

l Yes
l No
l NA

CM_ShowOnList Used to define which departments to build Axiom Cost Management plan
files. Valid entries include the following:

l TRUE – Type this to build a plan file.
l FALSE – Type this to exclude from plan file lists and build.

CM_PlanGroup Used to group departments together for applying assumptions and
configurations in Axiom Cost Management driver files.

CM_
ExtBenchmarkSource

The source name of the external benchmark to use for this department in
Axiom Cost Management. Used to link a department with the CM_
Benchmarks_yyyy tables.

ShowOnList_Capital Used to define which departments to build Axiom Capital Planning plan
files. Valid entries include the following:

l TRUE
l FALSE

PM_IT The IT reviewer assigned for Process Management in Axiom Capital
Planning and Capital Tracking.

RFGroup Used to define your forecast groups. Consider:

l Management structure and cultural impact
l Team concept versus individual department managers
l The availability of a statistic that can be collected

PM_Facilities The Facilities reviewer assigned for Process Management in Axiom Capital
Planning and Capital Tracking.

PM_Clinical The Clinical Engineering reviewer assigned for Process Management in the
Axiom Capital Planning and Capital Tracking systems.

PM_Voting The owner of the prioritization process assigned for Process Management
in Axiom Capital Planning and Capital Tracking.
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CDMCODE

The CDMCODE dimension table includes all the charge codes within an organization. The charge codes
are used to track gross revenue and statistics at an inpatient (IP) and outpatient (OP) level.

The following table lists all of the options available in this dimension table:

Column Description

CDMCode Used in Axiom Budgeting. This must be an alpha numeric field so that
during the import process, a C is appended to all CDMCodes to ensure
they are alpha numeric.

Description Identifies the CDMCode description. Try to be as explicit as possible, avoid
abbreviations, and use layman’s terms. Descriptions should not be in all
capital letters. To remove the all-caps format in the spreadsheet, use the
Proper formula =Proper().

KeyStat Identifies which CDMCodes to use for key stat calculation. Valid entries
include the following:

l To count the code, select Yes.
l To exclude the code, select No.

To summarize all of the Yes codes as monthly key stats, use the
Summarize CDMCode utility. This utility is available in Axiom Budgeting
and Performance Reporting in the Bud Admin task pane, Financial
Reporting > Financial Utilities > RevUsag.

RVU Identifies an RVU value for each CDMCode. This RVU value is used to
weight each CDMCode for monthly reporting. To summarize all of the Yes
codes as monthly key stats, use the Summarize CDMCode utility.

This utility is available in Axiom Budgeting and Performance Reporting in
the Bud Admin task pane, Financial Reporting > Financial Utilities >
RevUsage. This RVUmay also be used as a source for RVU information in
the costing process.

IPStatAcct To summarize all of the Yes codes as monthly key stats, use the
Summarize CDMCode utility. This utility is available in Axiom Budgeting
and Performance Reporting in the Bud Admin task pane, Financial
Reporting > Financial Utilities > RevUsage.

If you use this report, list a valid account number from the IP Statistic ACCT
dimension to use to post to when running this utility each month.
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Column Description

OPStatAcct To summarize all of the Yes codes as monthly key stats, use the
Summarize CDMCode utility. This utility is available in Axiom Budgeting
and Performance Reporting in the Bud Admin task pane, Financial
Reporting > Financial Utilities > RevUsage.

If you are using this report, list a valid account number from the OP
Statistic ACCT dimension to use to post to when running this utility each
month.

IPRevAcct Used for mapping if your organization is licensed for the CDMRevenue
template. This maps CDMCodes to IP revenue accounts in the budget
process.

OPRevAcct Used for mapping if your organization is licensed for the CDMRevenue
template. This maps CDMCodes to OP revenue accounts in the budget
process.

KHABgtCode Used for combining CDMCodes during budget plan file creation. If there
are historical values for two CDMCodes that you want to budget as one
combined CDMCode, list the surviving CDMCode on both lines. If you do
not want to combine codes, then the code for this column should be the
same as the CDMCode in the CDMCode column.

KHAStdLine Used during the budget creation process. Valid entries include the
following:

l To budget that CDMCode, select CDM.
l To not budget that CDMCode, select NA.

KHAINT Valid entries include the following:

l If RVU > 0, IPStatAcc > 0, KeyStat=Yes, select Include.
l If RVU<0, IPStatAcc < 0, KeyStat=No, select Exclude.

UBRev The Universal Billing Code associated with each charge code from your
chargemaster. If there is no code available, then enter NA. This column is
used for reporting purposes.

HCPCS_CPT The Health Care Procedure Coding System/Current Procedural
Terminology codes associated with each charge code from the
chargemaster. If there is no code available, then enter NA. This column is
used for reporting purposes.

CPT

The CPT dimension table contains all of the CPT Codes that have been billed within the organization and
is used for monthly reporting and provider-level budgeting.

The following table lists all of the options available in this dimension table:
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Column Description

CPT The CPT code used in Axiom Budgeting and Performance Reporting. This
must be an alpha code, so a C is prefixed during the import process.

Description Identifies the CPT description to use for budgeting and reporting.

KHABgtCode The code to equal the preferred budget level. Examples include LAB, RAD,
SURG, and so on. All values in this column must be in the CPT column.

KHAInt Used during the budget creation process. Valid entries include the
following:

l To budget the CPT, select ZProvider.
l To not budget the CPT, select NA.

GLRevAcct The GL Revenue Account to transfer Provider Revenue to the Stat_Rev
sheet. This can also be defined by FinClass. If FinClass is used, the default
should be 0 (zero). Do not leave blanks.

GLEncAcct The GL Statistic Account to transfer Encounters to the Stat_Rev sheet. For
non-Encounter codes, he default should be 0 (zero). Do not leave blanks.

GLVisAcct The GL Statistic Account to transfer Visits to the Stat_Rev sheet. For non-
Visit codes, he default should be 0 (zero). Do not leave blanks.

GLWRVUAcct The GL Statistic Account to transfer Provider WRVUs to the Stat_Rev sheet.
For codes without a WRVU, he default should be 0 (zero). Do not leave
blanks.

KeyStat Used via utility to summarize CPT volume and post to the financial data
tables. Valid options are Yes orNo.

To summarize all of the Yes codes as monthly key stats, use the
Summarize Provider Statistics to Financial utility. This utility is available in
Axiom Budgeting and Performance Reporting in the Bud Admin task pane
in Budget Reporting > Budget Utilities > Provider Utilities > Statistics.

ReportDescription Concatenation of the CPT column and Description column.

GLRVUAcct The GL Statistic Account to transfer Provider RVUs to the Stat_Rev sheet.
For codes without an RVU, he default should be 0 (zero). Do not leave
blanks.

RVU Used via utility to adjust volume during summarization prior to posting to
the financial tables. This utility is available in Axiom Budgeting and
Performance Reporting in the Bud Admin task pane, in Budget Reporting >
Budget Utilities > Provider Utilities > Statistics.
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Column Description

GLProAcct The GL Statistic Account to transfer Provider Procedures to the Stat_Rev
sheet. For codes without a procedure, he default should be 0 (zero). Do
not leave blanks.

Type Used during the import process to summarize CPT codes for Visits Counts.
Can also be used for reporting on types such as Visits, Lab, Radiology,
Surgery, and so on. If summarizing CPT codes for Visit counts, the type
must be Visit. The default value is NA.

RFCPT Used to identify the CPT codes for Axiom Rolling Forecast.

KHABgtCodeSum Used to configure the CPT codes for the Provider Summary option. While
any existing CPT Code can be used, the intent is to combine all CPT codes
to one value such as AllCodes. The value selected will be the value used to
build and process the Provider tab in a plan file.

NOTE: Use only one value in this column since all CPT codes will summarize
to one row in the plan file.

DATATYPE

The DATATYPE dimension is used to load provider-level to the data tables. Each record is tagged with a
DataType when loaded. Examples of DataTypes include Revenue, Visit, WRVU, and so on.

The following table lists all of the options available in this dimension table:

Column Description

DATATYPE The DATATYPE used in Axiom Budgeting and Performance Reporting. This
must be an alpha code.

Description Identifies the description to be use for budgeting and reporting.

BudgetType Used during interface to determine which section each data type should
interface to. Valid codes Include the following:

l Encounter
l Revenue
l RVU
l WRVU
l Volume
l NA
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Column Description

KHAInt Used to identify which tab an account should be interfaced to during the
budget plan file creation process. Valid entries include the following:

l Driver
l Statistic
l Financial

INITIATIVEID

Use the INITIATIVEID dimension when budgeting for initiatives, which may or may not be approved. It
allows for tracking the impact of proposed initiatives while keeping that data separate from the baseline
budget.

The following table lists all of the options available in this dimension table:

Column Description

INITIATIVEID The INITIATIVEID used in Axiom Budgeting. This is used during the budget
process to store new initiatives. InitiativeID 1 is used for baseline
operations. All other initiative numbering is determined by the system
administrator and must be numeric.

Description Identifies the INITIATIVEID description to use for budgeting and reporting.

InitType Groups initiatives together for reporting and categorization. Valid entries
include the following:

l Baseline (INITIATIVE 1 only)
l System - Initiatives that affect multiple departments
l Dept - Initiatives for a single department

Approve The coding for Approve/Exclude for new initiatives. Valid entries include
the following:

l Baseline (applies only to INITIATIVEID 1)
l Approve – Initiatives that have been approved
l Exclude – Initiatives that are declined or deleted
l Integration – Used when integrating Capital Planning to an initiative

project

SaveCustom Used to save from the Axiom Budgeting plan file to this dimension table.

IMPORTANT: Do not alter or recode.

SaveTagDocID Used to save from the Axiom Budgeting plan file to this dimension table.

IMPORTANT: Do not alter or recode.
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Column Description

Profile The profile type to apply to the initiative.

To not use a profile, typeNA.

For more information on setting up initiative profiles, see "Setting up
initiatives" in the Axiom Budgeting online help.

BudCM For internal use.

DefaultFlag_
Description

For internal use.

DefaultFlag_Approve For internal use.

INSCODE

The INSCODE dimension stores information for the insurance/health products offered by your
organization. This information is used to manage and configure the insurance/health plans included in
your budgets. Similar to other dimension tables like ACCT, there are column structures to control what
insurance plans will be allowed to interface to the HealthPlan tab and at what level of rollup, if any.

The following table lists all of the options available in this dimension table:

Column Description

INSCODE The short name or code your organization uses to represent the
insurance/health plan product.

Description The long description of the insurance/health plan.

InsCode_BgtCode The code used to group the insurance/health plan products together. For
example, grouping all commercial or FFS plans.

KHAInt Specify whether to include the product in the list of available plans to
include in your budgets. Select one of the following:

l HealthPlan – Select this option to include the product in the list of
available plans.

l NA – Select this option to remove the product from the list of available
plans.
NOTE: The system will retain historical information for plans removed
from the list.

JOBCODE

The JOBCODE dimension table includes records for all of the JobCodes within your organization. Each
JobCode represents a job position or role within the organization.

The following table lists all of the dimension options available in the JOBCODE dimension table:
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Column Description

JOBCODE The Axiom job code. This entry must be an alpha-numeric field so that
during the import process a J is prepended to all job codes to ensure they
are alpha numeric.

Description The job code description from the payroll system. Do not type
descriptions using all capital letters. To remove the all-caps format in the
spreadsheet, use the Proper formula =Proper().

GLAcct The GL account where regular dollars are posted on the GL. If your payroll
data maps to the GL based upon pay type, type 0 (zero).

HrAcct The GL account where regular hours are posted on the GL. If your payroll
hours map to the GL based upon pay type, type 0 (zero).

FICAAcct The FICA account code to use for each job code. You can use this to
allocate FICA expense to different accounts by job code.

JobClass Themajor job classes of individual job codes. You can use this to apply
salary increases for specific groups. Commonly used entries include the
following:

l Management
l Physician
l Professional
l Technical
l RN
l LPN
l Assistant
l Support
l Other
l Clerical
l Contract

GLClass Used to identify the GL Class each job code is assigned to for budget and
reporting salary-mapping purposes. The exception-mapping table is
located in the GLPayrollMapping table. If mapping payroll by job code or
pay type is not an option, this mapping table allows for special exceptions
for payroll mapping.

Variable Used to identify JobCodes, which are sensitive to volume changes. Valid
entries include Fixed and Variable.
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Column Description

KHABgtCode Used for combining accounts together during budget plan file creation. If
there are historical values for two accounts that you want to budget as
one combined account, list the surviving account number on both lines. If
not combining accounts, this value should match value in the Account
column. The default value is 0 (zero).

KHAInt Used to identify which tab an account should be interfaced to during the
budget plan file create process. Valid entries include the following:

l JOBCODE
l PROVIDER
l To exclude an account from all budget plan files, typeNA.

CostHr The Prod Hours Account Definitions for Costing

PhyInt Used to create an alternative to the KHAInt classification for the associated
job code.
Valid entries include the following:

l JOBCODE
l PROVIDER
l NA – Indicates the value will default to the value currently in the KHAInt

column.

ResourceJobClass Used in the RVU developer process by themapping of job codes to a
Resource Job Class, which determines the level of detailed RVU
development for labor resources. This attribute is also used in the
mapping of payroll hour and dollar into an average wage rate in the
resource table that then drives the calculation of the RVU.

CostCat The cost category for the job code.

KHAStandardClass The KHA standard classification for jobcode to be used in reports to
standardize across the organization. Double click to select the appropriate
classification.

StdHours Used to identify the standard FTE hours worked in a year. Options include
Default, which is 2086 hours, and 2080. For more information, see
"Working with FTE standard working hours" in the online help.

CostGL The Prod Dollars Account Definitions for Costing

Retirement Identifies the jobcodes to be used for retirement calculation. Used in
Jobcode and ProviderComp (available on Labor tabs). Valid entries are:

l NA
l Qualified

Setup Guide Axiom Budget Planning │ 101



Column Description

CostClass An alternative grouping column used in the costing process that is invoked
during the loading of payroll information into the CGL as statistics to
support a payroll related reclassification of GL dollars or hours.

RFCODEGL In Axiom Rolling Forecast, this may be used to allocate salaries to specific
salary related RFCodes.

CostVariable Not used at this time.

RFCODEHR In Axiom Rolling Forecast, this may be used to allocate hours to specific
hours related RFCodes.

FPCategory Used to identify the name of the Financial Planning category to be used for
transferring the financial plan targets during the integration process with
Axiom Financial Planning. If Axiom Financial Planning is not used, the
default is NA.

CM_PlanCode Used for combining job codes during reporting and plan file creation in
Axiom Cost Management. If there are historical values for two job codes
that you want to report as one combined job code, list the surviving job
code on both lines.

PAYTYPE

The PAYTYPE dimension table includes records for all of the possible categories of compensation that an
employeemight receive. For example, regular pay, paid time off, sick pay, incentive pay, and so on.

For more information on how to set up the PAYTYPE dimension for reporting, budgeting, and GL
mapping, seeMapping the PAYTYPE dimension.

The following table lists all of the options available in this dimension table:

Column Description

PAYTYPE The Axiom pay type. This must be an alpha-numeric field, so that during
the import process, a P is prepended to all pay types to ensure they are
alpha numeric.

Description Identifies the pay type description from the payroll system. Be as explicit
as possible, avoid abbreviations, and use layman’s terms. Do not enter a
description using all capital letters. To remove the all-caps format in the
spreadsheet, use the Proper formula =Proper().
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Column Description

PaySummary Used in reporting to identify major pay categories. Select one of the valid
entries:

l Prod
l NonProd
l Other
l Stat
l NA

PayDetail Used in reporting to identify detail pay categories. Select one of the valid
entries:

l Contract
l NA
l NonProd
l Other
l Overtime
l Regular
l Stat

LaborDist The variation of PayDetail used in Labor Distribution reporting. Valid
entries include the following:

l Regular
l Education
l PTO
l Overtime
l OnCall
l Other
l Contract
l Stat
l NA
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Column Description

FTE Indicates whether to include hours in FTE calculations. Select one of the
valid entries:

l To assign to pay types to count for FTE calculations such as Regular,
Overtime, Education, PTO, Jury Duty, Bereavement, Sick, and so on,
select Yes.

l To assign to pay types to not count for FTE calculations such as
Differentials, Call Pay (not callback), Bonus, Benefits, and so on, select
No.

l To assign to your productivity stat pay types, select Stat.
l If none of the above scenarios apply, select NA.

Empl_Detail Used to identify pay types that are FTE related for employee-level
budgeting. Select one of the valid entries:

l If it is FTE-related, select Z_Employee.
l If it is not FTE-related, select NA.

KHAInt Used to identify pay types to include in plan file processing. Select one of
the valid entries:

l To assign pay types to include in the JobCode block (generally FTE=Yes),
select JobCode.

l To assign pay types to include in the JobCode block as additional
dollars (generally FTE=No; examples include call pay, differentials,
bonus, etc.), select Dollars.

l To assign pay types to budget at the department (not job code) level,
select Dept.

l To assign pay types to exclude from the budget workbooks such as
PTO sellback, reimbursement\adoption reimbursement, car allowance,
benefit expenses, and so on, select NA.

GLAcct Used to identify the account number to use for dollars on the GL. Do one
of the following:

l If your payroll data maps to the GL-based upon job code, type 0 (zero).
l If your payroll data does not map to the GL-based on job code, type

the GL salary account from the ACCT dimension table.
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Column Description

HrAcct Used to identify the account number to use for hours on the GL. Do one of
the following:

l If your payroll hours map to the GL-based upon job code, type 0 (zero).
l If your payroll hours do not map to the GL-based on job code, type the

GL hours account from the ACCT dimension table.

JobCode The pay type summary groupings used for plan-file processing when using
the Jobcode labor method. The code used must be a valid pay type.

Staffing The pay type summary groupings used for plan-file processing when using
the Staffing labor method. The code used must be a valid pay type.

Employee The pay type summary groupings used for plan-file processing when using
the Employee labor method. The code used must be a valid pay type.

Provider The pay type summary groupings used for plan-file processing when using
the ProviderComp labor method. The code used must be a valid pay type.

KHAStdLine Used to identify default budget methodology used in budget plan files
during budget plan file creation. Refer to the calc methods for the Stat_Rev
sheet and Expense sheet in the Axiom Budgeting and Performance
Reporting Administrator's Guide (Budget Plan Files chapter) for valid
entries and definitions. The default value is NA.

RF_Pay26_Include_
Exclude

Select whether to include or exclude option from monthly payroll to GL.

ResourceCalculation Determines the calculation behavior for the hours or dollars within the
PAYTYPE when using the payroll information within the RVU development
process. When labor rates are calculated for the Resource Table, the
designation here determines if the Hours, Dollars, or Both are to be used in
the numerator and denominator in the average.

PHYStdLine Identifies the default budget methodology used in budget plan files during
budget plan file creation. Options include:

l CM_Jobcode
l Dept_AvgPerProdHr
l Dept_InputMonthly
l Input_Monthly
l JobCode
l NA

Setup Guide Axiom Budget Planning │ 105



Column Description

CDMStdLine Used to identify default budget methodology for CDM budget plan files
(departments which have CDMStdLine in KHACMDimGrp column of DEPT
Dimension) during budget plan file creation. It is used similarly to
KHAStdLine in Budget Planning workbooks.

Valid entries include the following:

l Statistical accounts = CDMStatistic
l IP Revenue accounts = CDMIPRevenue
l OP Revenue accounts = CDMOPRevenue

Copy the remaining account assignments from KHAStdLine column.

Accrue Used to identify paytypes to be included when using the payroll accrual
utility. Valid entries include the following:

• To accrue during monthly payroll accrual process, type Yes.

• To not accrue during monthly payroll accrual process, typeNo orNA.

RFPAYCLASS Not used at this time.

Cost Variable Not used at this time.

CM_PlanCode Used for combining pay types during Axiom Cost Management reporting
and plan-file creation. If there are historical values for two pay types that
you want to report as one combined pay type, list the surviving pay type
on both lines.

KHAStandardClass Grouping column that can be used to report on paytype usage across your
organization.

NewDeptStdLine New department standard CM Line.

CM_PayCategory Used in Axiom Cost Management to group individual pay types into
summary categories for planning purposes. Examples include the
following: Regular, Overtime, Education, PTO, Contract, Other, Stat.

CM_Paid Used to identify the pay type to include in the Paid Hours calculations in
Axiom Cost Management. Valid entries include the following:

l For paytypes that will be included in paid hours, select Yes.
l For paytypes that will not be included in paid hours, select No.

CM_Worked Used to identify the pay type to include in theWorked Hours calculations
in Axiom Cost Management.

l For Pay Types that will be included in worked hours, select Yes.
l For Pay Types that will not be included in worked hours, select No.
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Column Description

CM_PaidDLLRS Used to identify the pay type to include in the Paid Dollars calculations in
Axiom Cost Management.

l For Pay Types that will be included in paid dollars, select Yes.
l For Pay Types that will not be included in paid dollars, select No.

CM_WorkedDLLRS Used to identify the pay type to include in theWorked Dollars calculations
in Axiom Cost Management.

l For Pay Types that will be included in worked dollars, select Yes.
l For Pay Types that will not be included in worked dollars, select No.

CMStdLine Used during the interface process to assign the standard planning method
to use for each pay type. In other words, this identifies the desired formula
to use to calculate Axiom Cost Management initiatives. It is used similarly
to KHAStdLine in Budget Planning workbooks.

Options for Acct.FSDetail

l A_AccumDepr
l A_AR
l A_ARAllow
l A_BoardInvest
l A_BondAmort
l A_BondCost
l A_Cash
l A_CashInvest
l A_CIP
l A_CurLtdAsset
l A_CurOtherAsset
l A_CurReceivable
l A_Inventory
l A_Land
l A_LTNotesRec
l A_LTOtherAsset
l A_PPE
l A_Prepaid
l A_RelatedParty
l A_ThirdPartyRec
l A_Trusteed
l C_Comments
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l D_BadDebt
l D_Charity
l D_Contractual
l D_Discounts
l E_BadDebt
l E_Benefits
l E_Depreciation
l E_Drugs
l E_Insurance
l E_Interest
l E_MaintRepairs
l E_MedSupplies
l E_OtherExp
l E_OthSupplies
l E_ProFees
l E_PurchSvcs
l E_RentLease
l E_Salaries
l E_SalariesContract
l E_SalariesMid
l E_SalariesPhy
l E_Utilities
l F_ContractFTEs
l F_NonProdFTEs
l F_OvertimeFTEs
l F_ProdFTEs
l H_Contract
l H_JCHours
l H_Midlevel
l H_NonProd
l H_Overtime
l H_Physician
l H_Prod
l L_AccExpense
l L_AccPayroll
l L_AP
l L_CurLTDebt
l L_CurOthLiab
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l L_LTDebt
l L_LTOther1
l L_LTOther2
l L_ThirdPartyPay
l M_BmarkAdjD
l M_BmarkNOR
l M_DEPUOS
l M_NonLabor
l M_ONLPUOS
l M_PSPUOS
l M_SEPUOS
l M_TContPct
l M_TEducPct
l M_TEPUOS
l M_TFTERate
l M_TOTPct
l M_TPHUOS
l M_TUOSRate
l M_TWHPUOS
l N_NetAsset
l N_NetAssetPerm
l N_NetAssetTemp
l NA
l Q_Restricted
l Q_RestrictedPerm
l Q_RestrictedTemp
l Q_Unrestricted
l R_IPRev
l R_NonOpContrib
l R_NonOpExtraord
l R_NonOpGainLoss
l R_NonOpInterest
l R_NonOpInvest
l R_NonOpOther
l R_NonOpRev
l R_OPRev
l R_OtherRev
l R_OthPtRev
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l S_Admits
l S_Deliveries
l S_Discharges
l S_Encounters
l S_ER Visits
l S_GenStat
l S_Global
l S_KeyIP
l S_KeyOP
l S_KeyOth
l S_Newborn
l S_OthStat
l S_PatientDays
l S_PayorDays
l S_PayorDisch
l S_PayorVisits
l S_StatOth
l Z_Exclude

Mapping the PAYTYPE dimension

AXIOM BUDGETING: PAYTYPEMAPPING SETUP
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Working with Drivers
Driver files contain rates, statistics, and other drivers that your budget plan files reference to help
calculate data. Driver files can also contain global values such as calendar information.

The data in driver files is ultimately saved to the database into one or more driver tables. These driver
tables can then be referenced by templates/plan files to calculate planning data or determine other
global settings for the file group.

In Axiom Budgeting 2022.1, the file group for each year's budget contains a set of driver files that display
configuration settings and Budget Assumptions (key statistics) referenced by all of the other files within
the file group.

The configuration settings in the driver files can impact the structure of budget plan files in the following
ways:

l Show or hide sections of sheets, columns, and rows.
l Set default values and parameters within budget plan files, including:

o Pay types
o Number of pay periods
o Thresholds for flagging variances
o Column headings

Budget Assumptions are used in calculations throughout the entire budgeting process.

Examples of Budget Assumptions include:

l Inflation rates
l Labor merit increases and benefits percentages
l Revenue rates
l Any other statistics that impact multiple budgets
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NOTE: Whenever you create a new budget, review the assumptions and settings in the driver files to
make sure they still apply to the current year.

Cells in driver files are color-coded as follows:

l White shading – Cells cannot bemodified.
l Blue shading – Input or modify data in the cell.
l Green shading – Choose from a drop-down selection of entries.

Depending on a user's security profile settings, certain parts of a driver file may be protected.

IMPORTANT: Any changemade to the configuration settings and assumptions in the driver files can
impact the structure and contents of any number of related budget plan files.

The Budget Driver is referred to as a rebuildable driver. This means that the driver stores and controls
information using data tables, which provides the ability to control who can edit driver data and what
driver data each can edit. A rebuildable driver also provide other benefits:

l Secure access to default driver settings – You determine who can edit the default sections in each
driver table.

l Secure access to budget group exceptions – You determine which Budget Groups each product
admin member can view and edit.

l Filtered data access –When editing the driver, filtered data access provides improved
performance.

l Multi-user driver file access – You can havemultiple members responsible for separate budget
groups access the same driver at the same time.

l Updatability and enhancements – By removing the persistent file requirement, Syntellis can
provide you enhanced driver templates without any risk to current parameters and construct.

l Calc methods included – You can add additional sections/rows with double-clicks instead of
manually. You can save or delete each section using the drop-down next to each budget group
section.

NOTE: Axiom Budgeting driver files may reference dimension tables shared with other applications.

Throughout the driver files, you define default settings and assumptions for use throughout the file
group. In some cases, however, you might want to make exceptions for certain groups of departments,
accounts, and so on. These groupings of exceptions (particularly departments) are referred to as Budget
Groups. Many of the driver files include fields where you can indicate how budget groups are defined
within the dimension tables.

After the driver data is stored in data tables, you must establish security by doing the following:

l Allowmultiple users to access the driver files at the same time.
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l Configure a user to only have access to the correct budget group sections or all sections of each
driver file.

Opening budget driver files
There aremany drivers available in Axiom Budgeting. You can access most of them from the Bud Admin
task pane.

To open budget driver files:
1. In the Budget Admin task pane, in the Budget Assumptions section, do one of the following:

l To open next year's budget drivers, click Access NY Budget Assumptions.
l To open this year's budget drivers, click Access CY Budget Assumptions.

2. Double-click the driver.

3. Refresh the variables by doing the following:

NOTE: Not all drivers include the ability to select variables, depending on the purpose of the
driver.

a. In theMain ribbon tab, click Refresh Data, or press F9.

b. In the Refresh Variables dialog, for each variable option, click Choose Value.

c. In the Choose Value dialog, select one or more variables, and click OK.

TIP: If the dialog displays a large number of variables, you can use the Select All or
Clear All to select or deselect all the selections in the check boxes. If you do not select
check boxes for any variables, the system automatically includes all of the variables in
the driver. If you click Cancel, no variables are included in the driver, and it displays
blank.

4. After you make your changes, in theMain ribbon tab, click Save.
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Order to set up drivers
Set up the drivers in the following order:

1. Budget Configuration

2. Budget Labor Configuration

3. Budget Statistics

4. Budget Driver

5. Budget Depreciation

6. Budget Global Data Configuration

7. Budget Global Data 1

8. Budget Global Data 2

9. Budget Global Data 3

10. Budget Global Data 4

11. Budget Global Expense

12. Budget Revenue GlobalRev

13. Budget Expense Adjustments

14. Budget Labor Rates

15. Budget Assumptions

16. Budget CDM Config

17. Budget CDM Overrides

18. Budget Expense Admin Adjustments Setup

19. Budget Expense Adjustments

20. Budget Global Sum

21. Budget Labor Accounts

22. Budget Labor ADC Config
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23. Budget Labor Alt FTE Factors

24. Budget Labor Benchmark driver

25. Budget Labor JobCode Dropdown

26. Budget Labor Limits

27. Budget Labor Override

28. Budget Labor Target

29. Budget Provider Configuration

30. Budget Provider

31. Budget Provider Global Provider

32. Budget Provider GlobalVolChg

33. Budget Provider List

34. Budget Provider Simple Config

35. Budget Provider Simple Dept Config Basic

36. Budget Provider Simple Dept Rate

37. Budget Provider Vol

38. Budget Revenue Adjustments

39. Budget Revenue Deductions

40. Budget Revenue Payor Adjustments

41. Budget StatAcct

42. Budget Statistics Supplement

43. Membership Enrollment Trend

NOTE: This driver only displays if your organization has the Budgeting Health Plan license.

44. Membership PMPM

NOTE: This driver only displays if your organization has the Budgeting Health Plan license.
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Summary of commonly used drivers and use of global assumptions
Driver Global BudgetGroup Comments

Budget
Assumptions

Budget Driver

Plan files will default to
Global if BudgetGroup
block is not built out

Exceptions

Budget
Configuration

Budget Labor
Configuration

Plan files will default to
Global if BudgetGroup
block is not built out

Exceptions BudgetGroups built
out in both drivers
must match

Budget
Depreciation

Budget
GlobalData (1-4)

Budget GlobalExp

Budget
GlobalSum

Budget Revenue
GlobalRev

NA BudgetGroup/DEPT/ACCT
specific

Budget method must
be identified in
ACCT.KHAStdLine

Budget Expense
Adjustments

FSDetail level only

Plan files will default to
Global if BudgetGroup
block is not built out

FSDetail or ACCT level.

Budget Labor
Benchmark

NA NA DEPT specific,
regardless of
BudgetGroup

Budget Labor
Limits

NA NA JOBCODE specific,
regardless of
BudgetGroup

Budget Labor
Override

NA BudgetGroup, DEPT, or
DEPT/JOBCODE specific

Budget Labor
Rates

Global, Jobclass, or
Jobcode specific

Plan files will default to
Global if BudgetGroup
block is not built out

Global, Jobclass, or
Jobcode specific
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Driver Global BudgetGroup Comments

Budget Labor
Target

NA NA DEPT/JOBCODE
specific, regardless of
BudgetGroup

Budget Revenue
Adjustments

Global IP, OP, Other
Patient, Other Revenue

Global or ACCT specific IP,
OP, Other Patient, Other
Revenue

Budget Statistics Includes high level stats
only - Calendar &
Worked Days, Paid
Hours, Consolidated
Stats (Admissions,
Discharges, Patient
Days, Outpatient Visits,
ER Visits)

Consolidated Stats
summarize
BudgetGroups

Includes Admissions,
Patient Days, Discharges,
Adjusted Discharges,
Calendar Days, Worked
Days

Budget Assumption and Configuration drivers
The following table includes a description of each type of assumption and configuration driver:

Driver Description

Budget Configuration Use to configure a variety of general settings that affect themajority of
budget plan files.

TIP: Usually the first driver you edit prior to creating a budget.

Budget Driver Use to assign a driver statistic either to the facility or to an individual
department, and assign a default statistic to be used if a department does
not currently have a database statistic.

Budget Assumptions Use to control the contents of the Instructions and Planning sheets in
budget plan files.

Budget Depreciation Use to designate an alternative location for entering depreciation for
specific expense accounts shared across departments without having to
divide the depreciation between multiple budget plan files.

Current payroll period
driver

Use to change the current period for the Payroll 27 tables.

Service Line data
tables

Use to configure the import into tables that store your Decision Support
data (DSS).
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Driver Description

Budget Configuration Use to configure a variety of general settings that affect themajority of
budget plan files.

TIP: Usually the first driver you edit prior to creating a budget.

Budget Driver Use to assign a driver statistic either to the facility or to an individual
department, and assign a default statistic to be used if a department does
not currently have a database statistic.

Budget Assumptions Use to control the contents of the Instructions and Planning sheets in
budget plan files.

Budget Depreciation Use to designate an alternative location for entering depreciation for
specific expense accounts shared across departments without having to
divide the depreciation between multiple budget plan files.

Current payroll period
driver

Use to change the current period for the Payroll 27 tables.

Service Line data
tables

Use to configure the import into tables that store your Decision Support
data (DSS).

Budget Configuration

� Overview
This driver contains a variety of general configuration settings that affect themajority of budget plan
files. This is typically the first driver file you edit prior to creating a budget.
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The Budget Configuration driver is divided into a Global Setup section with settings that apply system-
wide and a section with default settings, followed by separate sections for each defined budget group.
Each section contains the following:

� Global Setup
Open the driver, and then configure the Global Setup parameters to apply to all the budget plan files.

Settings in this section include:

Option Definition

Dept Dimension
Grouping Code to be
used for Global
Assignments

Define the groupings by which the system will build and assemble the plan
files.
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Option Definition

Use KHACMDimGrp? Define from the ACCT dimension which Stdline to use for the department.
For example, if the budget plan file is a typical basic operating plan file used
in a hospital, then you would use Account KHAStdline. For a physician
department, you would likely select Physician KHAStdline.

Activate Red Flag
Popup?

For certain values, you can set variance thresholds which, if exceeded,
cause a red flag icon ( ) to display. Select one of the following options to
determine whether or not the user needs to address the threshold by
entering a comment:

l Yes -When the threshold is met, require the user to enter a comment
in the Comment field before they can save the plan file.

l No - Allow the user to save the plan file without entering comments.

Expense Transaction
Drilling, On or Off?

Select one of the following:

l On - To allow users to drill down to a subsidiary General Ledger in the
Expense tab.

l Off - To not allow users to drill down in the Expense tab.

Dept Column Width? By default, the department column width is 15 pt. Use this field to enter
different column width size.

Acct Column Width? By default, the account column width is 15 pt. Use this field to enter
different column width size.

NOTE: If you enter a size larger than 15 pt, large numbers will display in
scientific notation (i.e. #######).

� Budget Setup section
The Budget Setup section for each budget group defines basic parameters such as pay periods and start
and end months for the fiscal year.

Settings in this section include:

Option Definition

Payroll27 - YTD
Biweekly Pay Periods

Indicates howmany pay periods have elapsed in the current fiscal year, in
case you need to create a budget for a fiscal year already in progress.
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Option Definition

Financial - Current
Fiscal Year Period

Indicates the current fiscal year period, in case you need to create a budget
for a fiscal year already in progress. When you build a new budget, the
Current Period entered heremust equal the Current Period of your data
sources.

IMPORTANT: Be sure to enter a specific number. Do not use the
KHAPeriod formula (which returns the current period) in this cell, as it will
cause your data to become out of sync as the value of KHAPeriod changes.
Changing the value recalculates the YTD calendar days, impacting
calculations throughout the system. For example, if this field is mistakenly
set to seven months but the budgets were built using 8months of data,
most values will be overstated.

Year of Fiscal Year End The calendar year in which the budget's fiscal year ends.

Fiscal Year Beginning
and End Month

Themonth in which the fiscal year begins and ends for each budget plan
file.

Current Year
Beginning and YTD
Date

The date when the current year budget began and the date when YTD data
was imported.

� Budget Tab Settings section
This section configures the sheet headings for time period columns in budget plan files.

Settings in this section include:

Option Definition

Month End Determines the end date for all monthly spread sections in budgeting
driver and plan files.

NOTE: This must be updated for the current year end at the beginning of
each new budget cycle.
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Option Definition

Months in Period Designates the number ofmonths in each period, typically 12 for past year
actual data, but may vary for the YTD period versus projected period for
the current year.

Days in Period The total number of business days in the period.

NOTE: Must be updated for each budget year.

Identify columns to
hide in budget
workbooksplan files

Enter the names of any columns you wish to hide on the Stat_Rev and
Expense sheets in budget plan files.

Print Suppressor to
hideWB columns

Designates which columns have been suppressed per the previous row.

Identify columns to
hide in Summary Tab

Allows you to control which columns to display on the Summary sheet of
the budget plan files. Set to Yes to hide, No to display in the budget plan
files.

Print Suppressor to
hide Summary
columns

Designates which columns have been suppressed per the previous row.

� Red Flag Parameters section
This section determines if and when users will be required to enter comments for variances in budget
plan files (for more information, see the chapter on Variance Reporting).

Settings in this section include:

Option Definition

Percent Increase
Threshold

Sets the percentage variance above budget for which users will be required
to enter an explanation.

Percent Decrease
Threshold

Sets the percentage variance below budget for which users will be required
to enter an explanation.

Dollar Threshold (+/-) Sets a strict dollar amount above or below budget for which users will be
required to enter an explanation

� Other Tab Parameters section
This section addresses additional configuration options for budget plan files:
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Settings in this section include:

Option Definition

Use Preliminary
Estimate on Detail
Calc Method?

If set to Yes, the preliminary estimate displays on the detail sheet in
budget plan files. If set to No, the system will hide the preliminary estimate
row.

Display Contribution
Margin on Summary
Tab?

If set to Yes, the contribution margin row displays on the Summary sheet
in the budget plan files. If set to No, the system will hide the contribution
margin row. To display themargin, choose a custom name for that row on
the Summary sheet.

Use Forecast for
Current Year
Projection?

Select Yes orNo.

Show Initiatives Tab? Select to Show or Hide the Initiatives tab.

Show Plan Tab? Select to Show or Hide the Plan tab.

Show Empl_List tab
with JobCode and
Staffing Tabs?

Select to Show or Hide the Empl_List tab with the JobCode and Staffing
tabs.

Show Empl_List tab
with Employee Tab?

Select to Show or Hide the Empl_List tab with the Employee tab.

ShowNet Revenue
section on Stat_Rev
tab (Requires Global
Sum Setup)?

Select to Show or Hide the Net Revenue section on the Stat_Rev tab.

Budget Driver

� Overview
This driver is used for two major purposes:

1. Assign a driver statistic either to the facility or to an individual department.

l These drivers must exist in the Statistics sheet.
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l The code requested is the same code that is in column A of the Statistic worksheet which is
a combination of columns B & C in the Statistic worksheet.

l A red flag will indicate if an incorrect code has been input (refer to screen shot example).
2. Assign a default statistic to be used if a department does not currently have a database statistic.

l Departmental Exceptions from the facility assignment can be entered in the lower half of
this sheet (refer to screen shot below).

The Driver sheet contains the following columns for each entity:

l BudgetGroup Code
l Department Description
l IP Driver
l OP Driver
l Default Statistic

Drivers must be defined in column A on the Statistics sheet in order to be used.

� Settings
Open the driver, and complete the driver settings, as needed.
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Budget Assumptions

� Overview
Use this driver to control the contents of the Instructions and Planning sheets in budget plan files. It is
probably best to revisit this section after you have gone through the process of creating a budget and
viewed these sheets in the context of a budget plan file.

� Settings
Open the driver, and define different sets of instructions and planning questions for each Budget Group.

Each section has three columns:

l Budget Instruction Process Steps –Modify the description of each step.
l Due – Enter the due date for step.
l Use – Enter or modify the link.

Open the Budget Assumptions driver, and then use the following table to complete the settings in this
driver, as needed:
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Option Definition

Budget Contact Type the contact information for the Budget Administrator in case end
users have any questions.

Budget Assumptions Input key budget assumptions in this section to display for the user's
reference. Again, this is strictly for reference. These are not the cells that
the system refers to for assumptions data when performing actual
calculations.

Budget Planning
Account

Type the account used to store plan tab answers.

Planning Questions Type the questions to display on the Planning sheet in budget plan files.

Budget Depreciation

� Overview
This driver provides an alternative location for entering depreciation for specific expense accounts shared
across departments without having to divide the depreciation between multiple budget plan files.

To use this driver, set the budget method (KHAStdLine) in the ACCT dimension table to Depreciation.

To add a new department to the driver, double-clicking theDouble click to Insert New Department cell.

� Settings
Open the driver, and complete the driver settings, as needed.

Configuring the current payroll period

Use the Change Payroll 27 Tables-Current Period utility to change the Payroll 27 tables current period.

NOTE: You must have the Administrator role profile to access this utility.
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To configure the current payroll period:
1. In the Bud Admin orManagement Reporting Admin task pane, in the Budget System

Maintenance section, double-click Change Payroll 27 Tables-Current Period.

NOTE: The utility opens in a separate browser window.

2. From theNew Pay Period drop-down, select the current pay period.

3. Click Submit.

4. At the This may take around a minute to save prompt, click OK.

5. At the confirmation prompt, click OK.

Configuring the Service Line data tables

Service Line data tables allow you to house your Decision Support data (DSS). The tables are assigned to
the Performance Reporting license such as many other tables that house data for Actuals.

The data tables are located in the Service Line folder in the Table Library accessed through the Explorer
task pane.
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Open Tables In Spread Sheet (OTIS) is available for the following Syntellis standard roles for direct table
access, if needed:

l Management Reporting Admin
l Management Reporting Analyst

You will need Management Reporting Admin role to use the import.

One standard import is available in the Imports > Management Reportingmenu. You will need
Management Reporting Admin role to use the import. File specs will be provided in the related file spec
document and initial setup may be needed. Please contact Syntellis customer support for assistance.

The Service Line data tables contain four key fields, twelvemonthly periods columns, and calculated
summary fields. The Key fields are defined as follows:
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l Group Service Line – Service Line category name. This is client defined and no Syntellis standards
are required. This same field is used to define the Service Line namewhen configuring the Service
Line Supplement Driver.

l Primary Payor Plan Code – Used to summarize payor categories. This is client defined and no
Syntellis standards are required. This is used for reporting only and is not used as a key field in the
Service Line Supplement driver.

l Entity Code – Level of summarization similar to Budget Group. This is NOT a validated dimension
to the Entity validation table at this time, but we recommend that the Entity Codematches
validated codes.

l Data Type – Statistic category desired to be used in the data table. These are client defined and no
Syntellis standards are required.

Budget Global drivers
The following table includes a description of each type of Budget Global driver:

Driver Description

Budget Global Data
Configuration

Use to configure settings related to the GlobalData calc method.

Budget Global Data 1-
4

Use to configure next-year budget values by month for individual expense
items.

Budget Global
Expense

Use as an alternative location for budgeting dollars to specific expense
accounts shared across departments without having to divide the dollars
between multiple budget plan files.

Budget Global Sum Use to calculate the value of an account on the Stat_Rev or Expense sheet
based on the value of one or more other accounts on the Stat_Rev sheet.
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Driver Description

Budget Global Data
Configuration

Use to configure settings related to the GlobalData calc method.

Budget Global Data 1-
4

Use to configure next-year budget values by month for individual expense
items.

Budget Global
Expense

Use as an alternative location for budgeting dollars to specific expense
accounts shared across departments without having to divide the dollars
between multiple budget plan files.

Budget Global Sum Use to calculate the value of an account on the Stat_Rev or Expense sheet
based on the value of one or more other accounts on the Stat_Rev sheet.

Budget Global Data Configuration

� Overview
This driver contains settings related to the GlobalData calc method. The GlobalData calc method allows
you to create configurable budget relationships for calculating NYB amounts for the Expense tab only.
The GlobalData calc method is similar to GlobalExpense but allows you to use up to four configurable
tabs in GlobalData Assumptions.

This calc method works much like Global Expense, Global Revenue, and Depreciation, which look to the
StatData tab to get the budget values.

This driver file allows plan files to look up historical and projected values for expense items. To reference
a department/account combination to the Global Data Assumptions, you must specify the GlobalData
calc method in the appropriate grouping column on the ACCT dimension table. These accounts will then
look to one of the four GlobalData sheets for historical and projected data.

To use GlobalData, you must first specify a default GlobalData sheet for accounts using the GlobalData
calc method, along with any departmental or budget group exceptions. There are four sheets set up in
the Global Data Configuration to use when creating alternate data sets. If you need more than four
sheets or need to modify any of the default queries on the sheets, please contact your Syntellis
Consultant.
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� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Budget Global Data 1-4

� Overview
Each of the four GlobalData drivers allows you to adjust current year projections and next-year budget
values by month for individual expense items. The initial values are populated from source data using
predefined queries. The filter capability helps narrow down the available departments and/or accounts
to specify in this driver.

Note the following:

l In the DEPT and ACCT filter fields, make sure to only use DEPT or ACCT filters.
l Under the ACCT filter field, the driver lists the current filter and the last saved filter.
l When inserting a new department or account row, the system only offers a selection of

departments or accounts that meet the filter criteria. You cannot enter the department or
account number by typing it in the field.
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l The system will not allow you to save duplicate records.

� Settings
1. Open the driver.

2. In theDEPT Filter and/or ACCT Filter field, right-click the cell, and select Axiom Wizards > Filter
Wizard.

NOTE: Only users assigned the GlobalDriverMgmt role can make edits to this driver.

3. Create or select an existing filter to use. For instructions, see Using the Filter Wizard.

4. Refresh the variables by doing one of the following:
l In theMain ribbon tab, click Refresh Data.

l Press F9.

5. To add a new row, double-click Double Click to Insert New Dept/Acct row.

6. From theDepartment and/or Account column, select the appropriate department or account.

NOTE: Only the departments or accounts that meet the filter criteria will display in the list of
options.

7. To delete a record, in the far left column, select Delete from the drop-down.

8. After making your changes, in theMain ribbon, click Save.
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Budget Global Expense

� Overview
This driver provides an alternative location for budgeting dollars to specific expense accounts shared
across departments without having to divide the dollars between multiple budget plan files. Some
common uses are for Building Rent and Inter-company Allocations.

Use this sheet for any department and account combination to budget globally instead of by entering
values into individual budget plan files.

For an account to reference the values on this sheet, the budget method (KHAStdLine) in the ACCT
dimension table must be set to GlobalExpense.

You can add additional rows by copying the formulas from the ones already set up.

� Settings
Open the driver, and then complete the driver settings, as needed.
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Budget Global Sum

� Overview
This driver allows you to calculate the value of an account on the Stat_Rev or Expense sheet based on the
value of one or more other accounts on the Stat_Rev sheet.

Use this sheet for any department and account combination to budget as a percentage of the total of
specific accounts on the Stat_Rev sheet.

To reference this sheet, enter GlobalSum as the budget method in the ACCT dimension table
(KHAStdLine).

You can add additional rows by copying the formulas from the ones already set up.

IMPORTANT: Do not change the codes on Row1 or delete a column without consulting with Syntellis
first.

� Settings
Open the driver, and complete the following sections in the GlobalSum sheet:

� Revenue Accounts to be Summed section
Use this section to list the accounts on the Stat_Rev sheet to sum together.

Accounts to sum together and have the same adjustment factor applied should have the same Account
Summary Group.

Summary groups can be text or numeric. Do not use the word Unused to avoid inadvertent summations.

The only methodologies that can be summed are the following:

l Allowance
l BadDebt
l CDMIPRevenue
l CDMOPRevenue
l IP_Payor
l IP_Per_Unit
l OP_Payor
l OP_Per_Unit
l Oth_Payor
l Oth_Per_Unit
l ProviderRev

You can add additional rows by copying the formulas from the ones already set up.
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IMPORTANT: Do not change the codes on Row1 or delete a column without consulting with Syntellis
first.

Displayed fields and settings in the Revenue Accounts to be Summed section include:

Option Description

Budget Group l Acct – Add or modify the account number.
l AcctSumGroup1-4 – There are four account summary groups available.

Add or modify these values.

Dept\Acct Exceptions l Dept – Add or modify the department.
l Acct – Add or modify the account number.
l AcctSumGroup1-4 – There are four account summary groups available.

Enter or modify these values.

Acct Exceptions l Acct – Add or modify the account number.
l AcctSumGroup1-4 – There are four account summary groups available.

Enter or modify these values.

� Accounts to use GlobalSum Methodology section
Fields and settings in the Accounts to use GlobalSum Methodology section include:
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Option Description

Dept\Acct Exceptions l Dept – Add or modify the department.
l Acct – Add or modify the account number.
l Summary Group Column – From the drop-down, select one of the

following:
o AcctSumGroup1
o AcctSumGroup2
o AcctSumGroup2
o AcctSumGroup4

l Adjustment Factor Summary Group 1
l Adjustment Factor Summary Group 1
l Summary Group 1
l Summary Group 2

Acct Exceptions l Acct – Add or modify the account number.
l Summary Group Column – From the drop-down, select one of the

following
o AcctSumGroup1
o AcctSumGroup2
o AcctSumGroup3
o AcctSumGroup4

l Adjustment Factor Summary Group 1
l Adjustment Factor Summary Group 2
l Summary Group 1
l Summary Group 2

Budget Expenses drivers
The following table includes a description of each type of Budget Expense driver:
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Driver Description

Budget Expense
Adjustment

Use to control expense rate increases by facility, broken out by income
statement category.

Budget Expense
Admin Adjustments
Setup

Use to make incremental adjustments to manager inputs on budget plan
files.

Driver Description

Budget Expense
Adjustment

Use to control expense rate increases by facility, broken out by income
statement category.

Budget Expense
Admin Adjustments
Setup

Use to make incremental adjustments to manager inputs on budget plan
files.

Budget Expense Adjustments

� Overview
This driver contains the following fields for controlling expense rate increases by facility, broken out by
income statement category (as defined in the FSDetail column of the ACCT dimension table).

� Settings
Open the driver, and then use the following table to complete the settings in this driver, as needed :
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Option Definition

FY Year Projection
Adjustment

Use to modify expense values for current year projection.

FY YearBudget
Adjustment

The default expense adjustment for all budget plan files (exceptions can be
made for any defined Budget Groups in the sections below)

Budget Groups Defines exceptions to the global expense adjustments for any defined
Budget Groups. Exceptions can bemade by FSDetail category and/or
Account.

NOTE: Axiom Budgeting overrides default exceptions with the FSDetail
exceptions and overrides any FSDetail-level exceptions with the ACCT
exceptions. This applies for both current year and next year’s budget.

FYYear Fixed % Used if using the PctofSalaries_FixedPct methodology. This will set a fixed
percentage to be used for all departments in that budget group rather
than the historical percentage which would be different for all
departments.

FYYear Rate/FTE Used if using the RatePerFTE_Fixed methodology. This will set a fixed rate
per FTE to be used for all departments in that budget group rather than
the historical rate which would be different for all departments.

Budget Expense Admin Adjustments Setup

� Overview
Use these drivers to make incremental adjustments to manager inputs on Budget plan files. To use these
drivers, you must first set up the accounts in the Budget Expense Adjustments driver.

� Settings
When you open the driver, double-click where indicated to insert a row.
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Use the drop-down menu to select whether to enter exceptions for that DEPT/ACCT combination by
Amount or Percent.

Repeat for as many DEPT/ACCT combinations as you need to enter exceptions. When you are finished,
save the file.

Next, open the Budget Expense Admin Adjustments driver from the Budget Admin task pane. When you
open the driver file, your DEPT/ACCT combinations display. Finally, save the Budget Expense Admin
Adjustments driver.

NOTE: This driver only links to calc methods for Detail, Fixed, Rate Per FTE, and Variable. It is not
designed to work for FTE or salary adjustments.

Budget CDM drivers
The following table includes a description of each type of Budget CDM driver:
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Driver Description

Budget CDM
Configuration

Use to set configuration options for the CDMRevenue tab in budget plan
files, including the inpatient and outpatient volume settings.

Budget CDM
Overrides

Use to override the charge per unit rate for specific CDM codes, either
globally or by budget group/department.

Driver Description

Budget CDM
Configuration

Use to set configuration options for the CDMRevenue tab in budget plan
files, including the inpatient and outpatient volume settings.

Budget CDM
Overrides

Use to override the charge per unit rate for specific CDM codes, either
globally or by budget group/department.

Budget CDM Config

� Overview
Use this driver to configure the CDMRevenue tab in Budget plan files, including the inpatient and
outpatient volume settings.

Setup Guide Axiom Budget Planning │ 145



� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Option Description

Budget Option -
Activate KHABgtMap?

Select one of the following:

l To activate KHABgtMap, select Yes.
l To not activate KHABgtMap, select No.

Stat_Rev Integration
Option

l From the Allocate CDM Revenue to GL Accounts drop-down, do the
following:
o To calculate the total revenue on the CDMRevenue sheet to be

allocated to the GLAccounts interfaced on the Stat_Rev sheet, select
Yes. The allocation uses YTD history as its allocation method.

o If you select No, the Use CDM GLAcct to integrate with Stat_Rev
automatically will turn to Yes, and it will use themapping from the
RevUsage dimension table on the IPRevAcct and OPRevAcct
columns.

l From theUse CDMCode.GLAcct to integrate with Stat_Rev drop-
down, select Yes orNo.

Optional CDM
Revenue Column
Display

l Select whether to Show or Hide the Last Year Actual, Current Year
Budget, and Preliminary Budget columns on the CDMRevenue sheet in
the budget plan files.

l From the IP Revenue Spread and OP Revenue Spread drop-downs,
choose the default spread in the budget plan files. Choices include the
Driver, Calendar Days, Work Days, Even, or History. You can override
this setting in each budget plan file.

Budget CDM Overrides

� Overview
Use this driver to override the charge per unit rate for specific CDM codes, either globally or by budget
group/department.
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� Settings
Open the driver, and then complete the driver settings, as needed.

Option Description

CDM Code Type the charge code to override.
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Option Description

Description Displays a description of the charge code you entered in the CDM Code
column.

IP Inpatient

OP Outpatient

Health Plan drivers
The following table includes a description of each type of Budget Health Plan driver:

Driver Description

Membership
Enrollment Trend

Allows you to enrollment percentages for insurance/health plans offered
by your organization to determine themembership trend of each plan.
The trend percentages are then used in theMembership Per Member Per
Month (PMPM) driver to adjust themembership statistics.

Membership PMPM Provides the basis for several important planning activities needed for
your organization to budget insurance/health plans in your plan files
including calculating historical PMPM values based on available history
and calculating the projection and monthly budget for revenues and
expenses.

Membership Enrollment Trend driver

� Overview
Use this driver to enter enrollment percentages for each health plan or insurance product offered by
your organization. The purpose of this driver is to determine themembership trend of each insurance
product. The trend percentages are then used in theMembership Per Member Per Month (PMPM)
driver to adjust themembership statistics.

TIP: If themembership percentages are provided by the health plan company’s actuaries, you can
enter those values in this driver.

� About this driver
Note the following before configuring this driver:

l This driver is only accessible if your organization has the Axiom Budgeting Health Plan license.
l You must first add/edit insurance or health plan products in the INSCODE dimension table. The

system automatically populates the driver with the information from this dimension. The system
does not allow you to manually enter plans directly into the driver.
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l You must first complete this driver setup before configuring theMembership PMPM driver.
l Only users assigned the GlobalDriverMgmt role profile can access and update this driver.

Access to the data table that stores the health plan records is controlled using the Budget Security
Update utility. In the HealthPlan column, you can configure the filter for the health plan data. This
column only displays if your organization has an Axiom Budgeting Health Plan license.

� Understanding the interface
The driver displays the list of insurance plans by clearly grouping them together by entity. By default, the

list of insurance plans is expanded, but you can double-click to expand or double-click to contract
it. After you save your changes, the system remembers this setting the next time you open the driver.
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To remove an entity from the driver, click the Save drop-down, and select Delete. After you save your
changes, the system will remove the entity from the driver.

NOTE: This action does not delete the entity from the system. It simply removes the entity from the
driver list. To add the entity again, in theMain ribbon tab, click Refresh Data. You can also press F9
on your keyboard.

You can view specific parts of the driver from theMain ribbon tab by clicking Change View, and selecting
one of the following:

l Default - Displays both the actuals and budget columns for each period as well as the Projected
Actuals.

l Hide Actuals - Hides the actuals columns for each period. The projected actuals column remains
available.

l Hide Budget - Hides the budget columns for each period.

� Settings
Complete the following steps to configure this driver:

1. In the Bud AdminBud Admin task pane, in the Budget Assumptions section, do one of the
following:

l To open next year's budget drivers, click Access NY Budget Assumptions.
l To open this year's budget drivers, click Access CY Budget Assumptions.

Setup Guide Axiom Budget Planning │ 150



2. Double-click 45 Budget HealthPlan Enrollment Trend.

3. In the Refresh Variables dialog, type the entity number(s) in the field or click Choose Value to
select the entities, and then click OK.

4. To display the plans to budget for the entities, in the first column click the Select Option cell, and
select Save.

NOTE: The list that displays populates from the INSCODE dimension table. If you add a plan to
the table, the new plan is automatically added to this driver. Removing a plan causes an
unmatched records message on the screen. For more information, see Unmatched records
below.

5. In the actuals columns for each period, enter the actual percentage of growth or reduction of
membership that the plan experienced or expect to experience.

6. By default, and upon initial use, all Projected Actuals and Budget columns display 100% for all
plans. The configured growth or reduction ofmembership percentages provides the basis for
budgeting plan membership for the next budget year. You can change this number, if needed.

7. In the Comments column, enter any additional information related to the Actual or Projected
Actuals columns.

8. In the budget columns for each period, enter the percentage of growth or reduction of
membership that you expect the plan to experience.

9. After making your changes, click Save.

� Managing unmatched records (orphan data)
If a plan is removed from the INSCODE dimension table (i.e., a plan is retired or discontinued), an
Unmatched Records area displays at the bottom of the driver page. This is often referred to as orphan
data. The list of unmatched records means there are plans in the driver table that are no longer valid
because of the changes in the dimension table. The system lists the unmatched records and will remove
them from the driver table the next time you save.

TIP: The Unmatched Records area displays at the bottom of the driver page, so you may need to
scroll to see this information. You can also jump to this section from theMain ribbon tab by clicking
Go To >Unmatched Records. This option only displays when unmatched records exist. The driver
screen will also display a warning message.
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NOTE: More unmatched records may occur for other entities in the database, however the system
will only delete the plans for those entities you selected in the Refresh Variables dialog.

Membership Per Member Per Month (PMPM) driver

� Overview
This driver provides the basis for several important planning activities needed for your organization to
budget health plans and insurance products. The system uses the information in this driver to populate
the HealthPlan Operation utility.

l Depending on the level of detailed records loaded by your organization in the ACT_HP_20XX data
table, the driver can bring in actual data for members, revenues, and expenses by entity,
department, insurance code, location, and data type. The driver calculation methods then
calculate historical PMPM values based on available history.

l The historical PMPM rates carry forward to any non-actual period. For example, if six months of
actual is used, then month seven of the current year in the driver refers to themonth six PMPM
rate. The rates in all non-actual months can be edited.

l The PMPM rates in the projection and monthly budget columns are then used to calculate the
projection and monthly budget for revenues and expenses in the HealthPlan Operations utility.
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This driver provides a central location to reviewmember lives, revenue PMPM, and expense PMPM for
each health plan and specifically within each entity (or department). The enrollment percentages from
theMembership Enrollment Trend driver updates the planned member lives, which also flows to the
HealthPlan Operation utility.

� About this driver
Note the following before configuring this driver:

l This driver is only accessible if your organization is licensed for the Axiom Budgeting Health Plan
product. Only users assigned the GlobalDriverMgmt role profile have access to this driver.

l You must complete the following before configuring this driver:
o Add or edit insurance or health plan products in the INSCODE dimension. The system does

not allow you to manually enter plans directly in this driver because the system
automatically populates it with the plans listed in the INSCODE dimension.

o Add or edit the health plan budget data types in the DATATYPE dimension.
o Add or edit department locations in the LOCATION dimension.

For instructions on updating these dimensions, see Updating dimensions for health plan
budgeting.

o Configure theMembership Enrollment Trend driver before configuring this driver. If the
Membership Enrollment Trend driver is not configured, theMembership PMPM driver will
default to 100%.

l The system auto populates the driver with data that is stored in the ACT_HP_20XX data table. You
can enter the data manually in this table or as part of an import. Your Syntellis Implementation
Consultant will help you set up the table for your organization, but you will need to maintain this
table as new plans are added.

NOTE: There is no pre-defined import available to import health plan data at this time, but
you can work with your Syntellis Implementation Consultant to create a custom import.

l To remove or retire a plan, you cannot delete it from the driver. For instructions, see Removing or
retiring plans.

� Understanding the interface
The driver makes it easy to view and manage plans by displaying entities and department using a tiered
structure that follows this format:
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n Entity
n Department

n Insurance/Health Plan
n Location

n Data Type

When you first open the driver, the list of locations is expanded, but you can double-click to expand or

to contract it. After you save your changes, the system remembers this setting the next time you
open the driver.

The columns to the right of the listed data types are the actuals columns that display the data stored in
the Act_HP_20XX data table. The blue cells allow you to edit remaining projected by month and
budgeted values, if needed. By default, the values for themembership row are calculated using the
Membership Enrollment Trend driver. The system calculates these values by multiplying the previous
month's enrollment numbers by the percentage for the period in theMembership Enrollment Trend
driver.

Let's say an organization expects a 10% growth in their membership for period 7. Themembership
number for period 6was 88,798. The system multiplies this number by 1.10 for a projected actual of
97,678members. This calculation continues throughout the blue cells for both actuals and budgeted in
themembership row. You can edit this value two ways:

l Adjust the percentage in theMembership Enrollment Trend driver
l Edit the value directly in the actual or budget blue cell in theMembership PMPM driver
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NOTE: You can usually get the plan percentages from an actuary at the insurance or health plan
company.

The values in the data types from both the actual and budget columns are derived by dividing the data
type period value (located in the ACT_HP_20XX data table) by the number ofmembers in the same
period. In the following example, the value for hospital medical expenses for this departments plan in
period 6 is $11,099,749. The system divides this amount by the number ofmembers, in this case 88,798
and calculates the expense as $125 per member. TheMembership Enrollment Trend driver provides a
starting point for budgeting your health plan costs for the remainder of the year.
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When entering remaining projected and budget values, you can either use the values that are
automatically calculated by the system using theMembership Trend Enrollment driver, or you can enter
your own custom values. The option you choose is indicated by the Spread Tag column. When entering
and saving custom values, the Spread Tag column automatically changes from Default to Previous
Input. The Previous Input option means that the system stores and retrieves the values from the
Membership PMPM driver table versus using the default calculations. Even if you use custom values,
you can return to using the driver-calculated values at any time by selecting Default from the Spread Tag
column.

� Changing views
You can view specific parts of the driver from theMain ribbon tab by clicking Change View, and selecting
one of the following:

l Default - Displays both the actuals and budget columns for each period as well as the projected
actuals.

l Hide Actuals - Hides the actuals columns for each period. The projected actuals column remains
available.

l Hide Budget - Hides the budget columns for each period.

� Settings
Complete the following steps to configure this driver:
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1. In the Bud AdminBud Admin task pane, in the Budget Assumptions section, do one of the
following:

l To open next year's budget drivers, click Access NY Budget Assumptions.
l To open this year's budget drivers, click Access CY Budget Assumptions.

2. Double-click 46 Budget HealthPlan Membership PMPM.

3. In the Refresh Variables dialog, do the following to filter the entities or departments that display
in the driver:

a. In the Filter by Entity field, type the entity number(s) or click Choose Value to select the
entities, and then click OK.

b. Optionally, in the Filter by DEPT.KHABgtMap field, type the department number(s) or click
Choose Value to select the departments, and then click OK.

4. In the actuals and budget columns, do one of the following:
l To use the default values derived from theMembership Trend Enrollment driver, select

Default in the Spread Tag column (if it is not already selected).
l To use custom values, type the values in the columns. When you save your changes, the

Spread Tag column changes from Default to Previous Input.

TIP: Even if you enter custom values, you can go back to using the default values by
selecting Default from the Spread Tag column. The system will automatically use the
values calculated using theMembership Enrollment Trend driver. After you save your
change, the system will change the spread tag from Previous Input back to Default to
indicate that these are driver-calculated values.

For more information on how the spread tags work, see Understanding the interface in the
section above.

5. After making your changes, click Save.

� Adding data types
To add a data type:

1. In the list of data types, double-click Double click to Add New Datatype.
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NOTE: The purpose of this option is to allow you to add a revenue or expense category that
contains no actual history. For example, if the AARP health plan does not contain drug
expense historically, but nowwewish to include it for planning, this option will accommodate
that expense category.

2. In the Select Datatype field, type the name of the data type or click Choose Value to select the
data types.

3. Click OK.

Because you can only add one instance of a data type, the list of available data types diminishes as they
are added to the driver for a particular location. If all the data types have been used, then themessage
No additional Datatypes available for insertion replaces Double click to Add New Datatype at the
bottom of the list.

� Deleting data types
After you select the data types to delete, the system does not remove them until after you save the
driver.
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To delete a data type:
1. Next to the name for each data type to delete, click the Save cell drop-down, and select Delete.

2. In theMain ribbon tab, click Save.

� What if there are no members in a plan?
Newplans will likely have no members or historical information in the system, but you can still use this
driver to manually enter membership numbers and begin the health plan budget process. In this
situation, themembership row displaysMembers Not Found and the system displays zeroes in the
white cells of the actual period columns. However, in the blue cells, you can manually enter member
numbers and revenue/expense stream values, as needed.

TIP: Instead of entering the new plan information in this driver, another option is to simply enter this
same data in the ACT_HP_20XX table. The system will then pull in the data from the table as the
starting point for the new plan.

Budget Labor drivers
The following table includes a description of each type of Budget Labor driver:

Driver Description

Budget Labor
Configuration

Use to configure default settings for tracking
and calculating labor-related expenses.
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Driver Description

Budget Labor
Rates

Use to control the wage rate increases globally
for your entire organization as well as for
specific budget group and department
categories.

Budget Labor
Accounts

Use to configure certain salary or benefit
accounts to use total salaries or a subset of
salary accounts to use in the calculation.

Budget Labor
ADC
Configuration

Use to configure the job classes and staffing
ratios for each job class.

Budget Labor
Alt FTE
Factors

Use to configure Alt FTE factors.

Budget Labor
Benchmark
driver

Use to define a benchmark target of FTEs or
Worked Hours per Unit of Service (WHPUOS)
by department.

Budget Labor
JobCode
Dropdown

Use for any department where a filter applied
to a JobCode drop-down provides a
streamlines list for the user.

Budget Labor
Limits

Use to top-out rates when needed.

Budget Labor
Override

Use to make overrides to the various labor-
related sheets, such as Empl_List, in budget
plan files.

Budget Labor
Target

Use to define a target ofWorked Hours per
Unit of Service (WHPUOS) by department and
job code.

Driver Description

Budget Labor
Configuration

Use to configure default settings for tracking and calculating labor-related
expenses.

Budget Labor Rates Use to control the wage rate increases globally for your entire organization
as well as for specific budget group and department categories.

Budget Labor
Accounts

Use to configure certain salary or benefit accounts to use total salaries or a
subset of salary accounts to use in the calculation.
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Driver Description

Budget Labor ADC
Configuration

Use to configure the job classes and staffing ratios for each job class.

Budget Labor Alt FTE
Factors

Use to configure Alt FTE factors.

Budget Labor
Benchmark driver

Use to define a benchmark target of FTEs or Worked Hours per Unit of
Service (WHPUOS) by department.

Budget Labor
JobCode Dropdown

Use for any department where a filter applied to a JobCode drop-down
provides a streamlines list for the user.

Budget Labor Limits Use to top-out rates when needed.

Budget Labor
Override

Use to make overrides to the various labor-related sheets, such as Empl_
List, in budget plan files.

Budget Labor Target Use to define a target ofWorked Hours per Unit of Service (WHPUOS) by
department and job code.

Budget Labor Configuration

� Overview
This driver contains default settings for how labor-related expenses are tracked and calculated. You can
set exceptions for specific budget groups by adding another calc method and entering data for the
specific budget group.

This driver defaults to the FTE Scale field in the Year Period table of theGlobal Setup section. However,
you can modify the defaults at the Budget Group level. For more information, see Setting year and
period.

NOTE: Users with the Budgeting Analyst or Budgeting Admin roles or access to the 02 Budget Labor
Configuration driver and the Global Driver Management role can edit the FTE scale in this driver.
These roles and permissions may differ based on your organization.
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� Settings
Open the driver. The top of the sheet begins the settings for the global configuration, including the
following calc method blocks:

l Labor Configuration
l Standard Budget PayTypes
l Earned Paid Time Off Setup

NOTE: After configuring the global labor drivers, you can do the same for each budget group.

� Global Setup and Default Budget Workbook Configuration Settings section

Settings in this section include:

Option Definition

Activate Dept Based Pay? Enable or disable department-based pay and designate a
default JobCode (the default is initially set to JDept).
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Option Definition

Global or BudgetGroup name Hours
per FTE Convention

Do one of the following for each budget group:

l To use the default standard work hours specified by
your organization, select Default.
NOTE: The default is configured in the FTE Scale and
FTE Hours fields in the Year Period table.

l To use the non-default standard work hours, select it
from the list. For example, if the default is 2086, then it
displays as Default. The other option that would display
is 2080.

For more information, see Setting year and period.

Global or BudgetGroup name
Calendar Days

The calendar days for the YTD, remainder of the current
year, and upcoming budget years.

Global or BudgetGroup nameWork
Days in Period

The work days in each period.

Global or BudgetGroup name Hours
in Period

The hours in each period, calculated by work days.

Global or BudgetGroup name
Number of Holidays

The number of holidays in each period.

� Labor Configuration section
In this section, enter basic assumptions and key statistics related to payroll.

Settings in this sheet include:

Setup Guide Axiom Budget Planning │ 163



Option Definition

%of Staffing Change with Volume The ratio of staffing increases to volume increases.

Medicare Tax TheMedicare tax rate for staff.

Current FICA Rate The FICA rate for staff.

Current FICA Limit The FICA limit for staff for the calendar year.

Retirement Below FICA limit The retirement benefit rate to apply before the employee's
salary passes the amount in the Current FICA limit cell.

In the following example, the current FICA limit is $113,700.
As a result, the retirement benefit is calculated at 12%.

Retirement Above FICA limit The retirement benefit rate to apply when the employee's
salary exceeds the amount in the Current FICA limit cell
but does not exceed the amount in the Retirement Max
Limit cell.

For example, an employee's salary increases to $125,000.
As a result, the retirement benefit rate increases from 12%
to 18%.

Retirement Max Limit The amount at which the retirement benefit rate stops.

Uniform Merit Increase Date? Click Yes and designate a date when themerit increases go
into effect; otherwise, click No.

FTE Comparison to YTD Can use Scheduled FTEs (from Labor Master import) or
CYB FTE – Current year budget FTEs from Payroll26.

Projected FTE Starting Point Use this option to set the starting point for projected FTE
counts.

l To use YTD_FTEs as the projected starting point, select
YTD_FTE.

l To set the starting point as schedule and budget, select
Sched/Budget.

NOTE: To use CYB_FTE, you must run theMonthly to
Biweekly report under Reports Library >Management
Reporting Utilities > Payroll to transfer your budgeted FTEs
from themonthly payroll tables to the biweekly payroll
tables. Default setting is Sched_FTE, which feeds from the
Empl_List in the budget plan files.

Forecast FTEs from Projection To set the default budget FTEs to zero in all labor sheets
(JobCode, Staffing and Employee), select No. The default
setting is Yes.
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Option Definition

Hours per PayPeriod Defines the number of hours in a pay period. The default is
80.

Hours per Monthly This should not be edited.

Reimbursed Salaries Account This should not be edited.

KHASum Code for Agency Summary code for Agency labor.

KHASum Code for Physician Summary code for Physician labor.

Use Self-Balancing to Target on
JobCode tab?

When active, this feature forces the department budget to
a selected target on the Benchmark sheet.

JobCode to use for Self-Balancing
JobCode Adjustment

Input valid job code for variable and fixed.

PayType to use for Self-Balancing
JobCode Adjustment

Input valid pay type for variable and fixed. The default is
the Regular pay type specified in the Standard Budget
PayTypes Productive Categories section below.

Account to use for Self-Balancing
JobCode Adjustment

Input valid account for variable and fixed. Default is the
"Regular" account specified in the Standard Budget
PayTypes Productive Categories section below.

Projection FTEs - Use YTD Actual or
NYB Adjusted

You can base the Projected FTE allocation off of YTD or
NYB. This means that if there are adjustments in the yellow
allocation rows from the base YTD calculation, you can
elect to make that same assumption for the Projected FTE.

For example, assume that the YTD% for overtimewas 4%
YTD. The projection would also be 4% and would calculate
the overtime FTE accordingly. But, assume an adjustment
to overtime allocation of 8% is made. This would normally
apply to just NYB, but now that 8% adjustment can apply
to the Projection FTE too.

Program Additions Allows for custom naming of the Program Additions row.
To change the name, type the desired name in the cell to
the left of the label.

Position Changes Allows for custom naming of the Position Changes row. To
change the name, type the desired name in the cell to the
left of the label.

� Standard Budget PayTypes section
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This section defines the pay categories for Productive, NonProductive, and Contract labor that you can
assign to the JobCode, Staffing, and Employee columns in the PAYTYPE dimension table. This determines
how different paytypes are spread out over themonths of a year. The initial configuration is set up by
your Syntellis Implementation Consultant during implementation.

Settings in this section include:

Option Definition

Productive Categories Includes regular, overtime, education, and so on.

NonProductive
Categories

Includes time off and other non-productive hours.

Contract Labor
Categories

Define up to seven categories of contract labor in the labor models

Productivity Statistic Defines the PayType used to store productivity statistics, usually PStat.

� Earned Paid Time Off Setup section
Use this section to determine how PTO is computed based on labor hours.

Settings in this sheet include:
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Option Definition

Earned Paid Time Off
Setup

Set whether to use calculated PTO. To use historical taken PTO as the
budgeted PTO, select No. If you select Yes, you can select the gross or net
method for earned PTO.

Earned PTO Hrs
Conversion Factor

The rate at which hours accrue based on which account.

Default Earned PTO
Hours Per FTE

The default annual per FTE PTO hours earned.

Working with FTE standard working hours

The FTE Hours standard specified from the Year Period table is included in the Budget Labor
Configuration tab. This allows you to not only define standard working time globally across your
organization, but you can also define it for each budget group.

NOTE: Configurations in theGlobal Setup section are reflected in real time for each Budget Group
configuration set to default to include theHours in a Period line item. To see the changes you make
in other areas, you must click Save.

In the Budget Labor Configuration driver, the Default values are set up in the YearPeriod table where you
can set the standard working hours by job code.

NOTE: The default is configured in the Year Period table.
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You do this in the StdHours column in the JOBCODE dimension table. This is a validated field so the two
options are Default and 2080 Hours.

The FTE Hours standard specification is especially helpful if your organization has a mix of employees
using the Jobcode or ProviderComp labor methods but are using alternate FTE standard working hours.
For example, highly compensated employees are perhaps using a 2080 FTE scale while others are using a
2086 FTE scale, yet they are on the same Jobcode labor type.

NOTE: As an administrator, you only need to update this column if you need the alternate scale. The
column automatically displays Default, so no additional configuration is required.
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NOTE: Standard reports do not recognize FTE calculations based on the two scales. We recommend
that you modify or create your reports to represent the FTE values, if needed. For example, if an FTE
using 2080 hours is calculated with a denominator of 2086, then the FTE displays as .9971, unless
rounded to two decimals.

After setting up and applying the FTE Standard, within the plan file, a row is added. If the 2080 Hours
option is selected, the hours will be based on the FTE factors on this row.

In themonthly hours row of the applicable Labor calc method, the formula looks for 2080 Hour, and if
present, then the hours are based on the 2080 row, as seen i the calculation highlighted in the following
example.

The following example shows the option selected from the JOBCODE dimension.

Setup Guide Axiom Budget Planning │ 169



The following example shows the option selected from the JOBCODE dimension.

Budget Labor Rates

� Overview
The Budget Labor Rates driver allows you to control the wage rate increases globally for your entire
organization as well as for specific budget group and department categories. For each category, you can
also set rate increases by job code (determined by the JobClass grouping column in the JOBCODE
dimension table), job class, and step.

There are two types of wage rate increases you can configure:

l Annual Merit – The effective date from the labor master file is used in the budget plan file. If there
is no match to the Empl_List, theMerit Month is used by default.

l Market Adjustments – TheMarket month listed in Budget Assumptions is themonth in which the
increase is applied. You can define up to two Market Adjustment merit increases.
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� Settings
Open the driver. When configuring the Labor Rate driver, you begin by specifying global rate and merit
increases that apply to the broadest set of job codes. Next, you specify the rate and merit increases by
specific budget group. Finally, you can finish your configuration at themost specific category—by
department.

NOTE: Budget groups are normally used for entities within your organization, but you can use them
any way you wish.

Within each Labor Rate category, you can specify rate and merit increases by job code, job class, and
step. The following is a list of the different configuration combinations you can set up, in order of
broadest to most specific.

l Global | Global (Broadest)
l Global | JobClass
l Global | JobClass | Step
l Global | JobCode
l Global | JobCode | Step

l BudgetGroup | Global
l BudgetGroup | JobClass
l BudgetGroup | JobClass | Step
l BudgetGroup | JobCode
l BudgetGroup | JobCode | Step

l Dept| Global
l Dept | JobClass
l Dept | JobClass | Step
l Dept | JobCode
l Dept | JobCode | Step (Most specific)

When it comes to actually applying the rate and merit adjustments, Axiom Budgeting evaluates each job
code and applies themost specific Labor Rate driver configuration first. If a configuration does not apply
to the specific job code, the system evaluates the next least-specific configuration to see if it applies. If it
does not, the system continues to evaluate the job code until it meets the requirements of a
configuration.

In the following example, rates have been specified for Global |JobClass and Global | JobClass | Step for
a job class defined as Other. Employees who meet the step criteria will receive a 30% increase while those
in the same job class that do not meet the step criteria will only receive a 20% increase.
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In the following example, note the configuration of Global-J00200.

In this next example, note that Global-J00200 is recognized in the Empl_List tab.

When configuring the Labor Rate driver, remember the following:
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l Themost specific labor rate you configure will be the one that controls the labor rate adjustments.
For example, if you configure the rates for Dept | Global, but you do not specify the rates for Dept
| JobClass, then the rates apply to everyone in the department—regardless of job class, job code,
or step.

l To minimize the number of configurations you need to set up and maintain, we recommend using
the global configurations to institute your rate and merit increases for most job codes. You should
only use themore specific labor rate categories and configurations as exceptions.

The configurations you make in the Labor Rate driver affects the following tabs in the plan file:

l JobCode
l Staffing
l Employee
l Provider
l HHLabor
l AltFTE

The same exception principle that is applied in expense adjustment is applied here as well. After Axiom
Budgeting determines that it is an exception, all other related increases will not apply.

You can make exceptions to budget groups by adding another calc method block and entering the code
for the budget group.
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� Configuring labor-rate details
1. To make global rate changes for the Global, BudgetGroup, and/or Department categories, in the

Global Change row, type rate increase percentages in theMerit,Market-1, andMarket-2
columns.

2. To add a job class or job code to an existing labor-rate category, click >> next to <= Click here to
enter JobClass or <= Click here to enter JobCode.

3. To add a step to a job class or job code, in the Step field, type the step code or description.
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4. To make rate changes for job classes and job codes for a labor-rate category, type rate increase
percentages in theMerit,Market-1, andMarket-2 columns.

5. To add another job class or jobcode and step, double-click Double Click to Insert New Jobclass
and Step or Double Click to Insert New Jobcode or Step.

6. To add a new budget group and/or department, do the following:
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a. In the Enter New BudgetGroup Code section or the Enter New Department Code section,
in the BudgetGroup column, type the budget group or department group in the blue cell.

b. To add another new budget group or department, double-click Double Click to Insert New
Budget Group or Double Click to Insert New Department Group.

c. To add job classes, job codes, or steps to the new category, complete Steps 2-5.

7. When you are donemaking changes, in theMain ribbon tab, click Save.

NOTE: After you click Save, any new budget groups and departments that you added move
up to the list of existing budget groups and departments. The system then reorganizes the list
in alphabetical order.

8. At the confirmation prompt, click OK.

Budget Labor Accounts

� Overview
Use this driver to configure certain salary or benefit accounts to use total salaries or a subset of salary
accounts to use in the calculation. You can set the configuration for all or configure it for a specific budget
group.
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� Settings
Open the driver, and then complete the driver settings, as needed.

Budget Labor ADC Config

� Overview
In the Budget Labor ADCConfig driver, configure the job classes and staffing ratios for each job class. The
staffing ratios are used to build out the nursing grid in the budget plan files. You must also determine if
each class is considered:

l Fixed - Position is fixed but is not replaced for PTO calculation.
l Fixed With Replacement - Position is fixed but is replaced for PTO calculation.
l Variable - Position is replaced for PTO calculation and fluctuates with volume changes.

For each defined job class, you must input a staffing ratio to determine the flexing point of each Average
Daily Census level.

There are sections to do this globally for all departments, make exceptions by BudgetGroup, or make
exceptions by department. For each defined job class, you must input a staffing ratio.

Fields and settings in the ADC Configuration driver include:

l Global – Used to set a global staff-per-patient ratio for each category.
l BudgetGroup – Designate exceptions by budget group.
l Dept – Designate staff per-patient-ratios by department. This is themost commonly used section.

NOTE: To activate the ADC sheet for a department, enter JobcodeADC in LaborType in the DEPT
dimension table.
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� Settings
Open the driver, and then complete the driver settings for Global, BudgetGroup, and Dept, as needed,
for each shift.

Budget Labor Alt FTE Factors

This driver allows you to enter different bi-weekly hours for some job codes due to union labor contracts.
For example, you might need to enter 75 hours for some job codes instead of 80.

� Overview
Use this driver to configure the Alternate FTE factors.
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� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Option Description

JobCode Type the job code.

FTE Factor Type the FTE factor.

Budget Labor Benchmark driver

� Overview
Use this driver to define a benchmark target of FTEs or Worked Hours per Unit of Service (WHPUOS) by
department. You can define a target for the current year (CY Target) as well as next year (NY Target). The
Target Type column contains drop-downs to select the type of target to use for each department.
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� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Option Description

Dept Displays the department code.

Department Name Displays the name of the department.

Target Type Select the target number of paid FTEs for the department.

Total FTEs Type the target number of FTEs for the department.

WHPUOS Type the number ofWorked Hours per Unit of Service.

PHPUOS Type the number of Paid Hours per Unit of Service.

Budget Labor JobCode Dropdown

� Overview
Use the Budget Labor JobCode Dropdown driver for any department where a filter applied to a JobCode
dropdown provides a streamlined list for the user.

NOTE: This methodology only works with the Add New JobCodemethodologies on the JobCode tab.
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� Settings
Open the driver, and then complete the driver settings, as needed.

Budget Labor Limits

� Overview
Use the Budget Labor Limits driver to top-out rates when needed.

� Settings
Open the driver, and then complete the driver settings.

l Enter any applicable Job Code and its corresponding rate limit. If a Job Code has a rate limit of
$20.00 per hour and the 5% increase will exceed that, then the rate is capped at $20.00 per hour.

l TheMaxRate is used to determine if a lump sum payout should be calculated when a salary
increase is applied to employee rates. If you do not want to calculate lump sum payouts, set the
MaxRate to $1000. You can also set the Lump Sum Payout Multiplier on the Configuration sheet
to 0%.

l TheMid Rate (MidPoint) is used when a new Job Code is added to a departmental budget. The
Budgeted Rate defaults to the rate listed here, if available.

l TheMid and Max Rate values should reflect the rates that will be used in the new budget year. In
most cases, they should be adjusted by Human Resources to include the range updates related to
merit and market assumptions.
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Budget Labor Override

� Overview
Use this driver to make overrides to the various labor-related sheets, such as Empl_List, in budget plan
files. You can configure labor overrides at the following levels:

l Global
l Budget Groups
l Department Exceptions
l Department - Jobcode Exceptions
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The plan file calc methods process the overrides by first evaluating for exceptions at the job code level,
then department exceptions, budget group exceptions, and then finally applies the default settings at
the global level.

Labor Overrides allow you to modify how the Jobcode, Staffing, and Employee tabs calculate salaries and
related statistics and expenses.

You can adjust the following items:

l The source for Regular and PTO pay
l The source for PTO and EPTO FTEs
l The spread of pay across pay types

� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Option Definition

Department The department in which to apply the labor override.

Jobcode The job code for the specified department to apply the labor override.

NOTE: This column is only editable in theDepartment - Jobcode
Exceptions section.

Regular Rate Source Select the Regular Rate Source to use for the beginning budget rate for
each job code.

l History – Uses the historic rate based on themost recent current
period actual.

l Base – Uses the base rate from the EmployeeMaster sheet.
l Global – Uses the rate of pay entered on this tab in the Rate Override

Amount column.

Rate Override
Amount

Enter the override amount.

NOTE: This column is only editable in theDepartment - Jobcode
Exceptions section.

PTO Rate Source Select the beginning PTO budget rate for each job code.

l Base – Uses the rate listed on the EmployeeMaster sheet.
l Regular – Uses the Regular pay rate for PTO.
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Option Definition

PTO FTE Source Select the source of FTE for PTO Calculation.

l YTD – Uses actual Year-to-Date FTE.
l Rolling12 – Uses 12-month actual (full year) FTE.
l EPTO – Uses the EPTO rate based on scheduled. This may not match

the actual EPTO rate.

EPTO%Override Enter one of the following to override the calculated EPTO% from the
Empl_List:

l A percentage to override the standard PTO calculation.
l History orNA - If you do not want to adjust the EPTO%, enter NA, and

the default lookup to Emp_List logic applies.

IMPORTANT: Do not enter zero (0), because zero is a valid adjustment
percentage.

Adjustment to
Calculated PTO%

Modify the EPTO%used on the PTO row. This is a data validation entry
field, with a range from 0%-200%. For example, if the EPTO% for a selected
job code is 8%, and you enter 100% as the default in this column, the value
remains at 8% (i.e. 8% x 100% = 8%). If you enter the adjustments to
calculated EPTO% as 80%. then 6.4%would display as the value on the
PTO row.

EPTO FTE Source Select the source of the FTE for Earned PTO Calculation, if that option is
enabled on the Configuration sheet.

l YTD – The YTD FTE.
l Scheduled – The scheduled FTEs from the EmployeeMaster sheet.

Paytype Distribution
Overrides

Enter the Override FTE Allocation percentages by category. For each
category, do one of the following:

l Enter a percentage.
l To use the historical percentage by category by job code, select

History.

NOTE: History is the default. You can enter or modify this value. There are
several columns available, for both Prod and NonProd entries.

� Adding a new row to a section
To add a new row to a section, click theDouble Click to Insert New Budget Group/Dept
Exception/Jobcode Exception row.
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� Displaying the legend
The Labor Override Legend provides descriptions that corresponds to specified columns. The letter next
to the description corresponds to the letter that displays above the column, as seen in the following
screen shot.

By default, the legend is hidden. To display it, in theMain ribbon tab, click Change View > Legend.

To hide the legend, in theMain ribbon tab, click Change View > Default.

NOTE: When you close and reopen the driver, the system automatically hides the legend.
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Budget Labor Target

� Overview
Use this driver to define a target ofWorked Hours per Unit of Service (WHPUOS) by department and job
code.

� Settings
Open the driver, and complete the following:

l A target can only be defined for next year (NY Target).
l You can only enter a variable target based on worked hours per unit of service or a fixed paid FTE

target.
l The variable FTE calculation in the budget plan file will be forced to match the target.
l This method does not work on the Employee sheet since there is no variable logic.

Budget Revenue drivers
The following table includes a description of each type of Budget Revenue driver:

Driver Description

Budget
Revenue
GlobalRev

Use to budget all dollars for specific
revenue accounts centrally without
touching each individual budget plan file.
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Driver Description

Budget
Revenue
Adjustments

Use to control the revenue rate increases
by BudgetGroup broken out by Inpatient,
Outpatient, and Other Revenue.

Budget
Revenue
Deductions

Use to control the rest-of-year projection
as well as monthly budget assumptions
for those deduction accounts that are
budgeted at the department level.

Budget
Revenue
Payor
Adjustments

Use to configure percentage shifts in
payor mix.

Driver Description

Budget Revenue
GlobalRev

Use to budget all dollars for specific revenue accounts centrally without
touching each individual budget plan file.

Budget Revenue
Adjustments

Use to control the revenue rate increases by BudgetGroup broken out by
Inpatient, Outpatient, and Other Revenue.

Budget Revenue
Deductions

Use to control the rest-of-year projection as well as monthly budget
assumptions for those deduction accounts that are budgeted at the
department level.

Budget Revenue
Payor Adjustments

Use to configure percentage shifts in payor mix.

Budget Revenue GlobalRev

� Overview
Use this driver to budget all dollars for specific revenue accounts centrally without touching each
individual budget plan file. Common uses are for Other Operating revenue and Inter-company
allocations.

� Settings
To reference this sheet, the budget method (KHAStdLine) in the ACCT dimension table must be
GlobalRevenue.
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Budget Revenue Adjustments

� Overview
This driver allows you to control the revenue rate increases by BudgetGroup broken out by Inpatient,
Outpatient, and Other Revenue.

� Settings
You can make department and account exceptions.

l EffectiveMonth is based on Fiscal month (If FYE is June, January is effectivemonth 7.)
l Departmental Exceptions are allowed at the bottom of each section.
l Common exceptions are if nursing inpatient increases will occur at a different rate than other

inpatient services, you need to enter each nursing department as an exception. You can also use
this to reflect the results of a price optimization study.

IMPORTANT: After you enter a department or account as an exception, any global facility
parameter will not be applicable.

Budget Revenue Deductions

� Overview
Percentage of Gross Revenue for Estimated Deductions
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The Deductions driver controls the rest-of-year projection as well as monthly budget assumptions for
those deduction accounts that are budgeted at the department level.

The assumptions can be defined by:

l BudgetGroup and Account
l Department and Account

The same exception principle that is applied in expense adjustment is applied here as well. After Axiom
Budgeting determines that it is an exception, all other related increases will not apply.

� Settings
Open the driver, and complete the following settings:

l BudgetGroup – Enter or modify this value.
l Acct – You can enter, modify this value.
l [Monthly budget amounts] – 12months of budget amounts, which you enter or modify.

Budget Revenue Payor Adjustments

� Setting up payor adjustments
If your organization uses a general ledger structure that is set up with detailed revenue accounts by
payor, you can use the Budget Revenue Payor Adjustments driver to budget for percentage shifts in
payor mix. Payor adjustments are used for revenue accounts in the general ledger system and set up by
payor. In the ACCT dimension table, you need to configure the FSPayor column to use this sheet. List a
valid code in the FSPayor column and list percentage changes in the inpatient, outpatient, and other
patient columns. The payor shifts displays in the Stat_Rev sheet in budget plan files. The system
calculates and displays budget revenue shifts in the budget plan files in hidden columns AU-AW.

� Settings
Complete the following steps to configure this driver:
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1. In the ACCT dimension, configure the following columns for each payor specific account:

Column Description

ACCT.FSPayor Type R_IP (inpatient payors), R_OP
(outpatient payors), or R_Oth (other
payors) followed by the payor name.
For example, R_IPMedicare, R_
OPBlueCross, R_OthOther.

ACCT.KHAStdline Type one of the following:

l R_IP – Inpatient payors
l R_OP – Outpatient payors
l R_Oth – Other payors

2. Open the 41 Budget Revenue Payor Adjustments driver.

3. Enter the payor name in the FSPayor column without the prefix used in the ACCT.FSPayor column.
For example, if ACCT.FSPayor = R_IPMedicare, then column Q in the driver will read Medicare.
Then enter the percentage shifts for the budget year in the Inpatient, Outpatient, and Other
Patient columns.
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Budget Statistics drivers
The following table includes a description of each type of Budget Statistics driver:

Driver Description

Budget Statistics Use to ensure that your historical data for budget is the same as the data
in the database.

Budget StatAcct Use to set up with the Revenue_Stat (on Stat_Rev) and Variable_Stat (on
Expense) calc methods.

Budget Statistics
Supplement

Use to create custom statistics to pull into the Budget Statistics Driver.

Budget Statistics

� Overview
The Budget Statistics driver ensures that your historical data for budget is the same as the data in the
database. It is referenced by the Statistics, GlobalRev, GlobalExp and Depreciation worksheets for LYA,
CYB and CYA_YTD information. Also, the Rolling12 spreads on the Statistics worksheet are pulled from
the StatData tab.
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If you are using staggered start periods for your budget groups, the GlobalStatUpdate report has logic
that will pull the appropriate values to correspond to the correct period.

NOTE: Click Refresh Data to refresh your statistics with the latest information available.

� Settings
Open driver. For each entity, this driver contains the following information:

l BudgetGroup – Enter or modify this value.
l Stat Name – Enter or modify this value.
l DEPT – Enter or modify this value.
l ACCT – Enter or modify this value.
l Spread Tag (Facility Statistics only) – Select the default calc method to use for the budget group.

The Global Statistics sheet contains the following additional columns:

l FY 20XX Actual – Actual, year before last.
l FY 20XX Actual – Actual, last year.
l FY 20XX Budget – This year's budget.
l FY 20XX Dec YTD Actual – This year's December YTD actual.
l FY 20XX Jan-Jun Projected – This year's January - June, projected.
l FY 20XX Projected – This year, projected.
l Actual Percentage of Total – Percentage change from previous year.
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l Change – Percentage change.
l Budget Percent of Total - Budget percent of total.
l FY 20XX Budget – Next year's budget total.
l Bud-Proj Amt – Variance amount, budget vs. projection.
l Variance % – Variance percentage.

The Service Line information at the bottom of the worksheet is pulled from the Budget Service Line
Supplement driver. Before you make any changes to these line items, make sure to select Previous Input
from the Spread Tag column. This will ensure your edits are retrieved from the Statistics driver table
versus using the default calculations.

Budget StatAcct

� Overview
Use this driver for set up with the Revenue_Stat (on Stat_Rev) and Variable_Stat (on Expense) calc
methods.

� Settings
Open the driver, and enter the department and account combination on the left, then the driven by
department and account on the right. These calc methods will then pick up the set up to be used for the
calculation in budgets.
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Budget Statistics Supplement

� Overview
The Budget Statistics Supplement driver allows you to create custom statistics to pull into the Budget
Statistics Driver.

Setting up andmanaging health plan budgeting
With the Health Plan product for Axiom Budgeting, your organization can budget health plan and
insurance costs by calculating revenues and expenses based on Membership Per Member Per Month
(PMPM) calculations. You can then use this information to determine the profitability of each health plan
and/or insurance product.

Complete the following steps to configure and budget health plans and insurance products in your
organization:

NOTE: As you add or retire plans each year, you will need to complete these steps.

1. Update the LOCATION, INSCODE, and DATATYPE dimension tables.

2. Configure user access and the data filter in theHealthPlan column of the Budget Security Update
utility.

3. Add or edit plans and the corresponding actual account data into the ACT_HP_20XX table.

4. Configure theMembership Enrollment Trend driver.

5. Configure theMembership Per Member Per Month (PMPM) driver.

6. Open the HealthPlan Operations utility.

Updating dimensions for health plan budgeting
To implement health plan budgeting in your organization, start by making the following changes to the
following dimensions:

� LOCATION
The LOCATION dimension contains all of the physical locations that have been billed within the
organization and is used for monthly reporting and provider-level budgeting. This information is also
used for the Axiom Budgeting Health Plan product.

The following table lists all of the options available in this dimension table:
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Column Description

LOCATION The LOCATION used in Axiom Budgeting. This must be an alpha code (i.e.
WestClinic). Default should be used as the Location code if this dimension
is not being used.

Description Identifies the LOCATION description to be used for budgeting and
reporting.

KHABgtCode Used for combining accounts together during budget plan file creation. If
there are historical values for two accounts that you want to budget as
one combined account, list the surviving account number on both lines. If
not combining accounts, this value should match value in the LOCATION
column. The default value is NA.

KHAInt Currently no needed for health plan budgeting so the default is NA.

� INSCODE
The INSCODE dimension stores information for the insurance/health product plans offered by your
organization. This information is used to manage and configure the plans included in related driver tables
and in the Health Plan Operations utility. Similar to other dimension tables like ACCT, there are column
structures to control what insurance plans will be allowed to interface to the HealthPlan tab and at what
level of rollup, if any.

IMPORTANT: Use caution when using multi-layer mapping of the plan codes.

The following table lists all of the options available in this dimension table:

Column Description

INSCODE The short name or code your organization uses to represent the
insurance/health plan product.

Description The long description of the insurance/health plan.

InsCode.BgtCode The code used to group the insurance/health plan products together. For
example, grouping all commercial or FFS plans.
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Column Description

KHAInt Specify whether to include the insurance product in the list of available
plans in the Health Plan Operations utility. Enter one of the following:

NOTE: The system will allow you to enter any text into this field, however,
it only recognizes HealthPlan as the way to add the plan to the interface

l HealthPlan - Enter this option to include the product in the list of
available plans.

l NA - Enter this option to remove the product from the list of available
plans.
NOTE: The system will retain historical information for plans removed
from the list.

� DATATYPE
The DATATYPE dimension for health plan budgeting purposes is used to load configurable categories for
revenues and expenses. Use the Axiom provided default for members. Data imported or entered into the
data tables will need to include a valid data type from this table.

NOTE: Version 1 DATATYPE dimension permits DATATYPE.DataType='HP_Members' and
DATATYPE.BudgetType IN ('HP_Expense','HP_Revenue') - supplied by default data (i.e. one HP_
Members DataType and multiple versions of Revenue and Expense).

The following table lists all of the options available in this dimension table:

Column Description

DATATYPE The DATATYPE used in Axiom Budgeting and Performance Reporting. This
must be an alpha code.

l HP_Members - This is a required default for members data.
l HP_Revenue - This is a recommended default for revenue, but you may

use other codes. For example, other types of revenuemay be desired
to load and recognized as a separate revenue line item. (i.e. HP_
Revenue1, HP_Revenue2).

l HP_Revenue - This is a recommended default for revenue, but you may
use other codes. For example, other types of revenuemay be desired
to load and recognized as a separate revenue line item. (i.e. HP_
Revenue1, HP_Revenue2).

Description Identifies the description to be use for budgeting and reporting.
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Column Description

BudgetType Used in related driver tables and in the Health Plan Operations utility. Valid
codes will typically be what was used in the Datatype column, however
these can be used as a mapping code similar to how KHABgtCode is used in
other dimensions. For example, if there are codes used in DataType for
Revenue1, Revenue2, and so on but the desired configuration is to map
Revenue2 to Revenue1, this column would be used for themapping.

l HP_Members - This is a required default for members data.
l HP_Revenue - This is a recommended default for revenue, but you may

use other codes. For example, other types of revenuemay be desired
to load and recognized as a separate revenue line item. (i.e. HP_
Revenue1, HP_Revenue2).

l HP_DrugME - This is a recommended default for Drug Medical Expense,
but you may use other codes.

l HP_HospME - This is a recommended default for Hospital Medical
Expense, but you may use other codes.

l HP_OutPTME - This is a recommended default for OutPatient Medical
Expense, but you may use other codes.

KHAInt Used to identify which Datatype categories to use in the related driver
tables and in the Health Plan Operations utility. Valid entries include the
following:

l HealthPlan - Use this code to include the data type.
l NA - Use this code to exclude the data type.

NOTE: You may have data you want to record in the actual tables but
not necessarily include them for planning purposes.

Managing the ACT_HP_20XX data table

� Overview
The ACT_HP_20XX table stores the actual data used by the HealthPlan Operations utility to budget for
your organization's health and insurance plans across entities and departments. This information is used
primarily by theMembership Per Member Per Month (PMPM) driver to calculate actual and budget
amounts by period by the number ofmembers in a particular period. The table includes the following
information for each plan (INSCODE column):

l Department (DEPT)
l Location (LOCATION)
l Data type (DATATYPE) (includes membership numbers and revenue/expense streams)
l Values for periods 1-12 (P1-P12)
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NOTE: The following columns are reserved for future use at this time: GROUP, ACCT, NYBKHA,
SaveCustom, and SaveTagDocID

You can enter the data in this table manually or as part of an import. Your Kaufman Hall Implementation
Consultant will help you set up the table for your organization. There is no pre-defined import available
to import health plan data at this time, but you can work with your Kaufman Hall Implementation
Consultant to create a custom import.

IMPORTANT: Your organization cannot enter any health plan data containing patient identifying
information into the system. Please do not send any transmission of data in any form to Kaufman
Hall related to this feature containing any patient identifying information.

NOTE: The Health Plan product relies on data identified in this table for refresh variables and blocks
of data. Without the data, refresh variable picklist(s) will display blank. You will need to maintain this
table as plans, revenue streams, and expense streams are added or changed. If you need to remove
a plan, do not delete it from this table. For instructions, see Removing or retiring plans.

� About this table
Note the following before configuring this table:

l This table is only accessible if your organization is licensed for the Axiom Budgeting Health Plan
product. Only users assigned the Budget Administrator role profile can access this table.

l Before configuring this table, you will need to do the following:
o  Add or edit insurance or health plan products in the INSCODE dimension.
o Add or edit the health plan budget data types in the DATATYPE dimension.
o Add or edit department locations in the LOCATION dimension.

For instructions, see Updating dimensions for health plan budgeting.
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� Adding or editing plans
To add or edit a plan:

1. In the Admin ribbon tab, click System Browser.

2. In the Libraries section, click Table Library > Management Reporting > Actuals > Health Plan.

3. Double-click the file for the planning year. For example, if you are planning for 2021, double-click
ACT_HP_2021.

4. Add or edit the following columns for each plan:

Column Description

INSCODE Double-click to select the plan name.

DEPT Double-click to select the department.

LOCATION Double-click to select the department location.

DATATYPE Double-click to select the data type.

GROUP Reserved for future use.

ACCT Reserved for future use.

P1-P12 Enter the actual or budgeted amount for the period.
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Column Description

NYBKHA Reserved for future use.

SaveCustom Reserved for future use.

SaveTagDocID Reserved for future use.

5. After making your changes, in the Admin ribbon tab, click Save.

Removing or retiring plans
As new plans are added for your employees or for your service area, you may need to retire old plans
from the system. We do not recommend deleting plans from the ACT_HP_20XX data table. Instead,
open the INSCODE dimension table, and in the KHAInt column, typeNA. After you save the dimension,
the system will remove the plan from the Health Plan drivers as well as the budget plan files while still
retaining the plan history.

Setting variance thresholds
The threshold level determines howmuch an account can vary from budget before department
managers are required to enter comments explaining the variance.

To configure the threshold level, navigate to one of the following:
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l In the Bud AdminBud Admin task pane, in the Financial Reporting section, click Financial
Utilities > System Setup, and double-click VCC_Threshold.

l In theMgmt AdminMgmt Admin task pane, in theDimension & Reference Maintenance section,
click System Setup, and double-click VCC_Threshold.

NOTE: In the ACCTACCT dimension table, you need to create or include Variance Comments
accounts for the Summary selection where ACCT.Type=’Comments’.

� General settings

In the top section of the sheet, you may select the following options:

1. To only view thresholds for particular departments, type criteria in the Custom Filter for Alert
Processing cell (e.g., "(Dept.Manager='Chris Sparks' or Dept=101010)").

IMPORTANT: Do not remove the "Acct.Statement <>'NI'" criteria, otherwise new, approved
initiatives will be included.

IMPORTANT: Custom filters will not be applied to the optional Variance Comments Collection
tab in theMonth End Reporting dashboard.

2. In the Comparison Time Series cell, select one of the following options in which to base the
variance in the reports:

l For regular current year budget variances, select CYB.
l For flexible budget variances, select FLX.
l For three-month average variances, select 3MthAvg.
l For prior month variances, select LastMth.
l For the samemonth last year variances, select SameMthLY.

Setup Guide Axiom Budget Planning │ 201



3. In the Revenue & Usage Comparison field, do one of the following:

l To enable drilling in the statistic section down to CDMCode, select Budget.
l If unsure which option to select, select Budget.

4. In the Flag Max Positive Variance as Required cell, do one of the following:
l To be alerted to variances in a favorable direction as well as variances in an unfavorable

direction, select Yes.
l To not be alerted to variances, select No.

5. If your organization uses H_JCHours for Paid Hours, do the following:
l In theUse H_JCHours for Paid Hours filter (Default is H_Hours) cell, select Yes.
l If you are not sure, select No.

6. In the Activate Variance Comments Collection tab on Month End Review Dashboard drop-
down, select one of the following options:

l To create a Variance Comment Collections in theMonth End Review dashboard where you
will manage variance comments, select Yes.

l To manage variance comments in the Excel Client, especially if you already have customized
filters, select No.

� Comment level settings
In the Summary portion of the General Threshold Levels section of the page, you may decide whether to
collect comments at a summary level or account detail level.

IMPORTANT: Valid account codes are needed if reporting at the Summary level.

This setting is reflected in the Comment Input reports. If you select Summary, a single comment input
field displays at the summary level. If you select Detail, individual comment input fields display for each
account.
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If using the summary level, you need to create a dummy account to accept comment input. You need to
add the dummy accounts to the ACCT dimension table, and then indicated in the Summary Account
column on the ThresholdLevel sheet.

IMPORTANT: Do not assign any new account to an existing FSSummary category, otherwise the next
month that account will show up in detail. Use Summary instead.

You can define exceptions for summary level (and all other Threshold settings by Entity) in the sections
further down the worksheet.
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� Flag alert settings
For each account, you may define ranges at which various flags are set:

For each summary and/or detail account, you may set thresholds that will trigger flags with different
color coding in the variance reports.

Color Description

Green Displays on the report if the variance is below the value in theMin Yellow
column.

Yellow Displays on the report if the variance exceed theMin Yellow amount but
remains below the Red Threshold.

Red Displays on the report if the variance is greater thanMax Red but
comments are not required.

Setup Guide Axiom Budget Planning │ 204



Color Description

Red w/Yellow Box Displays in the yellow cell if variance is greater thanMax Red and
comments are required.

Building and processing budget plan files
A budget contains budget plan files for each department, organized into file groups, which typically each
contain a single year's budget.

IMPORTANT: Before you build and process plan files, you must first load and reconcile data. For
more information, see Preparing data for budget go-live

To initially create plan files for a new year, you will need to:

1. Build plan files - Creates the budget plan file.

2. Process plan files – Populates the budget plan file with data from the Axiom database that you
preloaded.

Budget file groups contain plan files with budget data for each department in the organization. However,
you do not copy individual plan files when cloning a file group. Instead, you use the Build & Process
Budget Files job in the Axiom Scheduler to generate a new set of plan files for the new budget year.

Budget plan files are generated from templates. Which templates are used for a particular department
and how those templates are configured is based on settings in our Budget Configuration and
Assumptions driver files.

Within the job, creating and processing are broken out to two different tasks to allow each to be run
independent of each other.

� Building budget plan files
To build budget plan files:

1. In the Bud AdminBud Admin task pane, in the Prepare Budget Plan Files section, double-click
Build & Process Budget Plan Files.

2. In the box on the left side of the Scheduler dialog, click Create Plan Files.
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3. Click the folder icon.

4. In the Choose File Group dialog, select the file group, and click OK.
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5. To create specific plan files, you can apply filters, as needed. For example, to only run for a
selected Entity or Dept. To apply filters, in the Task Details section, click the Plan Files tab. Select
theUse filter radio button to access filtering options.

6. After you select the options you want, in the Job ribbon, click Run Once.
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7. After creating the plan files, you need to process them. For more information, see Process plan
files.

� Refreshing data
Most of the data in Axiom Software is stored in a database. Plan files are typically generated as needed
by populating a template file with the relevant data from the database. The template used for a
particular plan file often depends on the configuration settings selected in the driver file for that file
group. Most plan files automatically refresh/recalculate data on open. If you need to update an open
workbook to reflect changes to the database or driver files, however, you can use the Refresh feature.

In plan files, this feature is only available to product administrators and to users with the Run AQs in Plan
Files security permission. This control prevents users from inadvertently overwriting plan data when the
template is not designed to accommodate data updates.

An Axiom query is a method of querying data from the database and updating a specific range in a sheet
with the data. If an Axiom query is configured to refresh when the file is opened, however, that refresh
occurs for all users, regardless of their security settings. Therefore, you may see data updates in the file
when it is first opened, regardless of whether the Refresh feature is available to use.

For administrators, typically the only time you may refresh individual plan files is during plan file testing.
To test changes made to a template, you build a plan file from the template, and then refresh the plan
file to bring in data. After testing has been completed and the final plan files are built out, use the Process
Plan Files utility to refresh plan files in a batch process rather than refreshing individual files.

After the plan files have been rolled out to end users, you only refresh the plan files if the templates are
designed to accommodate ongoing data updates.

To refresh a plan file:
l On theMain tab, in the File Options group, click Refresh.

NOTE: You may be prompted to define values before the refresh occurs. If so, these values are
applied to the plan file to impact the data refresh.

Setup Guide Axiom Budget Planning │ 208



� Viewing budget plan file templates
Templates define the default file structure for budget plan files. Each template contains one or more
sheets that are copied into a budget plan file at the time it is initially created. Individual cells in templates
may contain formulas (tags) that define how data flows from the database into the corresponding
budget plan file cells and/or how data input or modified in the plan should be written back to the
database.

In all Axiom Software products, templates are generally standardized for each application and not
editable by users. However, you may still view the contents of templates to help trace formulas back to
the source data and understand how data in plan files flows to and from the central database.

Which templates (or sheets within templates) are used to create a particular plan file depends on settings
within the related driver files and dimension table(s). You may or may not be able to configure these
associations, depending on the application and particular category of plan file.

NOTE: After plan files have been created from templates, subsequent changes to the template do
not impact the plan files unless the plan files are re-created.

To view templates:
1. In the ExplorerExplorer task pane, in the File Groups section, click the file group for the templates

to view.

2. Click Templates.

3. Double-click the template to view.
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� Processing budget plan files
To process budget plan files:

1. In the Bud AdminBud Admin task pane, in the Prepare Budget Plan Files section, double-click
Build & Process Budget Plan Files.

2. In the box on the left side of the Axiom Scheduler dialog, click Process Plan Files.

3. To process specific plan files, you can apply filters, as needed. For example, to only run for a
selected Entity or Dept. To apply filters, in the Task Details section, click the Plan Files tab. Select
theUse filter radio button to access filtering options.
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4. To process the plan files, in the Job ribbon, click Run Once.

Building plan files using a Scheduler job
Use a filter in Scheduler to run the Build & Process Budget Files job. To confirm that no errors occurred,
review the log for errors after the scheduled job completes.

To build plan files using a Scheduler job:
1. From the Admin ribbon tab, click Scheduler.

2. In the Job ribbon tab, click Open.

3. Double-click the Budgeting folder.

4. Double-click Build & Process Budget Files.
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NOTE: By default, the job is already set up to run, but you can complete steps 5-9 if you want
to filter the plan files to build and process. Otherwise, skip to step 10.

5. In the left-hand navigation, click Tasks > Create Plan Files (if it's not already selected).

6. In theGeneral tab, click the folder icon.
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7. Select the file group in which to select the plan file to create.

8. Click the Plan Files tab, and click Use filter.

Setup Guide Axiom Budget Planning │ 213



9. From the list, select the plan files to create by clicking the check box next to the left of theDEPT
column.

10. In the Job tab, click Run Once.

Configure budget security
This section provides the security settings for the Kaufman Hall Axiom Product roles - per the design of
the Axiom Budgeting product. It is intended not only to provide additional education towards security
settings but to also serve as an audit tool to validate your current Axiom EPM roles.

For more details regarding general set up and maintenance of Axiom security, see About security.

For more details regarding general set up and maintenance of Axiom Security, see "About security" in the
Axiom Budgeting online help.

� Design
Security is pre-configured according to each product. Each product provides five primary roles: System
Admin, Product Admin, Local Admin, Product Analyst, and Product User. Each role includes pre-
configured security to access specific locations, files, and features. You apply data filters to control each
user’s reach into the data.

There are two main elements to setting up security in Axiom products:

l Role - Allows access to features and files, but not data. Roles define what a user can do, which are
defined and explained in the Roles section.
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l Filter - Allows access to data and plan files with standard filters built into each role. The filters are
directly referenced from the dimension tables, which provides the ability to maintain data access
through the dimensions for additional disseminated control. These are explained in the Filters
section.

� Filters
The Product User, Analyst, and Local Admin roles come pre-configured with a flexible, dynamic filter. Each
member requires a unique filter. For example, the ICUmanager needs a unique filter to restrict access to
only ICU information, as true with every member of the suite. We accomplish this by using a variable to
drive each user’s data filter from a reference table you would commonly maintain. Themost common
table is the DEPT dimension. This table is shared by many planning process and data tables, and provides
an excellent means to protect your data. Other products may have an alternative key table that drives
security filters. Wewill use the DEPT dimension in our examples.

Each product includes nine columns in the DEPT dimension, which you assign to user’s login IDs based
on who is the owner of that role for each department listed. Those security columns with login IDs are
referenced by the corresponding role as for unique data and plan file filters. In the following table,
CSparks is assigned a Budget User role. The role gives him access to specific features, functions, and
tools. The role also includes a dynamic data filter for all budget data tables of “If BPOwner or BPReviewer
or BPApprover = login name”. So, when CSparks logs in, his role filter will apply his login name to his
budget role filter, resulting in if BPOwner or BPReviewer or BPApprover = CSparks. This gives him access
to the budget planning data tables for ICU and ER.

Managing member’s data and plan file filters aremanaged by assigning each members login ID to the
respective departments in the DEPT dimension without the need to access security. This allows you to
minimize number ofmembers with security access since Local Admin members can manage security
filters through dimension ownership assignments.

� Adding additional users
If you need additional users than the fields provide, you may create and use pseudo roles as an
assignment vs. a single login name. Every member of that role will inherit permissions to that
department. For example, let's say you have six local admins that need rights to all departments and
only there are only three slots available in the dimensions. You would do the following:

1. Open Security Manager.

2. Create a new role.

3. Assign the six members to the new role.

4. Open the Dimension Maintenance Utility.
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5. In the DEPT dimension, assign the role name to each of the departments in the BPAdmin column,
and save the changes.

1. Open Security Manager.

2. Create a new role.

3. Assign the six members to the new role.

4. Open the Dimension Maintenance Utility.

5. In the DEPT dimension, assign the role name to each of the departments in the BPAdmin column,
and save the changes.

For instructions related to managing security and managing dimensions, see the following topics in the
online help:

TIP: To find the exact topic listed below, type the name of the topic with quotations.

l "The Security Management dialog"
l "Managing roles"
l "Managing users and roles"
l "Launching the Dimension Maintenance Utility"
l "Editing a dimension"

All of themembers with that role will now have proper permissions.

If you need to assign broader filters, such as “Region=’IOWA’, you can apply a custom filter directly to
the user. A user-level filter and a role filter combine as an OR statement “User Filter OR Role Filter”. The
user filter is applied in multiple locations.

� Security basics
Security is configured by four sections.

Type Description

Product permissions General administrative functions. Many of these permissions span all
products. You can grant many of the permissions in the other sections.
This permission level is suite-wide.

Product file groups Determines access to what file groups, plan file filters, access, and abilities.

Data table types Determines access to data tables. Tables are categorized by type. For
example, the Financial type contains all the GL financial tables.

Files Determines access to select Axiom EPM files.
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� Tools

Name Description

Security Manager Allows you to maintain the complete security options for all users and
roles. We recommend this tool for adjusting security at the individual
level.

Security Spreadsheet Provides a spreadsheet view of file group and table options for all users
and roles.

IMPORTANT: Use caution when using this tool. If two or more security
members save this file with overlapping filters at the same time, the
system will overwrite one over the other.

Product Security
Setup Utilities

Allow you to bulk assign roles and data filters. Each product has a
configured set in the Product Utilities > Security Setup folder. You must be
a member of Security Admin to post changes. We recommended using this
tool for initial product and role assignment.

Dimension Security
Utility

Allow you to assign permissions for Admin members to maintain
dimensions. You must be a member of Security Admin to post changes.

Product Driver
Security Utility

Allows you to assign permissions for Admin or Analyst members to
maintain dimensions. You must be a member of Security Admin to post
changes.

Active Directory
Import

Using the Active Directory Import, you can map directory groups to EPM
roles to automate enabling newmembers.

� Roles
Each EPM license/product comes with the following role types:
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� Budget planning provider roles
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� Product permissions
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� Product file groups
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� Data table types
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� Files

� Specialty roles

Running processmanagement

� Running the Budget Approval Process
To use the Budget Approval Process:

1. In the Explorer Explorer task pane, in the File Groups section, click Budget-20XX > Process
Definitions.

2. Double-click Budget Approval Process.
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3. To view the steps in the process, click the Process Steps tab.

The steps for running the Budget Planning Process include:

Step Name Description

1 Budget
Configuration

Notifies the Budgeting Admin to configure the new year's budgeting file
group.

2 Driver
Configuration
Updates

Notifies the Budgeting Admin to make any necessary updates to the
Driver files.

3 Volume
Assumptions

Notifies the Budgeting Admin to adjust volume assumptions for the
new year.
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Step Name Description

4 Budget Approval
Stages

This subprocess containing multiple steps:

l Base Budget Build – Prompts the Budgeting Admin to build plan files
for the file group.

l Budget Owner Input – Prompts department managers to edit their
respective budget plan files.

l Budget Review – Submits plan files to their designated reviewers for
approval.

l Executive Approval – Submits approved plan files to their
designated executive for approval.

l Finance Team Approval – Submits approved plan files to their
designated financial department contact for approval.

� Copying the Recalculate Budget Files job
In Axiom Budgeting, you can copy the Recalculate Budget Files job to recalculate the budget files for one
or more specified entities.

To copy the Recalculate Budget Files job:
1. In the ExplorerExplorer task pane, in the Libraries section, click Scheduler Jobs Library >

Budgeting, and double-click Recalculate Budget Files.

2. In Tasks list in the left window pane, click Process Plan Files.

3. Right-click any of the tabs, and click Save As.
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4. Name and save the new scheduler job file.

5. Click the Plan Files tab.

6. At the Specify plan files to process option, select Use filter.

7. Create a filter to specify an entity by entering the filter syntax in the Plan File Filter box or click the
Filter Wizard button.

8. Click the Axiom Queries tab.

9. In the Refresh On Open column heading, click the gray drop-down, and in the Value field, type
True. This filters the list for all the AQs that should contain the check mark.
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10. Click any blank check boxes, and then click Save.

Releasing budget plan files
After you start building plan files, they become available to your end users - unless you restrict them - so
you want to make sure you are ready before releasing them to your end users.

Ensure that Security and Process Management is set up and ready to go.

Under certain circumstances, you may want to wait to make them available for a few days. For example,
waiting until after the weekend or a major holiday.

TIP: We recommend that you review reconciliation reports on a daily basis until the budget is
complete. This allows you to find and troubleshoot any issues quickly because you are starting each
day with "clean" data. If you wait too long to reconcile your budget, it can take longer to find where
the problems are located and resolve them. It also puts your organization or department in a
constant state of readiness so that you can report information at a moment's notice
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Rolling forward to a new fiscal year
IMPORTANT: Upgrade Axiom to themost current release, and then follow these steps. Also make
sure you're not in an active budget cycle.

As part of the implementation process, a Syntellis Implementation Consultant helps you create a budget
file group for the current year, as discussed the section Setting up Budget plan files. As part of the
implementation process, a Syntellis Implementation Consultant helps you create a budget file group for
the current year, as discussed the section "Setting up budget plan files" in the online help.

For the next or subsequent file year, however, there are steps you need to complete to set up next year's
file group. These steps include the following:

1. Archive the current year plan file

2. Prepare for the next fiscal year

3. Review other system areas

NOTE: To populate the Bud_Pay27 tables with budgeted hours, we recommend that you run the
Monthly to Biweekly utility located in the Reports Library >Management Reporting Utilities > Payroll.
For more information, see Payroll utilities see "Payroll utilities" in the online help.

Running the Budget Checklist process
Use this process to walk you through the steps needed to create plan files for the next budgeting season.
The Budget Checklist process displays all of the steps to complete on the left side of the window. Those
steps that include sub-steps are indicated with an arrow icon, which you can click to expand or contract
the list.

To run the Budget Checklist process:
1. In the Bud AdminBud Admin task pane, in the Prepare Budget Plan Files section, double-click

Budget Checklist.

3
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2. In the Process Owner field of the Process Properties tab, do one of the following:
l To assign a specific user as process owner, click Select User.
l To assign users with specific roles as process owners, click Select Role.

NOTE: You must assign a user or role before you can run this process.

3. Click Start Process in the upper right corner of the dialog.

4. At the Start process 'Budget Checklist' prompt, click OK.

5. As you complete each step, click Complete step in the upper right corner of the screen.
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TIP: An arrow icon displays next to steps that contain sub-steps. Click the icon to expand or
contract the list of sub-steps.

NOTE: You can skip steps that do not apply to your organization.

6. In the Process Action dialog, you can enter any details about the step you performed, and click
OK.

TIP: The dialog also displays the next step in the process.
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7. If you need to stop the process as you work on the different steps, click Stop process in the upper
left corner above the list of steps. This places the process in an inactive status until you are ready
to start the process again.

TIP: To view a report of the process history, click Process history in the upper left corner above
the list of steps.

8. At the Are you sure that you want to stop this process? prompt, click OK.

1. Archiving current year plan files
The Archive Current Year Plan Files command allows you to convert the current plan files in a file group to
static snapshots of the files, for viewing only. This command is intended to be used in cases where
planning is finished for the file group, but you still want the ability to view the finalized plan files.
However, you do not want the plan files to be updated with new data or save data to the database.

When you run this command, the system first creates a plan file restore point, so that you can restore
the plan file if a user accidentally executes it. Then, the system opens each plan file and normal "open
processes" occur, including applying default views, hiding sheets, and executing refresh-on-open Axiom
queries and data lookups.

NOTE: The plan file starts out in the same state it would be in if the user executing the command
opened the file normally.

The system then processes each plan file as follows:

l Converts all formulas in the plan file to values.
l Deletes all control sheets. This disables any process that depends on a control sheet, such as

Axiom queries or save-to-database.
l Disables refresh variables, action codes, and data lookups by prefixing the primary tags with an x.

For example: [xActionCodes].
l Applies workbook and worksheet protection, as configured on the original default Control Sheet.
l Saves the plan file in this static state.
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When a plan file is opened after being archived by the command, data queries will not run because there
is no longer any Control Sheet, and no formulas are left to be calculated. Manually refreshing the file will
have no effect. Users can still save the file if they have read/write access to it, but save-to-database
processes will no longer execute because there is no longer any Control Sheet.

IMPORTANT: The system processes all plan files using the permissions of the user who is executing
the command. This means that the plan files will be opened, refreshed, and then "frozen" based on
the permissions of that user. All users who open the archived files will see the plan files in the same
state. For example, if the "live" plan file used formulas to dynamically show and hide sheets based on
the current user's permissions, this will no longer apply to the archived file.

To archive current year plan files:
1. In the Bud Admin task pane, in the Budget System Maintenance section, double-click Archive

Current Year Plan Files.

2. At the Are you sure you wish to archive file group 'Budget-year' file group? prompt, to
continue, click Yes.

NOTE: The system determines the budget file group to archive based on the file group
associated with the current year's budget plan.

IMPORTANT: Confirm your File Group Alias for Current Year is pointed to the file group you
intend to archive.

2. Preparing for the next fiscal year
If you are applying the update, then it is likely you are ready to prepare your system for the next fiscal
year. This section includes some of the common steps, but it may not be an exhaustive list so please
contact Syntellis Support with any questions.

l Update system periods
l Update year and period tables
l Update payroll dates tables
l Update the current payroll schedule
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The new budget file group is now active, but see 3. Reviewing other systems for the new fiscal year to
make sure all systems have been reviewed and updated before you begin working with the new budget
file group.

Setting year and period
Use this table to configure the following for your organization:

l Set the fiscal year and the first month of the fiscal year
l Define the number of work days in the current year, last year, and next year
l Select the standard Full Time Equivalent (FTE) hours worked by employees in a year.

l For Budget Planning, the 02 Budget Labor Configuration driver will use the default FTE scale
created in the Year/Period Form but allow for modifications to the default at the Global and
Budget Group level.

NOTE: The standard FTE hours you select in this worksheet displays as the default FTE Hours in the
Budget Labor Configuration

The FTE Hours you select are reflected on the following tabs in the plan file:

l Expense
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l Jobcode
l Staffing
l Employee
l ProviderComp
l altEmployee
l HHLabor

To set year and period:
1. In theManagement Reporting Admin task pane, in theData Maintenance section, double-click

Update Year and Period Tables.

2. In the Primary Inputs section, complete the following options:

Option Description

Fiscal Year Select the fiscal year.

Fiscal Start Month Select themonth in which the fiscal year starts.

Day Type Select Calendar Days or Work Days.

FTE Scale Select a Daily, Weekly, Monthly, or Yearly scale.

FTE Hours Use one of the option to input the FTE value associated with the
FTE Scale field selected above:

l To use the standard of the number of days worked multiplied by a
40-hour work week divided by 7, type 2086.

l To use the standard 40-hour work-week multiplied by 52weeks,
type 2080(default).

l To use a custom FTE value, type it. To viewmultiple examples of
how to use this field, see the section Examples of custom FTE
scales below.

3. In theWorking Days Inputs area, enter the number of working days for the current year, last
year, and next year for each fiscal month.
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TIP: To hide the year and/or period tables, click the corresponding check boxes under the
Working Days Inputs section.

NOTE: When you select Work Days from the Day Type drop-down, Daily is the only available
option from the FTE Hours drop-down.

4. After making your changes, click Save.

� Examples of custom FTE scales
You can configure the FTE Scale to suit the needs of your organization in a variety of ways, here are some
examples:

Yearly
To calculate a full-time equivalent based on the yearly scale, complete the following:

1. In theDay Type drop-down, select Calendar Days.

2. In the FTE Scale drop-down, select Yearly.

3. In the FTE Hours field, type 2085.714.

NOTE: The default of 2080 hours per year displays next to FTE Hours.

The system displays themonthly hours worked based on your configuration in the Period Table section.
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NOTE: After you save your changes, the system will display values based on this configuration in the
Period Table section.

Daily
To configure a scale for 2080.5 instead of the standard 2086 (2085.71) scale, complete the following:

1. In theDay Type drop-down, select Calendar Days.

2. In the FTE Scale drop-down, select Daily.

3. In the FTE Hours field, enter 5.700.

NOTE: The FTE Hours default for this configuration is 5.7 hours per day.
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NOTE: After you enter your Primary Inputs, the Period Table section displays the calculated results
in real timewhich allows you to view your configuration before saving data.

Weekly
To configure an annual FTE of 2085.71 based on a weekly calculation of 40 hours per week, complete the
following:

1. In theDay Type drop-down, select Calendar Days.

2. In the FTE Scale drop-down, selectWeekly.

3. In the FTE Hours field, type 40.00.

NOTE: The default for this configuration is 40 hours per week.
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NOTE: After you save your changes, the system will display values based on this configuration in the
Period Table section.

Monthly
To configure on a scale where employees work that same number of hours per month, in this example an
annual FTE scale set to 2080 hours, where themonthly FTE hours are 173.3333, complete the following:

1. In theDay Type drop-down, select Calendar Days.

2. In the FTE Scale drop-down, selectMonthly.

3. In the FTE Hours text box, type 173.3333.

NOTE: The default for this configuration is 160 hours per month (for a 30 day month).
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NOTE: After you save your changes, the system will display values based on this configuration in the
Period Table section.

Setting payroll dates
Use this table to manage your organization's pay period dates. This table is used in many of the
productivity and pay period reports.

IMPORTANT: If your organization uses more than two cycles, it will not display in this table.

To set payroll dates:
1. In theMgmt Admin task pane, in theData Maintenance section, double-click Update Payroll

Dates Table.
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2. For Cycle 1 and Cycle 2, from the Select the initial period pay date drop-down, select the date for
Pay Period 1.

TIP: You can hide or show Cycle 1 and 2 using the toggle under the Save button.

3. From the Select the number of days the Pay Date is after the Pay Period End Date drop-down,
select the number of days.

4. After you make changes, click Save in the upper right corner of the page.

Configuring the current payroll period
Use the Change Payroll 27 Tables-Current Period utility to change the Payroll 27 tables current period.

NOTE: You must have the Administrator role profile to access this utility.

To configure the current payroll period:
1. In the Bud Admin orManagement Reporting Admin task pane, in the Budget System

Maintenance section, double-click Change Payroll 27 Tables-Current Period.
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NOTE: The utility opens in a separate browser window.

2. From theNew Pay Period drop-down, select the current pay period.

3. Click Submit.

4. At the This may take around a minute to save prompt, click OK.

5. At the confirmation prompt, click OK.

3. Reviewing other systems for the new fiscal year
Refer to the budget checklist and all of the topics related to it. Although the budget file group is now
active, there remains a few system areas to review and possibly update.

l Bring data current – Bring the GL and Statistic data current.
l Verify Budget Control columns in the DEPT dimension table – Validate that the DEPT dimension

key Budget columns have been reviewed and updated.
l Verify the Budget Control columns in the ACCT, JOBCODE, and PAYTYPE dimension tables
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l Load updated employeemaster data.
l Build 1-5 sample budgets for verification.
l Adjust dimension budget settings and driver information accordingly.
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Working with Budget plan files
All of the files, utilities, process definitions, and other materials for a budget year are all grouped together
into a single file group. The file group includes all of the budget plan files for each department. Budget
plan files are the primary means by which users pull data from and write data back to the central
database. Your organization creates a budget plan file for each department that needs a budget.

A budget plan file includes the following sheets:

l Instructions – Provides a guide to completing budget plan files, plus support contact information.

4
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l Budget - Includes all of the sheets associated with entering and reviewing the budget values.
o Summary - Provides a high-level summary of the department budget, based on

information from the plan file.
o Statistics and Revenue -Most of the sheet is pre-populated, but may require your input for

projections for next year's budget.
o Labor - Provides several different sheets for tracking payroll, depending on themethod

used by your organization and/or department.
o Expense - Summary and Detail of non-payroll expenses. Most of the sheet is pre-populated,

but may require your input for projections and next year budget.

l Provider or ProviderComp – Overview of encounters, procedures, gross charges, and RVUs for
each provider.

NOTE: Available only to organizations with the Provider module license.

l New Initiatives – Allows users to enter values into both approved and excluded (unapproved)
initiatives. Only approved initiatives are included in plan file totals. Totals incorporating excluded
initiatives are tracked in a separate column on the Summary sheet.

l Operating Plan – Questionnaire covering strategic budget concerns. A useful tool to help keep
real-world priorities in mind while you are working on budgets.

l Department History – Used to calculatemonthly spreads on the Expense tab. Contains a history of
budget updates going back 18months.

The budget plan file also allows you to include supporting files that you can attach to the budget.

Using budget plan files
Each budget plan file contains multiple sheets. Within a sheet, you can view data and/or input or modify
the values in blue or green cells.

� Opening budget plan files
Your access rights to each budget plan file (read-only or read/write) within a file group are determined by
a combination of your security settings and workflow or process settings, if applicable.

The Open Plan Files dialog lists all budget plan files available to you based on your role profile and
security settings. Use the filter box at the top of the dialog to quickly find a plan file based on the plan
code or description. You can also sort and filter the list to narrow down the list. If you have previously
opened a budget plan file within this session, the system highlights that plan file by default when you
open the dialog.
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Depending on your Axiom role profile, you can open budgets from either the Budgeting or Bud Admin
task panes.

� From the Budgeting task pane
1. From theMain ribbon tab, click Open App Menus, and select Budgeting.

2. In the Budgets section, double-click Open Next Year Budgets orOpen Current Year Budgets.
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3. In theOpen Plan Files dialog, select the budget plan file or files to open, and click OK.

4. If you have read/write permissions to a file but you want to open it as read-only to prevent locking
the file from other users, right-click your selection, and select Open Read Only.

� From the Bud Admin task pane
1. From the Adminribbon tab, click Admin Task Panes, and select Budget Admin.

2. In the Budget Files Administrationsection, double-click Open Next Year Budgets orOpen
Current Year Budgets.
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3. In theOpen Plan Files dialog, select the budget plan file or files to open, and click OK.

4. If you have read/write permissions to a file but you want to open it as read-only to prevent locking
the file from other users, right-click your selection, and select Open Read Only.

The selected budget plan files open. If a file was opened read-only, then the text (R/O) displays in the file
tab. You cannot save read-only budget plan files.

If the dialog is empty, then either you do not have access to any budget plan files in the file group or the
budget plan files have not yet been created for the plan codes that you have rights to.

If another user has the budget plan file open with read/write permissions, then the file is opened as read-
only—regardless of your security permissions.

� Navigating budget plan files
When you first open a budget plan file, the system displays two main areas: the Navigation panel and the
sheet display area. By default, the Summary sheet and its associated budget sheets display when the
plan file is first opened.

The Navigation panel is the primary way in which to open the different sheets that make up the budget
plan file. To open a specific sheet, double-click the tab name.

NOTE: If your organization is licensed to use the Provider module, the Navigation panel will include
links to those sheets as well.
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Each sheet you open displays as a separate tab in the plan file. The exception to this are the budget tabs,
which are grouped and open together as a unit to help facilitate the process of adding and entering
values. To move from one tab to another, you can use the Navigation panel or click the tab at the top of
the display area.

In the grouped budget sheets, you can also click the tab names at the bottom of the display area.
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You can easily move around to different sections within sheets by using theGoTo function onMain
ribbon tab. This opens a drop-down menu that lists links to specific sections of the budget. This is
typically a faster and more convenient way of reaching the section you need when working with tabs that
contain a large amount of data.

The system allows you to open multiple budget plan files simultaneously so that you can work on them
from one screen. To do this, click the Budgeting or Bud Admin tab, and open another budget plan file.
The system assigns color codes the tabs specific to each plan file. In the following example, the blue tabs
belong to the plan files for department 19100 and the orange tabs belong to the budget for department
27200.
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To close a sheet, click the X next to the tab name. If you have unsaved data, the system will prompt you
to save before closing.

NOTE: If there is only one sheet open for the plan file and you close it, the entire plan file will close.

� Changing sheet views
On theMain ribbon tab, click the Change View drop-down to select how to display data on certain
budget tabs.

For example, the Statistics and Revenue tab drop-down menus allows you to choose whether a section
of a sheet displays data for annual, monthly, and projection intervals.

� Understanding cell formatting and input types
The cells in the budget plan file are color coded as follows:
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l White cells: Displays information only. The values are either hard-coded, pre-populated from the
database, or calculated from other fields, and cannot be changed.

l Blue cells: These fields can be edited. Blue-shaded cells might be empty or pre-populated with a
value or formula that you can change.

l Green cells:. From these cells, you can select from one of several predefined options.

While different budget plan files call for different types of user input, some common cases where the user
is called upon to enter values include:

l Adjustments – Some calculations depend on historical account balances and can only be affected
by changing the budgeted increase over the previous year.

l Spreads – Some calculations automatically spread the budget value over the year, others allow
direct entry to adjust themonthly spread.

l Monthly input – There are sections on some tabs that allow you to enter values, while others
have formulas which pre-populate values directly into each of the twelvemonths.

l Variance comments / Red flags – For certain values, the Budget Administrator may set variance
thresholds which, if exceeded, cause a red flag icon ( ) to display. The system may display a
warning message if you attempt to save the budget. When this happens, enter a comment in the
Comment field explaining the reason(s) for the variance. Entering a comment allows you to save
the budget normally.

� Understanding source data
Themajority of a budget is pre-populated with data. Sources for this data include:

l Dimension tables –When you open a plan file, Axiom Budgeting typically runs a query against
one or more dimension tables and returns data for the specified department, account, and so on.

l Data tables – These tables contain data associated with one or more dimensions. Budgeting-
related examples include Financial and Payroll data tables.

l Driver files – Some cells in plan files contain formulas that reference assumptions (key statistics)
contained in the plan file's driver files.

l File group variables – Axiom Budgeting can associate certain variables with a file group. The
variable most often used in Axiom Budgeting 2022.1 is the file group year, which is set by Syntellis
when initially creating the file group.

l Other cells / other sheets – Some values are calculated based on the contents of other cells or
sheets within the plan file.

� Understanding calculation methods
Calculation methods (calc methods) are pre-formatted groups of rows with pre-defined cell contents that
can be inserted into plan files or reports. For instance, a budget plan file might use calc methods to insert
multi-line records for each account associated with a given department.
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The cells in a calc method may include formulas. These formulas might incorporate variables that
reference the year of an associated file group or an assumption or configuration setting in a driver file.
Some calc methods also incorporate user-defined variables.

Creating or modifying a budget plan file

Reading instructions

� Overview
The Instructions sheet provides information related to the following areas:

l Timeline and Deadlines for Submitting Budgets - Dates and other deadline information for
submitting your budget.

l Your Contact for Budgeting Questions Is - The name and contact information for the person in
your organization to contact if you have questions about managing the budget plan file.

l Budget Assumptions - Overall, high-level assumptions that may be important when creating your
budget.

l Instructions for Budgeting - Instructions related to navigating and entering information in the
budget.

NOTE: The information on this tab, including the section names, are determined and set up by your
organization. If you have Administrator privileges, you can add or edit the contents of this tab in the
Budget Assumptions driver.
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Reviewing budget summary

� Overview
The Summary sheet provides an overview of the entire budget. Beforemaking revisions, review the
Summary tab to get a sense of where the budget currently stands. After completing revisions, return to
the Summary sheet to see how the figures have changed. This sheet is also useful when submitting a
budget plan file for leadership review.

This sheet includes data from two sources:

l Base Budget – Summary of inputs on Stat_Rev and Expense tabs based on KHASum (set in column
U in the ACCT dimension table).

l New Initiatives – Incremental volumes, revenue, FTEs, and expenses for approved new initiatives.
It does not include data from unapproved initiatives.

This tab includes the following sections:

The Financial Summary section displays totals from the other tabs, along with the contribution margin.
The Analysis sections consist of Statistical Analysis and Hours Analysis, and features calculated metrics to
help gauge the reasonableness of a submitted budget.
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Statistics and Revenue sheet

� Overview
Use this sheet to review and adjust current year projection amounts and next year’s budget for
statistics, revenues, and deductions. The sheet is segmented into two main areas: statistics and revenue.

NOTE: Provide comments in any red comment cells.

� Statistics section
The following table describes the sections in this sheet:
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Section Description

Global Drivers Summarizes the Budget Assumptions used to drive initial projections
for the department.

Key Department Statistics Includes department-specific statistics that drive the variable gross
revenue, variable costs, and variable labor calculations in the
workbook. Global drivers are used to apply the overall organization
growth assumptions to the department statistic.

You can make adjustments in theMar-Jun change for CY as well as %
Adjust and Amt Adjust columns for NY Budget. Key statistics, such as
patient days by Nursing unit, are defined in the Budget Statistics
driver.

NOTE: If a statistic Dept/Acct combination is listed in the Budget
Assumptions driver, no adjustments may bemade in the budget plan
file.

Other Non-Key Statistic Displays other statistics captured for the department, but do not
drive any other calculations in the workbook.

� Revenue section
The following table describes the sections in this sheet:
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Section Description

Patient Revenue Summarizes all revenue. Displays projections based on historical
revenue per unit plus price increase (revenue adjustments) times
volume.

Patient Revenue Detail Displays detailed patient revenue, both inpatient and outpatient, by
specific account.

Other Revenue Models the projection and budget for other operating revenue
accounts, typically using a Fixed Revenue calc method, which uses
the projected value as the starting point for budget. You can make
adjustments in theMar-Jun change, % Adjust, and Amt Adjust
columns.
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� Inserting a new statistic or revenue line item
You can add statistic or revenue line items to individual sections, including:

l Key and non-key statistics
l Deductions
l Net and other revenue
l Inpatient, outpatient, and other patient revenue

The system adds the line by inserting the appropriate calc method into the sheet. The following table lists
the available calc methods used by the corresponding section in the sheet:

Calc Method Description Sheet Section

Add NewDetail Zero-based expense calculations when
adding a new account. Inputs are done on
the Detail tab in the budget plan file.

l Other Patient
Revenue

l Other Revenue

Add New Fixed Revenue Use this new revenue calc method to add a
new Fixed Revenue account.

l Inpatient Revenue
l Outpatient Revenue
l Other Patient

Revenue
l Other Revenue

Add New Input Monthly Use this new revenue or statistic calc
method to add a new account.

l Deductions from
Revenue

l Inpatient Revenue
l Outpatient Revenue
l Other Patient

Revenue
l Other Revenue

Add New Statistic Use this new statistic calc method to add a
new key statistic account.

Key Department
Statistics

Add New Statistic_Oth Use this new statistic calc method to add a
newOther Statistic account.

Other Non-Key Statistics

GlobalSum This SPM allows you to budget for an
account at a percentage of the total of
specific other account(s) within the same
workbook.

Net Revenue
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Calc Method Description Sheet Section

ProviderRev Transfers Revenue calculations from the
Provider Summary/Provider Detail tab to
the Stat_Rev tab to save to the Financial
Data tables.

NOTE: Only available to organizations with
the Provider module license.

l Inpatient Revenue
l Outpatient Revenue
l Other Patient

Revenue

ProviderStat Transfers Statistic calculations from the
Provider Summary/Provider Detail tab to
the Stat_Rev tab to save to the Financial
Data tables.

l Key Department
Statistics

l Other Non-Key
Statistics

To insert a new statistic or revenue line item:
1. Navigate to the section to add the new line item.

2. Double-click theDouble Click to Insert... cell.

3. In the Insert Calc Method(s) in sheet Stat_Rev dialog, select the calc method to insert, and click
OK.

NOTE: If the line only uses or your organization is only licensed for one type of calc method,
this dialog will not display. The system will open the Calc Methods Variable dialog instead.

4. In the Calc Methods Variable dialog, enter or select the account and department number, and
click OK.

5. Enter the appropriate values in the blue cells, as needed.

6. After making your changes, in theMain ribbon tab, click Save.

Reviewing employee master

� Overview
Use the Employee Listing sheet as reference to calculate when salary adjustments occur throughout the
planning cycle. This sheet lists all employees by job code and includes details regarding each employee's
current and next year's rate as well as their merit and market increasemonth and percentage.
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To make the budget plan file as accurate as it can be when calculating salaries, the system takes into
account any potential current year rate increases set to take place - depending on when the budget plan
file is built. For example, let's say the following budget plan file is built in month 8. All the radiology
technicians except Michael and Jeff have likely received their rate increases already because 0% displays
in the CY Inc % column and their anniversary dates have already passed. However, Michael is set to
receive his increase in month 9 and Jeff in month 10. The system anticipates this increase by showing
that their beginning rate as 3% higher than their current rate and uses this rate for the budget.

The system does the same for scheduled budget market and merit increases as well. In this example,
everyone will receive a 3%merit increase but no market increases. The system allows you to include up
to two market increases, which simply provides a way to apply additional percentages beyond themerit
increase. For example, a contract may stipulate that nurses receive two market increases per year.

The system then layers together all of the rate adjustments as well as themerit and market increases to
provide you with values related to the amount that salaries will increasemonth-over-month over the
year. In the following example, July starts with an increase of 0.70% but begins to increasemonth to
month as more employees receive their salary adjustments. These values are used in the Jobcode tab to
calculate salaries.
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The last month of the fiscal year becomes the "fully burdened" month because by this point all of the
increases have occurred. The effective rate for the fiscal year is located in the Total FTEs column. Knowing
the effective rate helps you determine the effect of adding merit or market adjustments. In the example
below, the user now knows that adding a 3%merit increase will result in a 1.67 effective rate.

The remaining section of the sheet is devoted to the scheduled hours for scheduled FTE employees. The
system projects scheduled hours based on when the employee was hired and whether they are working
full or part time.

Keep in mind the following when using this sheet:

l Employees are only listed in their home department. The Jobcode sheet may showmore
employees than what are listed for the job code in the Employee Listing sheet. This means that
employees have been borrowed from other departments.

l The Employee Listing sheet only displays current active employees.
l To add an employee, you must do so through the labor method itself. For example, if you use the

employee budgeting methodology, you must add a new employee in the Employee sheet.
l Merit and market increase factors are defined in the LaborRates sheet of the Budget Labor

Assumptions driver.
l This sheet incorporates max rate logic to calculate the lump sum payout if an employee is

currently above their max limit or defined increases will put them above the limit.
l Max limits are defined in the Budget Labor Limits driver.

Use this sheet to calculate PTO accrual hours if activated in the Budget Configuration driver.
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Labor sheets

� Overview
Different departments may use different methodologies to track their labor expenses (FTEs and salary
dollars). To facilitate this, the budget plan file template includes several different labor sheets for tracking
payroll. When a department's budget plan file is first created, the system copies the payroll sheet
specified for that department in the LaborType field of the DEPT dimension table.

There are four Labor sheets used to cover thesemethodologies:

l JobCode – Use for departments needing the ability to adjust FTEs on a monthly basis or based on
volume.

l Employee – Use to allow departments to budget at the employee level. No volume adjustments
are included in the salary calculations.

l Staffing – Use for 24/7 departments to prepare the budget by shift/day of the week.
l ADC Configuration – Use for nursing departments to prepare the budget Average Daily Census

(ADC) and Nursing Staffing grid levels by job class.

NOTE: This tab only works with the JobCode tab.

JobCode sheet

� Overview
The JobCode sheet is used for departments that need to adjust FTEs on a monthly basis or based on
volume.

This sheet is comprised of threemain areas:
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Summary and Target
This area displays at the top of the sheet and provides an overview of the productive hours, target hours
per unit, FTEs from target, paid hours per unit, and the productive percentage. This area automatically
updates as detail is added to each job code block. Targets are defined by department on the Budget
Labor Benchmark driver.

The Summary and Target area provides a quick and easy way to ensure that your numbers are on track
without having to dive into the details.

Jobcode Statistics
This section displays all of the statistic values related to the job codes in the department, including the
following:

l Departmental totals
l Total program additions
l Total position changes
l Total productive FTEs
l Total non-productive FTEs
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Jobcode
Most of the sheet is comprised of the individual job code values. By default, the sheet displays only a
summary view of the job code that includes the total productive, non-productive FTEs as well as the total
FTEs for the job code.

To view the job code details, double-click theDouble click to show details cell. From this expanded
section, you can view specific details about the job code.
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� Sheet columns
The following table provides descriptions for the columns in this sheet:

Column Name Column
Letter

Description

Job Code A The job code identification number (using
Jobcode.KHABgtCode).

Current Rate G The hourly rate as of the start of the budget process.

Start Rate H The hourly rate as of the start of the new budget year.
This includes any salary increases expected to occur in
the remainder of the current year.

End Rate I The hourly rate as of the end of the budget process. This
includes all salary increases through the end of the
budget year. This is calculated using the last month of the
budget as this would contain the effective rate of all merit
& market adjustments.

Alloc Rate J Calculated based upon YTD actual % of total FTE. You can
make adjustments to allocate NYB FTEs for salary
calculations.

Sched K Scheduled FTEs from the labor master file or CYB FTEs
depending on the configuration option chosen in the
Budget Configuration Assumptions driver file.

YTD Actual L Year-to-date FTEs from the Payroll26 database.

Month-Month Projected
(FTEs)

M Projected FTEs for the remaining months of the current
fiscal year. Initial FTE allocation is the same as YTD.
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Column Name Column
Letter

Description

FY20XX Budget (FTEs) N Starting point matches projected FTEs. You can make
monthly adjustments to theMonth FTEs columns
(columns S-AD).

Month-Month Projected
(Dollars)

O Projected dollars for the remaining months of the current
fiscal year.

FY20XX Budget (Dollars) P Projected dollars for the budget year.

Notes Q Enter comments for the line item, as needed.

Spread Method R Select a spread method for the pay type, as needed.

Month FTEs S-AD Enter a percentage of each FTE factor to the total factor.
For example, let's say that the FTE factor for month one is
177 divided by the FTE factor for the year of 2080 or 2086.
It usually ranges around 8% or so per month.

NOTE: Not all pay types allow you to update the spread
amount.

Month-Year Hours AG-AS Hours spread across months, including total budgeted
hours.

Month-Year Dollars AT-BF Dollars spread across months, including total budgeted
dollars.

Month-Year FICA BH-BT FICA spread across months, including total budged FICA.

Projected FICA BW Total projected FICA amount.

Month-Month Hours BX Total budgeted hours for the remaining months of the
fiscal year.

The following sections include instructions on performing specific actions in this sheet.

� Updating the staffing ratio for a job code
Use these instructions if you want to change the default staffing ratio type.

To update staffing ratio type for a job code:
1. Navigate to the job code, and double-click Double click to show details.
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2. In the job code title row, from the drop-down, select one of the following:
l Variable - Input is the worked FTEs per a normal work week. Non-productive hours are

added to productive based upon allocation percentage. This setting is a default from the
JOBCODE dimension. When Variable, the values in the job code will fluctuate based on
changes in the departments volume.

l Fixed - Input is the total paid FTEs per a normal work week. Non-productive hours are
allocated based upon allocation percentage. This setting is a default from the JOBCODE
dimension. When FIXED, the values in the job code will not fluctuate based on changes in
the departments volume.

3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

TIP: You can also click the Save button in theMain ribbon tab.

� Updating start rate and projected FTEs for program additions and position changes
To update start rate and projected FTEs for program additions and position changes:

1. Navigate to the job code, and double-click Double click to show details.

2. In the Program Additions field (column H), type the start rate amount.
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3. In the Position Changes field (column H), type the start rate amount.

4. In theMonth-Month Projected column (column M) for the program additions and position
changes line items, as needed.

5. In theNotes column (column Q), enter comments, as needed.

6. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the allocation rate for a job code pay type
To update the allocation rate for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. In the Alloc Rate column (column J), enter a percentage for each line item, as needed.
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3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the spread method for a job code pay type
To update the spread method for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. From the Spread Method column (column R), select the spread method to use.
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3. In theMonth-Year FTEs columns (columns S-AD), make adjustments, as needed.

NOTE: The spread methods available are configured by your organization.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Adding contract labor
To add contract labor:

1. Navigate to the contract labor job code.

2. In the Current Rate column (column G), enter the hourly rate for the contract labor.

3. In the Start Rate column (column H), enter the starting rate.

4. In theMonth-Month Projected (FTEs) column (column M), enter the projected FTE value.

5. In theMonth-Year FTEs columns (columns S-AD), enter the FTE spread across months.

6. After making your changes, in the budget file Navigation panel, click Save Budget.
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� Adding a new pay type for a job code
To add a new pay type for a job code:

1. In the job code in which to add the new employee, double-click Double click to show details.

2. Double-click Double Click to Insert New Pay Type.

3. From the Insert Calc Method(s) in sheet Employee dialog, select one of the following calc
methods, and click OK:

NOTE: The dialog includes fields that are not enabled at this time.

l Add New AvgPer Paid Hr PayType - Calculates other non-FTE related pay based on the
relationship to paid hours in the job code block. Monthly spread will be based on the
spread of paid hours.

l Add New AvgPer Prod Hr PayType - Calculates other non-FTE related pay based on the
relationship to productive hours in the job code block. Monthly spread will be based on the
spread of productive hours.

l Add New Input Monthly PayType - Calculates other non-FTE related pay by typing in the
monthly totals.

4. Do the following based on the calc method you selected in step 3:
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Calc Method Steps

Add NewAvgPer
Paid Hr PayType

Add NewAvgPer
Prod Hr PayType

a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In the Start Rate column (column H), enter the hourly start
rate.

c. In theNotes column (column Q), enter comments, as needed.

d. Repeat steps a-c for each pay type to add.

e. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Add New Input
Monthly PayType

a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In themonthly budget (columns AT-BE), enter values for the
applicable months.

d. In theNotes column (column Q), enter comments, as needed.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

� Adding a new job code to a department

NOTE: If you accidentally add a duplicate job code, see the Removing duplicate job codes section
below for instructions on how to remove it.

To add a new job code to a department:
1. Navigate to the end of the job code listing, and double-click Double Click to Insert New Job Code.
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2. In the Calc Method Variables dialog, do the following, and then click OK:
a. In the Select a JobCode field, enter a job code or click Choose Value to select a job code.

b. In the Select a Dept field, enter a department or click Choose Value to select a department.

3. To enter adjustments to allocate NYB FTEs for salary calculations, click Double Click to Show
Details.

4. From the details section, do any of the following:
l Updating start rate and projected FTEs for program additions and position changes
l Updating the allocation rate for a job code pay type
l Updating the spread method for a job code pay type

5. When you finish making changes, in the budget file Navigation panel, click Save Budget.

� Removing duplicate job codes
If you add a duplicate job code and save the JobCode sheet, the system will display the duplicate in the
sheet. The duplicate does not save to the database, but to remove it from the sheet you will need to do
one of the following:

l Rebuild the plan file.
l Manually delete the job code from the sheet, and save your changes.

� Adding a new department pay type
To add a new department pay type:

1. Navigate to the bottom of the sheet, and double-click Double Click to Insert New Dept Pay Type.
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2. From the Insert Calc Method(s) in sheet Employee dialog, select one of the following calc
methods, and click OK:

NOTE: The dialog includes fields that are not enabled at this time.

l Dept_AvgPerProdHr - Calculates other Non-FTE related pay based on the relationship to
productive hours in the department. Monthly spread will be based on the spread of
productive hours.

l Dept_InputMonthly - Calculates other Non-FTE related pay by inputting monthly amounts
for the department.

l Dept_InputTotal - Calculates other Non-FTE related pay by typing in a total for the
department. Monthly spread will be spread evenly by month.

3. Do the following based on the calc method you selected in step 2:

Calc Method Steps

Dept_AvgPerProdHr a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In the Budget column (column H), enter the hourly start rate.

c. In theNotes column (column Q), enter comments, as needed.

d. Repeat steps a-c for each pay type to add.

e. When you finish making changes, in the budget file Navigation
panel, click Save Budget.
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Calc Method Steps

Dept_InputMonthly a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In theNotes column (column Q), enter comments, as needed.

d. In themonthly budget (columns AT-BE), enter values for the
applicable months.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Dept_InputTotal a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In the FY 20XX Budget (Dollars) column (column P), enter the
projected budgeted dollars.

d. In theNotes column (column Q), enter comments, as needed.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Employee sheet

� Overview
The Employee sheet is for departments to budget at the employee level, and operates similarly to the
JobCode sheet. No volume adjustments are included in the salary calculations. This sheet combines the
data from the Employee Listing and Employee sheets.
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This sheet is comprised of threemain areas:

Summary
This area displays at the top of the sheet and provides an overview of the FTE totals, target, and FTEs
from the budget target. It also shows you the paid hours and the productive percentage. This provides a
quick and easy way to ensure that your numbers are on track without having to dive into the details.
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Jobcode Statistics
This section displays all of the statistic values related to the job codes in the department, including the
following:

l Departmental paid totals
l Total float staff
l Total program additions
l Total position changes
l Total productive FTEs
l Total non-productive FTEs

Jobcode summary and details
Most of the sheet is comprised of the individual job code values. By default, the sheet displays only a
summary view that includes the total productive, non-productive FTEs as well as the total FTEs for the
job code.
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To view the job code details, double-click theDouble click to show details cell. From this expanded
section you can view specific details about the job code as well as a list of all the employees assigned the
job code.

Keep in mind the following:

l Non-FTE-related pay categories are added during the interface process within the job code block
and use a dollars-per-productive-hour or input monthly methodology.

l You can makemonthly adjustments to FTEs to model staging of staffing changes.
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l For contract labor, you must enter requests for contract labor FTEs. No default to YTD is made.

IMPORTANT: If you add a new calc method to a labor method sheet (such as adding new job code
pay type) and you do not include any calculated hours and dollars, then the calc method will not be
included the next time the budget plan file is rebuilt.

� Sheet columns
The following table provides descriptions for the columns in this sheet:

Column Name Column
Letter

Description

Job Code A The job code identification number number (using
Jobcode.KHABgtCode).

Employee ID F The identification number of the employee.

Current Rate G The hourly rate as of the start of the budget process.

Start Rate H The hourly rate as of the start of the new budget year.
This includes any salary increases expected to occur in
the remainder of the current year.

End Rate I The hourly rate as of the end of the budget process. This
includes all salary increases through the end of the
budget year. This is calculated using the last month of the
budget as this would contain the effective rate of all merit
& market adjustments.

Alloc Rate J Calculated based upon YTD actual % of total FTE. You can
make adjustments to allocate NYB FTEs for salary
calculations.

Sched K Scheduled FTEs from the labor master file or CYB FTEs
depending on the configuration option chosen in the
Budget Configuration Assumptions driver file.

YTD Actual L Year-to-date FTEs from the Payroll26 database.

Month-Month Projected
(FTEs)

M Projected FTEs for the remaining months of the current
fiscal year. Initial FTE allocation is the same as YTD.

FY20XX Budget (FTEs) N Starting point matches projected FTEs. You can make
monthly adjustments theMonth-Year FTEs columns
(columns S-AD).

Month-Month Projected
(Dollars)

O Projected dollars for the remaining months of the current
fiscal year.
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Column Name Column
Letter

Description

FY20XX Budget (Dollars) P Projected dollars for the budget year.

Notes Q Enter comments for the line item, as needed.

Spread Method R Select a spread method for the pay type, as needed.

Month-Year FTEs S-AD Enter a percentage of each FTE factor to the total factor.
For example, let's say that the FTE factor for month one is
177 divided by the FTE factor for the year of 2080 or 2086.
It usually ranges around 8% or so per month.

NOTE: Not all pay types allow you to update the spread
amount.

Month-Year Hours AG-AS Hours spread across months, including total budgeted
hours.

Month-Year Dollars AT-BF Dollars spread across months, including total budgeted
dollars.

Month-Year FICA BH-BT FICA spread across months, including total budged FICA.

Projected FICA BW Total projected FICA amount.

Month-Month Hours BX Total budgeted hours for the remaining months of the
fiscal year.

Month-Month Dollars BY Total budgeted dollars for the remaining months of the
fiscal year.

The following sections include instructions on performing specific actions in this sheet.

� Updating projected and budgeted FTE for an employee
To update projected and budgeted FTE for an employee:

1. Navigate to the job code assigned to the employee, and double-click Double click to show
details.
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2. In theMonth-Month Projected (column M) and FY 20XX Budget (column n) columns, update the
FTE values for the employee, as needed.

3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating projected FTEs for float staff/inactive employees, program additions, and
position changes
To update projected FTEs for float staff/inactive employees, program additions, and position
changes:

1. Navigate to the job code, and double-click Double click to show details.

2. In theMonth-Month Projected column (column M) for the Float Staff/Inactive Employees,
Program Additions, and Position Changes line items, as needed.

3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.
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� Updating the allocation rate for a job code pay type
To update the allocation rate for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. In the Alloc Rate column (column J), enter a percentage for each line item, as needed.

3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the spread method for a job code pay type
To update the spread method for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. From the Spread Method column (column R), select the spread method to use.
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3. In theMonth-Year FTEs columns (columns S-AD), make adjustments, as needed.

NOTE: The spread methods available are configured by your organization.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Adding a new employee
To add a new employee:

1. Navigate to the job code to add the new employee, double-click Double click to show details.

2. Double-click Double Click to Insert New Employee.
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3. Enter information in the following columns, as needed:
l Employee Name (column E)
l Employee ID (column F)
l Current Rate (column G)
l Start Rate (column H)
l Month-Month Projected (FTE) (column M)
l Notes (column Q)
l Month-Month FTE columns (columns S-AD)

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Adding contract labor
To add contract labor:

1. Navigate to the contract labor job code.

2. In the Current Rate column (column G), enter the hourly rate for the contract labor.

3. In the Start Rate column (column H), enter the starting rate.

4. In theMonth-Month Projected (FTEs) column (column M), enter the projected FTE value.

5. In theMonth-Year FTEs columns (columns S-AD), enter the FTE spread across months.
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6. After making your changes, in the budget file Navigation panel, click Save Budget.

� Adding a new pay type for a job code
To add a new pay type for a job code:

1. In the job code in which to add the new employee, double-click Double click to show details.

2. Double-click Double Click to Insert New Pay Type.

3. From the Insert Calc Method(s) in sheet Employee dialog, select one of the following calc
methods, and click OK:

l Add New AvgPer Paid Hr PayType - Calculates other non-FTE related pay based on the
relationship to paid hours in the job code block. Monthly spread will be based on the
spread of paid hours.

l Add New AvgPer Prod Hr PayType - Calculates other non-FTE related pay based on the
relationship to productive hours in the job code block. Monthly spread will be based on the
spread of productive hours.

l Add New Input Monthly PayType - Calculates other non-FTE related pay by typing in the
monthly totals.

4. Do the following based on the calc method you selected in step 3:
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Calc Method Steps

Add NewAvgPer
Paid Hr PayType

Add NewAvgPer
Prod Hr PayType

a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In the Start Rate column (column H), enter the hourly start
rate.

c. In theNotes column (column Q), enter comments, as needed.

d. Repeat steps a-c for each pay type to add.

e. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Add New Input
Monthly PayType

a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In theNotes column (column Q), enter comments, as needed.

d. In themonthly budget (columns AT-BE), enter values for the
applicable months.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

� Adding a new job code to a department
To add a new job code to a department:

1. Navigate to the end of the job code listing, and double-click Double Click to Insert New Job Code.

2. In the Calc Method Variables dialog, enter a job code or click Choose Value to select a job code,
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and then click OK.

3. To enter adjustments to allocate NYB FTEs for salary calculations, click Double Click to Show
Details.

4. From the details section, do any of the following:
l Add a new pay type for a job code
l Update the spread method for a job code pay type
l Update the allocation rate for a job code pay type
l Update projected FTEs for float staff/inactive employees, program additions, and position

change
l Add a new employee
l Update projected and budgeted FTE for an employee

5. When you finish making changes, in the budget file Navigation panel, click Save Budget.

� Adding a new department pay type
To add a new department pay type:

1. Navigate to the bottom of the sheet, and double-click Double Click to Insert New Dept Pay Type.

2. From the Insert Calc Method(s) in sheet Employee dialog, select one of the following calc
methods, and click OK:
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NOTE: The dialog includes fields that are not enabled at this time.

l Dept_AvgPerProdHr - Calculates other Non-FTE related pay based on the relationship to
productive hours in the department. Monthly spread will be based on the spread of
productive hours.

l Dept_InputMonthly - Calculates other Non-FTE related pay by inputting monthly amounts
for the department.

l Dept_InputTotal - Calculates other Non-FTE related pay by typing in a total for the
department. Monthly spread will be spread evenly by month.

3. Do the following based on the calc method you selected in step 2:

Calc Method Steps

Dept_AvgPerProdHr a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In the Budget column (column H), enter the hourly start rate.

c. In theNotes column (column Q), enter comments, as needed.

d. Repeat steps a-c for each pay type to add.

e. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Dept_InputMonthly a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In theNotes column (column Q), enter comments, as needed.

d. In themonthly budget (columns AT-BE), enter values for the
applicable months.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.
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Calc Method Steps

Dept_InputTotal a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In the FY 20XX Budget (Dollars) column (column P), enter the
projected budgeted dollars.

d. In theNotes column (column Q), enter comments, as needed.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Staffing sheet

� Overview
This sheet allows 24/7 departments to prepare the budget by shift/day of the week, such as a nursing
department, cafeteria, lab, or security. This sheet is comprised of threemain areas:

Staffing Summary
This area displays at the top of the sheet and provides an overview of the total hours for productive and
target, the FTEs from target, the paid hours per unit, and the productive percentage. It also shows the
trending of FTEs over timewith LYA, YTD, and budgeted. This provides a quick and easy way to ensure
that your numbers are on track without having to dive into the details.

Department Statistics
The first line item in the sheet displays the primary department statistics, which include LYA, YTD, and
budgeted hours as well as the total department hours and dollars over months.
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Jobcode summary and details
Most of the sheet is comprised of the individual job code values. By default, the sheet displays only a
summary view that includes the shift FTE values, budgeted hours, pay type information, and the
breakdown of hours and dollars by month. To view the job code details, double-click theDouble click to
show details cell.

Instead of calculating values monthly, the Staffing sheet allows you to budget hours on a weekly basis
using the shift grid. This forms the core component of the calculations performed on this sheet. The
totals weekly hours are then translated into monthly values in terms of hours. As you move to the right,
you can view the spread of the hours and dollars.

While the Employee and Jobcode labor methods allow you to change FTEs on a monthly basis, you do
not have this ability using the Staffing labor method, though a lot of the logic is still the same in that you
still use budget to YTD or a target.
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� Sheet columns
The following table provides descriptions for the columns in this sheet:

Column Name Column
Letter

Description

LYA N Values from Last Year Actuals

YTD O Values for Year To Date

Month-Month P Values for themonths for Remaining Projection

NYB Q Values for the annual New Years Budget

Job Code AA The identification number associated with the job code
(using Jobcode.KHABgtCode)

Pay Type AB The pay type associated with the job code (using
Paytype.Staffing)

Pay Type Description AC A description of the pay type

Current Rate AD The current pay rate for the pay type

Begin Rate AE The beginning pay rate for the pay type

Year End Rate AF The pay rate for the pay type at the end of the year

Month-Year Hours AG-AR Total hours for each month of the year

Total Hours AS The sum of the total hours

Month-Year Dollars AT-BE Total dollars for each month of the year

Total Dollars BF The sum of the total dollars

� Updating the number of days to staff in a week
To update the number of days to staff in a week:

1. In theDays Staffed/Week field, type the number of days to staff in a week.

l Selecting 7will allocate FTEs in the grid to all seven days of the week.

l Selecting 5will allocate FTEs in the grid to only Mon-Fri columns.

2. After making your changes, in the budget file Navigation panel, click Save Budget.
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� Updating the shift FTE hours for a job code
The shift grid provides a visual representation of a full 24-hour clock. You can enter all your FTEs in a
specific row or you can split them up by time of day. While most organizations simply enter all their
hours in the Day part of the grid, you may want to enter hours in another part of the day if there is a
premium pay rate for those FTEs in the budget.

To update the shift FTE values for a job code:
1. Navigate to the job code, and double-click Double click to show details.

2. In the job code title row, from the drop-down, select the shift to assign to the job code.

3. Next to the shift drop-down, from the Fixed/Variable drop-down, select one of the following:

NOTE: In most cases, you will not need to change this unless an exception needs to bemade
to this job code.

l Fixed - The input is the Total Paid FTEs per a normal work week. Non-productive hours are
allocated based on the allocation percentage.

l Variable - The input is theWorked FTEs per a normal work week. Non-productive hours are
added based upon grossing up to total hours then subtracting productive hours.

l Fixed w/ Replacement - Similar to fixed, the input is the Total Paid FTEs per a normal work
week. Non-productive hours are added based upon grossing up to total hours then
subtracting productive hours.
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4. In the shift grid, enter the FTE hours for each day of the work week.

5. After you make your changes, in the budget file Navigation panel, click Save Budget.

� Updating the allocation rate for a job code pay type
To update the allocation rate for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. In the Allocation % column (column R), enter the allocation percentage for each pay type, as
needed.

3. After you finish making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the pay type values for a job code
To update the pay type values for a job code:

1. Navigate to the job code, and double-click Double click to show details.
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2. In theMonth-Month column (column P) and NYB column (column Q), enter dollar amounts in the
blue fields for each applicable pay type.

3. After you finish making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the monthly spread
To update the monthly spread:

1. Navigate to the job code, and double-click Double click to show details.

2. In theMonthly Spread column (column V), select one of the following:

NOTE: The choices in the drop-down depend on the pay type.

l FTEAlloc - Percentage of each FTE factor to the total factor. For example, let's say that the
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FTE factor for month one is 177 divided by the FTE factor for the year of 2080 or 2086. It
usually ranges around 8% or so per month.

l Global - Define your own percentage. For example, you may want to use this for a special
project where you know there will be a higher use of overtime over the next threemonths
for this project. You can use this option to reflect this in your budget.

l History - Percentage determined over a rolling 12months (i.e. Percentage ofmonth one to
total, month two to total, etc.)

l Prod Hours - Percentage based on productive hours per month to total.
l Paid Hours - Percentage based on the paid hours per month to total.
l Even - Spread evenly across each month.

3. After you finish making your changes, in the budget file Navigation panel, click Save Budget.

� Adding contract labor
To add contract labor:

1. Navigate to the contract labor job code.

2. In theMonth-Month column (column O), type the total hours for themonths.

3. In theNYB column (column P), type the total hours for the next year's budget.

4. In theHrly Rate cells (column Y and Z), type the hourly rate for current year and for next year's
budget.

5. After you finish making your changes, in the budget file Navigation panel, click Save Budget.

� Adding a new job code
To add a new job code:

1. Navigate to the bottom of the job code list, and double-click Double Click to Insert New Job
Code.

2. In the Select Job Code field, type a job code or click Choose Value to select one, and click OK.

3. Do the following:
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l Update the shift values
l Update the allocation rate
l Update the pay type values for non FTE, if needed
l Wage rate for Regular pay for the new job code can be pre-populated if the “Mid” wage rate

from the Labor Rates driver is filled out. Otherwise, a rate can bemanually entered in the
“Current Rate” column (note blue cell for Regular in the image below).

l You can also enter the starting month of the added FTE (if parital year) in the “Start” and
“End” section (note blue cells below for “Start” and “End”).

4. After you finish making changes, in the budget file Navigation panel, click Save Budget.

� Adding a new department pay type
To add a new department pay type:

1. Navigate to the bottom of the job code list, and double-click Double Click to Insert New Dept Pay
Type.

2. In the Insert Calc Method(s) in sheet Staffing dialog, click OK.

3. In the Select Pay Type field, type a pay type or click Choose Value to select one, and click OK.

4. In theMonth-Month Dollars column (column P), enter the dollars for the pay type.

5. After you finish making your changes, in the budget file Navigation panel, click Save Budget.

Labor Standard by ADC Setup sheet

� Overview
This sheet is designed for nursing departments to prepare an Average Daily Census (ADC) budget and
staffing levels by job class. The ADC worksheet models nursing staffing ratios by ADC level by job class
level.

IMPORTANT: All positions have to be budgeted in this sheet if you are going to use this labor
method.

The sheet is comprised of threemain areas:
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ADC Table
The ADC Table allows you to set the staffing ratio for a job class. You can configure up to 15 job classes.
The staffing ratio determines the number of staff needed per patient. For example, if the RN staffing ratio
is 5:1, then for census levels 1-5, one nurse would be required. At census levels 6-10, two nurses would be
required.

NOTE: The Fixed/Variable settings and the ratio values may be configured for the department using
the Budget Labor ADC Config driver. The system applies the setup from this driver to the ADC sheet
(starting in column W) in the plan file. The ADC staffing grid builds out based on the staffing ratios
entered for each job class set up in the Budget Assumptions driver.

Calculated Staffing Grid
The staffing grid is used to calculate job class specific budget FTEs. There is a section for each job class
that displays the results of these calculations (starting in column F). All calculations are then transferred
to the JobCode tab and allocated to each job code based on relative historical FTEs within each job class.
There is a row for non-productive time for each job class, which defaults to values based off of the history
for each job class, but you can change them, if desired. The productive and non-productive hours are
transferred to the JobCode sheet and distributed to each job code using the YTD historical distribution.
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Summary
The Summary section at the top of the ADC sheet that shows the following:

l The Patient Days for projection and for each budget month. Average Daily Cencus (ADC) values are
also presented.

l FTE information for the department by productive and non-productive.
l FTE differences between the JobCode tab and ADC tab for the department.
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NOTE: You can only use this feature with the JobCode tab. It is not configured to work with the
Staffing or Employee tabs. If the historical hours are zero for the defined JobClass, then JobClass will
not populate a section or the section title will remain unused.

The following sections include instructions on performing specific actions in this sheet.

� Setting the staffing ratio/paid FTEs for a job class
Setting the staffing ratio/paid FTEs for a job class:

1. Navigate to the ADC Table section of the sheet (starting at column W).

NOTE: If your organization has already added these values from the Budget Assumptions
driver, then you may not need to modify. Your system administrator will provide direction, as
needed.

2. In the Fixed/Variable row, select one of the following from the drop-downs:
l Fixed - The input is the Total Paid FTEs. Non-productive hours are allocated based on the

allocation percentage. This means that no matter howmany Average Daily Census days are
calculated in the Summary section, the number of employees will always remain fixed to
the number you enter in the Jobclass row (step 3 below).

l Variable - The input is the Staffing Ratio. Non-productive hours are added to productive
based upon the allocation percentage. This means that the number of people in this job
class will fluctuate based on the Average Daily Census days, so themore ADC days themore
employees are required.

l Fixed w/ Replacement - Similar to fixed, the input is the Total Paid FTEs. Non-productive
hours are added to the total based on the allocation percentage. The difference is that the
number of employees can be split across job codes in a job class.

3. In the Jobclass row, complete the following, depending on the staffing ratio type you selected in
step 2:

l Fixed - Type the true number of FTEs required. In the following example, four LPN FTEs are
required - regardless of patient census.

Setup Guide Axiom Budget Planning │ 298



l Variable - Type the number of patients the FTE can care for. In the following example, one
RN FTE can care for up to six patients. If more than one RN job code exists on the Jobcode
tab, the FTE value will be allocated to each occurrence of an RN job code

l Fixed w/ Replacement - Type the true number of FTEs required - regardless of patient
census. In the following example, only one clerical job class is required for each patient, but
those hours can be split among multiple job codes in the clerical job class.

4. To update the budgeted non-productive percentage for a job class, navigate to a job class, and in
the Budget Non Prod % row, enter the percentage value for each month, as needed.

NOTE: Using Jobcode ADC will require that you use the payroll utility that accrues biweekly to
monthly so that the historical productive and non productive hours can be used in the plan
file for JobcodeADC.

5. After making your changes, in the budget file Navigation panel, click Save Budget.
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6. Review the Jobclass data on the ADC grid. This will present several data points such as productive
and non productive FTE and hours that will be transferred to the Jobcode tab.

In the following example for the RN jobclass, 20.36 total budget FTEs were calculated from the ADC
staffing grid. The FTEs may vary month to month as shown below. Each month’s FTEs will be
transferred to the Jobcode tab.
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ProviderComp sheet

NOTE: This sheet displays only if your organization has purchased the Provider module.

The ProviderComp sheet displays the selected calc methods for provider compensation, which you can
change in the Budget Provider Assumptions driver (if you have Administrator role privileges).

NOTE: Provider Volume data carries over from the Provider Summary or Provider Detail sheet.

You can automatically change compensation models at a set point during the budget year. To
accomplish this, designate the Primary and Secondary Comp Models for each provider in the Budget
Provider Assumptions plan file, along with the Comp Model Changemonth. To keep the same Comp
Model throughout the year, select the same Comp Model for both the primary and secondary options.
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IMPORTANT: Any changes made to the provider's FTE value on this tab will affect the values for that
provider in the Provider Detail tab. For instructions, see Updating detail provider values from the
Stat_Rev tab.

Expense sheet

� Overview
The Expense sheet is where you review and adjust the current year projection and next year’s budget for
Expenses and Paid Hours. The Expense tab also captures data calculated on other budget tabs for paid
hours, salaries, and detail accounts.

The categories include:

l Salaries – All salary and contract labor accounts (Acct.BudgetType=’Salaries’). Most salary
calculations are done on the Labor tabs – JobCode, Staffing, or Employee. The Labor Calc Method
is used to summarize the salary dollars from the defined labor tab (JobCode, Staffing, Employee,
JobCode ADC).

l Benefits – All benefit accounts, if accounted for at the department level
(Acct.BudgetType=’Benefits’). FICA is calculated at the JobCode level on the Labor tabs.
If FICA is not budgeted at the department level, there is the option to use theMonthly FICA by
Dept report to summarize total FICA and add it to the Benefits department budget plan file.

l Supplies – All medical and other supply expense accounts (Acct.BudgetType=’Supplies’). Usually
budgeted on a rate-per-unit basis using the Variable calc method.
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l Other Expenses – All other expenses, excluding Bad Debt (Acct.BudgetType=’OtherExp’). Calc
methods are usually Fixed, Detail, Depreciation, or GlobalExpense.

l Paid Hours – All labor and contract labor hours accounts (Acct.BudgetType=’PaidHours’). Inputs
for hours are done on the Labor tabs – JobCode, Staffing or Employee. The Hours calc method is
used to summarize the paid hours.

NOTE: Be sure to provide comments in any comment field flagged red.

� Drilling to detail
You can drill from an account on the Expense tab (this tab only) to GL Transactions detail. To activate this
feature, open the Budget Configuration driver. In the Expense Transaction Drilling, On or Off row,
select Yes or No to turn on the drill. This is not budget group-specific so the election is for all plan files.

From the Expense tab, select the account desired, and drill on it from the year-to-date column. There are
three ways to drill on the account:

l On theMain ribbon tab, select Drill > JE Detail.
l From value on the Expense tab, right-click the year-to-date value, and select Drill > JE Drill.
l Double-click the selected row.
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To close the drill to detail report, double-click Return to Report or close the drill report tab.

� Adjusting supply percentage and amount for Next Year Budget
To adjust supply percentage and amount:

1. Navigate to the Supply section of the sheet.

2. In the supply line item, do any of the following to adjust for NYB:
l In the% Adjust column (column O), type the percentage amount.
l In the Amt Adjust column (column O), type the dollar amount.

3. After you finish making your changes, in theMain ribbon tab, click Save.

� Inserting a new expense line item
You can add new expense line items to individual sections, including:

l Salaries
l Benefits
l Supplies
l Other expenses
l Paid hours

The system adds the line by inserting the appropriate calc method into the sheet. The following table lists
the available calc methods used by the corresponding section in the sheet:
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Calc Method Description Sheet Section

Add Detail - Input
Monthly

Use this to insert a row to populate an
individual month.

Other Expenses

Add Detail - Input Total Use this to insert a row to enter an annual
amount, and then decide how to spread it.

Other Expenses

Add NewDetail Zero-based expense calculations. Inputs are
done on the Detail sheet in the budget plan
file.

l Benefits
l Supplies
l Other Expenses

Add NewHours Use this new labor calc method to add a new
hours account to the Expense sheet.

Paid Hours

Add New Input
Monthly

Month-by-month input. Use this calc method
only when adding a new account.

l Salaries
l Benefits
l Supplies
l Other Expenses
l Paid Hours

Add New Labor Use this new labor calc method to add a new
labor account to the Expense sheet.

Salaries

Add NewVariable Calculates based on the relationship to key
statistics. As there is no history when
inserting as new, use the Amt Adjust (column
P) to enter a value. If a projection value is
desired, enter a value in Manager Input
(Column J).

l Salaries
l Benefits
l Supplies
l Other Expenses
l Paid Hours

Fixed Use this fixed methodology and select how
you want to spread.

l Salaries
l Benefits
l Supplies
l Other Expenses
l Paid Hours

PctOfSalaries_FixedPct Calculates a designated fixed percent from
Budget Expense Adjustment Driver file,
Budget Expense Assumptions, based on the
relationship to salaries. Monthly spread will
be based on the spread of salaries.

Benefits

RatePerFTE_Fixed Allows you to define the fixed dollar amount
per FTE in Budget Expense Adjustment Driver
file to apply globally to benefit accounts.

Benefits
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To insert a new expense line item:
1. Navigate to the section to add the new line item.

2. Double-click theDouble Click to Insert... cell.

3. In the Insert Calc Method(s) in sheet Expense dialog, select the calc method to insert, and click
OK.

NOTE: If the line only uses or your organization is only licensed for one type of calc method,
this dialog will not display. The system will open the Calc Methods Variable dialog instead.

4. In the Calc Methods Variable dialog, enter or select the account and department number, and
click OK.

5. Enter the appropriate values in the blue cells, as needed.

6. After making your changes, in theMain ribbon tab, click Save.

Provider Detail and Provider Summary sheets
NOTE: This tab only displays if your organization purchased the Provider module license.

There are two sheets available that include provider level information: Provider Summary and Provider
Detail.

Provider statistics are computed using historical relationships. Provider volumes are computed using
today’s Encounters per Production Day and adjusted for next year’s Available Production Days.

IMPORTANT: Because the tab is rebuildable, any changes made in the Provider data tables after the
plan file is built will be automatically updated in the plan file. These changes are commonly referred
to as prior period adjustments, which will be reflected in the YTD columns in the tab.

To view a list of Provider calc methods, click one of the following:

l Expense sheet calc methods
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l Provider sheet calc methods
l Stat_Rev sheet calc methods

� Provider Summary sheets
This sheet provides a summary of the totals at the department and individual provider level.

� Provider Detail sheet
This sheet shows summary subtotal information for each provider, but you can also access the details for
each provider by using the Click-to-Expand feature.
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The Click-to-Expand feature expands the rows and inserts the calc method that includes the provider
detail information such as WRVUs, gross charges, RVUs, encounters, and so on. You can simply scan and
review the summary information for each provider without having to sort through multiple lines of
details to view the information you need, and if necessary, expand the details and manage only those
providers that need it.

TIP: When you save the file, the system will remember which providers you have expanded the detail
rows for that day. Let's say you expanded the detail rows for five providers and saved your changes,
when you open the file later, the detail lines will still display for those five providers. When the plan
file processes that evening, however, the system will collapse all of the detail rows so that the tab
opens faster.

IMPORTANT: The Summary Department Totals section at the top of the tab will not update values
until you save changes to the workbook.
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� Updating detail provider values from the Stat_Rev tab
Any changes made to the provider's FTE value on the ProviderComp sheet will affect the values for that
provider in the Provider Detail sheet. To see that result within your session, double-click theDouble click
to collapse/refresh Provider summaries cell to refresh the data; otherwise, the nightly recalculation
process will update it automatically.

New Initiatives sheet

� Overview
This sheet allows you to budget for new projects that are outside of your organization or department's
normal operations. The budgets for each new initiative save to unique Initiative IDs so that you can
analyze the new initiative budget separately from the ongoing operating budget. For each project to
budget, use the Initiatives tab to enter the project's monthly budget values. There is also a comments
section.

To create an initiative, double-click Double Click to Insert New Initiative. The Insert Calc-Method(s) in
sheet Initiatives dialog displays.

You can create one of two types of initiatives: department or system.

� Adding a department initiative
A department initiative is a project that applies only to a single department.
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To add a department initiative:
1. Double-click Add Department Initiative to create an outline for adding detailed information for

department-wide initiatives.

2. In the Insert Description Here cell, enter information to describe your initiative.

3. At the top of the screen, from the drop-down, select one of the following:
l To include the initiative for the next year budget amounts in the database, select Approve.
l To exclude the initiative from the next year budget amounts in the database, select Exclude

4. Update the blue cells with the budget data for the initiative, as needed. You can also add rows for
new items related to the initiative by double-clicking the appropriate row.

5. After you finish making changes, in theMain ribbon tab, click Save.

� Adding a system initiative
A system initiative is a project that applies to multiple departments in your organization.

To add a system initiative:
1. Double-click Add Project Initiative for a single project.
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2. In the Calc Method Variables dialog, click Choose Value.

3. In the Choose Value dialog, select the project, and click OK.

4. In the Calc Method Variables dialog, click OK.

5. The project list is created by you. Each project is pre-defined to Approve or Exclude.
l Approve saves data related to an initiative to the Financial data source for each department

with a budget for the initiative. Approved initiatives would subsequently be included in any
Budget Income Statement reports.

l Exclude saves the data from New Initiatives to the NYBDetail data source. Excluded
initiatives will not be included in any Budget Income Statement reports, but separate New
Initiatives reports can be run to summarize the totals for each initiative.

6. In theMain ribbon tab, click Refresh Data to populate the initiative with data.

NOTE: This assumes that your Axiom Budgeting administrator has instituted the New
Initiatives utility.

7. Update the blue cells with the budget data for the initiative, as needed. You can also add rows for
new items related to the initiative by double-clicking the appropriate row.

8. After you finish making changes, in theMain ribbon tab, click Save.
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Operating Plan sheet

� Overview
This sheet helps you clarify strategic budget objectives beforemaking updates to a budget. It presents a
questionnaire that lists the department's objectives and describe how any changes to the budget will
support each objective. For example, you can use this for a SWAT analysis approach or whatever is most
meaningful to your organization. The purpose of the planning questions is to capture higher level, salient
points within the plan file to facilitate a discussion with the budget stakeholders such as department
directors or vice presidents. You can review the questions with others by opening the plan file directly or
running the Budget Plan Questions report.

NOTE: The questions that display are determined and set up by your organization. If you have
Administrator privileges, you can add or edit them in the Budget Assumptions driver, as needed.
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� Completing plan questions
To complete plan questions:

1. In this tab, do any of the following:
l Answer the questions by entering content in as many rows as needed.

NOTE: The content in the rows do not wrap, meaning that once you get to the end of
the row, you need to continue entering content in the next row.

l To add a line, double-click Double Click to Insert New Planning Lines.

2. After you finish making changes, in theMain ribbon tab, click Save.

Department History sheet

� Overview
This sheet is a report that allows you to reference the historical spending trends for up to the last 18
months. This report is useful to keep open as you work on your budget. The reports is segmented into
the following areas for statistics, revenue, expenses, and hours:

l Last Year Actual - Includes values posted for over the last year.
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l Current Year Actual - Includes values posted for YTD.
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l Department History used for Monthly Spreads - Includes a combination of YTD values plus the
actuals from the previous year to form a full 12months of data. In the following example, the
actuals are posted through February 2019. In theMonthly Spreads section, the actuals are copied
from July through February. But, for themissing months that have no actuals yet, the system
copies the data from Last Year Actual and enters them for themissing months. In this example,
theMarch through June actuals are copied from the samemonths in the Last Year Actual section.

TIP: Before you begin entering budget values, look for anomalies or holes in the Last Year
Actual and Current Year Actual values that do not make sense or cannot be explained -
especially if you intend to use this section. Make sure to resolve any data issues before you
start creating a new budget for the next budget year or select an alternate spread option.

The system uses this combination of actuals and historical values to determine how to spread
budgeted expenses across an account. So, if a department spends moremoney at the beginning
of a fiscal year and adds a $10,000 expense to the budget, the system will automatically apply
more of that expense to the beginning of the year than at the end.

TIP: The same historical information is also available in the Expense sheet at the expense line
level. For more information, see Viewing historical values for expenses.

Viewing and managing file attachments for a plan file

� Overview
In a budget plan file, you can attach supporting files to help support your budgeting process. For
example, you may want to attach various supporting information about the spending requests or capital
projects, and have that information easily reviewable along with the plan file itself.
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If you have read/write access to a plan file, then you can add and delete attachments as well as view
attachments. If you have read-only access to a plan file, then you can only view existing attachments.

� Managing file attachments
Using theManage Attachments dialog, you can add, delete, and view attachments for a plan file.

l Adding a file attachment: Click Upload Attachment, and then navigate to the file that you want
to add as an attachment. The file will be imported into the Axiom Budget Planning database and
associated with the plan file.

l Deleting a file attachment: Select the file, and then click Delete. The file is deleted from the Axiom
Budget Planning database and will no longer be available as an attachment.

l Renaming a file attachment: To rename a file attachment, right-click the attachment and then
click Rename. The name becomes editable and you can type your changes.

l Editing the attachment description: To define or edit the description for the file attachment,
select the file and then click Edit Description.

l Opening a file attachment: Select the file, and then click Open (or you can double-click the file).

If the attachment is an Excel-compatible file that opens within the Axiom Budget Planning session, it will
open with read/write access. You can edit the file and save changes if desired.

If the attachment is a Word file or a PowerPoint file, then it opens in its native program with read/write
access if the corresponding Axiom Budget Planning add-in is already installed (or if it is successfully
installed when the file is opened). You can edit the file and save changes by using the add-in.

If theWord or PowerPoint add-in is not installed, or if the file is some other file type, then you cannot
edit and save the file directly. If you need to edit one of these files, you should save a copy of the file
locally and make your edits. You can then delete the existing file attachment in the Axiom Budget
Planning database, and upload your edited copy.

Saving budget plan files
Data resides in the budget plan file, which is not written back to the Axiom database until you save the
budget. When saving a budget, Axiom Budgeting verifies and validates the spreadsheet, saves the file,
and saves the information to the Axiom database.

Depending on how your system is configured, the system may require you to enter comments when a
line item exceeds a defined threshold in the Stat_Rev and Expense tabs before saving the plan file. A
message will display above the Comments column header, informing you of the number of variances to
address. A red flag icon displays in the Red Flag column. After you enter variance comments, you can
save the plan file.
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The order of saving budget plan files is left to right. This means that if required variances are needed, the
notification on save displays first on the Stat_Rev tab. After all Stat_Rev required variances aremet, the
user saves again. If required variances also exist on the Expense tab, another save notification prompts
the user for comments on the Expense tab.

To save a budget plan file
In the Navigation panel, double-click Save Budget - Advance when complete.

NOTE: You can use the Save button in the ribbon tab, but when you close the budget plan file, the
system may prompt you to save again.

If your organization uses Axiom process management, then the system displays a message asking if you
want to advance the plan file for review and approval process.

Calc methods

� Employee sheet
For instructions on using this sheet, click here.

Calc Method Type Description

JobCode Interface Sets up initial JobCode block on the Employee tab during the interface
process. Do no use when adding blocks to the JobCode tab.

AvgPerPaidHr Interface Calculates other Non-FTE related pay based on the relationship to
paid hours in the JobCode block. Monthly spread will be based on the
spread of paid hours.

AvgPerProdHr Interface Calculates other Non-FTE related pay based on the relationship to
productive hours in the JobCode block. Monthly spread will be based
on the spread of productive hours.

Setup Guide Axiom Budget Planning │ 317



Calc Method Type Description

Dept_
AvgPerProdHr

Interface Calculates other Non-FTE related pay based on the relationship to
productive hours in the department. Monthly spread will be based on
the spread of productive hours. Only use this calc method to budget
labor dollars at a department level and not a JobCode level.

Dept_
InputMonthly

Interface Calculates other Non-FTE related pay by inputting monthly amounts
for the department. Only use this calc method to budget labor dollars
at a department level and not a JobCode level.

Dept_
InputTotal

Interface Calculates other Non-FTE related pay by typing in a total for the
department. Monthly spread will be spread evenly by month. Only
use this calc method to budget labor dollars at a department level and
not a JobCode level.

Employee Interface Inserts a new employee into a JobCode block. You can input FTEs and
hourly rate. The default hourly rate comes from Mid Rate column in
the Budget Labor Limits driverBudget Labor Limits driver.

Holiday Interface Calculate salary dollars based on YTD holiday pay and spreads by the
listed holiday months in the Budget Labor Configuration driverBudget
Labor Configuration driver.

Input_
Monthly

Interface Calculates other Non-FTE related pay by typing in themonthly totals.
Add New JobCode 22 Lines New Sets up a new JobCode block on the
Employee tab. This calc method allows you to enter FTEs and hourly
rate for each labor category.

The default value for Input_Monthly is the current year projected.

Add New
AvgPer Paid
Hr PayType

New Calculates other Non-FTE related pay based on the relationship to
paid hours in the JobCode block. Monthly spread will be based on the
spread of paid hours. This calc method is only used when adding a
new pay type.

Add New
AvgPer Prod
Hr PayType

New Calculates other Non-FTE related pay based on the relationship to
productive hours in the JobCode block. Monthly spread will be based
on the spread of productive hours. This calc method is only used
when adding a new pay type.

Add New
Input
Monthly
PayType

New Calculates other Non-FTE related pay by typing in themonthly totals.
This calc method is only used when adding a new paytype.

� Expense sheet
For instructions on using this sheet, click here.
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Calc Method Type Description

Depreciation Interface Pushes depreciation calculations to the budget plan
file from List Driver file, Budget Expense
Assumptions. The end-user cannot change the totals
or the spread in the budget plan files. Only users
with administrative rights can update the
calculations.

Detail Interface Zero-based expense calculations. Inputs are done on
the Expense tab in the budget plan file.

Detail_CYB_History Interface This calc method is not selectable. If you have
selected the option to bring the current year
budgeted detail (budgeted last year) into accounts
using the "Detail" calc method, the system uses
Detail_CYB_History to hold those interfaced lines
from the current year budget.

FICA Interface Transfers FICA expense from the designated labor
tab (JobCode, Staffing, Employee, Provider) to the
Expense tab.

Fixed_Days Interface Allows changes to the projected year as well as
budget. This calc method uses calendar days as its
default spread option. Users choose themonthly
spread from the drop-down.

Fixed_Even Interface Allows changes to the projected year as well as
budget. This calc method uses an even monthly
spread as its default spread option. Users choose the
monthly spread from the drop-down.

Fixed_History Interface Allows changes to the projected year as well as
budget. This calc method uses history as its default
spread option. Users choose themonthly spread
from the drop-down.

Fixed_Stats Interface Interface Allows changes to the projected year as
well as budget. This calc method uses the key
statistic monthly spread as its default spread option.
Users choose themonthly spread from the drop-
down.

Fixed_WorkDays Interface Allows changes to the projected year as well as
budget. This calc method uses worked days as its
default spread option. Users choose themonthly
spread from the drop-down.
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Calc Method Type Description

GlobalAmt Interface Pushes expense calculations to the budget plan file
from List Driver file, Budget Expense Assumptions.
An end-user cannot change the totals or the spread
in the Budget Plan files. Only users with
administrative rights can update the calculations.

GlobalExpense Interface Pushes expense calculations to the budget plan file
from List Driver file, Budget Expense Assumptions.
An end-user cannot change the totals or the spread
in the Budget Plan files. Only users with
administrative rights can update the calculations.

Hours Interface Transfers hours from the designated labor tab
(JobCode, Staffing, Employee, Provider) to the
expense tab.

InputMonthly Interface Month-by-month input.

Labor Interface Transfers salary dollars from the designated labor
tab (JobCode, Staffing, Employee, Provider) to the
Expense tab.

NoBudget Interface Brings in historical values into the budget plan file,
but the budget for next year will be zero, and cannot
be changed.

GlobalData Interface This calc method allows the administrator to create
configurable budget relationships for calculating NYB
amounts for the Expense tab only. The GlobalData
calc method is similar to GlobalExpense but allows
you to use up to four configurable tabs in Global
Data Assumptions. Has to be setup in the Global
Data Assumptions Driver file.

PctofGrossRevenue Interface Uses the historical percentage of the account to
gross revenue from the Stat_Rev tab.

PctofSalaries_Rolling12 Interface Calculates based on the relationship to salaries using
Rolling12 instead of YTD. Monthly spread will be
based on the spread of salaries.

PctofNetRevenue Interface Calculates based on the relationship to net revenue.
Monthly spread will be based on the spread of net
revenue.
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Calc Method Type Description

GlobalSum Interface This calc method allows you to budget for an
account at a percentage of the total of specific other
account(s) on the Stat_Rev tab within the same plan
file.

PctofSalaries Interface Calculates based on the relationship to salaries.
Monthly spread will be based on the spread of
salaries.

PctofSalaries _FixedPct Interface Calculates a designated fixed percent from List Driver
file, Budget Expense Assumptions, based on the
relationship to salaries. Monthly spread will be
based on the spread of salaries.

RatePerFTE Interface Calculates based on the relationship to FTEs.
Monthly spread will be based on the spread of FTEs.

RatePerFTE_Fixed Interface Allows you to define the fixed dollar amount in List
Driver file, Budget Expense Assumptions.per FTE to
apply globally to benefit accounts.

Variable Interface Calculates based on the relationship to key statistics.
A dollars-per-key statistic rate is calculated based on
YTD history, and is used to calculate the projection
and budget.

Variable_Stat Interface Calculates based on the relationship to a user-
chosen statistic that is listed on the Stat_Rev tab. A
dollars-per-key statistic rate is calculated based on
YTD history, and is used to calculate the projection
and budget.

Add NewDetail New Zero-based expense calculations. Inputs are done on
the Detail sheet in the budget plan file.

Add New Fixed New Allows changes to the projected year as well as
budget. Monthly spread is chosen by the user from
a drop down box selection. Choose the spread
methodology from the drop-down. This Calc
Method is only used when adding a new account.

Add New Input Monthly New Month-by-month input. Use this calc method only
when adding a new account.
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Calc Method Type Description

Add NewVariable New Calculates based on the relationship to key statistics.
A dollars-per-key statistic rate is calculated based on
YTD history, and is used to calculate the projection
and budget. This calc method is only used when
adding a new account.

Add New Labor New Use this new labor calc method to add a new labor
account to the Expense sheet.

Add NewHours New Use this new labor calc method to add a new hours
account to the Expense sheet.

Provider Version Only
If your organization purchased the Provider module license, you have access to the following additional
calc methods:

Calc Method Type Description

ProviderComp Interface Transfers Salary calculations from the
ProviderComp sheet to the Expense sheet to save in
the Financial Data Tables.

ProviderLaborComp Interface Transfers Salary calculations from the
ProviderComp and designated labor sheet
(JobCode, Staffing, Employee) sheet to the Expense
sheet to save in the Financial Data Tables.

ProviderCompFICA Interface Transfers FICA calculations from the ProviderComp
sheet to the Expense sheet to save in the Financial
Data Tables.

ProviderLaborFICA Interface Transfers FICA calculations from the ProviderComp
and designated labor sheet (JobCode, Staffing,
Employee) sheet to the Expense sheet to save in the
Financial Data Tables.

ProviderCompHours Interface Transfers Hours calculations from the
ProviderComp sheet to the Expense sheet to save in
the Financial Data Tables.

ProviderLaborHours Interface Transfers Hours calculations from the
ProviderComp and designated labor sheet
(JobCode, Staffing, Employee) sheet to the Expense
sheet to save in the Financial Data Tables.

Setup Guide Axiom Budget Planning │ 322



Calc Method Type Description

ProviderCompOther Interface Transfers other labor calculations from the
ProviderComp sheet to the Expense sheet to be
saved in the Financial Data Tables.

Add New ProviderLaborComp New Use this new labor calc method to add a new labor
account to the Expense sheet for Providers.

Add New ProviderLaborHours New Use this new labor calc method when necessary to
add a new hours account to the Expense sheet for
Providers.

� JobCode sheet
For instructions on using this sheet, click here.

Calc Method Type Description

JobCode Interface Sets up initial JobCode block on the JobCode sheet during
the interface process. Do not use when adding blocks to
the JobCode tab.

AvgPerPaidHr Interface Calculates other Non-FTE related pay based on the
relationship to paid hours in the JobCode block. Monthly
spread will be based on the spread of paid hours.

AvgPerProdHr Interface Calculates other Non-FTE related pay based on the
relationship to productive hours in the JobCode block.
Monthly spread will be based on the spread of productive
hours.

Dept_
AvgPerProdHr

Interface Calculates other Non-FTE related pay based on the
relationship to productive hours in the department.
Monthly spread will be based on the spread of productive
hours. Only use this calc method to budget labor dollars at
a department level and not a JobCode level.

Dept_
InputMonthly

Interface Calculates other Non-FTE related pay by inputting monthly
amounts for the department. Only use this calc method to
budget labor dollars at a department level and not a
JobCode level.

Dept_InputTotal Interface Calculates other Non-FTE related pay by typing in a total
for the department. Monthly spread will be spread evenly
by month. Only use this calc method to budget labor
dollars at a department level and not a JobCode level.
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Calc Method Type Description

Holiday Interface Calculates salary dollars based on YTD holiday pay and
spreads by the listed holiday months in the Budget Labor
Configuration driverBudget Labor Configuration driver.

Input_Monthly Interface Calculate other Non-FTE related pay by typing in the
monthly totals.

The default value for Input_Monthly is the current year
projected.

Add New
JobCode

New Sets up a new JobCode block on the JobCode sheet. This
calc method allows the input of FTEs and hourly rate for
each labor category. The default hourly rate comes from
theMid Rate column in the Budget Labor Limits
driverBudget Labor Limits driver.

Add NewAvgPer
Paid Hr PayType

New Calculate other Non-FTE related pay based on the
relationship to paid hours in the JobCode block. Monthly
spread will be based on the spread of paid hours. This calc
method is only used when adding a new pay type.

Add NewAvgPer
Prod Hr PayType

New Calculates other Non-FTE related pay based on the
relationship to productive hours in the JobCode block.
Monthly spread will be based on the spread of productive
hours. This calc method is only used when adding a new
pay type.

Add New Input
Monthly
PayType

New Calculates other Non-FTE related pay by typing in the
monthly totals. This calc method is only used when adding
a new paytype.

� Provider sheet
For instructions on using this sheet, click here.

Calc Method Type Description

FinancialClass Interface Inserts financial class data to use during the initial interface
process.

Provider Interface Sets up the Provider Block to use during the initial interface
process.

Revenue Interface Inserts revenue data to use during the initial interface
process to insert revenue data.

RVU Interface Inserts RVU data to use during the initial interface process.
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Calc Method Type Description

Statistic Interface Inserts Procedure/Statistic data to use during the initial
interface process.

WRVU Interface Inserts WRVU data to use during the initial interface
process.

Add New
Encounter

New Inserts additional Encounter/Visit lines, if needed, after the
initial interface is complete.

Add New
FinancialClass

New Inserts additional Financial Class lines, if needed, after the
initial interface is complete.

Add New
Procedure

New Inserts additional Procedure lines, if needed, after the
initial interface is complete.

Add New
Provider

New Inserts a new Provider Block.

Add New
Revenue

New Inserts additional Revenue lines, if needed, after the initial
interface is complete.

Add NewRVU New Inserts additional RVU lines, if needed, after the initial
interface is complete.

Add NewWRVU New Inserts additionalWRVU lines, if needed, after the initial
interface is complete.

Copy From
Existing Provider

New Inserts a new Provider Block and allows the statistical
history from an existing Provider to copy into the new
Provider block.

� Staffing sheet
For instructions on using this sheet, click here.

Calc Method Type Description

JobCode Interface Sets up initial JobCode block on the Staffing tab during the
interface process. Do not use when adding blocks to the Staffing
tab.

AvgPerPaidHr Interface Calculates other Non-FTE related pay based on the relationship to
paid hours in the JobCode block. Monthly spread will be based
on the spread of paid hours.

AvgPerProdHr Interface Calculates other Non-FTE related pay based on the relationship to
productive hours in the JobCode block. Monthly spread will be
based on the spread of productive hours.
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Calc Method Type Description

DeptAvgPerPaidHr Interface Calculate other Non-FTE related pay based on the relationship to
paid hours in the department. Monthly spread will be based on
the spread of paid hours. Only use this calc method to budget
labor dollars at a department level and not a JobCode level.

Dept_
InputMonthly

Interface Calculates other Non-FTE related pay by inputting monthly
amounts for the department. Only use this calc methid to budget
labor dollars at a department level and not a JobCode level.

Dept_InputTotal Interface Calculates other Non-FTE related pay by typing in a total for the
department. Monthly spread will be spread evenly by month.
Only use this calc method to budget labor dollars at a
department level and not a JobCode level.

Holiday Interface Calculates salary dollars based on YTD holiday pay and spreads by
the listed holiday months in the Budget Labor Configuration
driverBudget Labor Configuration driver.

Input_Monthly Interface Calculates other Non-FTE related pay by typing in themonthly
totals.

The default value for Input_Monthly is the current year
projected.

Input_Total Interface Calculates other Non-FTE related pay by typing in the total
dollars. Themonthly spread will be spread evenly.

Add New JobCode New Sets up a new JobCode block on the Staffing tab. This calc
method allows the input of FTEs and hourly rate for each labor
category. The default hourly rate comes from theMid Rate
column in the Budget Labor Limits driverBudget Labor Limits
driver.

Add New Input
Monthly PayType

New Calculates other Non-FTE related pay by typing in themonthly
totals. This Calc Method is only used when adding a new pay
type.

Add New Input
Total PayType

New Calculates other Non-FTE related pay by typing in the total
dollars. Themonthly spread will be even. This calc method is only
used when adding a new pay type.
The FTEs from Target should have no variance for a budget to be
acceptable.

� Stat_Rev (Statistics and Revenue) sheet
For instructions on using this sheet, click here.
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Calc Method Description

Allowance Calculate deductions based on a percentage of gross revenue.

BadDebt Calculate bad debt based on a percentage of gross revenue.

Detail Zeros base revenue calculations.

FixedRevenue Allows changes to the projected year as well as budget. Usually used
for other operating revenue accounts. Select themonthly spread
from the drop-down.

GlobalRevenue Pushes revenue or deduction calculations to the budget plan file from
Budget Assumptions. End users cannot change the totals or the
spread in the budget plan files. Only users with administrative rights
can update the calculations.

GlobalSum This SPM allows you to budget for an account at a percentage of the
total of specific other account(s) on the Stat_Rev tab within the same
workbook.

InputMonthly Month by month input.

IP_Per_Unit This revenue calc method is now an independent calculation of IP
revenue by account using the historical revenue per unit.

IP_Payor Calculates the total IP revenue, and then allocates it based on the
historical percentages by payor. Only use this calc method if the GL
gross revenue account structure is by payor.

OP_Per_Unit This revenue calc method is now an independent calculation of OP
revenue by account using the historical revenue per unit.

OP_Payor This calc method calculates the total IP revenue, and then allocates it
based on the historical percentages by payor. Use this calc method
only if the GL gross revenue account structure is by payor.

Oth_Per_Unit This revenue calc method is now an independent calculation of Other
Patient revenue by account using the historical revenue per unit.

Oth_Payor This calc method calculates the total IP revenue, and then allocates it
based on the historical percentages by payor. Only use this calc
method if the GL gross revenue account structure is by payor.

NoBudget Brings in historical values into the budget plan file, but the budget for
next year will be zero, and cannot be changed.

Statistic Calculates projected and budget key statistics.

Statistic_Oth Calculates projected and budget non-key statistics based on their
relationship to the key statistic.
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Calc Method Description

Revenue_Stat This revenue calc method allows you to define the statistic account
from the Stat_Rev tab to use as the basis of the per unit calculation
and themultiplier for the budget. For example, theremy be an Other
Department statistic in the OR for implant cases that should be used
to drive the Revenue-Implant account.

Add NewDetail Zero-based expense calculations when adding a new account. Inputs
are done on the Detail tab in the budget plan file.

Add New Fixed Revenue Use this new revenue calc method to add a new Fixed Revenue
account to the Stat_Rev tab.

Add New Input Monthly Use this new revenue or statistic calc method to add a new account
to the Stat_Rev tab.

Add New Statistic Use this new statistic calc method to add a new key statistic account
to the Stat_Rev tab.

Add New Statistic_Oth Use this new statistic calc method to add a newOther Statistic
account to the Stat_Rev tab.

Provider Version Only
If your organization purchased the Provider module license, you have access to the following additional
calc methods:

Calc Method Description

ProviderRev Transfers Revenue calculations from the Provider Summary/Provider
Detail tab to the Stat_Rev tab to save to the Financial Data tables.

ProviderStat Transfers Statistic calculations from the Provider Summary/Provider
Detail tab to the Stat_Rev tab to save to the Financial Data tables.
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Calc Method Description

ProviderComp Transfers Salary calculations from the Provider tab to the Stat_Rev
tab to save to the Financial Data tables.

NOTE: Provider Light Version Only: Calc Methods – Stat_Rev Sheet

If your organization has purchased the Provider module, you can
access the following additional calc methods if using the Provider
Light.

l Provider_Simple_Rev – Transfers Revenue calculations from the
Provider Simple Rev tab to the Stat_Rev tab to save to the
Financial Data Tables. If your GL structure has multiple revenue
accounts for Provider revenue, then apply the calculation method
Provider_Simple_Rev to each revenue account.

l Provider_Simple_Stat – Transfers Statistic calculations from the
Provider Simple Rev tab to the Stat_Rev tab to save to the
Financial Data Tables. Assign this to the key statistic you are using
as your driver stat on the Provider tab. For example, when using
WRVU as your Driver stat, add Provider_Simple_Stat to the GL
acct on the ACCT dimension table for WRVUs.

Budgeting health plans
The HealthPlan Operations utility allows your organization to calculate revenues and expenses based on
Membership Per Member Per Month (PMPM) calculations, which you can then use to determine the
profitability of each health plan and/or insurance product.

TIP: The ability to determine profitability depends on the data provided by your organization. The
more revenue and expense data you enter into the system, the closer you can get to a truemargin
ratio.

This utility is primarily for Axiom Budgeting administrators and/or finance liaisons of health plan
companies and their key stakeholders.

The following list and image describe the different areas and functions of the utility:

a. Key Results Summary - Summarizes the results of all the health plans included in the utility.

b. Insurance Plans - Displays a list of all the health plans and their key metrics for members as well as
the PMPM rates for revenue and expenses. The system calculates historical PMPM values for
historical periods such as Last Year Actual and Year-to-Date. Projection and monthly budget
values are calculated based on members multiplied by the PMPM rate for revenues and expenses.
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The header bar for each entity/department displays the entity and department number, the
insurance plan product, and the location. For each entity/department, the system shows the
number of covered members, the revenue, and the expenses.

c. Annual Comparison and Budget - The first half of the sheet displays the Annual Comparison
section, which shows values for the current year, including the current fiscal year budget, YTD
actuals, and projected actuals and next year budget. The other half of the sheet is the Budget
section, which shows themonthly and total budgeted values for the next fiscal year.

d. Expand/Contract entity/department rows - By default, the list of entities/departments is

expanded, but you can double-click to expand or double-click to contract it. After you save
your changes, the system remembers this setting the next time you open the driver.

IMPORTANT: The utility does not allow your organization to enter any health plan data containing
patient identifying information.

To budget health and insurance plans:
1. In the Bud Admin task pane, in the Budget Files Administration section, double-click Open

HealthPlan Utility.

2. In the Refresh Variables dialog, do any of the following to filter the list of records that display in
the utility, and click OK:

l In the Filter by ENTITY field, enter or select one or more entities.
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l In the Filter by DEPT.KHABgtMap field, enter or select one or more departments.
l To include all entities and departments, leave the fields blank.

3. To enter details for a line item, in the Comments column, type information in the blue cells for the
appropriate line item.

NOTE: The information in the HealthPlan Operations utility is controlled by a series of dimension
tables and drivers. See theManaging utility information section below on how to update information
and calculations in the utility.

� Using different views
The system provides several different ways to view the sheet information. In theMain ribbon tab, click
Change View.

The following table provides a description of the different options.

Column views

View Description

Select All Show all Annual Comparison, Comments, and Budget columns
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View Description

Deselect All Hide all Annual Comparison, Comments, and Budget columns

Show Section - Annual
Comparison

Hide or show the Annual Comparison columns

ShowComments Hide or show only the Comments column

Show Section - Budget Hide or show only the Budget columns

Row views

View Description

Select All Show both the HealthPlan Operations title and Key Results Summary
Area

Deselect All Hide both the HealthPlan Operations title and Key Results Summary
area

Show Title Hide or show the HealthPlan Operations title

Show Section - Key Results
Summary

Hide or show the Key Results Summary area

Sheet views

View Description

Default Show both the Annual Comparison, Comments, and Budget rows
and columns

Annual Show only the Annual Comparison and Comments rows and columns

Monthly Show only the Comments and Budget row and columns

� Managing utility information
The information that displays in the utility comes from several different sources. The following table lists
where to update information, as needed:

NOTE: To update dimensions specific for health plan budgeting, see Updating dimensions for health
plan budgeting.

Location Description

LOCATION dimension Add or edit department locations.

INSCODE dimension Add or edit healthcare or insurance plans.

Setup Guide Axiom Budget Planning │ 332



Location Description

DATATYPE dimension Assign budget types to plan revenue and expense streams.

ACT_HP_20XX table Add or edit plans and the corresponding actual account data.

Membership Enrollment
Trend driver

Enter enrollment percentages for each health plan or insurance
product offered by your organization. The purpose of this driver is to
determine themembership trend of each product. The trend
percentages are then used in theMembership Per Member Per
Month (PMPM) driver to adjust themembership statistics.

Membership Per Member
Per Month driver

Reviewmember lives, revenue PMPM, and expense PMPM for each
health plan.

� Printing the HealthPlan Operations utility
Axiom Budgeting allows you to save the Annual or Monthly version of the HealthPlan Operations utility
as a PDF.

To print the HealthPlan Operations utility:
1. Open the HealthPlan Operations Utility.

2. In theMain ribbon tab, click Publish > Print > Print This Sheet.

3. In the Print Sheet dialog, do any of the following:
l Print Details - Click the View/Edit link to edit print view options, scaling, and header/footer

information.
l Print Preview - Click the Print Preview link to view a preview of the report.

4. Next to the sheet name, click the check box for the report to print, and click Print.
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Working with reports
Reports use Axiom file functionality to bring in data from the database, and if desired, to save data back
to the database. You can use any Axiom file feature in a report except calc method libraries.

Report files, unlike other Axiom files, are not associated with any file group. You can bring in data from
any table. For example, if you have two file groups that are configured to save data back to two different
tables (or to different columns in the same table), you can use a report to compare the data.

� Report structure
Axiom reports are free-format. When you create a new report, you can use various query options to
bring data anywhere into the report, and you can use spreadsheet functionality to format the report and
calculate values such as subtotals and percentages.

Reports can have any number of sheets. Each sheet can be configured to bring in data from the
database, and, if desired, save data back to the database. If you want to use an Axiom query on a sheet,
or save data to the database from a sheet, that sheet must be configured on the Control Sheet. Other
Axiom file functionality, such as Axiom functions or GoTo bookmarks, do not require the sheet to be
configured on the Control Sheet.

� Reports Library
Report files are stored in the Axiom Software database. To make it easy to access and organize reports,
Axiom Software supports a virtual folder structure known as the Reports Library.

Each report is assigned to a folder in the Reports Library. When you open reports, you can navigate
through the Reports Library structure to quickly locate the report that you want to open.

The Reports Library is managed by using Axiom Explorer. If you are an administrator, or if you have
Administer Axiom Explorer rights, then you can use Axiom Explorer to create report folders, move reports
between folders, and delete existing reports.

You can also save reports outside of the Axiom Software database—for example, to your local computer
or to a network folder. In this case the file is considered to be a non-managed file. It is recommended to
maintain all reports as managed files unless you have a compelling reason to use a non-managed file.

5
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� Report output and distribution
In addition to the standard output options for Axiom files—such as the ability to take a snapshot of an
Axiom file—report files can use the File Processing feature.

Using file processing, you can refresh a report file and perform output and distribution actions such as
saving a snapshot copy of the file, emailing a snapshot copy of a file, or exporting data to a CSV/TXT file.
You can process the file "as is," or perform Multipass processing on the file, where the file is processed
multiple times using a unique filter for each pass.

� Saving data to the database
In addition to viewing data, you can also use reports to calculate data and save data back to the
database. In certain circumstances, it may bemore appropriate to use a report to save data rather than
plan files or driver files. If a report file has been configured to save to the database, you can use the Save
button in the File Options group to save data.

Contact Kaufman Hall Support if you are unsure about the best way to manage a certain set of data.

Budgeting reports
Axiom Budgeting 2022.1 comes with a variety of standard budget reports, organized within the following
folders and subfolders.

TIP: In some reports, you can drill down to specific data to view how the values were calculated. For
more information, see Drilling data: Using Drill Down.

� Budgeting Analysis reports
The following reports allow you to view general budget data. For examples of these reports, see Analysis
reports.

Report Description

Budget Account Analysis Use to analyze the proposed budget compared to last year
actual, current year budget, and current year projected for
an individual account by department. Comments entered
into the budget plan files also show on the report to assist
with the analysis.

Budget FTE Comparison Use to analyze the proposed budget for FTE compared to
last year actual, current year budget, year-to-date actual,
and current year projected by department.
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Report Description

Budget Key Statistics By Department Use to view highlighted key statistic trends across multiple
fiscal years.

Budget Per Unit Analysis Use to analyze per-unit amounts by comparing the current
year projection to next year’s budget for Patient Revenue,
Salaries, Supplies, and Other Expenses.

Budget Plan Questions Use to report on inputs from the Plan tab in plan files.

Budget Red Flag Analysis Use to review the comments and explanations for
accounts flagged in the budget plan files because they
exceeded the defined red-flag threshold. The report shows
year-to-date actual and current year projection compared
to the proposed budget request. The report also includes
fields for the adjustments and comments posted from the
budget workbook for each account.

Budget Salary Comparison Use to analyze salary variances for the proposed budget
compared to the current year projection. The report also
includes prior year and current year actual history to use
for comparison.

Budget Salary Rate Analysis Use to analyze departmental average hourly-rate variances
in the proposed budget. The report shows prior year and
current year actual history and projection compared to the
new budget. The variance is broken out into two different
categories—FTE and Rate Effect.

Budget Summary by Department Use to analyze total-expense variances by department,
comparing the proposed budget to the current-year
projection. The report shows prior-year actual, current-
year actual, and current-year budget history.

Budget Threshold Analysis Use to analyze account categories by applying a low and
high threshold for variances. Historical data for last-year
actual and current-year budget are also included.

Budget Workbook Changes for CYB
and NYB

Use to view highlighted areas where users made inputs in
the yellow cells in budget plan files.

� Budgeting Statement reports
The following reports are designed for budget analysis. For examples of these reports, see Statement
reports.
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Report Description

Budget Income Detail Use to analyze the proposed budget-by-income statement
category compared to last-year actual, current-year
budget, current-year projected, year-to-date actual, and
current-year annualized. Each category shows all values for
all accounts in that category.

Budget Income Financial Plan Use to view annuals income statement comparisons across
multiple scenarios.

Budget Income Scenarios Use to analyze the proposed budget by FSDetail category
compared to the Baseline Budget, NYBScenario1, and
NYBScenario2. BudScenario1 and BudScenario2 are fields
in the database used to store the results of different sets of
driver files. You can use this report to compare passes of
the budget (BudPass1, BudPass2).

Budget Income Summary Use to summarize the proposed budget by FSDetail
category compared to last-year actual, current-year
budget, current-year annualized, and current-year
projected.

Budget Monthly Dept P&L Use to review themonthly spread by account for the
proposed budget by Budget Type category for an
individual department. This report is often used to provide
the department manager with a final copy of their month-
by-month budget.

� Initiative Analysis reports
The following reports are designed for budget analysis of new initiatives. For examples of these reports,
see Initiative Analysis reports.

Report Description

Budget Income Summary-Initiative Use to review new initiatives by Income Statement
category.

Budget Income Summary-Initiative
Monthly

Use to review new initiatives by Income Statement
category by month.

Income Statement by Initiative ID Use to review new initiatives side-by-side for multiple
initiatives.

Initiative Summary Use to review new initiatives by department by category,
with monthly FTEs.
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� Payroll Analysis reports
The following reports are designed for payroll budget analysis. For examples of these reports, see Payroll
Analysis reports.

Report Description

FTE Additions and Changes by
JobCode

Use to review the FTE summary by department by
JobCode, highlighting changes made to the projected year
and budget in the plan files.

FTEs by Department Use to review the FTE summary by department, including
prior-year actual, current-year budget, and year-to-date
actual. The proposed budget is compared to year-to-date
actual as well as the current-year budget.

FTEs by Department by JobCode Use to review FTE report by department by job code,
including prior-year actual, current-year budget, and year-
to-date actual. The proposed budget is compared to year-
to-date actual as well as the current-year budget.

FTEs by JobCode Use to review the FTE report by job code, including prior-
year actual, current-year budget, and year-to-date actual.
The proposed budget is compared to year-to-date actual
as well as the current-year budget.

Monthly FICA by Department Use to showmonthly total FICA expense by department
for both current-year projected and next-year budget.
Monthly expense shows for next-year budget. Designed
for use by clients who budget FICA in a central department
or to review the overall monthly spread of FICA expense.

Monthly FTE Target Variance by
Department

Use to review a department summary of the FTE variance
by month for next year’s budget to the department target.

Monthly FTEs by Department Use to review a department summary of total FTEs by
month for next year’s budget. Designed to be used to
review themonthly spread of total FTEs as well as by
department.

NYB Hours and Dollars by Employee Use to review hours and dollars by employee, job code,
paytype, and department. To use this report, the
department must use the employee labor option in plan
files.

Worked Hours Per Unit by
Department by JobCode

Use to compare the projected and NY Budget by Provider
to the current year by selected DataType.
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� Provider Budget Analysis reports (optional feature)
The following reports are designed for physician analysis. For examples of these reports, see Running
Provider Budget Analysis reports.

NOTE: You can also find these same reports in the Financial Reporting section > Financial Reporting
> Provider Analysis.

Report Description

Current Period vs Previous
Comparison

Use to compare current period vs previous period
information by provider as well as last year actual. You can
select the data type to analyze in the report.

Current Period vs Previous
Comparison_CPT

Use to compare current period vs previous period
information by CPT or CPT Summary category and last
year actual. You can select the data type to analyze in the
report.

CY Actual vs Budget Comparison Use to compare current period and year-to-date actual vs
budget information by provider and last year actual. You
can select the data type to analyze in the report.

CY Actual vs Budget Comparison_CPT Use to compare current period and year-to-date actual vs
budget information by CPT or CPT Summary code and last
year actual. You can select the data type to analyze in the
report.

NY Budget Comparison Use to compare current year projections with next year's
budget.

NY Budget Comparison_CPT Use to compare current year projections with next year's
budget by CPT or CPT Summary category.

Provider Key Indicators By Month Use to comparemonth-by-month values for last year,
current year, and target by data type.

Provider Key Indicators By Month_
Rolling 12

Use to comparemonth-by-month values for themost
recent 12months by data type.

Provider Revenue Per Encounter Use to compare the current month to the prior three-
month average for different years for revenue per
encounter.

Provider Revenue Per RVU Use to compare the current month to the prior three-
month average for different years for revenue per RVU.

Provider Revenue PerWRVU Use to compare the current month to the prior three-
month average for different years for revenue perWRVU.
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Report Description

Provider Volume by Specialty Use to compare actual vs budget volume by data type for
the current period and year-to-date, subtotaled by
provider specialty.

Provider Volume by Specialty_
Monthly

Use to showmonthly totals by provider, for a chosen data
type and year, subtotaled by provider specialty.

Provider Compensation Benchmark Use to compare the proposed budget salary to a salary
target for each provider. The target is factored for the
budget FTE.

Provider Compensation Comparison Use to compare the calculated budget salary under each of
the available compensation methods, by provider, to
evaluate the cost ofmoving providers to another model or
standardizing the compensation model. There is also a
comparison of the current year vs proposed budget salary
cost per work RVU to test if the compensation is changing
+\- the Hold Harmless percentage.

� Provider Budget Compensation reports (optional feature)
The following reports are designed for payroll/provider budget analysis. For examples of these reports,
see .

Report Description

Provider Compensation Benchmark Use to compare the proposed budget salary to a salary
target for each provider. The target is factored for the
budget FTE.

Provider Compensation Comparison Use to compare the calculated budget salary under each of
the available compensation methods, by provider, to
evaluate the cost ofmoving providers to another model or
standardizing the compensation model.

Analysis reports
These reports are designed for budget analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Budget
Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Budget Analysis.
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� Budget Income Detail
Use to analyze the proposed budget compared to last year actual, current year budget, and current year
projected for an individual account by department. Comments entered into the budget plan files also
show on the report to assist with the analysis.

� Budget FTE Comparison
Use to analyze the proposed budget for FTE compared to last year actual, current year budget, year-to-
date actual, and current year projected by department.
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� Budget Key Statistics By Department
Use to view highlighted key statistic trends across multiple fiscal years.

� Budget Per Unit Analysis
Use to analyze per-unit amounts by comparing the current year projection to next year’s budget for
Patient Revenue, Salaries, Supplies, and Other Expenses.
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� Budget Plan Questions
Use to report on inputs from the Plan tab in plan files.

� Budget Red Flag Analysis
Use to review the comments and explanations for accounts flagged in the budget plan files because they
exceeded the defined red-flag threshold. The report shows year-to-date actual and current year
projection compared to the proposed budget request. The report also includes fields for the
adjustments and comments posted from the budget workbook for each account.

� Budget Salary Comparison
Use to analyze salary variances for the proposed budget compared to the current year projection. The
report also includes prior year and current year actual history to use for comparison.
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� Budget Salary Rate Analysis
Use to analyze departmental average hourly-rate variances in the proposed budget. The report shows
prior year and current year actual history and projection compared to the new budget. The variance is
broken out into two different categories—FTE and Rate Effect.

� Budget Summary by Department
Use to analyze total-expense variances by department, comparing the proposed budget to the current-
year projection. The report shows prior-year actual, current-year actual, and current-year budget
history.
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� Budget Threshold Analysis
Use to analyze account categories by applying a low and high threshold for variances. Historical data for
last-year actual and current-year budget are also included.

� Budget Workbook Changes for CYB and NYB
Use to view highlighted areas where users made inputs in the yellow cells in budget plan files.
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Statement reports
These reports are designed for budget analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Budget
Statements. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Budget Statements.
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� Budget Income Detail
Use to analyze the proposed budget-by-income statement category compared to last-year actual,
current-year budget, current-year projected, year-to-date actual, and current-year annualized. Each
category shows all values for all accounts in that category.

� Budget Income Financial Plan
Use to view annuals income statement comparisons across multiple scenarios.

� Budget Income Scenarios
Use to analyze the proposed budget by FSDetail category compared to the Baseline Budget,
NYBScenario1, and NYBScenario2. BudScenario1 and BudScenario2 are fields in the database used to
store the results of different sets of driver files. You can use this report to compare passes of the budget
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(BudPass1, BudPass2).

� Budget Income Summary
Use to summarize the proposed budget by FSDetail category compared to last-year actual, current-year
budget, current-year annualized, and current-year projected.

� Budget Monthly Dept P&L
Use to review themonthly spread by account for the proposed budget by Budget Type category for an
individual department. This report is often used to provide the department manager with a final copy of
their month-by-month budget.
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Initiative Analysis reports
These reports are designed for budget analysis of new initiatives.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Initiatives
Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Initiatives Analysis.

� Budget Income Summary - Initiative
Use to review new initiatives by Income Statement category.
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� Budget Income Summary - Initiative Monthly
Use to review new initiatives by Income Statement category by month.
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� Income Statement by Initiative ID
Use to review new initiatives side-by-side for multiple initiatives.
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� Initiative Summary
Use to review new initiatives by department by category, with monthly FTEs.

Initiative Analysis reports
These reports are designed for budget analysis of new initiatives.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Initiatives
Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Initiatives Analysis.

� Budget Income Summary - Initiative
Use to review new initiatives by Income Statement category.
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� Budget Income Summary - Initiative Monthly
Use to review new initiatives by Income Statement category by month.
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� Income Statement by Initiative ID
Use to review new initiatives side-by-side for multiple initiatives.

Setup Guide Axiom Budget Planning │ 354



� Initiative Summary
Use to review new initiatives by department by category, with monthly FTEs.

Payroll Analysis reports
These reports are designed for payroll budget analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Payroll
Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Payroll Analysis.

Setup Guide Axiom Budget Planning │ 355



� FTE Additions and Changes by Jobcode
Use to review the FTE summary by department by JobCode, highlighting changes made to the projected
year and budget in the plan files.

� FTEs by Department
Use to review the FTE summary by department, including prior-year actual, current-year budget, and
year-to-date actual. The proposed budget is compared to year-to-date actual as well as the current-year
budget.
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� FTEs by Department by Jobcode
Use to review FTE report by department by job code, including prior-year actual, current-year budget,
and year-to-date actual. The proposed budget is compared to year-to-date actual as well as the current-
year budget.

� FTEs by Jobcode
Use to review the FTE report by job code, including prior-year actual, current-year budget, and year-to-
date actual. The proposed budget is compared to year-to-date actual as well as the current-year budget.

� Monthly FICA by Department
Use to showmonthly total FICA expense by department for both current-year projected and next-year
budget. Monthly expense shows for next-year budget. Designed for use by clients who budget FICA in a
central department or to review the overall monthly spread of FICA expense.
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� Monthly FTE Target Variance by Department
Use to review a department summary of the FTE variance by month for next year’s budget to the
department target.

� Monthly FTEs by Department
Use to review a department summary of total FTEs by month for next year’s budget. Designed to be
used to review themonthly spread of total FTEs as well as by department.
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� NYB Hours and Dollars by Employee
Use to review hours and dollars by employee, job code, pay type, and department. To use this report,
the department must use the employee labor option in plan files.

� Worked Hours Per Unit By Department by Jobcode
Use to compare the projected and NY Budget by Provider to the current year by selected DataType.
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Provider Compensation reports

Budgeting utilities
Axiom Budgeting 2022.1 comes with a variety of standard budget utilites, organized within the following
folders and subfolders.

TIP: In some reports, you can drill down to specific data to view how the values were calculated. For
more information, see Drilling data: Using Drill Down.

� Balance Sheet and Deductions
The following utilities are designed for budget balance sheet calculation and deductions modeling to post
the results to the database. For examples of these reports, see Balance Sheet and Deductions utilities.

Report Description

Budget Balance Sheet and Cash Flow Use this save-to-database report to project the balance
sheet for the remainder of the current year and next year’s
budget by category.

Budget Deductions All statistics, revenues and deductions are broken out by
payer. You can make assumptions for the projection and
budget in each payer section.

NYB_Deductions_FSDetail Use this deductions model to project deductions using the
historical relationship to gross revenue for each deduction
category.

NYB_Deductions_FSPayor Use this deductions model to project deductions using the
historical relationship to gross revenue by payer.

� Budget Reconciliation utilities
The following utilities are designed for budget balance sheet calculation and deductions modeling to post
the results to the database. For examples of these reports, see Reconciliation utilities.

Report Description

Budget Department Audit Report Use to resolve possible mapping errors at the department
level by highlighting mapping and process management
inconsistencies in the DEPT dimension table before
building plan files and starting process management.
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Report Description

Budget Process Management Report Use to showwhat stage each budget plan file is in when
using process management for budget staging.

Budget Workbook Reconciliation Use to compare check totals from different columns in the
budget workbooks to the summary fields in the database
to make sure they are in balance. If the budgets are all in
balance, then this report returns no data, which is the
desired outcome of this report.

Global Depreciation Reconciliation
Report

Use to show the variance between the budgeted
depreciation accounts to the same accounts in the general
ledger budget for a user-specified budget year.

Global Expense Reconciliation Report Use to show the variance between the budgeted
depreciation accounts to the same accounts in the general
ledger budget for a user-specified budget year.

Global Revenue Reconciliation Report Use to show the variance between the budgeted global
revenue accounts to the same accounts in the general
ledger budget for a user-specified budget year.

Labor Non-Matched Use to identify the JobCode/PayType combinations that
have dollars but have no FTE hours for the year.

NewDepartment Utility Use to create default records for a new department. You
can save records to the Financial, Payroll, Provider, or
RevUsage tables.

Payroll12 Hours Reconciliation Use to highlight job codes saved in the Payroll12 data
source from the budget workbooks that have hours but
no dollars in the budget.

Payroll12 Negative Hours Use to highlight job codes and pay types that have any
negative FTEs budgeted in any month. The report returns
all job codes in the database, but only the ones with the
Review flag need to be investigated and changed, if
necessary.

PayTypeMapping Analysis Use during budget set up for payroll budgeting to show
what PayTypes map to which payroll budget category.

Reconcile NYBDetail to Financial Reconcile values saved in NYBDetail table to those values
saved in the Budget Table which could indicate that values
in your budget plan files are not saving properly.

Reconcile Payroll12 to Financial-
Dollars

Use to test the data transfer from the Labor tab to the
Expense tab in the budget workbook.
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Report Description

Reconcile Payroll12 to Financial-FICA Use to test the data transfer from the Labor tab to the
Expense tab in the budget workbook.

Reconcile Payroll12 to Financial-Hours Use to test the data transfer from the Labor tab to the
Expense tab in the budget workbook.

Salaries Do Not Match Use to identify accounts on the Labors tabs in the plan files
that do not have history on the Expense tab and would
cause a balancing mismatch.

� Budget Setup utilities
The following utility is designed to help set up security. For examples of these reports, see Setup utilities.

Report Description

PayrollGLMapping To allowmapping of GL accounts and Hours accounts
different from the Jobcode dimensions table or Paytype
dimensions table as a result of various combinations to
match GL accounts.

� Budget Extract from EPM utilities
The following utility is designed to extract budget data from the Axiom database. For examples of this
reports, see Extract from EPM utilities.

Report Description

PayrollGLMapping To allowmapping of GL accounts and Hours accounts
different from the Jobcode Dimensions Table or Paytype
Dimensions Table as a result of various combinations to
match GL accounts.

� Budget Provider Utilities - Reconciliation utilities
These utilities are designed to reconcile data to support physician analysis. For examples of these
reports, see Provider Reconciliation utilities.

Report Description

Matching Provider Dept Revenue to
Dept Salaries

Use to determine if there are situations where the provider
revenue and salaries do not match by department.

Matching Provider Revenue to
Salaries

Use to check the net difference between revenue and
salaries by provider.
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Report Description

ProviderComp JobCodes Use to compare the coding in global assumptions to the
information in the Payroll27 tables before creating budget
plan files.

Reconcile GL Revenue to Provider Use to reconcile the gross charges in the Financial data
source to the gross charges in the Provider data source for
both the current period as well as year-to-date.

Review Provider Data Use to identify situations where there is revenue without
matching volume in the historical data that is used for
projection and budget purposes.

� Budget Provider – Statistics utilities (optional feature)
This utility is designed to reconcile data to support physician analysis. For examples of this reports, see
Provider Statistics utilities.

Report Description

Summarize Provider Statistics to
Financial

Use this save-to-database report to summarize provider
data into monthly statistics to be used in Financial data
tables and reports.

� Budget Provider – System Setup utilities
This utility is designed to reconcile data to support physician analysis. For examples of this reports, see
Provider System Setup utilities.

Report Description

ProvBenchmark This table may be used for reports to compare provider
compensation to benchmarks.

� Budget Report Batch utilities
This utility is designed to run multiple reports together. For examples of this report, see Report Batch
utilities.

Report Description

Budget Reconciliation Reports Batch Use to run multiple budget reconciliation reports for
distribution.

� Budget Security utilities
This utility is designed to run multiple reports together. For examples of this report, see Security utilities.
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Report Description

Budget Driver Security Update Use to update the Driver security settings and filters for
Admin users who have access to update Driver files.

Budget Security Update Use to update security settings and filters for all users.

Balance Sheet and Deductions utilities
These reports are designed for budget balance sheet calculation and deductions modeling to post the
results to the database.

� Accessing these utilities
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Balance
Sheet & Deductions. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, and click
Budget Utilities > Balance Sheet & Deductions.

� Budget Balance Sheet and Cash Flow
Use this save-to-database report to project the balance sheet for the remainder of the current year and
next year’s budget, by category.

The Budget Balance Sheet and Cash Flow utility allows you to project the remainder of the current year
and next year budget balance sheet and cash flow numbers. This utility integrates with the budgeted
income statement numbers and allows for frequent updates to the budgeted balance sheet and cash
flow numbers, if the income statement is updated. The utility’s results save back to the database and
then become available in the budget data tables and reports for budget analysis.
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Running the Budget Balance Sheet and Cash Flow utility
1. Open the report.

2. In the Refresh Variables dialog, do the following, and click OK:

l From the Select 'Yes' to add New Income to Fund Balance drop-down, select Yes orNo to
determine whether to add net income to the fund balance.

l To select the default departments, where you would like the budget balance sheet
numbers to be saved back to, click Choose Value, and select a department.

l In the Create a Save Tag Value box, type a save tag (max of 100 characters). This save tag
ensures that the data saving back to the database is saved with a save tag that is unique to
a specific entity/group that you may want to filter this report for. It also avoids having to
createmultiple Balance Sheet reports for different entities/groups.

3. After the report populates, do the following:

l At the top of the spreadsheet, make sure that the data in the Net Income rowmatches the
balance sheet to be prepared.

l Verify historical information for Two Years Ago, Last Year, and Current YTD all balance.

l In the header section, review to the Balance Check row to confirm that themodel is in
balance.
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TIP: If themodel appears to be out of balance, we recommend that you refresh the report and
verify that the Add Net Income to Fund Balance setting was configured properly per your
organization’s accounting practice.

4. In column AD, in the blue input cells, enter the default accounts numbers that you would like the
balance sheet numbers to save back to. For example, you may choose to save back the numbers
for Board Designated Investments and Other Assets to the same default asset account OR you
may choose to use accounts specific to each of these categories.

5. Complete the following sections of the utility, as needed:
l Balance Sheet Assumptions – Use this section to enter key balance sheet metrics to

calculate various balance sheet numbers. Values for balance sheet categories can be
adjusted or keyed in directly in the detailed schedules / inputs section.

l Assets
l Liabilities and Net Assets
l Detailed Schedules - Use this section to input detailed schedules for each category.
l Statement and Cash Flows

TIP: Enter inputs incrementally. For example, to change days in AR from 64 to 56, enter 8 and
not 56.

NOTE: The Budget Balance Sheet utility is configured to always stay in balance. As a result,
inputs/adjustments to Balance Sheet metrics will result in the out of balance difference being
plugged to either the other assets/other liabilities section.

6. To save your changes to the database, in theMain ribbon tab, click Save.

The Summary tab of the Budget Balance Sheet utility will populate with next year’s budgeted balance
sheet and cash flow numbers by month for budget analysis purposes.
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� Budget Deductions
This is a deductions modeling tool that is similar to the deductions modeling in Kaufman Hall Financial
Planning. All statistics, revenues and deductions are broken out by payer. You can make assumptions for
the projection and budget in each payer section. The resulting calculated values post to the database.
When using this model, do not create budget workbooks for your deduction department(s).

GL Accounts are summarized by balance sheet categories, and the resulting summary data can be posted
back to the database for both the Current Year Projection and Next Year Budget as well as inclusion in all
related Budget Analysis reports. If necessary, values for balance sheet categories can be adjusted or
keyed in directly.

As budgets and assumptions change, simply refresh data in the Budget Balance Sheet to update and
post newly computed balance sheet information for calculating metrics driven by income statement
parameters (assuming the balance sheet assumptions remain unchanged).

The Budget Balance Sheet report assigns GL accounts to balance sheet categories per the FSSummary,
FSDetail, and FPCode grouping columns in the ACCT dimension table.

The Balance Sheet and Cash Flow Report includes the following sections:

l Balance Sheet Assumptions – Key metrics used to drive various balance sheet calculations. Valid
entries are listed in the Balance Sheet Assumptions Inputs section.

l Assets
l Liabilities and Net Assets
l Detailed Schedules – Contains rows to input detailed schedules for each category.
l Statement of Cash Flows
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l Summary Income Statement

You can filter the report by Entity or group, as defined in dimensions by using the Quick Filter option in
theMain ribbon tab. You may make adjustments to the values in any blue cells in the report. After
making your changes, review the cash flow statement to make sure it balances to total cash and make
sure the summaries match your expectations on the summary tab.

To run the Budget Sheet and Cash Flow report:
1. In the Refresh Variables dialog, do the following, and click OK:

l From the Select 'Yes' to add New Income to Fund Balance drop-down, select Yes orNo to
determine whether to add net income to the fund balance.

l To select the default departments to include in the report, click Choose Value, select a
department, and click OK.

2. Add or enter information in the blue cell, as appropriate.

3. After the report populates, verify the following:
l At the top of the spreadsheet, make sure that the data in theNet Income rowmatches the

balance sheet to be prepared.
l Historical information for Two Years Ago, Last Year, and Current YTD all balance.
l In the header section, review to the Balance Check row to confirm that themodel is in

balance.

NOTE: If themodel appears to be out of balance, you might want to refresh the report
and verify that the Add Net Income to Fund Balance setting was configured properly
per your organization’s accounting practice

4. To save your changes back to the database, in theMain ribbon tab, click Save.

Balance Sheet assumption inputs

NOTE: Enter inputs incrementally. For example, to change days in AR from 64 to 56, enter 8 and not
56.
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Asset inputs (All inputs should be in whole dollars)

Cash and cash
equivalents

Computed through days of
operating cash

Short-term cash
investments

Input Schedule

Current assets limited as
to use

Input Schedule

Patient Accounts
Receivable

Computed from Gross A\R days in
gross patient receivables

Configurable sections are
netted from the total
calculation on the first row.

Physician Accounts
Receivable

Input Schedule

Allowance for
Uncollectibles

Calculated from Net A\R Days less
Gross receivables

Configurable sections are
netted from the total
calculation on the first row

Third Party Settlements Computed from 3rd Party days in
Net Patient Receivables

Configurable sections are
netted from the total
calculation on the first row.

Current Receivables Input Schedule

Supply Inventories, at
cost

Computed from Days in Supply
inventories

Configurable sections are
netted from the total
calculation on the first row.

Driven by total supplies expense
from the income statement

Prepaid Expenses Computed from Days in Prepaid
Expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Other Current Assets Input Schedule

Assets Limited as to use –
Trusteed Assets

Input Schedule

Assets Limited as to use –
Board Designated
Investments

Computed
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PPE – Land Input Schedule Net Capital Acquisitions

Revaluation amount

PPE – Property and
Equipment

Input Schedule Net Capital Acquisitions

+\- Revaluation amount

PPE – Accumulated
Depreciation

Input Schedule Depreciation Expense –
Automatic flow from Income
Statement

+\- Disposals

PPE – Construction in
Progress

Net Capital Acquisitions +\- Revaluation amount

Unamortized Financing
Fees

Input Schedule

Amortization of existing
fees

Input Schedule

Investment in
subsidiaries

Input Schedule

Notes Receivable Input Schedule

Other Long-Term Assets Input Schedule Liability Inputs (All inputs
should be in whole dollars)

Line of credit Calculated

Current maturity of long-
term debt

Input Schedule Est. current portion of long-
term debt

Adj of current portion of long-
term debt

Accounts Payable Computed from A\P days in other
expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Accrued Payroll Computed from Acc Payroll days in
salary expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement
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Accrued Expenses Computed from Accrued Exp days
in other expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Third Party Settlements Computed from 3rd party days in
other expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Other Accrued Liabilities Input Schedule

Other Long Term
Liabilities 1

Input Schedule

Other Long Term
Liabilities 2

Input Schedule

Long-Term Debt Input Schedule Net new loans

Regular principal payments

Equity inputs (All inputs should be in thousands)

Fund Balance Input Schedule Net Income – Computed and
included in projection if
Instructions tab diaplsy Yes to
include in Fund Balance. Net
Income is automatically added
to fund balance for budget.

Temporarily restricted
net assets

Input Schedule

Permanently restricted
net assets

Input Schedule

� NYB_Deductions_FSDetail
Use this deductions model to project deductions using the historical relationship to gross revenue for
each deduction category. This report summarizes categories using the Acct-FSDetail column in
dimensions. The resulting calculated values posts to the database. If you are using this model, do not
create budget workbooks for your deduction department(s).
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� NYB_Deductions_FSPayor
Use this deductions model to project deductions using the historical relationship to gross revenue by
payer. This report summarizes categories using the Acct-FSPayor column in dimensions. The resulting
calculated values post to the database. If you are using this model, do not create budget workbooks for
your deduction department(s).
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Reconciliation utilities
These utilities are designed for budget reconciliation to the database.

� Accessing these reports
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Budget
Reconciliation. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Budget Reconciliation.

� Budget Department Audit report
Use to resolve possible mapping errors at the department level by highlighting mapping and process
management inconsistencies in the DEPT dimension table before building plan files and starting process
management.
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� Budget Process Management report
Use to showwhat stage each budget plan file is in when using process management for budget staging.

� Budget Workbook Reconciliation
Use to compare check totals from different columns in the budget workbooks to the summary fields in
the database to make sure they are in balance. If the budgets are all in balance, then this report returns
no data, which is the desired outcome of this report.
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� Global Depreciation Reconciliation report
Use to show the variance between the budgeted depreciation accounts to the same accounts in the
general ledger budget for a user-specified budget year.

� Global Expense Reconciliation report
Use to show the variance between the budgeted depreciation accounts to the same accounts in the
general ledger budget for a user-specified budget year.
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� Global Revenue Reconciliation report
Use to show the variance between the budgeted global revenue accounts to the same accounts in the
general ledger budget for a user-specified budget year.

� Labor Non-Matched
Use to identify the JobCode/PayType combinations that have dollars but have no FTE hours for the year.
This causes a matching issue because to create a JobCode block on the labor tabs, that JobCode needs to
have YTD FTE related hours. This report identifies thosemismatches and posts a 1 to the NYBKHA field so
that the JobCode interfaces into that labor tab.
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� Payroll12 Hours Reconciliation
Use to highlight job codes saved in the Payroll12 data source from the budget workbooks that have
hours but no dollars in the budget.
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� Payroll12 Negative Hours
Use to highlight job codes and pay types that have any negative FTEs budgeted in any month. The report
returns all job codes in the database, but only the ones with the Review flag need to be investigated and
changed, if necessary.

� PayType Mapping Analysis
Use during budget set up for payroll budgeting to showwhat PayTypes map to which payroll budget
category.

NOTE: Prior to reviewing the report, your organization needs to load and reconcile the payroll data
as well as complete the Labor Configuration driver. To understand this report, the user needs to have
knowledge of the Labor Configuration Driver.

Running the PayType Mapping Analysis report
Use the following instructions to run and review the report.
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1. Open the report.

2. Press F9, and select the proper Refresh Variables to review based on organizational needs.

3. Review the following in the report:
l In the top section of the report, which provides an overall summary, ensure that all the pay

types are loaded and map to a specific grouping. The variance should be zero. If not, review
your PAYTYPE dimension table to see what pay type is not mapped.

l The remaining sections of the report correspond to the Labor Configuration driver set up
and how the pay types are grouped/mapped in the PAYTYPE dimension table. These
sections give you an overall summary of what pay types are grouped together, the overall
hours and dollars, the FTE status, as well as the GL accounts if the GL is structured by pay
type.

l Review the overall groupings to make sure they are grouped as expected. The bottom
section shows what is not interfaced or coming into the plan files. Confirm that these are
accurate prior to beginning the budget cycle. If you need to make changes, update the
PAYTYPE dimension table and rerun the report to review.

� Reconcile NYBDetail to Financial
Reconcile values saved in NYBDetail table to those values saved in the Budget Table which could indicate
that values in your budget plan files are not saving properly.

� Reconcile Payroll12 to Financial-Dollars
Use to test the data transfer from the Labor tab to the Expense tab in the budget workbook. It compares
the dollars saved in the Payroll12 tables (Labor tab in budget plan files) to the values posted to the
Financial tables (Expense tab in budget plan files). If there any variances in this report, they will need to
be fixed in the budget workbook and saved to the database. The desired outcome for this report is to
have zero variances.
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� Reconcile Payroll12 to Financial-FICA
Use to test the data transfer from the Labor tab to the Expense tab in the budget workbook. It compares
the FICA dollars saved in the Payroll12 tables (Labor tab in budget plan files) to the values posted to the
Financial tables (Expense tab in budget plan files). If there any variances in this report, they will need to
be fixed in the budget workbook and saved to the database. The desired outcome for this report is to
have zero variances.

Setup Guide Axiom Budget Planning │ 380



� Reconcile Payroll12 to Financial-Hours
Use to test the data transfer from the Labor tab to the Expense tab in the budget workbook. It compares
the hours saved in the Payroll12 tables (Labor tab in budget plan files) to the values posted to the
Financial tables (Expense tab in budget plan files). If there any variances in this report, they will need to
be fixed in the budget workbook and saved to the database. The desired outcome for this report is to
have zero variances.
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� Salaries Do Not Match
Use to identify accounts on the Labors tabs in the plan files that do not have history on the Expense tab
and would cause a balancing mismatch. This utility posts a 1 to the NYBKHA fields so those accounts
interface in the plan files.
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Setup utilities
These reports are designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Budget Set
Up. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Budget Setup.
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� PayrollGLMapping
To allowmapping of GL accounts and Hours accounts different from the Jobcode Dimensions Table or
Paytype Dimensions Table as a result of various combinations to match GL accounts.

Extract from EPM utilities
These reports are designed to extract budget data from the Axiom database.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Extract from
EPM. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Extract from EPM.

� Budget Extract Utility
Use to extract budget data from Axiom EPM to upload into GL systems such as Meditech, for example.
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Provider Reconciliation utilities
These reports are designed Designed to reconcile data to support physician analysis.

� Accessing these utilities
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Provider
Utilities\Reconciliation. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Provider Utilities > Reconciliation.
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� Matching Provider Dept Revenue to Dept Salaries
Use to determine if there are situations where the provider revenue and salaries do not match by
department.

� Matching Provider Revenue to Salaries
Use to check the net difference between revenue and salaries by provider.
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� ProviderComp JobCodes
Use to compare the coding in global assumptions to the information in the Payroll27 tables before
creating budget plan files.
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� Reconcile GL Revenue to Provider
Use to reconcile the gross charges in the Financial data source to the gross charges in the Provider data
source for both the current period as well as year-to-date.

� Review Provider Data
Use to identify situations where there is revenue without matching volume in the historical data that is
used for projection and budget purposes.
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Provider Statistics utilities
These reports are designed to reconcile data to support physician analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Provider
Utilities\Statistics. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Provider Utilities > Statistics.
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� Summarize Provider Statistics to Financial
Use this save-to-database report to summarize provider data into monthly statistics to be used in
Financial data tables and reports.

Provider System Setup utilities
This report is designed to reconcile data to support physician analysis.

� Accessing these utilities
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Provider
Utilities\System Setup. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Provider Utilities > System Setup.
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� ProvBenchmark
This table may be used for reports to compare provider compensation to benchmarks.

Report Batch utilities
These utilities are designed for budget reconciliation to the database.

� Accessing these reports
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Report
Batches. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Report Batches.
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� Budget Reconciliation Reports Batch
Use to run multiple budget reconciliation reports for distribution.

Security utilities
These reports are designed for budget balance sheet calculation and deductions modeling to post the
results to the database.

� Accessing these utilities
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Security. For
instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Security.
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� Budget Driver Security Update
Use to update the Driver security settings and filters for Admin users who have access to update driver
files.

� Budget Security Update
Use to update security settings and filters for all users.

Financial reports
Axiom Budgeting 2022.1 comes with a variety of standard financial reports, organized within the
following folders and subfolders.

TIP: In some reports, you can drill down to specific data to view how the values were calculated. For
more information, see Drilling data: Using Drill Down.

� Financial Analysis reports
The following reports allow you to view general budget data. For examples of these reports, see Analysis
reports.
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Report Description

Account Analysis Use to analyze the current month- and year-to-date
variances for an individual account by department.

Current Year Actual (CYA) Per Unit
Analysis

Use to analyze year-to-date (current) per-unit amounts for
Patient Revenue, Salaries, Supplies, and Other Expenses
compared to current-year budget (Budget).

Expense Summary by Department Use to analyze expense variances by department.

Key Dept Ratios Use to analyze current month and year-to-date salary
variances for an individual department. The salary variance
is broken into categories for Price, Volume, and Efficiency.
A summary section is also provided to show the
components of the total variance.

Labor Price, Volume, & Efficiency
Variances

Use to quickly analyze salaries to determine if the variances
are related to rate or volume.

Labor Summary by Department Use to analyze labor variances by department.

MultiYear Statistic Review Use to show key and non-key statistical accounts for the
current-year actual and budget, prior year, and two years
ago. You can run this report for a single department or
combined for multiple departments. If is often used to
confirm that the statistical basis across different years is
consistent.

Threshold Analysis Use to analyze current month values compared to the
average of the previous threemonth. You can enter a
dollar threshold. After the report is populated, you can
change the view to only show the departments that
exceed the threshold. The purpose of this report is to show
unusual activity or possible missing entries in the current
month.

� Financial Statement reports
The following reports are designed for month-end financial analysis. For examples of these reports, see
Running Financial Statement reports.

Report Description

Balance Sheet Use to review and analyze the Balance Sheet values by
FSDetail category across multiple years.

Balance Sheet and Cash Flow Use to review and analyze the Balance Sheet and Cash
Flow across multiple years.
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Report Description

Balance Sheet By Entity Use to show by entity for one fiscal year across the balance
sheet categories in FSDetail. You can update the report to
run for any fiscal year in the database.

Balance Sheet Detail Use to show the detail accounts within each balance sheet
category of FSDetail, showing last-year actual and current-
year actual.

Forecast Income Summary Use to show the Current Year Forecast by FSDetail
category compared to Current Year Budget and Current
Year Annualized.

Forecast Scenario Comparison Use to show the Current Year To Date, Current Year
Annualized compared to the Current Year Forecast and
Alternate Forecast.

Income Statement By Entity Use to show the Income Statement categories by entity for
the current fiscal year.

Income Statement Detail Use to show the detail accounts within each income
statement category of FSDetail showing current-year detail
and last-year actual.

Income Statement Multi-Year Use to review the Income Statement totals by FSDetail
category across multiple fiscal years.

Income Statement Projection Use to review the Income Statement totals by FSDetail
category by month. For the remaining months of the year,
it projects using the current-year budget or current-year
forecast, which you can then compare to the annual
budget.

Income Statement Summary Use to review the Income Statement totals by FSDetail
category for the current period and year-to-date compared
to budget and prior year.

Income Statement Summary-12
Month

Use to view the Income Statement totals by FSDetail
category, by month. You can also update the report to
process for any fiscal year in the database.

Income Statement Summary-Drill Use to view review the Income Statement totals by
FSDetail category for the current period and year-to-date
actual compared to budget and prior year. You can drill
down to the detail transactions for revenue, expense,
payroll data, or show a trend for each category.

Provider Income Statement Summary Use to show the Income Statement totals by FSProvider
category for the current period and year-to-date compared
to budget and prior year.
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� Payroll reports
The following reports are designed for bi-weekly payroll analysis. For examples of these reports, see
Payroll reports.

Report Description

Employee Roster Use to show employee-related information for a single
department by job code. This information is used for
budget-labor budgets.

Employee Roster – Position Control Use to show employee-related information by job code
and by employee.

Labor Distribution Use to show bi-weekly paid hours and dollars by job code,
employee, and pay category for a single pay period.

Labor Distribution Detail Use to show hours and dollars by a department, by job
code for multiple pay period, and by category of pay.

Overtime Alert Use to show highlights of overtime trends by pay period
and department.

Overtime Analysis Use to show overtime FTE-related hours by department
trended for multiple pay periods. This report is normally
processed by VP or Director.

� Provider Analysis reports (optional feature)
The following reports are designed for physician analysis.

NOTE: You can also find these same reports in the Budget Reporting section > Provider Budget >
Analysis.

For a description of each report, see Provider Budget reports.

� Report Packages
The following reports are designed for month-end or payroll electronic reporting.

Executive
For examples of these reports, see .
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Report Description

Budget Variance Rollup Use to show the current month and year-to-date Actual,
Flexible, or Fixed Budget and Prior Year values by category
in detail. This report can be processed at a rolled-up level
by Entity, VP, Director, and so on. You can use any
grouping column in dimensions for summarization.

Budget Variance Summary Use to show the expense, cost-per-unit of service, and
hours-per-unit of service variances for each department.
This report is typically run by VP to give them a summary
of the departments that have variances for the current
month.

Cover_Executive Use as the cover page for monthly Executive report
package. You can customize this report to meet your
reporting needs.

Dept Variance Rollup Use to show department variances over a chosen
threshold by category for revenue and expenses for the
current period and year-to-date. This report also contains
a monthly variance output and projection for the rest of
the fiscal year.

ExecutiveMonthly Package Use to speed up report processing and distribution by
running all of the individual executive reports and including
them in one report package.

Pay Summary by Department Use to show bi-weekly paid hours by department, by
payroll summary category trended over multiple pay
periods. This report is normally processed by VP but can
also be processed by Director, Division, and so on.

Statistic Variance Summary Use to show key statistics by department for the past four
months to show statistical trends and variances.

Top 10 Variances Use to show top and bottom ten department variances for
salaries, supplies, and other expenses.

Variance Overview Use to showmonthly variances by department, by
account that exceed the thresholds set by the system
administrator.

Manager
For examples of these reports, see.
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Report Description

AP Distribution Report (optional
feature)

Use to show themonthly Accounts Payable (AP) detail by
general ledger account by vendor, check number, and
check date.

AR Distribution Report (optional
feature)

Use to show themonthly Accrued Receipts (PO Received
Not Invoiced) detail by vendor, PO Number, line item
description, and receipt date subtotaled by general ledger
account.

Budget Variance By Department Use to show the current month and year-to-date actual,
which are then compared to the Flexible or Fixed Budget as
well as Prior Year values by category and in detail.

Cover_Manager Use to generate a cover page for monthly Manager report
package. You can customize this report to meet your
reporting needs.

Dept Monthly Package Use to run all of the individual manager reports and
distribute them in one report package

GL Distribution Report (optional
feature)

Use to show themonthly journal entry detail for each
general ledger account.

MM Distribution Report (optional
feature)

Use to show themonthly materials management issues,
including the location of issue, unit of issue, unit price,
quantity, and the amount subtotaled by general ledger
account.

Pay By Employee ID Use to show the biweekly paid hours by employee, by
payroll summary category trended over multiple pay
periods.

Pay By JobCode Use to show the biweekly paid hours by job code, by
payroll summary category trended over multiple pay
periods.

RU Report (optional feature) Use to show the current month and year-to-date Revenue
and Usage units and gross revenue by CDMCode. Units for
specific CDM can be RVUweighted to use for monthly
statistics summarization.

RU Report_Budget (optional feature) Use to show the current-month actual, budget, and year-
to-date Revenue and Usage units and gross revenue by
CDMCode. Units for specific CDM can be RVUweighted to
use for monthly statistics summarization.

Scorecard Use to show financial and ratio indicators for the chosen
department compared to budget and trend.
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Report Description

Variance Alert Use to show accounts that exceed variance thresholds for
themonth.

Package Utilities
For examples of these reports, see Report Packages - Utilities.

Report Description

Monthly All in One VP Package Use to automatically build a report packaging batch using
the database and dimensions. You may build a batch to
distribute reports based on a single dimension grouping by
another dimension grouping (For example, Dept by VP,
Manager by Director, etc.).

Monthly Manager Package Use to package and email monthly reporting packages to
managers. Each column in the report represents a
recipient, with the reports listed under each person as the
reports they receive in their monthly package.

Monthly VP Package Use to package and email monthly reporting packages to
VPs. Each column in the report represents a recipient, with
the reports listed under each person as the reports they
receive in their monthly package.

Analysis reports
These reports are designed for designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Analysis.
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� Account Analysis
Use to analyze the current month- and year-to-date variances for an individual account by department.

� Current Year Actual (CYA) Per Unit Analysis
Use to analyze year-to-date (current) per-unit amounts for Patient Revenue, Salaries, Supplies, and Other
Expenses compared to current-year budget (Budget).
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� Expense Summary by Department
Use to analyze expense variances by department.

� Key Dept Ratios
Use to analyze current month and year-to-date salary variances for an individual department. The salary
variance is broken into categories for Price, Volume, and Efficiency. A summary section is also provided
to show the components of the total variance.
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� Labor Price, Volume, and Efficiency Variances
Use to quickly analyze salaries to determine if the variances are related to rate or volume.

� Labor Summary by Department
Use to analyze labor variances by department.
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� MultiYear Statistic Review
Use to show key and non-key statistical accounts for the current-year actual and budget, prior year, and
two years ago. You can run this report for a single department or combined for multiple departments. If
is often used to confirm that the statistical basis across different years is consistent.

� Threshold Analysis
Use to analyze current month values compared to the average of the previous threemonth. You can
enter a dollar threshold. After the report is populated, you can change the view to only show the
departments that exceed the threshold. The purpose of this report is to show unusual activity or
possible missing entries in the current month.
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Balance Sheet and Cash Flow reports
These reports are designed for designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Financial Statements\Balance Sheet & Cash Flow. For instructions, see Browsing the Report
Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Financial Statements > Balance Sheet & Cash Flow.
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� Balance Sheet
Use to review and analyze the Balance Sheet values by FSDetail category across multiple years.

� Balance Sheet and Cash Flow
Use to review and analyze the Balance Sheet and Cash Flow across multiple year
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� Balance Sheet by Entity
Use to show by entity for one fiscal year across the balance sheet categories in FSDetail. You can update
the report to run for any fiscal year in the database.
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� Balance Sheet Detail
Use to show the detail accounts within each balance sheet category of FSDetail, showing last-year actual
and current-year actual.
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Reports in the Department Monthly Package
These reports are designed for month-end or payroll electronic reporting. For more information on
setting up and configuring this report package, see Configuring the Department Monthly Package report.

� AP Distribution Report (optional feature)
Use to show themonthly Accounts Payable (AP) detail by general ledger account by vendor, check
number, and check date.
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� AR Distribution Report (optional feature)
Use to show themonthly Accrued Receipts (PO Received Not Invoiced) detail by vendor, PO Number, line
item description, and receipt date subtotaled by general ledger account.

� Budget Variance By Department
Use to show the current month and year-to-date actual, which are then compared to the Flexible or Fixed
Budget as well as Prior Year values by category and in detail.

The Budget Variance by Department report also shows themonthly values by category and account. It
will fill in the remainder of the year with last year actual, current year budget, or forecast data to calculate
a year-end projection.
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� Cover_Manager
Use to generate a cover page for monthly Manager report package. You can customize this report to
meet your reporting needs.

� GL Distribution Report (optional feature)
Use to show themonthly journal entry detail for each general ledger account.
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� MM Distribution Report (optional feature)
Use to show themonthly materials management issues, including the location of issue, unit of issue, unit
price, quantity, and the amount subtotaled by general ledger account.
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� Pay By Employee ID
Use to show the biweekly paid hours by employee, by payroll summary category trended over multiple
pay periods.

� Pay By JobCode
Use to show the biweekly paid hours by job code, by payroll summary category trended over multiple
pay periods.

� RU Report (optional feature)
Use to show the current month and year-to-date Revenue and Usage units and gross revenue by
CDMCode. Units for specific CDM can be RVUweighted to use for monthly statistics summarization.
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� Scorecard
Use to show financial and ratio indicators for the chosen department compared to budget and trend.

� Variance Alert
Use to show accounts that exceed variance thresholds for themonth.
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Reports in the Executive Monthly Package
These reports are designed for month-end or payroll electronic reporting. For more information on
setting up and configuring this report package, see Configuring the ExecutiveMonthly Package report.

� Budget Variance Rollup
Use to show the current month and year-to-date Actual, Flexible, or Fixed Budget and Prior Year values
by category in detail. This report can be processed at a rolled-up level by Entity, VP, Director, and so on.
You can use any grouping column in dimensions for summarization.

The Budget Variance Rollup report also shows themonthly values by category and account. It will fill in
the remainder of the year with budget last year or forecast data to show a year end projection.
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� Budget Variance Summary
Use to show the expense, cost-per-unit of service, and hours-per-unit of service variances for each
department. This report is typically run by VP to give them a summary of the departments that have
variances for the current month.

� Cover_Executive
Use as the cover page for monthly Executive report package. You can customize this report to meet your
reporting needs.
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� Dept Variance Rollup
Use to show department variances over a chosen threshold by category for revenue and expenses for
the current period and year-to-date. This report also contains a monthly variance output and projection
for the rest of the fiscal year.

The Budget Variance Rollup report also shows themonthly values by category and account. It will fill in
the remainder of the year with budget last year or forecast data to show a year end projection.
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� Pay Summary by Department
Use to show bi-weekly paid hours by department, by payroll summary category trended over multiple
pay periods. This report is normally processed by VP but can also be processed by Director, Division, and
so on.

� Statistic Variance Summary
Use to show key statistics by department for the past four months to show statistical trends and
variances.
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� Top 10 Variances
Use to show top and bottom ten department variances for salaries, supplies, and other expenses.

� Variance Overview
Use to showmonthly variances by department, by account that exceed the thresholds set by the system
administrator.

Setup Guide Axiom Budget Planning │ 418



Income Statement reports
These reports are designed for designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Financial Statements\Income Statement. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Financial Statements > Income Statement.
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� Forecast Income Summary
Use to show the Current Year Forecast by FSDetail category compared to Current Year Budget and
Current Year Annualized.
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� Forecast Scenario Comparison
Use to show the Current Year To Date, Current Year Annualized compared to the Current Year Forecast
and Alternate Forecast.

� Income Statement By Entity
Use to show the Income Statement categories by entity for the current fiscal year.
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� Income Statement Detail
Use to show the detail accounts within each income statement category of FSDetail showing current-year
detail and last-year actual.
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� Income Statement Multi-Year
Use to review the Income Statement totals by FSDetail category across multiple fiscal years.

� Income Statement Projection
Use to review the Income Statement totals by FSDetail category by month. For the remaining months of
the year, it projects using the current-year budget or current-year forecast, which you can then compare
to the annual budget.
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� Income Statement Summary
Use to review the Income Statement totals by FSDetail category for the current period and year-to-date
compared to budget and prior year.

� Income Statement Summary-12 Month
Use to view the Income Statement totals by FSDetail category, by month. You can also update the report
to process for any fiscal year in the database.

� Income Statement Summary - Detail
Use to view review the Income Statement totals by FSDetail category for the current period and year-to-
date actual compared to budget and prior year. You can drill down to the detail transactions for revenue,
expense, payroll data, or show a trend for each category.
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Provider Income Statement reports
These reports are designed for month-end financial analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Financial Statements\Provider. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Financial Statements > Provider.
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� Provider Income Statement Summary
Use to show the Income Statement totals by FSProvider category for the current period and year-to-date
compared to budget and prior year.

Payroll reports
These reports are designed for bi-weekly payroll analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting\Payroll.
For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Payroll.
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� Employee Roster
Use to show employee-related information for a single department by job code. This information is used
for budget-labor budgets.

� Employee Roster - Position Control
Use to show employee-related information by job code and by employee.
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� Labor Distribution
Use to show bi-weekly paid hours and dollars by job code, employee, and pay category for a single pay
period.

� Labor Distribution Detail
Use to show hours and dollars by a department, by job code for multiple pay period, and by category of
pay.

� Overtime Alert
Use to show highlights of overtime trends by pay period and department.
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� Overtime Analysis
Use to show overtime FTE-related hours by department trended for multiple pay periods. This report is
normally processed by VP or Director.

Provider Analysis reports
These reports are designed for physician analysis.

NOTE: These reports are optional reports that you can purchase as an add on to your current
license.
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� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Provider Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Provider Analysis.

� Current Period vs Previous Comparison
Use to compare current period vs previous period information by provider as well as last year actual. You
can select the data type to analyze in the report.
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� Current Period vs Previous Comparison_CPT
Use to compare current period vs previous period information by CPT or CPT Summary category and last
year actual. You can select the data type to analyze in the report.

� CY Actual vs Budget Comparison
Use to compare current period and year-to-date actual vs budget information by provider and last year
actual. You can select the data type to analyze in the report.
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� CY Actual vs Budget Comparison_CPT
Use to compare current period and year-to-date actual vs budget information by CPT or CPT Summary
code and last year actual. You can select the data type to analyze in the report.

� NY Budget Comparison
Use to compare current year projections with next year's budget.

� NY Budget Comparison_CPT
Use to compare current year projections with next year's budget by CPT or CPT Summary category.
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� Provider Key Indicators By Month
Use to comparemonth-by-month values for last year, current year, and target by data type.

� Provider Key Indicators By Month_Rolling 12
Use to comparemonth-by-month values for themost recent 12months by data type
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� Provider Practice Summary
Use to analyze by provider, by practice the worked vs target productivity by provider.

� Provider Productivity
Use to analyze by provider worked vs target productivity.
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� Provider Revenue Per Encounter
Use to compare the current month to the prior three-month average for different years for revenue per
encounter.

� Provider Revenue Per RVU
Use to compare the current month to the prior three-month average for different years for revenue per
RVU.
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� Provider Revenue Per WRVU
Use to compare the current month to the prior three-month average for different years for revenue per
WRVU.

� Provider Volume by Specialty
Use to compare actual vs budget volume by data type for the current period and year-to-date,
subtotaled by provider specialty.
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� Provider Volume by Specialty_Monthly
Use to showmonthly totals by provider, for a chosen data type and year, subtotaled by provider
specialty.

Report Packages - Utilities
These reports are designed for month-end or payroll electronic packaging for distribution.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting\Report
Packages\Package Utilities. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Report Packages > Package Utilities.
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� DeptMonthlyPackage_FileCollect
Use this utility to combine all of theMonthly Manager Package reports into one file, configure the file
source and output settings and delivery method (email and/or save as a file to a directory location) for
the . If sending the report by email, you can configure the email subject line and body text, the recipient
type, and file attachment options. For more information, see Processing and distributing the
Department Monthly Package report.

� ExecutiveMonthlyPackage_FileCollect
Use this utility to combine all of the ExecutiveMonthly Package reports into one file, configure the file
source and output settings and delivery method (email and/or save as a file to a directory location) for
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the . If sending the report by email, you can configure the email subject line and body text, the recipient
type, and file attachment options. For more information, see Processing and distributing the Executive
Monthly Package report .

Running the Revenue Usage - Budget report
This reports shows the current-month actual, budget, and year-to-date Revenue and Usage units and
gross revenue by CDMCode. Units for specific CDM can be RVUweighted to use for monthly statistics
summarization.

� Accessing this report
The report is located in \Axiom\Reports Library\Management Reporting\Report Packages\Manager.
For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Report Packages > Manager.

Setup Guide Axiom Budget Planning │ 439



Financial utilities
Axiom Budgeting 2022.1 comes with a variety of standard financial reports, organized within the
following folders and subfolders.

TIP: In some reports, you can drill down to specific data to view how the values were calculated. For
more information, see Drilling data: Using Drill Down.

� Financial Current Year Forecast – Forecast Adjustment utilities
These reports are designed to post calculated values to the database. For examples of these reports, see
Current Year Forecast – Forecast Adjustment Utilities.

Report Description

Dept Specific Forecast Adjustments This is a save-to-database report used to make
adjustments to the current-year forecast at a specific
department and account level.
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Report Description

Monthly Forecast Adjustments This is a save-to-database report used to make
adjustments to the current-year forecast at an income-
statement level.

� Current Year Forecast – Forecast Processing utilities
This report is designed to post calculated values to the database. For examples of these reports, see
Current Year Forecast – Forecast Processing Utilities.

Report Description

Monthly Forecast Utility Use to calculate and post a monthly forecast for the
remaining months of the fiscal year to the database using a
variety of forecast methods.

� Financial Data Audit
This report is designed to improve the quality of data. For examples of these reports, see Data Audit.

Report Description

Standard Data Assessment Use to improve the quality of your data, keep you
compliant with Kaufman Hall standards, and save time
preparing for monthly reporting and annual budgeting.

� Financial Data Input utilities
These reports are designed as save-to-database reports for statistics and contract labor hours. For
examples of these reports, see Data Input utilities.

Report Description

Input Biweekly Contract Labor Use as an input report for biweekly contract labor hours
data collection. You enter biweekly hours and then post
them to the database from this report.

Input Monthly Contract Labor Use as an input report for monthly contract labor hours
data collection. You enter monthly hours and then post
them to the database from this report.

Input Monthly Statistics Use to input monthly statistics data collection or
calculations. You enter themonthly statistics and then
post to the database from this report.
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� Financial Data Reconciliation utilities
These reports are designed for designed for month-end close analysis. For examples of these reports, see
Data Reconciliation utilities.

Report Description

Acct Standards Review Use this report to map standardized data for accounts in
your organization to KHA Standard Class codes.

BiWeekly Payroll Reconciliation report After the payroll file is loaded, run the Biweekly Payroll
Reconciliation report.

Consolidations and Eliminations This is a save to database report that allows you to input
eliminations for your Financial database.

Dept Standards Review Use this report to map standardized data for departments
in your organization to KHA Standard Class codes.

Entity Standards Review Use this report to map standardized data for entities in
your organization to KHA Standard Class codes.

Jobcode Standards Review Use this report to map standardized data for job codes in
your organization to KHA Standard Class codes.

Monthly RevUsage Reconciliation After all data is loaded, run theMonthly RevUsage
Reconciliation. This report shows the IPVolume,
IPRevenue, OPVolume, and OPRvenue by department for
each month.

Paytype Standards Review Use this report to map standardized data for pay types in
your organization to KHA Standard Class codes.

Provider Standards Review Use this report to map standard data for providers in your
organization, such as NPI and Standard Specialty Code.

Reconcile GL to GL Transactions
report

If you load subledger detail into Axiom, such as Accounts
Payable (AP), Accrued Receipts (AR), Materials
Management (MM) and Journal Entries (JE), we have a
reconciliation utility that ties the subledger data back to
the ledger data (ACT20XX). This report confirms that the
data loaded to the GL matches the data loaded to Journal
Entry (JE) detail.

Reconcile GL to Pay12 to Pay27 report Use this report to compare the Current Year Gross
Revenue in the Financial tables to the RevUsage tables.

Reconcile GL to Rev Usage report Use to reconcile GL revenue data in the Financial tables to
the Revenue and Usage data imported into the database
on a monthly and year-to-date basis.
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� Financial Dimensions System Structure reports
These reports are designed to help you review and confirm that your dimensions coding is complete and
correct. For examples of these reports, see Dimensions System Structure reports.

Report Description

System Structure Accounts Use to show the current mapping in the ACCT dimension
table.

System Structure Departments Use to show the current mapping in the DEPT dimension
table.

System Structure JobCodes Use to show the current mapping in the JOBCODE
dimension table.

System Structure PayTypes Use to show the current mapping in the PAYTYPE
dimension table.

� Financial Dimensions Flex Budget utilities
These reports are designed to help you review and confirm that your dimensions coding is complete and
correct. For examples of these reports, see Flex Budget utilities.

Report Description

FlexBudgetSetup Use configure options for the Flex Calculator utility.

FlexCalculator by Month Use this save-to-database report to post flexible budget
calculations to the database.

� Financial Payroll utilities
These utilities are designed to post calculated values to the database. For examples of these reports, see
Payroll utilities.

Report Description

BiWeekly To Monthly Use this utility to accrue for both hours and dollars from
your biweekly payroll load (Payroll26) into themonthly
data tables (Payroll12).

BiWeekly to Monthly with LY Use this utility to post accrued biweekly hours or dollars
from the Payroll27 tables to the Payroll12 tables.

Monthly to BiWeekly Use this utility to post reverse-accrued budgeted monthly
hours from the Payroll12 tables to biweekly amounts and
post them to the Payroll27 tables for labor or productivity
reporting.
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Report Description

Monthly to GL If payroll hours are not coming through your GL Import,
you can move your hours from the Payroll12 data tables
created from the previous process to your Financial tables
by running theMonthly to GL accrual utility.

� Financial Report Batches
These reports are designed to process multiple reports for multiple outputs. For examples of these
reports, see Report Batches.

Report Description

Monthly All in One Executive
Reporting Batch

Use to run the ExecutiveMonthly Package report for
distribution.

Monthly All in OneManager
Reporting Batch

Use to run the Department Monthly Package report for
distribution.

Monthly Financial Statements Batch Use to run themonthly Financial Statements for
distribution.

Monthly Hours Accrual Batch Use to run themonthly the Hours accrual reports.

� Financial RevUsage utilities
These reports are designed to process multiple reports for multiple outputs. For examples of these
reports, see RevUsage utilities.

Report Description

Summarize CDM Statistics (optional
feature)

Use to summarize CDM values to department-level
statistics and post them to the Financial database to use as
key statistics for monthly reporting as well as budgeting.

� Financial Security Setup utilities
These reports are designed to manage user roles and permissions. For examples of these reports, see
System Setup utilities.

Report Description

Performance Reporting Security
Update

Use to configure security.
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� Financial Statistic Transfer utilities
These reports are designed as save-to-database reports for statistics. For examples of these reports, see
Statistic Transfer utilities.

Report Description

Transfer Key Stats from Fin to PR12 Use this save-to-database report to transfer statistics from
the Financial tables to the Payroll12 tables at the end of
the budget process.

Transfer Key Stats for Fin to PR26 Use this save-to-database report to transfer statistics from
the Financial tables to the Payroll27 tables at the end of
the budget process.

� Financial System Setup utilities
These reports are designed as utility reports to help you set up the system. For examples of these
reports, see System Setup utilities.

Report Description

Benchmark Used as factors in productivity reports.

CalDate Update Utility Use as a utility to help you fill out the necessary columns in
the CALDATE dimensions table. Only needed if licensed for
Daily Productivity.

FP Payor Use to assign the payors for use in the Axiom Financial
Planning product.

Names Use this table in reports or FileCollect process to look up
email, names, titles, and login information.

Payroll_Dates Used in reports to look up the pay period end date and
pay date for current year and last year. There are two
sections if your organization uses two pay cycles.

VCC_Payroll_Mapping Used by Variance Comments and other payroll utilities to
map GL accounts to job codes and/or pay types.

VCC_Threshold Used to set configure howmuch an account can vary from
budget before department managers are required to enter
comments explaining the variance

YearPeriod Used in configure the first year and month of the fiscal
year, number of work days in the current, last, and next
year, and the standard FTE hours worked by employees in
a year.
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Current Year Forecast – Forecast Adjustment Utilities
These reports are designed to post calculated values to the database.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Current Year Forecast\Forecast Adjustments. For instructions, see Browsing the Report
Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Current Year Forecast > Forecast Adjustments.

� Dept Specific Forecast Adjustments
This is a save-to-database report used to make adjustments to the current-year forecast at a specific
department and account level.
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� Monthly Forecast Adjustments
This is a save-to-database report used to make adjustments to the current-year forecast at an income-
statement level.

Current Year Forecast – Forecast Processing Utilities
This report is designed to post calculated values to the database.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Current Year Forecast\Forecast Processing. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Current Year Forecast > Forecast Processing.
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� Monthly Forecast Utility
This is a save-to-database report used to calculate and post a monthly forecast for the remaining months
of the fiscal year to the database using a variety of forecast methods.

Data Audit
This report is designed to improve the quality of data.
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� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
ReportingUtilities\Data Audit. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Data Audit.

� Standard Data Assessment
Use to improve the quality of your data, keep you compliant with Kaufman Hall standards, and save time
preparing for monthly reporting and annual budgeting. For more information, see Standardizing data.
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Data Input utilities
These reports are designed as save-to-database reports for statistics and contract labor hours.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
ReportingUtilities\Data Input. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Data Input.

� Input Biweekly Contract Labor
Use as an input report for biweekly contract labor hours data collection. You enter biweekly hours and
then post them to the database from this report.
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� Input Monthly Contract Labor
Use as an input report for monthly contract labor hours data collection. You enter monthly hours and
then post them to the database from this report.

� Input Monthly Statistics
Use to input monthly statistics data collection or calculations. You enter themonthly statistics and then
post to the database from this report. In some cases, theremay be an import for statistics that already
loads statistics on a monthly basis. You can use this report as a replacement for an import or in addition
to the statistics import.

Setup Guide Axiom Budget Planning │ 451



Data Reconciliation utilities
These reports are designed for designed for month-end close analysis and standardizing data.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Data Reconciliation. For instructions, see Browsing the Report Library.

You can also access them from the following:

l Bud Admin task pane: In the Financial Reporting section, click Financial Utilities > Data
Reconciliation.

l Mgmt Admin task pane: In theData Maintenance section, click Data Reconciliation.

� Acct Standards Review
Use this report to map standardized data for accounts in your organization to KHA Standard Class codes.

NOTE: For instructions, seeMapping KHA Standard Class codes.
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� BiWeekly Payroll Reconciliation report
After the payroll file is loaded, run the Biweekly Payroll Reconciliation report.

Using the loaded import file, total the dollars and hours from the import file, and enter the totals into the
BiWeekly Payroll Reconciliation report to see if your check totals from your import file match what was
loaded in to Axiom.

If your dollars and hours for the loaded period matches the Grand Total, the data is reconciled, and you
can move on to either loading another payroll for the current month or running the Payroll Accrual utility
to accrue your biweekly payroll to a monthly payroll.

� Consolidations and Eliminations
This is a save to database report that allows you to input eliminations for your financial database.
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� Dept Standards Review
Use this report to map standardized data for departments in your organization to KHA Standard Class
codes.

NOTE: For instructions, seeMapping KHA Standard Class codes.

� Entity Standards Review
Use this report to map standardized data for entities in your organization to KHA Standard Class codes.

NOTE: For instructions, seeMapping KHA Standard Class codes.

� Jobcode Standards Review
Use this report to map standardized data for job codes in your organization to KHA Standard Class
codes.

NOTE: For instructions, seeMapping KHA Standard Class codes.
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� Monthly RevUsage Reconciliation
After all data is loaded, run theMonthly RevUsage Reconciliation. This report shows the IPVolume,
IPRevenue, OPVolume, and OPRvenue by department for each month.

Using the import file that was loaded, total the Volumes and Revenue dollars from the import file, and
key the totals into theMonthly RevUsage Reconciliation report to see if your check totals from your
import file match what was loaded in to Axiom.

If your dollars and volumes for the period loaded matches the Grand Total, the data is reconciled. If you
use RevUsage volumes to calculate statistics for productivity, you can move forward to summarize your
IP\OP volumes from your RevUsage data table (ACT_RU_20XX) to your Financial data table (ACT20XX)
using the Summarize CDM Statistics utility.

� Paytype Standards Review
Use this report to map standardized data for pay types in your organization to KHA Standard Class
codes.

NOTE: For instructions, seeMapping KHA Standard Class codes.
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� Provider Standards Review
Use this report to map standard specialty data for providers in your organization.

NOTE: For instructions, seeMapping provider standard specialty data.

� Reconcile GL to GLTransactions report
If you load subledger detail into Axiom, such as Accounts Payable (AP), Accrued Receipts (AR), Materials
Management (MM) and Journal Entries (JE), we have a reconciliation utility that ties the subledger data
back to the ledger data (ACT20XX). This report confirms that the data loaded to the GL matches the data
loaded to Journal Entry (JE) detail. It also compares the JE Detail to AP, MM, AR transactions to make
sure the data is in balance.

TIP: Your Kaufman Hall Implementation Consultant will help you set up this report during
implementation.
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NOTE: Use the Reconcile GL to RevUsage report to reconcile your chargemaster data for Inpatient
and Outpatient between the Financial data source (ACT20XX) and the RevUsage data set (ACT_RU_
20XX). Manual adjusting journal entries outside of the source system will cause reconciling variances
to the General Ledger RevUsage data so do not use this report regularly. The report is located in the
Reports Library in theManagement Reporting Utilities > Data Reconciliation folder.

� Reconcile GL to Pay12 to Pay27 report
Use this report to compare the Current Year Gross Revenue in the Financial tables to the RevUsage
tables.

� Reconcile GL to Rev Usage report
Use to reconcile GL revenue data in the Financial tables to the Revenue and Usage data imported into the
database on a monthly and year-to-date basis. The desired result for this report is to show a zero
variance.
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Dimensions System Structure reports
These reports are designed to help you review and confirm that your dimensions coding is complete and
correct.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Dimension System Structure Reports. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Dimension System Structure Reports.
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� System Structure Accounts
Use to show the current mapping in the ACCT dimension table.

� System Structure Departments
Use to show the current mapping in the DEPT dimension table.

Setup Guide Axiom Budget Planning │ 459



� System Structure JobCodes
Use to show the current mapping in the JOBCODE dimension table.

� System Structure PayTypes
Use to show the current mapping in the PAYTYPE dimension table.
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Dimension Update utilities
These reports are designed to help you update dimension table coding.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Dimension Update Utilities. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Dimension Update Utilities.
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� Update DIM - CALDATE
Use to update the CDM dimension table.

� Update DIM - GLPERIOD
Use to update the GLPERIOD dimension table.
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� Update DIM - INITIATIVEID
Use to update the INITIATIVEID dimension table.

Flex Budget utilities
These reports are designed to post calculated values to the database.
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� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Flex Budget. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Flex Budget.

� Flex Budget Setup
Use configure options for the Flex Calculator utility.
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� FlexCalculator by Month
Use this save-to-database report to post flexible budget calculations to the database. The calculations are
based upon default assignments in the department and account dimensions as well as exceptions that
can be defined in custom tables.

Payroll utilities
These utilities are designed to post calculated values to the database.

Setup Guide Axiom Budget Planning │ 465



� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Payroll. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Payroll.

� BiWeekly to Monthly
Use this utility to accrue for both hours and dollars from your biweekly payroll load (Payroll26) into the
monthly data tables (Payroll12).

Depending on howmany years of biweekly payroll data are stored in your Axiom system, you have two
utility options:

l Biweekly to Monthly – Your organization is in their first year in Axiom and have no prior year
payroll data utilize this utility.

l Biweekly to Monthly with LY – Your organization has more than one year of historical payroll
data to capture the days of the year-end biweekly payroll that may cross over their fiscal year
utilize this utility.

In the Refresh Variables dialog, select from the following drop-downs options, and click OK:

Setup Guide Axiom Budget Planning │ 466



Option Description

Choose Year (Current Year
or Last Year

Depending on what biweekly payrolls you want to accrue, select CYA
(Current Year) or LYA (Last Year) .

Choose Payroll Sequence
(Hours, Dllrs, Stats)

Select Hours or Dllrs.

NOTE: These need to be run individually so once you run one (Hours)
you will have to then run the other (Dllrs).

Post results to the
database?

To post the results to the Axiom database, select Yes; otherwise,
select No.

TIP: Ensure that the number of FY days in First Pay Period are correct. If they are not, review the pay
period dates on the Custom Tables > Payroll tab.

In the File Processing task pane, click Process file multipass to run the utility by department and post
the values to the database. Repeat this step for the Hours by refreshing the report variables, select Hours
from the refresh variable, and then Process File multipass. If you also load statistics into you biweekly
payroll tables, you can also run this utility to move the statistics to your financial data source.
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� BiWeekly to Monthly with LY
Use this utility to post accrued biweekly hours or dollars from the Payroll27 tables to the Payroll12 tables.
The first period of the year is calculated using the final LY pay period.

� Monthly to BiWeekly
Use this utility to post reverse-accrued budgeted monthly hours from the Payroll12 tables to biweekly
amounts and post them to the Payroll27 tables for labor or productivity reporting.
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� Monthly to GL
If payroll hours are not coming through your GL Import, you can move your hours from the Payroll12
data tables created from the previous process to your Financial tables by running theMonthly to GL
accrual utility.

IMPORTANT: Only run this utility if you are not loading hours from your GL via the GL12Month or
Monthly Statistics imports.
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NOTE: Use theMonthly to BiWeekly utility to take budgeted Payroll12 data and reverse accrue it to a
biweekly data set.

Report Batches
These reports are designed to process multiple reports for multiple outputs.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Report Batches. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Report Batches.

� Monthly All in One Executive Reporting Batch
Use to run the ExecutiveMonthly Package report for distribution.

Setup Guide Axiom Budget Planning │ 470



� Monthly All in One Manager Reporting Batch
Use to run the Department Monthly Package report for distribution.

� Monthly Financial Statements Batch
Use to run themonthly Financial Statements for distribution.

� Monthly Hours Accrual Batch
Use to run themonthly the Hours accrual reports.

RevUsage utilities
This report is designed to calculate and post values to the database.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\RevUsage. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > RevUsage.
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� Summarize CDM Statistics (optional feature)
Use to summarize CDM values to department-level statistics and post them to the Financial database to
use as key statistics for monthly reporting as well as budgeting.

Security Setup utilities
These reports are designed to manage user roles and permissions.
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� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Security Setup. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Security Setup.

Managing Performance Reporting user security

Use this utility to configure security for Axiom Performance Reporting users.

NOTE: This tool is intended only for adding users, subsystems, and roles. You cannot use this utility
to remove a user from a system or role; instead, you must use the Security Manager. However, be
aware that removing users from roles or subsystems in the Security Manager will not remove the
associated filters or revoke access in most cases.

� About the utility
This utility has the following sections:

l EXISTING PERFORMANCE REPORTING USERS – Lists existing users of theManagement Reporting
subsystem

l EXISTING OTHER USERS – Lists users that exist in security but are not members of the
Management Reporting subsystem

l NEWUSERS – Allows you to add new users to theManagement Reporting subsystem
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NOTE:Please note the following about changes and saving:
l Changed rows are indicated by a green [Save] tag, as shown in the following example. This tag

indicates a change was made or an unexpected previous parameter was found and modified,
thereby creating a change.

l Changes to a username, email, or password may not trigger a save unless accompanied by
other changes, such as a change to filters, subsystems, or roles, that trigger the [Save] tag. If a
[Save] tag does not appear at the beginning of a row to which you made a change, the change
is not saved. Make the changes in the Security Manager if you are unable to make them in the
update utility.

l If a user is assigned to a product subsystem but not a role, this tool automatically assigns
them to the user role, thereby, creating a change.

l Executing the Process file option does not cause a refresh after save, so you will continue to
see the newly added record in the NEWUSERS section until you perform a refresh. Additional
changes made to the record in this section will NOT be saved, even if you click the Save button
in theMain ribbon tab to save subsequent changes unless you first refresh the utility, make
additional changes, and then save.

To configure security:
1. In the Bud Admin task pane under Financial Reporting, expand Security Setup, and then double-

click Performance Reporting Security Update.

2. In the utility, moving from left to right, edit the data in the columns as needed. Use the following
table as a guide. You can enter data into blue cells and select data from drop-downs in green cells.

NOTE: To add new users, enter them into the NEWUSERS section at the bottom of the
worksheet.
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Field Steps

LoginName The login name for the user.

If your organization uses the login information supplied by your
IT department, then the login name is auto generated.

NOTE: If you attempt to add an existing user in the NEWUSERS
section, the name and row become highlighted to let you know
that the user is already in the system. Delete the name, then
locate the user in the sections above and make changes there.

PrincipalID This entry is auto generated by the system. Do not make
changes to this cell.

FirstName Type the user’s first name.

LastName Type the user’s last name.

EmailAddress Type the user’s email address.

AuthenticationType Click the drop-down to select how the user is authenticated to
use the system.

Only Axiom Prompt
Password

If the user uses Windows authentication, then this field remains
blank. If this user uses the Axiom Prompt, then type in the user's
password.

IsSyncEnabled This information is imported from Security Manager. Do not
make changes to this cell.

UserLicenseType This information is imported from Security Manager. Do not
make changes to this cell.

IsEnabled This information is imported from Security Manager. Do not
make changes to this cell.

IsAdmin This information is imported from Security Manager. Do not
make changes to this cell.

Management Reporting
System

Do one of the following:

l To give a user access to Axiom Performance Reporting, select
TRUE.

l To rescind or deny access to a user, select FALSE.

Productivity System Do one of the following:

l To give access to the Productivity system, select TRUE.
l To rescind or deny access, select FALSE.
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Field Steps

Mgmt Reporting Role To give access to Management Reporting, from the drop-down,
select one of the following:

l Management Reporting Admin – Provides access to
Management reports, Management utilities, Dimension
maintenance, imports, scheduled jobs, and Process
Management.

l Management Reporting Analyst – In addition to user role
permissions, provides access to Axiom Explorer, scheduled
jobs, AxiomWindows Client, and User Documents folder.

l Management Reporting User – Provides access to
Management reports.

Productivity Role To give access to the Productivity module, from the drop-down,
select one of the following:

l Productivity User – Provides access to Productivity reports.
l Productivity Admin – Provides access to Productivity reports

and Productivity utilities.

Management Reporting
Physician Role

To give access, from the drop-down, selectManagement
Reporting Physician.

3. Before saving, be sure you understand how saving works in this utility. In theMain ribbon tab,
click Save.

IMPORTANT: DO NOT execute a save-as or open in a read/write mode. Structural
modifications to this tool could negatively impact your security setup.

4. In theMain ribbon tab, click Refresh Data.

Statistic Transfer utilities
These reports are designed as save-to-database reports for statistics.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Statistic Transfers. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Statistic Transfers.

Setup Guide Axiom Budget Planning │ 476



� Transfer Key Stats from Fin to PR12
Use this save-to-database report to transfer statistics from the Financial tables to the Payroll12 tables at
the end of the budget process. The statistics can then be used once they are reverse accrued into
biweekly periods for biweekly productivity.

� Transfer Key Stats from Fin to PR26
Use this save-to-database report to transfer statistics from the Financial tables to the Payroll27 tables at
the end of the budget process. The statistics can then be used once they are reverse accrued into
biweekly periods for biweekly productivity.
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System Setup utilities
These reports are designed as utility reports to help you set up the system.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\System Setup. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > System Setup.
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� Benchmark
Used as factors in productivity reports.
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� CalDate Update Utility
Use as a utility to help you fill out the necessary columns in the CALDATE dimensions table. Only needed
if licensed for Daily Productivity.

� FP Payor
Use to assign the payors for use in the Axiom Financial Planning product.
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� Names
Use this table in reports or FileCollect process to look up email, names, titles, and login information.

� Payroll_Dates
Used in reports to look up the pay period end date and pay date for current year and last year. There are
two sections if your organization uses two pay cycles.
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� VCC_Payroll_Mapping
Used by Variance Comments and other payroll utilities to map GL accounts to job codes and/or pay
types.

� VCC_Threshold
Used to set configure howmuch an account can vary from budget before department managers are
required to enter comments explaining the variance

� YearPeriod
Used in configure the first year and month of the fiscal year, number of work days in the current, last,
and next year, and the standard FTE hours worked by employees in a year.

Setup Guide Axiom Budget Planning │ 482



Browsing the Report Library
In addition to browsing the report folders in the Axiom Budgeting task panes, you can search all of the
available Axiom reports in the Reports Library.

To browse the Report Library:
1. In theMain ribbon tab, in the Reports group, click Reports > Browse All Reports.

2. In the Reports Library dialog, you can do the following:
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l To sort, group, or search by any of the columns, click the drop-down arrow next to the
column label.

l To open a report, select it from the list, and click OK.

The system includes many different reports, but you can search through them more easily by using the
following search functionality:

1. Click the down arrow beside theDocument Name column header.
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2. In theGroup By box, type a search value, and click OK.

The system will display the reports that include the value you entered in the report name.

Navigating reports
Apart from each report having an Instructions tab, Axiom Software report files do not have a standard
structure. Each report can have any number of sheets, layouts, custom views, drill-downs, GoTo targets,
quick filters, and associated task panes—all configured for the specific information that displays.

Although not all of these features are available for every report, here is an overview of common report
features:

� Instruction tab
Each report has an Instructions tab that provides an overview of its specific business purpose, features,
and steps for processing the report.

� Custom views
Custom views allow for different presentations of data within a report. For instance, a report might
default to showing monthly data but have custom views defined for displaying data by quarter or year.

NOTE: Not all reports have custom views defined.
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If custom views have been defined within a report, you can access them by doing the following:

1. In theMain ribbon tab, in theWorkbook Options group, click Change View.

2. From themenu, select the view to use.

� Quick Filter
AQuick Filter is a temporary report filter. This allows you to quickly view the data at a different level of
detail, without needing to alter the report configuration. For more information, see the following:

l Applying a Quick Filter to a report
l Using the Advanced Filter Wizard
l Understanding hierarchy-based Quick Filters

� Drills
Some reports contain rows (or columns) where the data represents a roll-up of values for multiple
database records. For instance, an income summary report might combine patient revenue for all
departments into a single total for the year, or a report on payroll by department might roll up both
regular and non-productive hours into a combined number of hours for each department. In such cases,
you can use drills to view the individual values for each item included in the roll-up.

To drill in a report, do the following:

1. In the report spreadsheet, select a cell.

2. In theMain ribbon tab, in theWorkbook Options group, click Drill.

3. From the drop-down, select any of the available drills to view a breakdown by that dimension or
value.

A new spreadsheet opens to display data at the specified drill-down level.
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NOTE: While we havemade an effort to deactivate any drill options that do not apply to a particular
row/column/cell, there are simply too many possibilities for us to deactivate every invalid drilling
method for every cell in every report. As a result, certain drill methods may produce strange results.
For themost part, common sense should imply which dimensions or values you can drill for a given
roll-up (for example, drilling by Vice President on a single department might result in a report with a
single record, as a department typically has one VP assigned to it).

� GoTo targets
GoTo targets are simply bookmarks that allow you to jump to different sections of a report. Not all
reports include GoTo targets. To navigate to a target, do the following:

1. In theMain ribbon tab, in theWorkbook Options group, click GoTo.

2. From themenu, select the GoTo target.

Refreshing a report with data
To update a report with themost current data from the database, refresh the file. A refresh does the
following:

l Updates active Axiom queries with data, according to the update settings defined for the query.
l Updates Axiom functions with data.
l Performs an Excel calculation.
l Reapplies the currently active views (if applicable).

To refresh a report with data:
Do one of the following:

l On theMain ribbon tab, in theWorkbook Options group, click Refresh Data.

l Press F9.
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The system may prompt you to define values before the refresh occurs. If so, the system applies these
values to the report to affect the data refresh.

Saving a report
When you save a report, the report file is updated in the Axiom Budgeting file system. If the report is
configured to save data to the database, a save-to-database also occurs.

To save a report:
l On theMain ribbon tab, in the File Options group, click Save.

Your file permission settings in Security determine whether you can save a particular report. If a report is
open with read/write permissions, then you can save it.

If a report is open with read-only permissions, then clicking Save opens the Save As dialog. You can save
a copy of the report to any Reports Library folder location where you have read/write permissions, or to
your My Documents folder (if applicable). A lock icon displays next to folders where you do not have
read/write permissions to any folder in that folder tree.

If you do not have read/write permissions to any folder, then when you click Save you are informed that
you cannot save the file anywhere inside the Axiom file system. Alternatively, you can save a snapshot
copy of the file, or save a copy locally using Save As (Local).

Note the following:

l Some files may use a Control Sheet setting that causes the data in Axiom functions to zero when
the file is saved. This is a security precaution that is normally enabled in reports only. You can click
Refresh to restore the data.

l You may have non-managed report files that are saved on your local computer or a network file
share. The Save option also updates these files. However, a save-to-database cannot be
performed on non-managed files.

Applying a Quick Filter to a report
Using the Quick Filter feature, you can apply a temporary filter to a report. This allows you to quickly view
the data at a different level of detail, without needing to alter the report configuration.
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For example, you may be viewing an Income Statement report for the entire consolidated organization,
and you want to view the same report at a different level of detail, such as for just North America or just
the South region. You can use the Quick Filter to recalculate the report at the desired level of detail, and
then clear the filter when you are done.

The Quick Filter is combined with your table security filters and any filters that are currently defined in
the report, such as sheet filters and filters defined for Axiom queries.

NOTE: You can also use the Quick Filter feature on file group utilities and drivers.

To apply a Quick Filter to a report:
1. On theMain ribbon tab, in theWorkbook Options group, click Quick Filter.

2. At the top of the dialog, specify how the filter should be applied:
l Workbook (default): The Quick Filter is applied to all sheets in the workbook.
l Active Sheet: The Quick Filter is only applied to the currently active sheet.
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This selection may determine which hierarchies and tables are available in the dialog to build the
filter. For more information, see Hierarchy and table availability in the Quick Filter dialog.

3. In theQuick Filter dialog, define a filter using one of the following methods:

l Data Hierarchies: Select the desired hierarchy level(s) from the hierarchies listed in the
dialog. As you select items in the hierarchy, the corresponding filter is automatically built in
the Filter box.

For example, you might have a hierarchy named Geography, which has local regions rolling
up into countries, and countries rolling up into world regions. You can select the desired
items that you want to see in the report, such as Europe, Asia, or North America as world
regions. For more information and examples, see Understanding hierarchy-based Quick
Filters.

l Manual Filter: You can manually type a filter into the Filter box using standard filter criteria
statement syntax. Fully qualified Table.Column syntaxmust be used.

l Advanced Filter: Click Advanced Filter to create a filter using any reference table columns
(not just hierarchy columns).
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For more information about general filter settings in this dialog, see Using the Filter Wizard.

NOTE: If the data in the report comes from tables that usemultiple-level hookups, then using
a hierarchy to apply a Quick Filter may not result in the intended data. Instead, you should
use the Advanced Filter to build up the filter using the appropriatemultiple-level syntax.

4. Click OK.

If the Quick Filter is applied to the entire workbook, a warning message informs you that the
entire workbook will be refreshed. If you do not want to see this message again in the future,
select Don't show this message again. Click OK to continue.

� Clearing the Quick Filter
After you have applied a Quick Filter to a report, the filter remains applied until one of the following
occurs:

l The file is closed. Quick Filters cannot be saved in the file and are always cleared when the file is
closed.
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l A newQuick Filter is applied by using theQuick Filter button and selecting a different filter.
l The Quick Filter is manually cleared. To clear the Quick Filter, click theQuick Filter button again

and then click Clear Filter.

� Hierarchy and table availability in the Quick Filter dialog
The hierarchies and tables shown in the Quick Filter dialog are based on the Axiom queries in the report.
Axiom Budgeting looks up the primary tables for the queries, and only shows the hierarchies and
reference tables that are relevant to those primary tables. This is done to help ensure that the Quick
Filter will be applicable to at least one query in the report.

If the filter applies to the entire workbook, then Axiom Budgeting looks at the primary tables for all Axiom
queries in the workbook. If the filter applies to the active sheet only, then Axiom Budgeting looks at only
the primary tables for the Axiom queries defined on the active sheet.

NOTE: In the Advanced Filter view, only reference tables are shown unless the primary table has
potentially ambiguous lookup relationships. In that case, the primary data table is also shown so
that the selections can bemade directly on these lookup relationships, to avoid any ambiguity. For
example, if the primary data table has columns PrimaryPhysician and SecondaryPhysician that both
look up to Physician.Physician, then the selection must bemade through the primary data table so
that the correct path to Physician.Physician is used.

If the report uses GetData functions instead of an Axiom query, then all hierarchies and reference tables
are listed in the dialog because Axiom Budgeting cannot determine the primary table in this context. In
this case, it is possible to define a Quick Filter that does not apply to any GetData functions in the
workbook. If this occurs, the filter will simply have no effect.

Understanding hierarchy-based Quick Filters
When you use hierarchies to create a Quick Filter, Axiom Budgeting automatically creates the filter based
on your selections. When only one item is selected, the filter is simple—only data that matches the
selected item is included. For example, if you select Asia from a Geography hierarchy, you will get a filter
something like: Dept.WorldRegion='Asia', as shown in the following example:
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NOTE: Sometimes when you select a single child item underneath a parent item, the child and parent
are joined with AND. For example: DEPT.VP='Jones' AND DEPT.Manager='Smith'. This means
that the DEPT table has other instances ofManager Smith that belong to different VPs, so the
compound statement ensures that you only get the data whereManager Smith is under VP Jones.
(You can manually edit the filter to remove the Jones portion of the statement to see all of the data
for Manager Smith, regardless of VP). If instead Axiom Budgeting constructs the filter as just
Dept.Manager='Smith', that means all instances ofManager Smith are also under VP Jones.

You can select multiple items in the same hierarchy or from different hierarchies. Items from the same
hierarchy are combined using OR, which means data matching any of the selected items is included.
Items from different hierarchies are combined using AND, which means only data that matches both
selected items is included. In the following example, we selected two items from the same grouping level
in a single hierarchy, so a simple filter criteria statement is created using IN. The resulting filter includes all
of the data from Asia and Europe.
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Next, we selected two items from different grouping levels, but within the same hierarchy. In this case, a
compound filter criteria statement is created using OR. The resulting filter includes all of the data that
belongs to Italy or US East.

Setup Guide Axiom Budget Planning │ 494



Finally, we selected two items from different hierarchies, so a compound filter criteria statement is
created using AND. The resulting filter includes only data that belongs to both US East and VP Jason
Guppy.
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Creating a new report
You can create a new report if you have read/write access to at least one folder in the Reports Library.
You can use any of themethods discussed below to create a new report. If you do not have these
permissions, then the associated menu options for creating new reports will not be available to you.

NOTE: After saving a new report to the Axiom file system, you may not see that new report displayed
in Axiom Explorer or the Reports menu until the file system has been refreshed. You can go to
Reports > Refresh file system to manually trigger a refresh and cause the new report to display.
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� Creating a new report using the Report Wizard
You can create a new report using the Report Wizard. In the wizard, you make selections regarding the
type of report that you want to create and the desired data, and then the wizard creates a report based
on your choices. You can then further modify the report as needed. For more information, see About the
Report Wizard in Help (Main ribbon tab >Help).

To create a new report using the Report Wizard:
l On theMain ribbon tab, in the Reports group, select Reports > Design Reports > Report Wizard.

� Creating a new blank report
You can create a new report from scratch using the default blank report template. This template is
entirely free-format.

If your organization has saved additional report templates, you can use those to create a new report as
well. Only administrators can create new report templates.

To create a new blank report:
l On theMain ribbon tab, in the Reports group, select Reports > Design Reports > New Report.

If your system has multiple report templates, you can select the template to use from this menu.
Otherwise, the default ReportTemplate is automatically used.

You can now use Axiom file functionality on this sheet, such as using Axiom queries to bring in data. For
more details on setting up Axiom files, see Axiom file setup in Help (Main ribbon tab >Help).

� Saving a new report
To save a new report, in the File Options group of theMain ribbon tab, click Save. When you save the
new report for the first time, you are prompted to define a file name and select a folder location in the
Reports Library. You can also define a description for the report.
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You must have read/write permissions to a folder to save a report there. A lock icon displays next to
folders where you do not have read/write permissions. If you have access to a My Documents folder,
you can also save reports there for your own use.

If you later want to change the file name, location, or description, you can use Axiom Explorer. If you do
not have rights to access Axiom Explorer, you can edit the description by using Save As (Repository)
(save the file with the same name and location, but edit the description).

You can also choose to save the report to your local drive or to a network location, by using Save As
(Local File). In this case the report is not stored in the Axiom Budgeting database and is considered to be
a non-managed file.

NOTE: Access to certain task panes (such as the Sheet Assistant) may depend on security
permissions defined at a folder level. When a new report file is created, the file location is assumed to
be the root of the Reports Library until the file is saved. Therefore access to task panes for brand new
reports depends on the user's permissions defined at the Reports Library level. If a user does not
have permission to the task panes at the Reports Library level but does have access at a sub-folder
level, then the user will not see the task panes until they save the file to that sub-folder.
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� Creating a new report based on an existing file
You can use Save As to create a new report based on a copy of an existing report. You can save the
copied file to the Reports Library, or as a local non-managed file.

You can also create a report based on an existing Excel file, by opening the Excel file in Axiom Budgeting.
To use certain Axiom file features such as Axiom queries, you must add a Control Sheet to the report. For
more information, see Control Sheets in Help (Main ribbon tab >Help). Then you can use Save As
(Repository) to save the file to the Reports Library.

Creating a new report using an existing report
Axiom Budgeting comes with a wide array of standard reports for a variety of situations, and you should
have no immediate need to create your own.

When the time comes that you require a customized report, however, Axiom Budgeting offers powerful
and flexible options for building your own reports.

When creating custom reports, you can start from scratch, or perform a Save As on a standard report
and begin customizing from there.

To create a new report using an existing report:
l To Save As, right click the report name, and select one of the following:

o To save the new report in Axiom Budgeting, select Save As (Repository).
o To save the new report outside of Axiom Budgeting, select Save As (Local File).

After you create a new report, we recommend saving it in My Files or some other location separate from
the Axiom Budgeting list of standard reports.

Working with Report Processing
Some reports support automated processing. If so, the File Processing task pane displays collapsed on
the left side of the screen when you open the report.
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By using file processing, you can automatically refresh a file, such as a report, and then perform various
actions on it. The file can be processed as-is, or you can leverageMultipass processing to cycle through
each element of a dimension or grouping, with an appropriate data filter automatically applied to each
pass.

You can use processing to perform the following actions:

l Save snapshot of file – Create a snapshot copy of the current file, and then save and/or email it.
l Print – Print the current file, using one or more print views.
l Export to delimited text file – Export data in the current file to a delimited text file, and then save

and/or email it.
l Save data – Perform a save-to-database from the current file.
l Alerts – Process alert conditions defined in the file.
l File collect – Combinemultiple spreadsheet files into a single file, and then save and/or email it.
l Batch – Perform file processing on multiple files in a batch process, including the ability to override

certain file processing settings for the file.

One common use for file processing is report distribution, which allows you to automatically deliver
report files to multiple recipients. This frequently involves using several different features of file
processing, for example:

l Multiple reports configured for snapshot file processing and using Multipass processing. For
example, an income statement processed by department, region, or VP, and creating a separate
snapshot file for each element.

l A report configured for file collect, to collect all of the snapshots into targeted report packages,
including adding things like cover sheets and other supporting information. These packages could
be saved to designated file locations and/or emailed to the appropriate recipients.

l A report configured for batch processing to run everything at once. For example, the batch would
contain an entry for each report configured for snapshot processing, and then finish with the file
collect report.

File processing is set up on a per-file basis. File processing can be set up on any Axiom file, but the
primary use case is in reports.

NOTE: To set up a report for processing, some processing actions require set up before they can be
performed. For example, to run a file collect process, the report must have a File Collect sheet
defined. For more information, see File Processing in Axiom Help (Main ribbon tab >Help).

After the file has been configured to use file processing, you can process it by using File Output > File
Processing. From this menu, you can choose to Process File or Process File Multipass. File processing
can also be performed using Scheduler and from a task pane.
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Removing reporting source files
Before running themonthly reports, we recommend that you first delete the reports that were sent out
last month. Copies of these reports are stored in the Explorer task pane, in the Financial Mgmt Utilities
> Report Distribution > Sent Files folder.

To remove reporting source files:
1. In Explorer, in the Libraries section, click Reports Library > Management Reporting Utilities >

Report Distribution > Source Files, and delete all of the files before running any batches.

2. In the Financial Mgmt Utilities > Report Distribution > Sent Files folder, make a copy for each
month, and move the reports to a monthly folder for storage.

TIP: You may also want to keep these copies off the Axiom application server and in a
designated place on your network.

Working with Variance Reporting
Variance Comments Collection automates the process ofmanagers submitting explanations for
variances between monthly budgets and actuals. In addition to collecting manager comments, Variance
Comments Collection also prompts managers to submit proposed action plans for bringing their
department's actuals in line with targets.

The Variance Comments Collection feature is implemented as an optional tab that you can include in the
Month End ReviewDashboard. This tab allows the following:

l Collect variance explanations and action plans for correction on a monthly basis.
l Enables one-stop shopping for the department manager by providing drill-downs.
l Provides a way to input variance explanations and actions plans for multiple departments at the

same time.

Configuring Variance Comments Collection
Before you can collect variance comments for a newmonth, you must do the following:

1. Set variance thresholds and alert flags.

2. Set VCC Payroll mapping.

3. Set additional data requirements

Confirm that all necessary monthly data has been loaded, the payroll accrual process has been
completed, and that periods have been set properly for the following data sources:
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Datasource Definition

Financial Monthly GL & Statistics loaded and proper period set

Payroll12 Biweekly payroll (Payroll27) accrued to Payroll12 with EMPLOYEE
NAME

l PP26to12_Hours– Act_Pay27_YYYY to Act_Pay12_YYYYHours
sequence

l PP26to12_Dollars – Act_Pay27_YYYY to Act_Pay12_YYYY Dollars
sequence

l EmpIDDesc

Use the PP27to12 utility report to filter hours properly as well as transfer employee names from
Payroll27 tables to Payroll12 tables.

Drilling Down to Detail

The following data is necessary to enable the corresponding drill-downs to detail.

l GLDetail – Journal entry transaction data imported for current period.
l GLTransactions - AP/MM/AR transaction data imported for current period.
l RevUsage –Monthly Gross Charges and Volumes by patient type (IP and OP) by CDM Code

Activating Variance Comments Collection
When activating Variance Comments Collection, you are adding the Variance Comments Collection tab
to theMonth End Review dashboard. This allows you to easily manage variance comments from one
location. After you activate the tab, see Using the Variance Comments Collection tab in theMonth End
Review dashboard.

NOTE: Before you can activate the tab, you must complete the setup steps. For more information,
see Configuring Variance Comments Collection.

To activate Variance Comments Collection:
1. Navigate to one of the following:

a. In the Bud AdminBud Admin task pane, in the Financial Reporting section, click Financial
Utilities > System Setup, and double-click VCC_Threshold.

b. In theMgmt AdminMgmt Admin task pane, in theDimension & Reference Maintenance
section, click System Setup, and double-click VCC_Threshold.

2. Click the Activate Variance Comments Collection tab on Month End Review Dashboard drop-
down and click Yes.
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3. Click Save.

Using the Variance Comments Collection tab in the Month End Review
dashboard
The Variance Comments Collection tab in theMonth End Review dashboard allows you to manage
variance comments. The tab displays as a sub-tab of the Operational Overview section within the
dashboard. For instructions on activating the tab, see Activating Variance Comments Collection.

� Applying filters
You must filter accounts before data will display.

To apply filters:
1. Click the filter icon in the upper-left toolbar.

Setup Guide Axiom Budget Planning │ 503



2. In the drop-down menus that display, click options to set your time period, target, category, filter,
and department. For more information on these filters, see Viewing and filtering theMonth End
Review dashboard.

3. In the Variance Comments Collection section, complete the following options, as needed:

Option Description

Which items do you want
to see? drop-down

Click one of the following options:

l All Items: displays all accounts.
l Show Required Comments Only: displays only the accounts

where variance comments are required based on threshold
settings.

Action Plan checkbox When checked, the tab displays the Action Plan column. The
Action Plan column displays a text box for each account where
comments are required. Use this text box to describe your action
plan in regard to the variance.

Rate Volume Variance
checkbox

This box is checked by default. When checked, the tab displays
the following columns: Rate, Volume, Efficiency, and 12mo.
Alert. The alerts are based on threshold settings.

Year-To-Date checkbox When checked, the tab displays the following columns: Current
year Actual, Last Year, Variance, Variance %, and Last Year Alert.
The alerts are based on threshold settings.
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4. Click Apply.

5. In the Variance Explanation column, type a description that explains the variance from the
previous year.

TIP: You can enter information in this column specific to the period you selected in Step 2.

6. In the Action Plan column, type the actions your organization plans on taking to address the
variance.

NOTE: This column only displays if you select the Action Plan check box in Step 3.

TIP: You can enter information in this column specific to the period you selected in Step 2.

7. After you finish making changes, click Save in the upper right corner of the page.

� Drilling down to detail
Once you apply the filters, you can drill-down to greater levels of detail. To drill down, click the blue
magnifying glass icon to see greater detail regarding the account in that row.

In the example below, we drill-down on Salaries - Overtime > all associated job codes > all associated
employees.
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NOTE: You can only access drill-downs for data that you have loaded already. For example, the
JobCode Variance drill-down will not be available if you have not loaded job code data.

� Viewing document images
AP and AR transactions may include links to supporting documentation that you can view directly in the
Variance Comments Collection tab. To view the document links, drill down to the appropriate
transaction, and click and drag the scroll bar until the Link to Image column displays. Click the icon to
open the document image.
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Running the Monthly Reporting Process
Complete the following steps to generate a monthly report for your organization:

1. Load GL 12-month data.

2. Load Monthly Statistics data.

3. Load GL Detail data.

4. Load AP Detail data.

5. Load MM Detail data.

6. Load Accrued Receipts data.

7. Reconcile GL to GL Transactions.

8. Load Revenue and Usage data.

9. Reconcile monthly RevUsage reconciliation.

10. Summarize CDM statistics to financial.

11. Load Biweekly Payroll data.

12. Reconcile Biweekly Payroll.

13. Run Biweekly to Monthly Payroll Accrual report.

14. Run Monthly to GL Accrual utility.

15. Remove reporting source files.

16. Configure the Department Monthly Package report.

17. Process and distribute the Department Monthly Package report.

18. View theMonth End Review dashboard.

Complete the following steps to generate a monthly report for your organization:

1. Load GL 12-month data.

2. Load Monthly Statistics data.

3. Load GL Detail data.

4. Load AP Detail data.

5. Load MM Detail data.

6. Load Accrued Receipts data.

7. Reconcile GL to GL Transactions.

8. Load Revenue and Usage data.
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9. Reconcile monthly RevUsage reconciliation.

10. Summarize CDM statistics to financial.

11. Load Biweekly Payroll data.

12. Reconcile Biweekly Payroll.

13. Run Biweekly to Monthly Payroll Accrual report.

14. Run Monthly to GL Accrual utility.

15. Remove reporting source files.

16. Configure the Department Monthly Package report.

17. Process and distribute the Department Monthly Package report.

18. View theMonth End Review dashboard.

Loading GL12 Month data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a GL_ prefix.

To load GL12 Month data:
1. To change the current period, in the Admin ribbon tab, in theDatabase group, click Imports &

Utilities > System Period/Year.

2. In the System Current Period dialog, in theNew Value field, type the newmonth value, and click
OK.

IMPORTANT: Do not change the System Current Year field unless changing over a new fiscal
year. Setting the system period and year could affect other Axiom Healthcare Suite products.
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3. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports,
Management Reporting> 01-Load GL 12 Months, and click Execute.

4. Click Execute.

5. In the Variables dialog, do the following, and click OK:
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Field Steps

Table: Select Table Select the ACT or BUD table.

Year Selection: Input
Year (YYYY)

Type the year to load.

6. In the Choose the import source file dialog, select the source file to load.-

If the import encounters validation errors, see Resolving import validation errors.

7. After you load the data, run the Income Statement Summary report in Explorer in Reports Library
> Management Reporting > Income Statement > Income Statement Summary to reconcile to
your GL income statement.

Loading Monthly Statistic data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a ST_prefix.

To load Monthly Statistic data:
1. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports >

Management Reporting > 02-Load Monthly Stats, and click Execute.
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2. Click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

Table: Select Table Select the ACT or BUD table.

Year Selection: Input
Year (YYYY)

Type the year to load.

4. In the Chose the import source file dialog, navigate to the location where you stored the source
file, and select it.

NOTE: We recommend that you name the file using a ST_ prefix.

If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

5. If you are not loading your statistics through an import set up by your Kaufman Hall
Implementation Consultant, then you can also load statistics using a Save to Database report.
There are standard reports delivered with your system for this, which you can find in Explorer in
Management Reporting Utilities > Data Input > Input Monthly Statistics.

6. Use the top section of the report, labeled Add New Stats, when entering a newDept-Acct
combination into the database.

Setup Guide Axiom Budget Planning │ 512



If needed, you can copy additional rows by copying the entire row, and then using the Insert
Entire Row option in Excel. If you Refresh the report, it will bring in all existing statistic
combinations from the database, and you can then update any monthly value in the blue cells in
the Change Existing Stats section.

7. After you complete your inputs, from theMain ribbon tab, click Save to send the data into the
database and save the report.

Loading AP Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with an AP_prefix.

To load AP Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

06-Load AP Detail > Execute.
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2. In the Execute Import: 06-Load AP Data dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:

Setup Guide Axiom Budget Planning │ 514



Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading GL Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a JE_prefix.

To load GL Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

05-Load GL Detail > Execute.
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2. In the Execute Import: 05-Load GL Data dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading MM Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with an MM_prefix.

To load MM Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

07-Load Materials Issues> Execute.
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2. In the Execute Import: 07-Load Materials Issues dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading Accrued Receipts data
Make sure the import file is created and saved to a directory accessible by the Axiom Application server.
We recommend naming the file with an AR_prefix.

To load Accrued Receipts data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 08-

Load Accrued Receipts > Execute.
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2. In the Execute Import: 08-Load Accrued Receipts dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading Revenue and Usage data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a RU_prefix.

To load Revenue and Usage data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 09-

Load RevUsage > Execute.

Setup Guide Axiom Budget Planning │ 521



2. In the Execute Import: 09-Load RevUsage dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

Month: Select
Current Month

In the drop-down, select themonth to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Loading GL12
Month data.

Summarizing CDM statistics to financial
To use your ChargeMaster (CDMCODE) to create your statistics, we offer a save-to-database utility that
summarizes the Inpatient and Outpatient volumes in the RevUsage database (ACT_RU_20XX) into
statistic accounts that can be stored in the Financial database (ACT20XX). For this utility to work, your
Kaufman Hall consultant will help you design your CDMCODE table during the implementation.

To summarize CDM statistics to financial:
1. To run this Save to Database utility, navigate to In the ExplorerExplorer task pane, in the Libraries

section, click the Reports Library > Management Reporting Utilities > RevUsage folder, and
double-click Summarize CDM Statistics.

2. In the drop down box in cell M19, select whether you are running the process for Current Year or
Last Year.
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3. Refresh the data by doing one of the following:

l In theMain ribbon tab, click Refresh Data.

l Press F9.

4. In the File Processing task pane, click Process file.
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NOTE: You do not need to run this utility using Multipass unless you are a large health system and
are noting performance issues when previously running.

Loading Biweekly Payroll data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
The file should be saved as LD_MMDDYY_PP. For example, LD_100418_1

To load Biweekly Payroll data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Table Current Periods.

Setup Guide Axiom Budget Planning │ 525



2. Filter using the Table Type, and select Payroll.

3. Change the period for all of the payroll tables where theUses System checkbox is not selected.
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4. In the Table Current Periods dialog, double-click the current period for the table, and type the
new period.

5. When you have finished all the tables, click OK.
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6. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 03-
Load Biweekly Payroll > Execute.

7. In the Execute Import: 03-Load Biweekly Payroll dialog, click Execute.

8. In the Variables dialog, do the following, and click OK:

Field Steps

Year Selection: Input
Year (YYYY)

Type the year to load.

PayPeriod: Input
Period (1 – 27)

In the drop-down, select the pay period to load to.
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9. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

10. If there are any import exceptions, follow the import exceptions remediation from .

Resolving import validation errors
If the import experiences import validation errors, you can view them in two places in the system: a
separate CSV file and the Execution log area of the Execute Import dialog, as shown in Step 8 of Loading
GL12Month data.

The CSV file is located in Explorer in the Imports Library > Management Reporting > Import Errors
folder.

The CSV file shows you which rows of data were invalid within the context of the import data. This error
file includes the following:

l Look up validation errors from Kaufman Hall's Software's built-in validation against lookup
columns.

l Validation errors from any Custom Data Validation steps in the transforms.

l Key validation errors such as blank keys or duplicate keys.

Setup Guide Axiom Budget Planning │ 529



You can also open the file from the Execute Import dialog by clicking the link the Status area. The status
displays either "failed" or "warning," followed by "click here to open errors in a spreadsheet." The status
type depends on whether the option to Ignore lookup and key errors is selected.

Each execution of an import that results in a lookup error generates a unique error file (differentiated by
a date/time stamp). These error files are not automatically deleted; you must manually delete them
when you finish investigating the error.

The CSV file contains the import data, followed by one or more validation columns. Validation columns
are labeled as follows:

l LookupColumnName Lookup Error column – Contains lookup and key validation messages. For
example, Acct Lookup Error"\ when looking up against the ACCT column.

l AXTRANSFORM_StepNumber column – Contains Custom Data Validation messages where
StepNumber is the number of the associated transformation step. For example, AXTRANSFORM_5
when the associated transform is step 5 in the list.

If there are errors (most commonly new codes in Dimensions), add those codes to dimensions, and re-
run the import.
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Working with the Month End Review dashboard
TheMonth End Review dashboard allows executives and managers to easily view variances between the
month/YTD plan versus actual for all of your organization all the way down to the department level. It
provides a visual summary of performance, including trends by month and Key Performance Indicators
(KPIs). Use the filter function to specify the information to display in the dashboard.

TIP: The rolling 12month charts actually display 13months of data so that you can compare the
current period with the same period last year.

� Summary tab
The Summary tab is the first tab that displays in the dashboard. It provides a visual representation of
actuals versus target, grouped into Revenue, Labor, and Expense categories. This tab provides KPI
visibility into all of your departments for the current period and year.

NOTE: The page will only include those departments in which you have permissions to view.

To view the statistic and per-unit KPI information at the department-level, go to the Operational
Overview tab.

To see a chart of rolling 12months actuals, click the chart icon in the upper left corner of each box.
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� Executive Overview
The Executive Overview tab displays summary-level revenue, expense, and statistics information for all
the departments in your organization.

To see a chart of rolling 12months actuals, click the chart icon in the upper left corner of each box.

You can also toggle between viewing the data for the period or YTD.

� Revenue Overview and Expense Overview tabs
The Revenue Overview and Expense Overview tabs work similarly by displaying the following sections for
revenue and expenses:
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l Income Statement Summary – Shows the actuals, targets, variance, and variance percentage for
inpatient revenue, outpatient revenue, other patient revenue, other revenue, and non-revenue
categories. As you click each category, the Top 10 Favorable and Unfavorable sections list the
departments that make up those values. For example, if you click Inpatient Revenue, the Top 10
Favorable and Unfavorable inpatient departments display.

l Top 10 Favorable Variances – Shows the top ten departments with the highest positive variance
(actuals minus target) by department, actual, target, and variance.
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l Top 10 Unfavorable Variances - Shows the top ten departments with highest negative variance
(actuals minus target) by department, actual, target, and variance.

For each department in the Top 10 Favorable and Unfavorable sections, click the department
chart icon to see a rolling 12months of actuals as well as the actuals, target, and variance listed by
account.

You can also access the ExecutiveMonthly Package from either tab.

� Statistical Overview tab
The Statistical Overview tab shows a list of key statistics by department for the selected month and year.
This tab shows:

l Prior month, two month, and threemonth data
l Four month average
l Variance to the prior month
l Variance to the four month average
l Current target (3Month Average, Last Month, or SameMonth Last Year)
l Variance to target

By using the filter function, you can filter the data by:
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l Target - Select the target of either Budget, 3Month Average, Last Month, or SameMonth Last
Year

l Category - Select VP, Director, Manager, Budget Group, Division, Dept (RPTMap).
l Time Period - Select a month and year.

You can also sort the data by either the Variance to Prior Month, Variance 4month Average, or Variance
to Target column as well as export the data to Excel.

� Operational Overview
The Operational Overview tab allows you to view the details regarding how a department is performing
by providing data regarding KPIs, patient revenue, expenses, labor, and benefits. This tab includes the
following sub-tabs:

� KPI tab
The KPI tab displays a visual representation of actuals versus target, grouped into Revenue, Labor, and
Expense categories. This tab provides KPI visibility into a department for the current period and year.
You can also access the Dept Monthly Package from this tab.
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� Patient Revenue tab
The Revenue tab displays inpatient and outpatient revenue, broken out by rate and volume variance.

To view the 12-month revenue trend and details, click the Inpatient Revenue and Outpatient Revenue
boxes.

To view actuals for the period or Year to Date, click the Period/YTD toggle in the upper right corner of the
page.
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� Other Revenue
The Other Revenue displays other patient, operating, and non-operating revenue. Click the boxes to
view the 12-month revenue trend for the associated revenue category.

� Labor tab
The Labor tab displays an overview of labor expenses excluding benefits. This tab shows salaries, the
average hourly rate, FTEs, and the paid hours per unit. The tab also shows the salary and hour details as
well as KPIs.
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� Benefits tab
The Benefits tab displays benefit information including benefits, percentage of salaries, rate per FTE, and
benefits per unit. The tab also displays details for each benefit type as well as KPIs.
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� Other Expenses tab

Supplies view

Other Expenses view
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Variance Comments Collection

� Drilling data
Some line items display a magnifying glass icon next to them. This indicates that you can drill for more
information regarding that line item. Some drills includemultiple layer of drills, depending on the types
of data available.

To open a drill, double-click themagnifying glass icon. The system opens a separate tab with the drill
information. Click the X in the tab to close the drill.
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Viewing and filtering the Month End Review dashboard
To view the Month End Review dashboard:

1. In theMgmt Reporting orMgmt Admin task pane, in the Performance Reporting section,
double-clickMonth End Review.

2. To filter the data for the dashboard, in the upper left tool bar, click the funnel icon.

3. Complete the following filter options, as needed:

Option Description

Time Period Select the period and year.
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Option Description

Target (All Except
Statistical)

Select one of the following target types:

l Budget
l Flex
l 3Month Average
l Last Month
l SameMonth LY
NOTE: This filter does not apply to the Executive Overview > Statistical
Overview tab.

Category & Filter
(Summary &
Executive)

a. From the Select Category drop-down, select the organization
level in which to view data. For example, to view all of the
departments and accounts at the VP level, select VP.

b. From the Select Filter drop-down, select the filter created by
your organization.

NOTE: This filter only applies to the Summary and Executive Overview
tabs.

Target (Only
Statistical)

Select one of the following target types to filter the data in the
Executive Overview > Statistical Overview tab:

l Budget
l 3Month Average
l Last Month
l SameMonth LY

Dept (Only
Operational)

Select the department to filter the data in the Operational Overview
tab.

NOTE: The drop-down list includes more departments than what the
system displays. To include a specific department, we recommend
just typing the department number into the field. Also, note that the
list only includes those departments assigned to you.

4. Click Apply.

Working with the Budget Assessment Dashboard
The Budget Assessment dashboard allows you to compare a department's proposed budget for next
year with internal and external peer groups.

NOTE: This feature requires a license for Axiom Comparative Analytics.
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� Opening the dashboard
Users must be assigned either the Budget Admin or Budget User role plus the Comparative Analytics -
Dept role to use the dashboard.

To open the dashboard:
In the Budgeting or Bud Admin task pane, in the Budget Reporting section, double-click Budget
Assessment.

Location of dashboard in Budgeting task pane

Location of dashboard in Bud Admin task pane

� Using the dashboard
The dashboard is comprised of the following areas:
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Filters
Do any of the following:

l Configure the criteria to include in the dashboard by selecting the filter criteria options in the drop-
downs, and click Apply.

l To clear a filter criteria option, click the X next to the drop-down.
l To clear all the filter criteria options, click Clear All.

The filter criteria detail you select also display above the tabs.

Tabs
Budget comparison data is segmented into four areas: Summary, Labor, Non-Labor, and Other
Expenses. Click any of the tabs to view the data comparison charts and KPIs.

Data Controls
The section below the tabs and above the data charts includes controls that allow you to customize the
report data.

Graph and data view

Toggle between viewing graphical and detailed data.
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These categories listed are the same for both the graph view and the data view.

Period

Select the period in which to view data.

Percentiles

Select the percentiles to use to display the dollar variance between each of the percentiles in the KPI
section of the dashboard and determine what data displays in the charts.

External and internal comparison

Select to compare data against peers outside of your organization (External) or your department
(Internal). This only applies to the KPI section.

Graphs
The graph view displays by default and compares the budget areas against performance of peers
(external) and your department (internal) across percentiles. The horizontal bars show how the
department selected in the filter and the peer data compare to the current, 3-month, and next year

Setup Guide Axiom Budget Planning │ 545



budget's percentages.

To view the detailed data behind this graph, click themagnifying glass icon in the upper right corner of
the screen. This opens theMetric Explorer dashboard. For more information, seeWorking with the
Metric Explorer dashboard.

Key Performance Indicators (KPIs)
The KPI boxes, to the right of the graphs, display the dollar variance between each of the percentiles
selected at the top of the report. You can customize the percentiles and the time period used for
calculations using those drop-down menus.

NOTE: The system shows the variance between the actuals (rather than budget) and each of the
percentiles.

Click the graph icon in the upper-right corner of the KPI card to display a detailed graph of the percentiles
and actuals over the last year.

Setup Guide Axiom Budget Planning │ 546



Working with the Metric Explorer dashboard
TheMetric Explorer dashboard allows you to evaluatemonthly and annual performance of key metric
areas for business segments and provides a deeper analysis of data that displays in the Budget
Assessment dashboard.

� Using the dashboard
The dashboard is comprised of the following areas:

Filters
Do any of the following:

l Configure the criteria to include in the dashboard by selecting the filter criteria options in the drop-
downs, and click Apply.

l To clear a filter criteria option, click the X next to the drop-down.
l To clear all the filter criteria options, click Clear All.

The filter criteria detail you select also display above the tabs.
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Tabs
Data metrics are segmented into several categories and sub-categories. Click a drop-down menu
category, and click a sub-category to display the data for that element.

Key Performance Indicators (KPIs)
TheMetric Explorer dashboard displays Key Performance Indicators (KPI) data in the form of cards,
which includes the following visual indicators and data points:

An arrow communicates month-over-month change. An up arrow indicates that the current
month has improved over the previous month. A down arrow indicates that the current month
worsened over the previous month. The large text next to the arrow displays the title of the
metric title and the text below displays themetric description.
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An alert icon indicates a visual representation of budget variance performance.

- Favorable variance to budget

-Within a 0%-5% threshold of budget

- Unfavorable variance by >5% to budget

The first line in this section details the actuals for the period selected. The second line displays
the percentile rank for the selected period. The text indicates if the percentile is rising (higher
rank than the previous period), steady, or falling (lower rank than the previous period).

Click the icon to viewmore information comparing your organization's KPI ranking among your
peer group.

A graph displays a 12-month trend from themost recent period of data available.

This area displays the budget variance percentage.

The indicator in the lower-right corner of the KPI provides you with the year-over-year (YoY)
percentage change value. An up arrow indicates that the current year has improved over the
previous year. A down arrow indicates the current year has worsened over the previous year.

Click the KPI card to view different charts associated with the data. When the chart view is activated, the
card displays a black background. Beneath the cards, the dashboard provides three different chart view
options in which to view the card data. Hover your cursor over each dot in any of the graphs to view the
percentage details. To exit the chart view, click the card again.
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Understanding the Executive Monthly Package
To help speed up report processing and distribution, you can generate executive-level reports by using
the ExecutiveMonthly Package, which combines all of the individual reports into one file. Each tab in the
workbook represents a different report.
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You can then process and email the report to the appropriatemanagement personnel and attach the
report file or a link to a directory. You can run the report generation process manually or set up a
Scheduler job to process the reports automatically at certain times of themonth.

For descriptions of each report included in the ExecutiveMonthly Package, see Reports in the Executive
Monthly Package.

Configuring the Executive Monthly Package report
Use this utility to select and combine themultiple executive reports into a single report, which you can
then distributemultiple ways - including sending an email with the attached report or a link to the
directory where the report is stored. For a description of each report included in this package, see
Reports in the ExecutiveMonthly Package.

To configure the Executive Monthly Package report:
1. Navigate to one of the following:

l In theMgmt Admin task pane, in theManagement Reporting section, click Executive, and
double-click Executive Monthly Package.

l In theMgmt Report task pane, in the Performance Reporting section, click Executive, and
double-click Executive Monthly Package.

2. Refresh the data by doing one of the following:
l In theMain ribbon tab, click Refresh Data.

l Press F9.

3. Complete the following refresh variables, and click OK:

Option Description

Select Time Comparison Select Budget , Flex, 3 Mth Avg, Last Month, or Last Year.

Select Method for
Projection Option in
Trend Reports

Select to populate the projection months by Budget, Current
Year Forecast, or Last Year Actuals.

Choose Rollup Level Select to run the report by VP or Director.
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Option Description

Pick Director/VP Select a Director or VP, depending on the option selected from
the Choose Rollup Level drop-down. To return the data for all,
leave the field blank. Leave the field blank to view all data.

Fiscal Year (optional) Select the fiscal year to include in the report.

Fiscal Period (optional) Select themonth to include in the report (based on the year you
selected in the Fiscal Year field).

Pay Period (optional) Select the pay period to include in the report (based on the year
you selected in the Fiscal Year field).

4. To specify the reports to output data in this batch report, do the following:
l To output data for a report when processing, type an X in the cell next to the report name.

By default, an X displays next to each report name.
l To exclude a report from generating data when processing, clear the X from the cell.

IMPORTANT: When you run the batch report on your screen, the system processes the
data for the reports and displays each report as a tab—even those where you have
removed the X. However, when you actually process the batch report, the system will
not include any data in those reports where you have removed the X, though the tab
still displays.

5. In the Configuration section, do the following:
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Option Description

File Prefix Displays the year and month selected in the refresh variables
selected in Step 3. You can edit this field, as needed. The prefix
name is followed by the executive level and name. For example,
Feb-2017VPSallyKlein.

Dept Variance Threshold Type the variance percentage to use in the trend-based reports.

Select Hours Code for
Dept_Variance and Dept_
Trend

Select the code used for hours accounts.

6. There aremultiple ways to generate and distribute the report package, depending on your need.
For more information and instructions, see Processing and distributing the ExecutiveMonthly
Package report.

Processing and distributing the Executive Monthly Package report
This topic covers the ways in which you can process and distribute the ExecutiveMonthly Package report
to executive personnel. To configure the reports to include in the package and the reporting variables,
see Configuring the ExecutiveMonthly Package report.

NOTE: Before processing this report package, you may consider removing the reports from last
month. For instructions, see Removing reporting source files.

� File collect
The ExecutiveMonthlyPackage_FileCollect utility allows you to process and distributemultiple Executive
Monthly Package reports to multiple people using one tool. You can configure the file source and output
settings and delivery method (email and/or save as a file to a directory location). If sending the report by
email, you can configure the email subject line and body text, the recipient type, and file attachment
options.

TIP: If you use file collect, you can add it to theMonthly All in One Executive Reporting batch control
sheet, which allows you to automate the process of
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To process and distribute package reports using the file collect:
1. From Axiom Explorer, in the Libraries section, click Reports > Management Reporting > Report

Packages > Package Utilities, and double-click ExecutiveMonthlyPackage_FileCollect.

2. Complete the following options in the Source and Output Settings section:
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Option Description

Source file name prefix Edit the source file name prefix, if needed.

Output file name suffix
(no extension)

Edit the file name for report.

Output file location Enter the location in which to save the generated report file(s).

3. Complete the following options in theDelivery Methods section:

Option Description

Assemble by Select the executive level in which to generate and distribute the
report package.

Save or email generated
files

Select one of the following:

l To save the report file(s) to a directory, select Save File.
l To include the report file(s) as attachment(s) or a link to a

directory where the files are stored in an email, select Email
File.

l To save the report file(s) to a directory and send an email,
select Save File and Send Email.

4. If you select email or save file and send email as the output option, complete the Email Settings
section:

Option Description

Subject text Type the subject line text for the email.
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Option Description

Body text Type the body text to include in the email.

Recipient Select the recipient type in which to send the reports.

Attach file to email Select one of the following:

l To attach the report file(s) to the email, select Yes.
l To include a link to the directory location for the report file

instead of attaching a file, click No.

Attach each file
separately

NOTE: This option does not display if you select the Save File
and Send Email option in step 3.

Select one of the following:

l To include the packaged reports into a single report file with
tabs for each report, click Off.

l To generate the packaged reports as individual report files,
click On.

5. After making your changes, in theMain ribbon tab, click Save.

NOTE: The system will prompt you to save your settings as a new file. This allows you to create
multiple setting versions, if needed.

6. In the Save As dialog, type a name for the file, and click Save.

7. When you are ready to process the report, in theMain ribbon tab, click Publish > File Processing
> Process File Multipass. For more information, see Running file processing on an Axiom file.

� Executive Monthly Package utility
You can also process and distribute the report package directly from the ExecutiveMonthly Package
utility. This option is useful when generating one-off packages to just a few people or for someonewants
a variant of the reporting package outside of your normal regularly scheduled process.

To process and distribute package reports using the Executive Monthly Package utility:
1. Open the ExecutiveMonthly Package utility, and make any necessary report or variable

configuration changes, including selecting the executive-level personnel to receive the report.

2. From the Select How To Process the Files drop-down, select one of the following:

l To save the report, select Save Files. By default, the file saves to the following output
folder: \Axiom\Reports Library\Management Reporting Utilities

l To email the files, select Email Files. The report outputs to the recipient email addresses
listed in the Email Settings/Groupings section of this report.
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l To save and email the report, select Save and Email files.

3. If emailing the files, in the Email Settings/Groupings section, do the following:

Option Description

Recipient Email Address Displays the email addresses the report will be sent to.

NOTE: Email addresses are derived from the security profile for
the user.

Subject Line Edit the content for the email subject line, as needed.

Body Text Edit the content for the email body text, as needed.

4. When you are ready to process the report, in theMain ribbon tab, click Publish > File Processing
> Process File Multipass. For more information, see Running file processing on an Axiom file.

� Batch processing and Scheduler
Another way to process the report package is to use a report batch control sheet, which allows you to
process multiple reports simultaneously. The system comes preloaded with theMonthly All in One
Executive Reporting Batch control sheet, which is pre-configured with the settings needed to run the
ExecutiveMonthly Package for both the VP-level and Director-level reports, but you can change these
settings if needed. After you have set up the batch control sheet, you can then perform a file process.

TIP: To make generating the report package even easier, you can configure a Scheduler job to
process the batch control sheet for a specific date and time. By default, theMonthly All in One
Executive Reporting batch control sheet does not include the ExecutiveMonthlyPackage_FileCollect
utility because not all organizations use file collect. However, you can also automate the process of
distributing the report by adding the file collect utility to the batch control sheet.

To process and distribute package reports using batch processing and Scheduler:
1. Open the ExecutiveMonthly Package utility, and make any necessary report or variable

configuration changes.

2. To include the file collect in the batch control sheet, open the file collect utility, and make any
necessary changes.
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3. In theMgmt Admin task pane, in the Financial Reporting Batches section, click Report Batches,
and double-clickMonthly All in One Executive Reporting Batch.

4. Update the batch control sheet, as needed, including adding the file collect utility location to
generatemultiple reports for multiple people. For more information, see the following:

l For configuring the Batch tab, see Batch Control Sheet.
l For an overview of file processing and how it works, see File processingFile Processing.

5. To process the batch, you can do one of the following:
l In the batch control sheet, click File Processing > Process File.
l Create a Scheduler job to process the report the package, if desired. For more information,

see Batch processing using Scheduler.

Understanding the Department Monthly Package
To help speed up report processing and distribution, you can generatemanager-level reports by using
the Department Monthly Package, which combines all of the individual reports into one file. The
Department Monthly Package allows management personnel to view department performance against a
static or flexible budget and against prior year’s performance and Enables one-stop shopping for the
department manager by providing the department’s overall performance as well as reports with the
detail transactions that support the expenses on the Summary reports. Each tab in the workbook
represents a different report.

The purpose of the this package is to understand financial performance and find opportunities for
improvement where possible. In this section, we describe the financial review process in two steps and,
in each section, provide an overview of the reports available in the Department Monthly Package to
complete the analysis:

l Analysis ofMonthly General Ledger (Account-level) data
l Additional Analysis of Labor (Salary Expenses and FTE amounts)
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You can then process and email the report to the appropriatemanagement personnel and attach the
report file or a link to a directory. You can run the report generation process manually or set up a
Scheduler job to process the reports automatically at certain times of themonth.

For descriptions of each report included in the Department Monthly Package, see Reports in the
Department Monthly Package.

NOTE: Before running the report package, you may need to update the imported data used in the
reports. For more information, see Preparing data for budget go-live .

Configuring the Department Monthly Package report
Use this utility to select and combine themultiple management reports into a single report, which you
can then distributemultiple ways - including sending an email with the attached report or a link to the
directory where the report is stored. For a description of each report included in this package, see
Reports in the Department Monthly Package.

Before generating this report package, you may consider removing the reports from last month. For
instructions, see Removing reporting source files.

To configure the Department Monthly Package report:
1. Navigate to one of the following:

l In theMgmt Admin task pane, in theManagement Reporting section, clickManager, and
double-click Dept Monthly Package.

l In theMgmt Report task pane, in the Performance Reporting section, clickManager, and
double-click Dept Monthly Package.
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2. Refresh the data by doing one of the following:
l In theMain ribbon tab, click Refresh Data.

l Press F9.

3. Complete the following refresh variables, and click OK:

Option Description

BudVar Report ONLY - Select Comparison
Time Series

For comparing to actual amounts within the
reports, select either Budget (Static Budget)
or Flex (Flex Budget).

BudVar Report ONLY - Populate Remaining
Months with...

To populate remaining months in your trend
report, select Budget (Static Budget), Current
Year Forecast, or Last Year Actuals(Flex
Budget).

Choose Department Rollup Select the department to include in the
report.

Fiscal Year (optional) Select the fiscal year to include in the report.

Fiscal Period (optional) Select themonth to include in the report
(based on the year you selected in the Fiscal
Year field).

Pay Period (optional) Select the pay period to include in the report
(based on the year you selected in the Fiscal
Year field).

4. To specify the reports to output data in this batch report, do the following:
l To output data for a report when processing, type an X in the cell next to the report name.

By default, an X displays next to each report name.
l To exclude a report from generating data when processing, clear the X from the cell.

IMPORTANT: When you run the batch report on your screen, the system processes the
data for the reports and displays each report as a tab—even those where you have
removed the X. However, when you actually process the batch report, the system will
not include any data in those reports where you have removed the X, though the tab
still displays.
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5. In the Configuration section, do the following:

Option Description

File Prefix Displays the year and month selected in the
refresh variables selected in Step 3. You can
edit this field, as needed. The prefix name is
followed by the executive level and name.
For example, Feb-2017SallyKlein.

Configured Comparison Period for BudVar
Tab

Select one of the following:

l Current Year Budget (CYB)
l Flex Budget (FLX)

Select Other Comparison Period for BudVar
Tab

Select one of the following:

l Last Year Actuals (LYA)
l Current Year Budget (CYB)

Trend - Remaining Yr Months for BudVar Tab Select one of the following:

l Current Year Forecast (CYF)
l Current Budget (BUD)
l Last Year Actuals (LYACT)

6. There aremultiple ways to generate and distribute the report package, depending on your need.
For more information and instructions, see Processing and distributing the Department Monthly
Package report.
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Processing and distributing the Department Monthly Package report
This topic covers the ways in which you can process and distribute the Department Monthly Package
report to executive personnel. To configure the reports to include in the package and the reporting
variables, see Configuring the Department Monthly Package report. The Department Monthly Package
report may also be referred to as theManager Monthly Report.

NOTE: Before processing this report package, you may consider removing the reports from last
month. For instructions, see Removing reporting source files.

� File collect
The DeptMonthlyPackage_FileCollect utility allows you to process and distributemultiple Department
Monthly Package reports to multiple people using one tool. You can configure the file source and output
settings and delivery method (email and/or save as a file to a directory location). If sending the report by
email, you can configure the email subject line and body text, the recipient type, and file attachment
options.

TIP: If you use file collect, you can add it to theMonthly All in OneManager Reporting batch control
sheet, which allows you to automate the process of

To process and distribute package reports using the file collect:
1. From Axiom Explorer, in the Libraries section, click Reports > Management Reporting > Report

Packages > Package Utilities, and double-click DeptMonthlyPackage_FileCollect.
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2. Complete the following options in the Source and Output Settings section:

Option Description

Source file name prefix Edit the source location, if needed.
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Option Description

Output file name suffix
(no extension)

Edit the file name for report.

Output file location Enter the location in which to save the generated report file(s).

3. Complete the following options in theDelivery Methods section:

Option Description

Assemble by Select themanagement level in which to generate and distribute
the report package.

Save or email generated
files

Select one of the following:

l To save the report file(s) to a directory, select Save File.
l To include the report file(s) as attachment(s) or a link to a

directory where the files are stored in an email, select Email
File.

l To save the report file(s) to a directory and send an email,
select Save File and Send Email.

4. If you select email or save file and send email as the output option, complete the Email Settings
section:
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Option Description

Subject text Type the subject line text for the email.

Body text Type the body text to include in the email.

Recipient Select the recipient type in which to send the reports.

Attach file to email Select one of the following:

l To attach the report file(s) to the email, select Yes.
l To include a link to the directory location for the report file

instead of attaching a file, click No.

Attach each file
separately

NOTE: This option does not display if you select the Save File
and Send Email option in step 3.

Select one of the following:

l To include the packaged reports into a single report file with
tabs for each report, click Off.

l To generate the packaged reports as individual report files,
click On.

5. After making your changes, in theMain ribbon tab, click Save.

NOTE: The system will prompt you to save your settings as a new file. This allows you to create
multiple setting versions, if needed.

6. In the Save As dialog, type a name for the file, and click Save.

7. When you are ready to process the report, in theMain ribbon tab, click Publish > File Processing
> Process File Multipass. For more information, see Running file processing on an Axiom file.

� Dept Monthly Package utility
You can also process and distribute the report package directly from the Dept Monthly Package utility.
This option is useful when generating one-off packages to just a few people or for someonewants a
variant of the reporting package outside of your normal regularly scheduled process.

To process and distribute package reports using the Dept Monthly Package utility:
1. Open the Dept Monthly Package utility, and make any necessary report or variable configuration

changes, including selecting themanagement-level personnel to receive the report.

2. From the Select How To Process the Files drop-down, select one of the following:

l To save the report, select Save Files. By default, the file saves to the following output
folder: \Axiom\Reports Library\Management Reporting Utilities
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l To email the files, select Email Files. The report outputs to the recipient email addresses
listed in the Email Settings/Groupings section of this report.

l To save and email the report, select Save and Email files.

3. If emailing the files, in the Email Settings/Groupings section, do the following:

Option Description

Select the Recipient Role Select the role type of the email recipient.

Recipient Email Address Displays the email addresses the report will be sent to.

NOTE: Email addresses are derived from the security profile for
the user.

Subject Line Edit the content for the email subject line, as needed.

Body Text Edit the content for the email body text, as needed.

4. When you are ready to process the report, in theMain ribbon tab, click Publish > File Processing
> Process File Multipass. For more information, see Running file processing on an Axiom file.

� Batch processing and Scheduler
Another way to process the report package is to use a report batch control sheet, which allows you to
process multiple reports simultaneously. The system comes preloaded with theMonthly All in One
Manager Reporting Batch control sheet, which is pre-configured with the settings needed to run the
Department Monthly Package for multiple management-level reports, but you can change these settings
if needed. After you have set up the batch control sheet, you can then perform a file process.

TIP: To make generating the report package even easier, you can configure a Scheduler job to
process the batch control sheet for a specific date and time. By default, theMonthly All in One
Manager Reporting batch control sheet does not include the DeptMonthlyPackage_FileCollect utility
because not all organizations use file collect. However, you can also automate the process of
distributing the report by adding the file collect utility to the batch control sheet.

Setup Guide Axiom Budget Planning │ 566



To process and distribute package reports using batch processing and Scheduler:
1. Open the Dept Monthly Package utility, and make any necessary report or variable configuration

changes.

2. To include the file collect in the batch control sheet, open the file collect utility, and make any
necessary changes.

3. In theMgmt Admin task pane, in the Financial Reporting Batches section, click Report Batches,
and double-clickMonthly All in One Executive Reporting Batch.

4. Update the batch control sheet, as needed, including adding the file collect utility location to
generatemultiple reports for multiple people. For more information, see the following:

l For configuring the Batch tab, see Batch Control Sheet.
l For an overview of file processing and how it works, see File Processing.

5. To process the batch, you can do one of the following:
l In the batch control sheet, click File Processing > Process File.
l Create a Scheduler job to process the report the package, if desired. For more information,

see Batch processing using Scheduler.

Opening Manager reports
To open Manager reports:

1. In theMain ribbon tab, click Open App Menus, and clickManagement Reporting.

2. In theMgmt Report task pane, click Department Manager:
l Mgmt Report displays on the task bar tab to indicate that theManagement Reporting task

pane is open.
l The term Performance Reporting is used synonymously with Management Reporting.
l The task pane lists all of the reports listed within the Department Management folder.
l The Dept Monthly Package includes each individual report as a tab for a selected

department.
l To open a report, double-click the report name.
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Understanding financial performance
The purpose of themonthly financial package is to understand financial performance and find
opportunities for improvement where possible. In this guide, we describe the financial review process in
two steps and, in each section, provide an overview of the reports available in theManager Monthly
Report Package to complete the analysis:

l Analysis ofMonthly General Ledger (Account-level) data
l Additional Analysis of Labor (Salary Expenses and FTE amounts)

Understanding Monthly Variance Analysis
Monthly Variance Analysis is focused on departmental volumes and all expenses. While this also includes
Salary related expenses and FTEs, further analysis is often completed for these items by reviewing the bi-
weekly the reports in the Labor Analysis section.

Steps and questions for reviewing monthly general ledger data:

1. Reviewmonthly financial data for variances and determine cause of variances. Then, analyze
whether variances will continue, could have been prevented, or were strategic (such as “bulk buy
to reduce total costs”).

2. Reviewmonthly financial data for positive and negative trends.
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A focus on expense per unit (also known as per key statistic) values in volume-sensitive areas is
particularly useful to determine if any expense variances are caused by a volume variance, a rate or cost
variance, or related to efficiency. For example, if an expense line item is showing a variance and the actual
expense per unit equals the budgeted expense per unit, this situation is considered a Volume variance.
However, if the line item’s actual expense per unit is higher than the budgeted expense per unit, volume
cannot be the cause of the variance. In this case, you would determine the following:

l Is the price we are paying for the supply or service higher than budgeted causing a Rate variance?
If so are there ways to lower the price? Or was this an unexpected cost increase that will cause a
budget variance for the rest of the year?

l Are we using more of the supply or service on a per unit basis than planned causing an Efficiency
variance, or

l Is there a combination of the circumstances above causing the variance to be attributed to both
Rate and Efficiency?

In each case, why is this occurring and can we get a lower price or use the resourcemore efficiently?

The following tools in theManager Monthly Package can be used for this review:

� Cover
The Cover tab is the first sheet that displays within the Dept Monthly Package. It is also included as part
of theManager’s month-end distributed package.

This sheet provides general information such as the current reporting period and type of information
provided within each report.
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� Scorecard
The Scorecard report shows Key Financial and Ratio Indicators. It provides an overview of departmental
performance, and highlights areas requiring further review.
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� Scorecard Detail report (SCDetail)
The Scorecard Detail report (SCDetail) shows actual versus budget information and flags the areas
requiring variance comment input explanations within the Axiom Variance Comments Collection module.

Note that some additional details can be derived from this report, we can now answer some of the
questions posed within the Variance Items to Note box from the previous Scorecard section:

l Salaries are over due to Contract Labor; only benefits were budgeted in this department.

l In Other Expenses, the $6,000 unfavorable variance was spent on Recruitment.
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� Variance Alert report (VarAlert)
The Variance Alert (VarAlert) report provides the following:

l Variance by individual account lines provide further detail. If your organization uses the Variance
Comments Collection (VCC) tool, this report highlights which accounts require a variance
explanation entry.

l Displays any Variance Comments and Action Plans previously entered within the VCC tool.

� Budget Variance report (BudVar)
The Budget Variance report (BudVar) includes the following information:

l Key and supplemental statistics information
l Operating revenue and expenses
l Key per-unit calculations
l Staffing information

The Budget Variance Report is broken out into four sections:

l Income Statement Summary - Current Month and Year-to-Date
l Income Statement Account detail - Current Month and Year-to-Date
l Current Year Forecast Summary
l Current Year Forecast Account detail

If opened within the Axiom system, all four sections display on the same tab. If the report is delivered
through email or saved on a network drive, the four sections may be presented on a single sheet or
separated on four individual tabs.
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Review the Summary Level information, then look to the detail for further explanation regarding
variances. Determining the account numbers with variances will provide the link to the detailed
information on the AP, AR, MM, etc. reports that support the expense. As in our example above, Salaries
and Other Expenses resulted in a Red Flag Variance, specifically within accounts 60600 Salaries-Contract
Labor and 69230-Recruitment.

The first section of the report contains Current Month and Year to Date information at a Summary level.

Below the first section is Current Month and Year to Date information, detailed by Account Number.

To the right of the first section is Monthly Trend information at a Summary Level.
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To the right of the Detail for Current and Year to Date is Monthly Trend information by Account Number.

� Charts
The Charts report provides an overview of comparative trends across periods for Volume, Total Expense
per unit, Worked Hours per unit, and Salary Expense per unit.

Similar to the Scorecard, this report can be used to review performance trends that may require further
research.
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l Volume chart - Compares the department’s key statistic amounts by month for current year
actual, current year budget, and last year actual

l Total Expense Per Unit chart - Compares the department’s total expense per key statistic
amounts by month for current year actual, current year budget, last year actual, and current year
flex budget (if used)

l Worked Hours Per Unit chart - Compares the department’s total worked (productive) hours per
key statistic amounts by month for current year actual, current year budget, last year actual, and
current year flex budget (if used)

l Salary Expense Per Unit chart - Compares the department’s total salary expense per key statistic
amounts by month for current year actual, current year budget, last year actual, and current year
flex budget (if used)

For example, when reviewing the Volume and Total Expense Per Unit charts within the screen shot
below, you will notice the following:

l The department’s current year actual key statistic volume represented by the red line has been
moving in a positive direction since December, and is above the current year budget’s blue line
and is equal to last year actual’s yellow line for the current month of February.

l The department’s actual total expenses per unit (key statistic volume) represented by the red line
is moving in the right direction with the downward trend since December. For the current month
of February the actual is slightly below the current year static budget’s blue line, and slightly
above the current year flex budget’s green line.

These trends provide a couple of positive observations for the current month of February—
departmental volume is above budget expectations, and total expenses per key stat are below the static
budget and in line with the flex budget. The details behind these trends can be explained by reviewing
the pertinent reports within this package.
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� General Ledger report (GL)
The General Ledger report (GL) contains every transaction that makes up the total dollar amount for each
expense account. This report, combined with the AP, MM, and AR reports described below, helps you
understand the nature of the expenses. In other words, they help you recall items purchased or services
utilized for each account.

The standard JE Source codes of each GL transaction are categorized as follows (individual company
source codes may vary slightly):

l Salaries and wages come from the payroll source system and usually have a PR in the JE Source.
To ensure the JE Salary dollars are in line with FTE amounts, the JC and EmpID tabs included in the
reporting package allow you to review payroll hours by Jobcode and individual Employee.

l Invoices have a JE Source ofAP or accounts payable if the invoice has already been processed for
payment, click the AP tab.

l Invoices have a JE Source ofAR or accrued receipts for purchase order acquisitions that have been
received but have not been invoiced. For further detail of an AR expense, click the AR tab.

l Inventory items coming from supply chain or your materials management department
customarily have aMM in the JE Source. For further detail of an MM expense, click theMM tab.
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l A journal entry or JE code are expenses processed by the Accounting department. An example of a
JE item would be an annual prepaid subscription. Even though the invoice for the subscription
was paid in full with a single payment to the vendor, Accounting would hold the total amount and
book onemonth’s worth of the expense to your department for each of the 12months covered
under the subscription. For further details related to JE expense transactions, please contact your
assigned Finance representative.

� Accounts Payable Distribution report (AP)
The Accounts Payable Distribution report (AP) comes directly from the Accounts Payable Source System
and provides individual invoice information for purchases made including Description, Vendor Name, PO
Number, and Amount.
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AP transactions may include links to supporting documentation. In the Link to Image column, click the
folder to open the document image.

� Materials Management Distribution report (MM)
TheMaterials Management Distribution report (MM) comes directly from the inventory system (store
room) and provides transaction detail items pulled from inventory including Item Description, Quantity,
and Amount.
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� Accounts Receipts Distribution report (AR)
The Accrued Receipts Distribution report (AR) comes directly from the purchasing system and provides
purchase order detail. Items on this report have been received in your purchasing system, however,
your organization has not received an invoice for the purchases. Information provided on this report
includes Vendor Name, PO Number, Item Description, Invoice Number, and Amount.
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AR transactions may include links to supporting documentation. In the Link to Image column, click the
folder to open the document image.

� Labor Analysis
Labor is typically the largest expense in healthcare organizations and thus a key component to
understanding and potentially improving your department’s financial performance.

Steps and questions for reviewing labor (salaries and hours) data:

1. In the previous section you may have identified variances in salary and/or hours at a general
ledger account level. The expense per unit data on those reports would let you know if the
variance is related to volume. If not volume, more detail is helpful in determining whether the
cause is efficiency (using more labor hours than budgeted) or rate (paying more labor dollars per
unit). If the variance is due to paying more labor dollars per unit, the cause could be an issue
related to:

l Staffing Mix where higher paid positions are used more than the budgeted profile (an
unplanned higher use of RNs instead of LPNs); or

l Salary Rates where the individuals within the budgeted positions earning more dollars per
hour than planned.

2. Review payroll data to identify variances, their causes and trend data. Useful questions include:

Overtime:

l Is overtime usage value-added or resulting from undisciplined employee clocking habits?
l Is overtime usage approved?
l Is overtime themost efficient way to leverage departmental staff vs. float employees, or

could a different staffing mix be used (are there other staff members available for
scheduling who would not incur overtime in given period)?

Productivity:

l Are productive hours per unit consistent with budget? If not, what is cause? Are there
opportunities to flex or increase/decrease staffing with an increase/decrease in
departmental volumes?

l Are salary rates per productive hour consistent with budget? If not, is staffing mix a factor
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(using more high cost positions than lower cost)?

Use the following reports in theManager Monthly Package to complete the Labor Analysis:

Pay by Employee ID report (EmpID)
The Pay by Employee ID (EmpID) report contains Hour and FTE information by individual Employee ,
including recent individual pay periods and year-to-date.

Hours are categorized by Productive, Overtime, and Non Productive categories.

Pay by Job Code (JC) report
The Pay by Job Code (JC) report contains Hour and FTE information by individual Jobcode , including
recent individual pay periods and year-to-date.

Hours are categorized by Productive, Overtime, and Non Productive categories.
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Revenue and Usage report
This report displays actual Volume and Revenue by individual Inpatient/Outpatient CDM code for the
appropriate departments.

Please note the detailed lines shown here will sum up to the actual key stat volume totals displayed
within the other financial reports of this package. For example, the screen shot below provides the CDM
details related to the sample department’s current period key stat volume of 514 previously shown
within the Scorecard section of this guide.

CDM Codes Included in Department Statistics:

l Included to determine key stat volume totals for driving variable items for Budgeting, also used as
the denominator for departmental per unit calculations including Gross Revenue per unit, Salaries
per unit, etc.

CDM Codes Not Included in Department Statistics:

l CDM Charges that are billed and included as revenue, but not included in the departmental key
stat volume totals. For example, Supply related codes are captured and billed as revenue, but any
related volume is not included or counted as a key statistic.

Setup Guide Axiom Budget Planning │ 582



Understanding file output options
Axiom Budgeting provides a variety of file output options to share data with people throughout your
organization. This section explains the file setup to use these features.

l Print view setup: You can set up one or more custom print views for each sheet in an Axiom file.
You can associate these print views with sheet views to automatically hide and/or format rows
and columns in the print copy.

l Snapshot setup: Users can take snapshot copies of Axiom files without requiring any advance
setup. However, if desired, you can flag certain rows and columns in the sheet to be deleted in the
snapshot copy. The primary use for this would be to delete work areas or Axiom query artifacts
that are no longer necessary in the snapshot copy.

Printing an Axiom file
You can print an Axiom file on a per sheet basis by using the Print command. Each sheet can have one or
more defined print views. You can use the print views to print different views of the sheet, and to set
certain standard print options such as the print orientation. For example, for a plan file, you might have
one print view that prints a summary view of the sheet with certain columns and rows hidden for
printing, and another print view that prints a detail view of the sheet with all columns and rows visible.

If a sheet has no predefined print views, then you can print the sheet using the settings defined for the
spreadsheet using standard Excel printing features. For more information on defining print settings for a
spreadsheet, see theMicrosoft Excel Help. In theWindows Client, the spreadsheet print settings are
defined in theWorkbook Explorer, in the Page Setup section for each sheet.

NOTE: You can always print the file using standard spreadsheet print functionality, even if Axiom
print views have been defined.
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To print an Axiom file:
1. On theMain ribbon tab, in the File Output group, click Publish to do one of the following:

l To select the sheets to print, click Print > Print This Sheet.

The Print Sheets dialog opens. This dialog lists the available print views for the entire
workbook or for the current sheet, depending on how you entered the dialog. To sort this
list by the Sheet Name or Print View Name, click the column header.

Note the following:

o If a sheet does not have a defined print view, then it is listed with a print view name
of Default, and uses the print settings defined for the spreadsheet.

o Control Sheets cannot be printed using the Axiom Budgeting printing feature,
whether they are visible or hidden. To print a Control Sheet, use the standard
spreadsheet printing features.

2. In the Print Sheets dialog, select the sheet / print view combinations to print.
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To print all print views for all sheets, select the checkbox in the column header to select all.

If you opened this dialog by using Print This Sheet and the sheet has only one available print
view, then that view is selected by default.

3. You can also do any of the following before printing:

l View and edit the print settings. To view and potentially change the print settings for a
selected view, click the View/Edit link. In the Print Options dialog, you can change any of
the print settings for the current print job only (the changes are not saved in the file). For
more information, see Print Options dialog.

l Preview a print view. To preview a print view, click the Print Preview link. The native
spreadsheet Print Preview feature opens to preview the print job. You can only view one
preview at a time.

l Select a printer. To print to a different printer than your default printer, click Choose
Printer at the bottom of the dialog. In the Printer Setup dialog, select the printer to use,
and then click OK.
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4. Click Print.

The selected items print.

Print Options dialog
The Print Options dialog displays the print settings for the current print view. If desired, you can edit
settings for the current print job only. Any changes you make are not saved in the file.

NOTE: Print options are read-only when using the Print Plan Files option to print multiple plan files.

This dialog displays all of the settings that will be applied to the print job, whether the setting is defined
in the associated Print tag or inherited from the spreadsheet settings. If a setting is blank, then that print
option is not defined and is not applied to the print job.

� Print View Options

Item Description

Print ViewName The name of the current print view.

ViewName The name of the sheet view to be applied when printing. These are
the same sheet views that are available from the Change Viewmenu.
For example, if the sheet view is configured to hide columns or rows,
those columns and rows are hidden in the print copy. Row and
column sizing are also applied.

Paper Size The paper size for the print job, either Letter or Legal.

Orientation The print orientation for the print view, either Portrait or Landscape.

Repeat Rows The rows to repeat at the top of the page. Rows must be specified as
a range; for example: 1:3.

Repeat Columns The columns to repeat at the left of the page. Columns must be
specified as a range; for example: A:C.

� Scaling

Item Description

Fit To Pages Wide The number of pages on which to fit the print area. For example, if
you want the print area to fit on one page, specify 1.

Percent Zoom The percent zoom to apply to the print range. Specify the number
without a percent sign. For example, to zoom by 90%, specify 90.
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� Headers and Footers

Item Description

Left Header Header text to display in the left-hand side of the header.

Center Header Header text to display in the center of the header.

Right Header Header text to display in the right-hand side of the header.

Left Footer Footer text to display in the left-hand side of the footer.

Center Footer Footer text to display in the center of the footer.

Right Footer Footer text to display in the right of the footer.

Emailing a hyperlink to an Axiom file
You can email a hyperlink to an Axiom Budgeting file using the E-mail feature on theMain tab. Axiom
Budgeting creates a URL hyperlink to the file and includes it in an email. The email recipient can click on
the link to launch the system and open the file directly, assuming that the recipient is an Axiom
Budgeting user who has rights to access the file.

NOTE: The email hyperlink feature is not supported for use with the Axiom Budgeting shared client.

You can send the email using your default email client (such as Microsoft Outlook), or you can send the
file using the Axiom Budgeting Scheduler email service. For example, you may be using Axiom Budgeting
on a shared client server where you do not have access to a local email client, and therefore you would
use the system's email service to send the email.

NOTE: The Scheduler email service does not support HTML format for email.

If you use the Scheduler service, the email message is sent the next time the Scheduler SMTP Email
Delivery task is run. The frequency of Scheduler email delivery depends on how this task has been
configured in your environment, but typically it runs continuously (or close to it).

Note the following:

l Alternatively, you can obtain a URL to an Axiom file using a variety of ways and then paste it into
an email that you createmanually. For example, you can use GetDocumentHyperlink or right-click
a file in Axiom Explorer to obtain a URL. The email hyperlink feature is provided as a convenience
to quickly send a hyperlink to the current file.

l The email hyperlink feature cannot be used to send a hyperlink to open a form-enabled file as a
form; the source file is always opened as a spreadsheet.

l The hyperlink included in the email uses the same format as hyperlinks generated using
GetDocumentHyperlink, including the differing URL format for systems using SAML or OpenID
Authentication.
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To email a hyperlink to an Axiom file:
1. Open the file in Axiom Budgeting.

2. On theMain ribbon tab, in the File Output group, click Publish > E-mail Workbook.

3. In the Email Active Workbook dialog, for Send As, select Document Link.
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4. For Send using, select one of the following::

l Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

NOTE: This option is not available if you use Axiom Budgeting on a shared client server.

l Axiom Mail Service: Send the email using the Axiom Budgeting Scheduler email service.

5. Optional. Complete the following Document Link Options in the dialog:

Option Description

Sheet Filter If desired, enter a filter to apply to the file when it is opened. You can type
the filter statement or use the Filter Wizard.

The filter is applied like a Quick Filter and affects any data queries in the file.
For example, Dept.Region='West' means that all data queried is limited to
theWest region.

If desired, you can specify a table or table type to apply the filter to, using the
same filter syntax that is available for the GetDocumentHyperlink function. In
this case you must manually type the filter syntax because the Filter Wizard
does not account for this type of syntax.

Cell Address If desired, specify the cell to bemade active when the document is opened.

For example: Sheet1!D22

If the specified location would not be in view normally then the file will be
scrolled to that location; otherwise the file will open in its default viewwith
the cursor placed at that location.

6. Click OK.

If you selected to send the hyperlink using your default email client, then a new email message opens,
with the hyperlink included in the body text. You can then specify the recipient, subject, and additional
body text for the email, and then send it.

If you selected to send the hyperlink using the Axiom email service, then an E-Mail dialog opens so that
you can specify the recipient, subject, and additional body text for the email. In the Address fields (To ,CC
, and BCC fields, you can type an email address or click the button to select an Axiom Budgeting user. If
you select a user, the email will be sent using the user's email address as defined in Axiom security. When
you click OK, the email settings are saved to the database, to be sent the next time the Scheduler SMTP
Email Delivery task is run.
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Emailing a snapshot of an Axiom file
You can email a snapshot of an Axiom file using the E-mail feature on theMain ribbon tab. Axiom
Budgeting creates a snapshot copy of the file and attaches it to an email. The copy can then be viewed
outside of Axiom Budgeting by someonewho may have no access to the system. When you use this
feature, the system creates a snapshot copy of the file just like it would if you used the Snapshot feature.

You can send the email using your default email client (such as Microsoft Outlook), or you can send the
file using the Axiom Budgeting Scheduler email service. For example, you may be using the software on a
shared client server where you do not have access to a local email client, and therefore you would use
the Axiom Budgeting email service to send the email.

NOTE: The Scheduler email service does not support HTML format for email.

If you use the Scheduler service, the email message is sent the next time the Scheduler SMTP Email
Delivery task is run. The frequency of Scheduler email delivery depends on how this task has been
configured in your environment, but typically it runs continuously (or close to it).

Note the following:

l The name of the emailed file is Sheetname_snapshot (if the snapshot contains only one sheet) or
FileName_snapshot (if the snapshot has multiple sheets). You cannot change the name.

l You can also email snapshot copies using the File Processing feature. File processing is typically
used when you want to automate the process and employ Multipass processing to send the same
file to different people using different data. The E-mail feature is best used to send one-off
snapshots as needed.

To email a snapshot copy of an Axiom file:
1. Open the file in Axiom Budgeting.

2. On theMain ribbon tab, in the File Output group, click Publish > E-mail Workbook.

3. In the Email Active Workbook dialog, for Send As, select Snapshot.
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4. For Send using, select one of the following:

l Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

NOTE: This option is not available if you use Axiom Budgeting on a shared client server.

l Axiom Mail Service: Send the email using the Axiom Budgeting Scheduler email service.

5. Complete the following Snapshot Options in the dialog:
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Option Description

Send file as Select XLS, XLSX, XLSM, or PDF. XLSX is selected by default.

NOTE: PDF is not available in the Axiom Budgeting Windows Client.

Include Select one of the following:

l Entire Workbook: All sheets are included in the snapshot (except Control
Sheets and hidden sheets, which are always removed).

l Active Worksheet Only (default): Only the active worksheet is included in
the snapshot.

Formulas l Convert All Formulas (default): All formulas are converted to values.
l Retain Excel Native Formulas: Axiom formulas are converted to values,

but Excel formulas are left as is.
If an Excel formula references a sheet that is not included in the snapshot,
that formula will be converted to a value.

NOTE: If the file contains a pivot table, this option must be selected in order
for the pivot table to work in the snapshot copy. This option does not apply
if PDF is the selected file type.

6. Click OK.

If you selected to send the file using your default email client, then a new email message opens, with the
snapshot file attached. You can then specify the recipient, subject, and body text for the email, and then
send it.

If you selected to send the file using the Axiom mail service, then an E-Mail dialog opens so that you can
specify the recipient, subject, and body text for the email. In the address fields (To, Cc, and BCC), you can
type an email address or click the button to select an Axiom Budgeting user. If you select a user, the
email is sent using the user's email address as defined in Axiom security. When you click OK, the email
settings are saved to the database, to be sent the next time the Scheduler SMTP Email Delivery task is
run.
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